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CCHHAAPPTTEERR  11..    IINNTTRROODDUUCCTTIIOONN  

IINNTTRROODDUUCCTTIIOONN  
Welcome to the RealFlight Generation 3.5 R/C Flight Simulator (also known as 
RealFlight G3.5, or simply G3.5).  RealFlight G3.5 is, without question, the most 
advanced R/C aircraft simulation available.  RealFlight G3.5 is so technologically 
advanced and so realistic, you’ll find it hard to believe that it’s only a simulation.  
The culmination of many years of development and design, G3.5 offers 
advancements that will serve to fine-tune flying skills of even the most seasoned R/C 
veteran.  If you’re an entry-level R/C-er, RealFlight G3.5 is the ideal way to learn to 
fly, practice maneuvers, feel the effects of design modifications, or just have an 
incredible amount of fun. 

RealFlight G3.5 includes over 50 models that look and fly like the real thing, plus a 
multitude of flying sites -- each with their own unique ‘feel’ and distinctive 
characteristics.  In addition, G3.5 offers its users the most powerful, most flexible 
aircraft and flying site editors ever unveiled to the modeling community, allowing 
modelers to experiment with a virtually unlimited number of parameters.  G3.5 
enables you to change the look and feel of a flying site with nothing more than a few 
keystrokes, the click of the mouse and a little imagination.  The integrated 
AccuModel™ aircraft editor makes modifying aircraft just as easy. 

RealFlight G3.5 also offers a wide array of tools to help you understand how to use 
the program and how to improve your R/C piloting skills.  This extensive Help file 
explains every feature and option as you use it.  Our Virtual Flight Instruction 
feature, Heli Hover Trainer, Airplane Hover Trainer and Heli Orientation Trainer 
provide on-the-fly learning opportunities, and our trained and dedicated Product 
Support staff is ready to provide help when you need it.  No other R/C simulator 
goes further to enrich your R/C experience. 

The following section briefly outlines some of the new features in RealFlight G3.5.  
We strongly suggest that you peruse this manual in its entirety before running the 
software.  Subsequent chapters will describe all RealFlight features in complete 
detail. 

Finally, we’d like to express our gratitude to you for purchasing RealFlight G3.5.  
We think you will be enormously pleased with G3.5.  Have fun flying! 
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WWHHAATT’’SS  NNEEWW  IINN  RREEAALLFFLLIIGGHHTT  GGEENNEERRAATTIIOONN  33..55  WWIITTHH  UUSSBB  
IINNTTEERRLLIINNKK™™  PPLLUUSS  CCOONNTTRROOLLLLEERR  

This section briefly outlines some of the new features included in RealFlight G3.5 with the 
USB InterLink Plus Controller.  RealFlight G3.5 and the patented and patent pending 
InterLink Plus Controller incorporate a significant number of enhancements and 
improvements over previous RealFlight systems. 

USB INTERLINK PLUS CONTROLLER  
The InterLink Plus Controller by Futaba is a revolutionary device that offers you: 

• A high quality USB compatible plug and play controller for RealFlight 
G3.5. 

• A built-in interface for (optionally) using your own R/C transmitter to 
control RealFlight G3.5. 

• The InterLink Plus Controller is fully hot swappable — you can 
connect and disconnect the InterLink, or your own transmitter, without 
rebooting your computer (or even shutting down RealFlight). 

• High-speed response to control inputs. 

• Digitally precise inputs for unmatched control precision. 

• MultiMode split screen capability- allowing you to use the InterLink 
Plus as a controller and an interface simultaneously. 

• A keyboard-free push button reset of the simulation. 

• Hand-launch gliders and other aircraft that do not incorporate landing 
gear. 

MENU-DRIVEN INTERFACE  
RealFlight G3.5 utilizes a drop-down menu-driven interface system.  Created for 
ease of use and maximum flexibility, the menu system provides an interface familiar 
to even a casual computer user. 

ADDITIONAL NEW FEATURES 
• Take 3D flight to 4D with the variable pitch prop.  Select the popular 

FlatOuts™ Extra 300S with V-Pitch and try amazing maneuvers you 
didn’t think were possible with an airplane – like flying backwards. 

• Learn to torque roll or hover a heli with RealFlight’s Heli and Airplane 
Hover Trainers.  For more excitement, try the Heli Orientation Trainer.  
Each a great training aid for anyone new to radio control. 

• Just because the sun goes down, doesn’t mean you can’t fly.  The same 
is true with RealFlight’s night flying.  Pick a nighttime airport, and 
watch as your aircraft lights up the sky. 

• G3.5 also includes ultra-realistic PhotoField™ airports.  Using 
incredible high-resolution digital images, RealFlight PhotoField 
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airports are as real as it gets.  In addition, the Import feature allows you 
to use your own panoramic photos to create new flying sites. 

• More realistic crashes!  Now when you crash, you’ll see chaff and other 
parts fly off your aircraft or fly into a tree and see the leaves fall to the 
ground. 

• Run into a garbage can or traffic cone and watch as they fall over in 
response – just like real-life. 

• Virtual sound effects have been added to increase the realism of the 
flying sites. 

These are just a few of the new features to G3.5.  See Chapter 4 for a complete list of 
features available in RealFlight.  Please keep the suggestions coming!  Great Planes 
and Knife Edge Software are continually enhancing RealFlight, striving to provide 
you with the most accurate and realistic R/C Simulator ever created.  Submit your 
suggestions to:  rfnl@greatplanes.com.  Please use RealFlight Suggestions as the 
subject title. 
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CCHHAAPPTTEERR  22..    BBEEFFOORREE  YYOOUU  BBEEGGIINN  

SSYYSSTTEEMM  RREEQQUUIIRREEMMEENNTTSS  
You will find the suggested system requirements for the RealFlight Generation 3.5 
R/C Flight Simulator listed below.  The minimum system requirements below are the 
bare minimum PC configuration for installing RealFlight G3.5.  Meeting the 
minimum requirements will allow you to enjoy G3.5.  However, in order to take 
complete advantage of the many features and functions offered by G3.5, you should 
have a computer at or near the specifications as specified in the optimum system 
requirements. 

MINIMUM SYSTEM REQUIREMENTS 
• Windows XP*, 2000*, ME or 98  

* Local administrator access required for Windows XP or 2000 

• Intel Pentium 1.0 GHz or equivalent processor 

• 256 MB RAM  

• DirectX 9 (or above) feature-compatible video card and sound card 

• 3D video card with at least 32MB RAM 

• 2 GB hard drive space 

• CD-ROM drive 

• USB port 

SUGGESTIONS FOR OPTIMUM PERFORMANCE 
In addition to the requirements above: 

• Windows XP 

• Intel Pentium 3.0 GHz (or equivalent) and above processor 

• 3D video card with 128 MB (or higher) RAM 

• 1 GB RAM 
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MULTIPLAYER REQUIREMENTS- 
• 56.6 Kbps (or faster) modem or LAN connection 

VVIIDDEEOO  AANNDD  SSOOUUNNDD  CCAARRDDSS  
In order to achieve optimum performance and the best flying experience in 
RealFlight, there are two important components of your computer that deserve 
special attention:  the video and sound cards. 

RealFlight G3.5 has undergone countless hours of compatibility testing and 
evaluation.  As such, this software will adequately function with a variety of video 
cards- ranging from yesterday’s favorites to tomorrow’s hits. 

While RealFlight works well on a wide variety of hardware configurations, it offers 
many features and functions that are designed to take particular advantage of the 
latest video technology.  If you have an older computer, or a newer computer with a 
lower-end video card, you may want to consider purchasing a new video card to take 
advantage of these features and functions.  This moderately priced upgrade can 
vastly enhance your enjoyment of RealFlight.  Aside from increasing your 
satisfaction with G3.5, a new video card will also work with many other games or 
simulators, improving their performance as well. 

For a list of the video cards that have been tested by our staff, please visit: 

http://www.gpsoftware.com/ 

While not as important as the video card, upgrading your sound card may also 
improve your satisfaction with RealFlight.  This is especially true if your computer 
uses an on-board sound card (a sound card affixed to the motherboard). 

GGEETTTTIINNGG  TTHHEE  MMOOSSTT  OOUUTT  OOFF  RREEAALLFFLLIIGGHHTT  
We think you’ll agree that RealFlight offers the finest set of instructions and practice 
tools of any R/C simulator, for both beginners and experienced pilots.  Great Planes 
and Knife Edge Software are committed to the continual improvement of our 
products.  When using the software, you should keep two things in mind. 

First, similar to other pursuits, what you get out of RealFlight depends upon what 
you put in.  Mastering radio control requires a great deal of patience and practice.  If 
you crash an aircraft in the simulation, take it very seriously.  Crashing an actual R/C 
aircraft can cost you a lot of time and money.  Try to examine what you did 
incorrectly, using the experience to avoid making the same mistake again. 

Secondly, while the simulator is quite realistic, and will assist you in learning many 
of the skills necessary to become a proficient pilot, there is no substitute for actual 
flying time at the field.  A simulation can be a wonderful practice tool.  However, no 
simulator, no matter how realistic, can completely replace a qualified, experienced, 
human flight instructor.  If you are new to R/C, you should never attempt to fly a real 
aircraft without the supervision of a qualified instructor, no matter how 
accomplished you are on the simulator. 
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CCHHAAPPTTEERR  33..    GGEETTTTIINNGG  SSTTAARRTTEEDD  

OOVVEERRVVIIEEWW  
This chapter covers the installation procedure for RealFlight G3.5, describes the 
basics of running the program, and introduces you to some of RealFlight’s frequently 
used features. 

The first section, Installing RealFlight Generation 3.5, offers a step-by-step 
approach to the installation procedure for both the program software and the 
controller. 

The second section, Exploring RealFlight G3.5, offers a brief tour of the RealFlight 
G3.5 program.  You'll learn how to perform some basic functions, such as selecting 
the aircraft you wish to fly, performing simple edits to the flying field, manipulating 
viewports, and using RealFlight’s new Virtual Flight Instruction feature. 

This chapter only touches briefly on some of RealFlight G3.5’s features.  We 
strongly suggest that you also read the subsequent chapters, which describe the 
various features in comprehensive detail. 

IINNSSTTAALLLLIINNGG  RREEAALLFFLLIIGGHHTT  GG33..55  
The RealFlight G3.5 InterLink Plus controller has several different modes of 
operation.  By itself, it serves as a realistic ‘stand alone’ controller or joystick.  
Alternatively, it has a built-in interface that lets you use your own R/C transmitter to 
control RealFlight G3.5.  The final mode of operation combines the InterLink Plus’ 
ability to serve as a controller and an interface simultaneously. 
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The USB InterLink Plus Controller 

To install RealFlight G3.5 using the InterLink Plus controller, follow the instructions 
in this chapter. 

Regardless of whether you plan to use the InterLink Plus controller by itself or with 
your own R/C radio to control RealFlight, follow the instructions on Program 
Installation in the next section. 

PROGRAM INSTALLATION 
RealFlight Generation 3.5 features a simple, one-step installation process.  There are, 
however, further steps that must be followed prior to running the program for the 
first time.  This section will explain how to install the RealFlight G3.5 software and 
hardware.  Upon completion of this section, you should be able to fly the aircraft on 
your PC. 

The InterLink Plus’ built-in transmitter interface also allows you to use your own 
R/C transmitter to control RealFlight G3.5 should you opt to do so.  To activate the 
interface adapter, you will first need to follow the instructions in the section below.  
This section, will explain the methodology of using the transmitter interface option 
in the InterLink Plus controller. 

UPDATE DRIVERS 
Before you begin installation, we strongly suggest that you update the drivers for 
both the sound and video cards on your PC.  A driver is a software program that your 
computer uses to control hardware devices.  Each card has its own respective driver.  
Most problems with installing and using RealFlight, as well as many other programs 
that use DirectX, arise from using outdated video and/or sound card drivers. 

If you are not sure how to update your drivers, you can find instructions in article 
Q01-1038, Locating and installing drivers, at http://www.gpsoftware.com/kb/q01-
1038.htm.  This support article will take you through the process step-by-step and 
has links to driver download sites for most manufacturers. 
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INSTALLING THE SOFTWARE 
After you have completed installation of the new video and sound card drivers, you 
are now ready to install RealFlight G3.5. 

1) Before installing the software, make sure to close any applications that you are 
running.  This includes virus checkers and other similar applications. 

2) Insert Disc 1 (One) into the appropriate CD-ROM drive. 

3) If Auto-Play is active, setup will begin automatically when the CD-ROM drive 
is closed.  Simply click the Install button when prompted.  If Auto-Play is not 
active, click Start on the task bar.  Next, click Run.  In the dialog box that 
appears, type ‘d:\setup’ (assuming that ‘d’ is your CD-ROM drive) and click 
OK. 

Follow the on-screen instructions to complete the setup procedure.  When 
prompted, remove Disc 1 (One) and insert Disc 2 (Two).  Following the on-
screen prompt once again, remove Disc 2 (Two) and insert Disc 3 (Three).  
Upon completion of the installation, click OK. 

INSTALLING OR UPDATING DIRECTX 
1) RealFlight will ask if you wish to install DirectX 9 on your PC.  It is important 

that your PC utilizes DirectX 9.0C or later.  Click OK to proceed to the DirectX 
License Agreement. 

2) Click "I accept the license agreement" to install DirectX 9.0C.  Alternatively, 
if you do not wish to update DirectX at this time, click Cancel. 

3) If you have opted to accept the license agreement, click Next to proceed with 
the installation.  DirectX will install the necessary files to update your PC. 

4) When prompted, click Finish.  Your PC will power down and then restart once 
again. 

CONNECT THE INTERLINK PLUS CONTROLLER 
The InterLink Plus controller uses the USB (Universal Serial Bus) port, so there is 
little to do in the way of setup. 

1) With the software installation procedure complete, firmly plug the InterLink 
Plus controller into one of the unused USB ports on the PC.  Because the 
controller is hot swappable, you do not have to shut the PC down to plug the 
controller in. 

2) The amber light on the front of the InterLink Plus controller should begin to 
flash.  This indicates that the controller is properly connected.  If the light does 
not blink, remove the controller from the USB port and plug it in firmly once 
again. 
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STARTING REALFLIGHT GENERATION 3.5 
1) Double-click the RealFlight G3.5 Launcher located on your desktop. 

2) Type in your name, software serial number and InterLink Plus controller serial 
number in the appropriate location.  Please be sure to enter the numbers exactly 
as they appear.  If you fail to do this, you will not be able to proceed to the next 
step.  If the serial numbers are entered properly, the OK button will become 
active. 

3) Click OK.  The RealFlight G3.5 Launcher will come up.  Click Run 
RealFlight.  The program will start with a default airplane (Hobbico’s 
NexSTAR Select) on the default flying site. 

You are now set up to run RealFlight G3.5, using the InterLink Plus controller.  If 
you would like to use your own R/C transmitter with RealFlight, please read the 
following section as well as the chapter pertaining to the InterLink Plus Controller. 

USING YOUR OWN R/C RADIO TO CONTROL REALFLIGHT 
(OPTIONAL)  

Follow these instructions if you intend to use your own R/C transmitter to control 
RealFlight G3.5.  If you do not want to use your own transmitter, skip this section. 

CONNECTING YOUR TRANSMITTER 
You can use your R/C transmitter to control RealFlight G3.5 by connecting it to the 
InterLink Plus controller, ‘buddy box’ style (see diagrams).  RealFlight G3.5 
includes several adapter cables used to make the connection to many popular R/C 
transmitters. 



R/C Simulator RealFlight Chapter 3.  Getting Started  •  11 

 
 

 

 

 

 

Locate the cable input port on the rear of the InterLink Plus Controller.  Plug one end 
of the included connector cable into this port.  Next, plug the other end of the adapter 
cable into the buddy box port (a.k.a. trainer jack) of your transmitter.  The procedure 
for doing so depends on your transmitter: 

• If your transmitter’s buddy box port directly accepts the 1/8” stereo 
plug, insert this end directly into the radio.  This works for most JR® 
radios. 

• If your radio takes a 6-pin DIN plug (e.g., the round Futaba 
connectors), use the short extra 1/8” stereo to 6-pin DIN adapter cable 
included with RealFlight G3.5 (see left panel of the diagram above). 

• If your transmitter’s buddy box port requires the micro (square) 
connector, use the squared adapter cord included with the simulator. 

• Some radios (e.g., Airtronics®) require the purchase of an optional 
adapter cable.  This adapter cable is available wherever you purchased 
your copy of RealFlight G3.5. 

SETUP 
After you have connected your transmitter to the InterLink Plus controller, you will 
need to perform a brief setup procedure before utilizing it with the simulation. 

1. First, make sure that the transmitter is in FM or PPM mode rather 
than PCM mode.  Refer to the manual for your transmitter if you 
are unsure how to do this. 

2. If the transmitter did not power up when the interface cord was 
plugged into it, turn the power switch on at this time. 

Futaba 
Adapter 
cord 

Hitec/ 
Futaba 
adapter 
cord

Interface 
adapter port 

Interface adapter 

To the JR pin 
on the Interface 
adapter cord 

To Futaba micro-
plug transmitter 

To InterLink 
adapter port 

To Hitec/ Futaba 
transmitter 

To JR 
transmitters OR 
adapter cord 
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3. Next, click the Controller menu and then highlight the Select 
Controller menu item.  After a brief delay an option for the 
InterLink Transmitter x channel should appear.  Choose the 
InterLink Transmitter x channel option. 
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EEXXPPLLOORRIINNGG  RREEAALLFFLLIIGGHHTT  GG33..55    
Now that you have completed the installation of RealFlight G3.5, it’s time to begin 
exploring the program.  The following sections will take you on a quick tour of 
RealFlight G3.5’s most popular features, such as selecting an aircraft, choosing 
alternate flying locations, customizing the flying sites, and using the training aids 
instruction.  Along the way, we will show you where to go for help and how to 
obtain additional information. 

Even if you are familiar with previous versions of the RealFlight software, you 
should read this section thoroughly.  The features described here are either new or 
have been completely revised for G3.5. 

START THE PROGRAM 
1) Close all open applications.  This includes virus checkers and other similar 

programs. 

2) Double-click the RealFlight G3.5 Launcher located on your desktop. 

3) To start the simulation, click the Run RealFlight button. 

The program will start using the pre-set defaults -- including pilot perspective, flying 
location, and aircraft. 

THE MAIN REALFLIGHT DISPLAY 
RealFlight G3.5 is a menu-driven program.  As seen in the picture below, a menu bar 
appears across the top of the RealFlight screen.  The menus contain additional menu 
items and pull-down lists for the related options of the respective menu.  These 
menus allow access to the command and control functions for the RealFlight G3.5 
simulation. 
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Navigating the Menus  
To access the various menu items, simply highlight and click the mouse on the menu 
that you would like to view.  For example, clicking on the Aircraft menu activates 
the sub-menu items for that menu. 

The top-level menus found in G3.5 are as follows: 

• Simulation 

• Aircraft 

• Controller 

• Events 

• Multiplayer 

• Recordings  

• Training 

• View 

• Window 

• Help 

This manual includes a separate chapter for each menu title.  Later chapters describe 
(in detail) all of the menu items, sub-menus and options. 

Please note that it is also possible to access many of the features and functions of 
RealFlight Generation 3.5 using hot keys.  Pressing the H key on the keyboard 
activates the Keyboard Commands dialog, which summarizes the available hot 
keys. 

AIRCRAFT SELECTION 
When you start G3.5 for the first time, you will be piloting Hobbico’s NexSTAR 
Select.  This is the default aircraft for RealFlight G3.5. 

To select a different aircraft, click the Aircraft menu title in the main menu bar.  
Next, click the Select Aircraft… menu item found in the drop-down menu.  This 
activates the Select Aircraft dialog (as shown below), which displays a list of 
available aircraft. 
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Each aircraft available in G3.5 is listed along the left-hand side.  The icon next to 
each name differs depending on whether the model is an airplane or a helicopter.  To 
select an aircraft from the list, click on the desired aircraft.  The selected model will 
now appear in the ReadySelect™ preview box.  Additionally, an aircraft description 
and information data will appear in the aircraft information pane, which appears just 
below the ReadySelect preview window. 

When you are satisfied with your selection, click OK to return to the simulator using 
the new aircraft selection. 

Complete information pertaining to the Select Aircraft… menu item is available in 
a later chapter of this manual. 

MOST RECENTLY USED LIST 
If you have selected alternative aircraft previously, you will note that these aircraft 
appear on a list in the Aircraft menu, as shown below.  This list is at the very bottom 
of the menu.  This list is commonly referred to as a Most Recently Used, or MRU 
list.  It is limited to the eight most recently used aircraft.  If you wish to fly one of the 
aircraft from this list, simply click on the name of the aircraft in the MRU list. 



16  •  Chapter 3.  Getting Started R/C Simulator RealFlight 

 

CHANGING AIRPORTS 
Changing flying sites uses a process similar to the process used to select an aircraft.  
To select a new flying location, click the Simulation menu located in the header.  
Next, click the Select Airport… menu item found in the drop-down menu.  This 
opens the Select Airport dialog, which lists the available flying locations.  Select 
either the PhotoFields or the Sierra Nevada location. 

Each airport is preceded with a [+] (plus) and an icon.  The [+] (plus) indicates that 
another expansion level (selection) is available to you.  To access the complete list of 
airports for a respective location, either click the [+] (plus) or double-click on the 
desired airport.  For example, clicking the [+] (plus) on the PhotoField folder reveals 
all of the PhotoField flying sites available to you. 

To select an airport from the list, click on the desired airport.  The selected airport 
will now appear in the preview box.  Additionally, an airport description and 
informational data will appear in the information pane, which appears just below the 
preview window. 

When you are satisfied with your selection, click OK to return to the simulator using 
the new airport selection. 
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MOST RECENTLY USED LIST 
If you have previously selected an alternative flying location, it will appear on a list 
in the Simulation menu.  This list is at the very bottom of the menu and is 
commonly referred to as a Most Recently Used, or MRU list.  It is limited to the 
eight most recently selected locations.  If you wish to fly at one of these locations 
simply click on the respective location in the MRU list to load it into the simulation. 
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SOME COMMON TASKS 
• The easiest method of resetting your aircraft to its original takeoff 

position is to press the red button located on the front of the InterLink 
Plus controller.  Alternatively, you can reset the aircraft by pressing the 
space bar on the keyboard, or by selecting the Reset Position menu 
item, which is located in the Aircraft menu. 

• If your aircraft is equipped with smoke, the two-position switch located 
on the upper right of your InterLink Plus controller will generally be 
utilized to activate this feature. 

• To magnify the view or zoom in on an aircraft, press the [+] (plus) key 
on the number pad of the keyboard.  Alternatively, you may use menu 
commands to zoom in.  To do so, click on the View menu and then 
click on the Zoom In menu item.  Each time the [+] (plus) key or the 
Zoom In menu item are pressed or selected, the view will increase 
incrementally. 

• To reduce the magnification, or zoom out of the current view press the 
[–] (minus) key on the number pad of the keyboard.  Alternatively, you 
may use menu commands to zoom out.  To do so, click on the View 
menu and then click on the Zoom Out menu item.  Every time you 
press [-] (minus) key or select and press the Zoom Out menu item, the 
view will decrease incrementally. 

• To reset the view to the default magnification, press the Backspace on 
the keyboard. 

CREATING A VIEWPORT 
RealFlight allows you to create multiple picture-in-picture viewports.  Once you 
create a new viewport, you may resize or reposition it by dragging with the mouse.  
You can also fully adjust all of the viewport’s properties independently of the main 
window or other viewports.  These viewports may be utilized for a variety of 
applications, such as changing the viewing perspective of your simulation. 

To create a new viewport, click the Window menu title followed by the Create New 
View menu item.  Alternatively, you may also press the ‘N’ key on the keyboard to 
create an additional viewport. 
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To change the vantage point within the viewport, press the ‘C’ key on the keyboard.  
The ‘C’ toggles through the various camera modes; the first of which is the cockpit 
or pilot’s perspective.  The second is chase view, and the last mode is the fixed 
viewpoint, or what you would see if you were standing at the side of the runway.  
Please note:  depending upon the flying site selected, some of these viewing options 
may not be applicable. 

It is possible to create multiple viewports simultaneously.  It is important to note that 
adding more viewport windows will require RealFlight G3.5 to use additional 
computing power.  Consequently, there is a practical limit to the number of windows 
that you can add without negatively impacting the performance of your computer.  If 
you have multiple viewports open and you begin to experience performance 
problems such as low frame rate or sluggish response, try closing a few viewports. 

Each viewport is chronologically numbered as it is added, for purposes of 
identification.  The main RealFlight G3.5 window is not numbered.  As such, the 
first additional viewport is considered as viewport number one, and so on. 

The View chapter of this manual contains a thorough explanation of the viewports 
and the viewport options. 

USING GADGETS 
The RealFlight G3.5 software includes several gadgets that may be displayed in the 
main window when running the software.  A gadget is an onscreen display that 
provides helpful information or allows you to access a variety of RealFlight features 
and functions. 

For example, the NavGuides gadget displays continuously updated information 
about your aircraft’s altitude, airspeed, directional heading, and other flight 
parameters.  To display the NavGuides gadget, click the View menu title followed 
by the Gadgets menu item.  Next, select the NavGuides gadget located in the drop-
down menu.  You may also access the NavGuides gadget by pressing the numerical 
‘1’ key on your keyboard. 
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When you select NavGuides, you should see the NavGuides gadget appear on your 
screen: 

 
As discussed previously, you can customize the gadgets for personal preference.  For 
complete information on how to do so, please refer to the chapter pertaining to the 
View menu options. 

VIRTUAL FLIGHT INSTRUCTION 
RealFlight G3.5 includes a variety of basic, intermediate and advanced pre-recorded 
maneuver lessons for helicopter and airplane pilots.  A professional, award-winning 
R/C pilot talks you through every facet of the maneuver.  You can use the Virtual 
Flight Instruction to learn new maneuvers as well as to perfect those maneuvers that 
you already know. 

To activate the pre-recorded maneuvers, click on the Training menu followed by the 
Virtual Flight Instruction… menu item.  This brings forth two options:  airplane 
and helicopter, each preceded by a [+] (plus) symbol.  If you wish to practice an 
airplane-related maneuver, click the [+] (plus) near the airplane.  Alternatively, you 
may also double-click the word itself (e.g., airplane).  This brings up the pilot 
selections.  To select amongst the pilots, click the [+] (plus), which precedes their 
name.  Alternatively, you may double-click the pilot’s name. 

To select a maneuver, double-click the name of the maneuver itself.  Alternatively, 
highlight the name of the maneuver by clicking on it, then select OK.  After you 
have selected a maneuver, click OK to proceed.  RealFlight G3.5 will automatically 
load the default airport and then start the VFI recording. 
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Once the VFI starts, you will see the instructor’s aircraft fly the maneuver and hear 
the instructor’s voice explaining how it’s done.  As depicted below, you can also 
watch the instructor’s actual stick movements using the onscreen, digitized R/C 
radio. 
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You can even fly your own aircraft next to the instructor’s!  This allows you to 
mimic the inputs and aircraft reaction simultaneously.  To simultaneously watch 
your aircraft and the instructor’s, create an additional viewport focused on your 
aircraft.  The main window will show the instructor’s aircraft and the onscreen radio 
will show the instructor’s stick movements.  The newly created viewport will show 
your aircraft. 

HELI AND AIRPLANE HOVER TRAINERS 
RealFlight G3.5 includes several training aids to help learn the basics of hovering a 
heli and torque rolling an aerobatic airplane.  Select Heli Hover Trainer…, 
Airplane Hover Trainer…, or Heli Orientation Trainer… from the Training 
menu. 

The Heli Hover Trainer and Airplane Hover Trainer allow you to select the 
controls you wish to learn, RealFlight will help out by taking over the other controls 
for you.  Helicopter pilots who desire an additional challenge and more excitement, 
can choose the Heli Orientation Trainer.  Your goal is to mimic the orientation of 
the example heli before it moves to a new spot.  The difficulty increases with each 
new level. 

 

AIRPORT EDITING 
RealFlight G3.5 offers the most powerful, flexible flying site editor ever produced on 
an R/C simulation.  G3.5’s FlexiField™ editor allows you to completely customize 
virtually every aspect of your flying sites. 

 
You can add, remove, change orientation, or resize virtually every aspect of your 
flying site.  You can alter the position and orientation of the ground objects (such as 
runways) that ‘snap’ to the terrain—you can even have a runway running up a hill!  
It’s even possible to control lighting, terrain, clouds, fog/haze, and much more.  
FlexiField provides you with almost unlimited freedom to create the flying 
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environment you want.  Moreover, when you’ve created an airport, you can share it 
with other RealFlight G3.5 users. 

To learn more about the FlexiField flying site editor, please refer to the section titled 
“Edit Current Airport…”. 

WWHHEERREE  TTOO  GGOO  FFRROOMM  HHEERREE  
The examples in this chapter only scratch the surface of RealFlight G3.5’s 
unparalleled capabilities.  You can fly with others over the Internet, fly with a friend 
using MultiMode on the same PC, try your hand at a limbo event, customize your 
aircraft’s flight parameters, and much, much more!  We encourage you to explore 
RealFlight G3.5 using some of the methods below. 

• Browse through the menus.  Many of the menus are self-explanatory, 
providing you with a more thorough look at the software.  If you’re 
adventuresome, dive right in and start making modifications to an 
aircraft or a flying site!  It’s a great way to learn more about what 
makes G3.5 tick! 

• If you’d like to learn more about a particular menu or item, look it up in 
the table of contents. 

• If you would like RealFlight G3.5 to perform a certain function but 
cannot locate the appropriate command, check the index. 

• Use the Help facilities in RealFlight’s Help menu. 

• Talk to other RealFlight users.  When you visit www.knifeedge.com, 
check out our discussion boards. 
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CCHHAAPPTTEERR  44..    UUSSIINNGG  RREEAALLFFLLIIGGHHTT  
GGEENNEERRAATTIIOONN  33..55  

IINNTTRROODDUUCCTTIIOONN  
Chapter 3 took you on a brief tour of some of RealFlight’s most popular features.  
This chapter provides you with a broad overview of all RealFlight features, and 
advises you how and where to find detailed information about the features that most 
interest you. 

PPRROOGGRRAAMM  FFEEAATTUURREESS  
SUMMARY OF FEATURES 

• RealPhysics 3D™ - One of the most ambitious models of flight in the 
world, RealPhysics 3D is untouched in its ability to re-create the 
lifelike characteristics of model flying.  RealFlight G3.5’s physics 
engine has been tried and approved by world-class competition pilots 
like Todd Bennett, Mike Cross, Pete Niotis, Frank Noll, and Jason 
Shulman.  Furthermore, aircraft in G3.5 behave with real-world 
predictability because they are carefully modeled using advanced 
methods and extensive real-world data.  If it happens at the field or in 
the air, it’s re-created with exacting detail in G3.5! 

• Variable Pitch Prop-Take 3D flight to 4D with the variable pitch 
prop.  Select the popular FlatOuts™ Extra 300S with V-Pitch and try 
amazing maneuvers you didn’t think were possible with an airplane – 
like flying backwards. 

• Hovering Training Aids- Learn to torque roll or hover a heli with 
RealFlight’s Heli and Airplane Hover Trainer.  For more excitement, 
try the Heli Orientation Trainer.  Each a great training aid for anyone 
new to radio control. 
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• Night Flying- Just because the sun is down, doesn’t mean you can’t 
fly.  The same is true with RealFlight night flying.  Pick a nighttime 
airport, and watch as your aircraft lights up the sky. 

• PhotoFields- G3.5 also includes ultra-realistic PhotoField airports.  
Using incredible high-resolution digital images, RealFlight PhotoField 
airports are as real as it gets.  In addition, the Import feature allows you 
to use your own panoramic photos to create new flying sites. 

•  “Full Coverage” collision detection- Instead of using sensors at only 
a few points, “Full Coverage” blankets the entire aircraft with points 
ensuring that every part of an aircraft will not only register a strike but 
will react authentically.  Contact can result in damage ranging from 
minor handling problems to spectacular crashes -- complete with 
realistic sound effects. 

• TruFlo Wind Dynamics™- RealFlight G3.5 introduces modelers to 
R/C’s most realistic wind model.  The five components of TruFlo Wind 
Dynamics work together to create the single most accurate wind field in 
any simulation.  Wind impacts every facet of your flight, just as it 
would at the local field. 

• AccuModel™ Aircraft Editor- G3.5’s new aircraft editor is the most 
powerful and most flexible editor ever introduced in an R/C simulator.  
AccuModel allows you to change virtually every aspect of your model 
with ease -- it places over 1,500 airfoils at your disposal, a multitude of 
propellers, and much, much more!  AccuModel brings up a wire-frame 
model for easy reference and highlights the editing area.  Make a 
change and it’s immediately reflected on-screen, ready for review and 
revision. 

• Sierra Nevada’s New Flying Sites and over 5,000 square miles to 
explore- RealFlight’s TrueLife Terrain™ goes beyond the limitations 
of traditional simulator flight.  Created and mapped from satellite 
imagery, G3.5’s landscape looks as “right” and richly varied as the 
view from your front door.  Digital elevation data brings it all into 
accurate perspective. 

• A living, breathing environment- Everything in G3.5’s 3D world is as 
realistic as possible, complete with depth and details that transcend the 
traditional “billboard” look of other simulators.  You’ll see leaves and 
branches that dance in a passing breeze and clouds that roll by with the 
prevailing winds. 

• FlexiField™ flying site editor- Takes you beyond 2D scenes into a 3D 
environment rich in new objects and editing options.  Customize an 
existing field with new foliage, different objects or both -- or create a 
new field with nothing more than a mouse, imagination and a few 
simple keystrokes. 

• InterLink™ Plus Controller- G3.5’s InterLink Plus controller 
functions as a controller, as an interface, or both.  Its push-button is 
capable of resetting the aircraft or hand-launching a sailplane. 

• Fly Split Screen- G3.5’s MultiMode™ option allows two modelers to 
fly simultaneously on one PC.  It’s perfect for practicing formation 
flight, a game of tag or personalized flight instruction. 

• Uses VirtualRevolution™ sound technology-- Doppler-correct stereo 
sounds heighten the realistic effect with true sound recordings of 2-
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stroke, 4-stroke, turbine, electric, ducted fan and gasoline engines.  As 
the aircraft crosses the field, the engine sound follows, just like its R/C 
counterpart.   

• RotoSonics™ technology-- recreating distinctive engine/blade sounds 
with startling accuracy.  Sounds so lifelike, you’ll swear you are at the 
field! 

• VFI (Virtual Flight Instruction) -- VFI gives you personal flight 
lessons from R/C’s leading experts.  Using VFI, you can select a 
maneuver (loop, roll, etc.) from an extensive list.  VFI then 
demonstrates the maneuver onscreen, performed by an expert.  While 
you watch, the voice of the pilot/instructor will explain how to perform 
the maneuver. 

• AFR (Advanced Flight Recorder) -- This feature allows the pilot to 
not only view prerecorded maneuvers, but also to record maneuvers of 
his/her own as well.  G3.5 even allows you to record your own audio 
for personalized flight instruction.  Much like a VCR, this feature also 
allows you to:  pause, speed up, slow down, and loop the performance.  
You can also play multiple recordings at the same time.  The pilot has 
the option to activate the digitized transmitter display so that he/she can 
view the radio input while flying. 

• NavGuides™- Using the NavGuides, you can display a variety of 
heads-up onscreen informational displays.  Options range from altitude 
and airspeed to aircraft heading and engine rpm’s.  This feature 
improves your ability to “see” what is going on in your virtual world. 

• Viewports- You can open up multiple picture-in-picture displays 
(number is only limited by the capability of your computer).  These can 
be used for multiple viewpoint perspectives and more.  Each viewport 
is treated as an independent “window on the world”; so that you can 
individually adjust each viewport’s vantage point, zoom level, and 
direction of view. 

• Multiplayer-You can fly with up to seven additional RealFlight G3.5 
owners in competitions, or just for the thrill of flying with one another.  
This feature can also be used to learn new maneuvers from pilots across 
the street or around the world. 

• Events- Compete solo, or fly with up to seven additional RealFlight 
G3.5 owners in a variety of Events such as:  Limbo, Spot Landing, Free 
Style, Auto rotation and Pylon Racing. 

• Control Panel- RealFlight G3.5’s Control Panel allows for easy one-
click access to program upgrades, online registration, and technical 
support. 

• Animated control surfaces and retracts— Control surfaces, retracts, 
propellers, and rotor blades move for added realism. 

• Aircraft exhaust/smoke-You can control the color, density, ‘hang 
time’, and other parameters related to airplane and helicopter smoke 
and exhaust. 

• Streamers- Add streamers to any aircraft, to any location, in any color.  
Watch as they corkscrew behind the airplane during a roll, or react to 
the wind and the propwash. 
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• Flight Failures- RealFlight can simulate many common flight failures 
(radio interference, stuck servos, engine failures, etc.).  Use this feature 
to prepare for emergencies at the field. 

• Fully editable aircraft paint/decal schemes-Customize trim schemes 
for your aircraft so that they look the way you want.  (To design your 
own paint scheme, you must use a third-party program that edits “.tga” 
files.) 

• Extensive Help materials- RealFlight G3.5 features extensive online 
tool tips and diagrams, a detailed manual, and technical support to 
enhance your enjoyment of the program. 

 

WINDOWS XP, 2000, ME AND 98SE COMPATIBLE 
RealFlight G3.5 is a native 32-bit program, designed for Windows 
XP/2000/ME/98SE.  It uses Microsoft’s DirectX 9.0C to provide cutting-edge 
graphics realism. 

CUSTOMIZABLE AIRPORTS 
RealFlight G3.5 offers you unprecedented freedom in designing your own flying 
sites.  With the new G3.5 objects, your airports will look more realistic than ever 
before.  Your imagination is the only limit. 

• G3.5’s graphical interface allows you to create entirely new fields with 
a mouse and a few simple keystrokes. 

• Choose from hundreds of objects! 

• Complete freedom to insert, remove, move, rotate and size scenery 
objects. 

• Adjust the lighting to suit your personal tastes 

• Use as many runways as you want, positioned and oriented the way you 
want.  

• Visit the forums on www.knifeedge.com to share custom airports. 

GRAPHICS 
G3.5 represents a huge leap forward in the realm of realistic rendering.  No other 
simulation comes close to matching the look and feel of the models or the virtual 
world around you. 

• Realistic shading on all objects, including the airplanes and helis.  G3.5 
even includes object self-shadowing for added authenticity. 

• G3.5’s reflectivity characteristics utilize an environmental map that 
accurately reflects objects in the scene. 

• Transparency.  RealFlight uses transparency to model the rotor blades 
of the helicopter, the airplane propellers, exhaust and smoke from the 
aircraft, aircraft canopies, and atmospheric effects such as rainbows. 

• High-resolution graphics, including visible panel lines and moving 
control surfaces, for added realism and authenticity. 
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• Optimization—G3.5 allows you to customize the resolution of the 
textures, the graphics, and the terrain independently to achieve the most 
realistic look and feel for the simulation.  This control also allows the 
user to tailor the program options to match the performance of his/her 
PC. 

• Aircraft offer moveable control surfaces such as:  ailerons, elevators, 
rudders, etc.  You’ll also note moveable props, rotors and retracts, all of 
which add to the authenticity of the simulation. 

SOUND 
• Employs Doppler-correct VirtualRevolution sound technology, 

heightening the realistic effect with true recordings of a variety of 
power plants throughout their RPM range.  The recorded power plants 
include everything from 2-stroke and 4-stroke engines to actual 
turbines. 

• RotoSonics creates realistic helicopter sounds, accurately modeling the 
sounds of auto rotations as well as other aggressive maneuvers. 

• Doppler-correct stereo effects.  As the aircraft crosses the field, the 
engine sounds follow; just like its R/C counterpart. 

PHYSICS 
• RealFlight G3.5 offers the most accurate flight model on the market, 

with special attention to 3D physics. 

• Tried, tested and approved by R/C experts such as Todd Bennett, Sean 
McMurtry, John Glezellis, Pete Niotis, Frank Noll, and Jason Shulman, 
RealFlight G3.5’s physics have proven repeatedly that they offer the 
most lifelike authenticity that R/C has ever seen. 

• Unmatched collision detection.  G3.5 offers triangle-to-triangle 
collision detection, covering every point of the aircraft for the ultimate 
in precision. 

CUSTOMIZABLE AIRCRAFT 
• G3.5 offers the most powerful and most flexible aircraft editor ever 

released.  The graphical interface and point-and-click menus make 
AccuModel easier than ever to use. 

• Radio editing options that support almost unlimited mixing 
possibilities. 

• Select either metric or SAE measurements. 

• Thousands of parameters to modify! Your options are virtually 
unlimited! 

• Create customized trim schemes using third-party bitmap editors. 
Third-party software must be capable of editing Targa [“.tga”] files. 

• Visit the forums on www.knifeedge.com to share custom aircraft or 
download aircraft that others have created. 



30  •  Chapter 4.  Using RealFlight Generation 3.5 R/C Simulator RealFlight 

CCOONNTTRROOLLLLEERR  FFEEAATTUURREESS  
RealFlight G3.5 comes with Great Planes’  InterLink Plus controller by Futaba. This 
revolutionary controller brings you: 

 
• Full USB compatibility.  The InterLink Plus controller plugs directly 

into your computer’s USB port with little, if any, additional setup 
required. 

• Use the controller by itself as a high quality ‘mockup’ R/C radio for 
controlling RealFlight G3.5.  Realistic transmitter features include a 
three-position switch, rotary knob, adjustable stick length and a push-
button for keyboard-free resets and hand-launching capabilities. 

• Ability to use your own FM or FM compatible, 4-12 channel R/C radio 
transmitter to control RealFlight, using the InterLink Plus Controller’s 
built-in interface. 

• MultiMode capability allows two modelers to fly on one PC. 

• High-speed data transfer ensures rapid, digitally precise response to 
your control input. 

• Hot swappable—connect/disconnect your controller without shutting 
down or rebooting. 

 

GGRRAAPPHHIICCSS  AANNDD  SSOOUUNNDD  QQUUAALLIITTYY  
The makers of RealFlight continually work to bring you the most realistic graphics 
and sound possible, since we feel that these are important contributions to your 
simulation experience.  To do so, we take full advantage of modern video and sound 
hardware.  However, we still provide you with extensive, detailed control over 
graphics and sound quality, so that you can usefully run RealFlight G3.5 on 
computers with widely varying speed, power and performance. 
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FRAME RATE 
Frame rate is usually described as how fast the computer can compute and display a 
new ‘snapshot’.  In other words, it is the rate at which frames (the individual 
pictures that are shown in sequence to create the illusion of motion) are displayed in 
a film or video.  Frame rate is measured in frames per second (fps).  Like a movie 
picture, when stills are quickly flashed by, RealFlight G3.5 creates a sequence of 
frames that provide the illusion of motion.  Television flickers the pictures at 30 
times per second (30 FPS).  A typical movie theater displays about 24/48 FPS.  
RealFlight can produce output ranging from 2FPS to over 150FPS. 

Frame rate is a function of many things and cannot be ‘set’ by the end user, although 
the end user can do things to affect it.  Frame rate is affected by: 

• Computer Speed 

• Video card speed 

• Sound card speed 

• How many optional airport items are selected 

•  3D technology selected 

• Aircraft selection 

• Terrain display options 

• Physics and simulator settings 
 

In order for the simulator to work best, you should run at a high enough frame rate so 
that you do not notice the picture moving from one frame to the next.  It should 
appear as a smooth, fluid motion.  If you observe any “stop-and-go” motions from 
the simulation, several things may improve the frame rate.  For more information, 
please see “Improving RealFlight G3.5 Performance” on page 401. 

GRAPHICS QUALITY 
RealFlight is capable of many different levels of graphics quality, some of which are 
entirely dependent upon the video hardware and monitor used.  G3.5 will try to set 
the defaults to match your computer, but you still may need to adjust some settings.  
As such, RealFlight Generation 3.5 allows you to control a multitude of graphics 
variables in order to configure the simulation to attain the highest possible 
performance.  You can control these variables using the Graphics menu item.  Click 
the Simulation menu, followed by the Settings… menu item.  Select the Graphics 
option of the left of the new dialog window that appears. 

SOUND QUALITY 
In order to use your sound card with RealFlight G3.5, the sound card must support 
Microsoft’s DirectSound.  Many sound cards accelerate the mixing of multiple 
sounds.  RealFlight will take advantage of any acceleration that the card supports.  
This acceleration removes some of the calculation tasks from your CPU, thereby 
increasing your frame rate. 
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TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  
Besides providing the best R/C simulator, we sincerely feel that we provide the most 
extensive product support for any R/C simulator.  Since cards, drivers, operating 
systems, etc. are always changing, we work hard to keep our support up to date on 
the latest issues and problems RealFlight G3.5 users might encounter. 

We provide a wide variety of sources for information, help and advice about 
installing, using, and resolving problems with RealFlight G3.5 (as well as our other 
software products).  These sources range from a detailed, publicly accessible product 
knowledge base, to live technical support, to peer chat and message boards.  Should 
you encounter any problems with RealFlight, you can access any of these sources, 
many with a click of the mouse or telephone call. 

If you have any questions, please contact Great Planes Support.  To do so, email 
them at rfsupport@greatplanes.com or telephone them at 217-398-8970 (option #1).  
It is important to note that each email sent will receive an automated reply advising 
that your email inquiry has been received successfully.  If you do not receive this 
auto-responder, Great Planes Support has not received your message.  Please try 
sending once again. 

Appendix C provides additional information about your technical support options.
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CCHHAAPPTTEERR  55..    TTHHEE  IINNTTEERRLLIINNKK  PPLLUUSS  
CCOONNTTRROOLLLLEERR  

TTHHEE  IINNTTEERRLLIINNKK  PPLLUUSS  CCOONNTTRROOLLLLEERR——DDEESSIIGGNNEEDD  FFOORR  RR//CC  
The R/C transmitter is a key component in all types of R/C flying.  This unique 
method of control is part of what separates R/C from every other type of aviation.  
Consequently, a realistically simulated transmitter is an important key to an authentic 
simulation of the R/C experience. 

With this in mind, we at Great Planes are proud to offer our revolutionary USB 
InterLink Plus (U.S. Patent #6,842,804 and #7,010,628) controller, made by Futaba.  
The InterLink Plus controller was designed from the ground up to meet the needs of 
the R/C purist.  We believe that no other R/C simulator control method goes farther 
to enrich your R/C simulator experience. 

 

The InterLink Plus Controller 
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Features of the InterLink Plus Controller: 

• USB compatibility and convenience.  The InterLink Plus offers the 
“plug and play” convenience, “hot pluggable” installation and removal, 
as well as the high-speed digital performance made possible by 
Universal Serial Bus (USB) technology. 

• High quality “mockup” transmitter.  Use the InterLink Plus 
controller by itself as a pseudo R/C transmitter, with the controls you 
expect in a standard FM 8-channel radio.  The mockup transmitter 
features two 2-position switches, one 3-position switch, a rotary knob, 
knurled control sticks with adjustable length and a push-button. 

• Built-in Transmitter interface.  If you so choose, you can use your 
own FM or FM-compatible R/C transmitter to control RealFlight, using 
the InterLink Plus controller’s built-in interface.  You can even switch 
back and forth between the pseudo controller and your own transmitter!  
Interface adapter cords are included for most JR, Futaba and Hitec 
transmitters. 

• Simultaneous interface and controller.  The InterLink Plus makes it 
possible for two modelers to fly on the same PC, each using his/her 
own controller to pilot the aircraft. 

• Easy setup and use.  In most cases, you do not even have to calibrate 
the InterLink Plus controller, unlike other computer joysticks.  Simply 
plug it in and go! 

• Simulate sophisticated computer radios.  The InterLink Plus, used in 
conjunction with RealFlight, allows you to simulate the 
programmability (mixing, exponential, etc.) of sophisticated computer 
radios. 

The following sections describe how to set up and use the InterLink Plus Controller 
with RealFlight G3.5.  Finally, this chapter concludes with a collection of pointers 
and advice that will help you get the most out of your InterLink Plus Controller. 

SSTTAARRTT  FFLLYYIINNGG!!  
When you start RealFlight for the first time, the software will automatically detect 
the InterLink Plus controller.  Simply add throttle and start flying right away. 

RealFlight, by default, uses the InterLink Joystick setting.  This setting affords 
G3.5 the plug-and-play capability in the simulation.  In this mode, the InterLink 
Joystick allows the InterLink Plus to control all functions associated with the flight 
of your aircraft. 

The InterLink Plus also allows you to use your own R/C transmitter to control the 
RealFlight aircraft.  This is referred to as the Interface Transmitter Mode.
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CCHHAAPPTTEERR  66..    TTHHEE  SSIIMMUULLAATTIIOONN  MMEENNUU  

SSIIMMUULLAATTIIOONN  MMEENNUU  OOVVEERRVVIIEEWW  
The Simulation menu allows you to access a variety of simulation-related features, 
functions and options.  Clicking the Simulation menu brings forth a pull-down 
menu, which will look similar to the following screen shot. 

 

The menu items in this menu are: 

• Select Airport… 

• Edit Airport Name… 

• Create New Airport… 

• Capture Screenshot 

• Flight Failures 

• Cause Flight Failure 
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• Sun 

• Wind 

• Import 

• Export 

• Manage User Files 

• Settings… 

• Exit 

• Airport MRU 

The following sections describe the function or purpose of each of these menu items. 

SSEELLEECCTT  AAIIRRPPOORRTT……  
When you click on Select Airport… the following dialog appears: 

 
This dialog lets you choose the flying site that you wish to use for your flight.  Each 
location offers its own unique characteristics and challenges. 

The list on the left of the dialog box displays all of the flying sites available to you.  
If you have created any flying sites, those sites will also be visible here. 

The flying sites are listed in files and folders in accordance with the software from 
which they were loaded.  If, for example, you have installed Add-Ons 2, the sites 
from this disk will be listed, alphabetically, beneath the Add-Ons 2 folder.  You can 
change how the airports are organized by clicking on the Grouping drop down and 
select another grouping option.  The options are: 

Product, Scene: As explained above, airports are first grouped into folders by the 
product they are found in.  Then within each group they are grouped again by Scene. 

Product: Airports are grouped by product alone. 

Scene: Airports are grouped by scene alone.   
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None: Airports are not grouped into folders at all.  Rather, they are listed 
alphabetically. 

Click the [+] (plus) or the [-] (minus) symbol to reveal or hide the respective 
airports within these folders.  To select an airport, click on the name of the airport at 
which you wish to fly. 

The rotating image on the right side of the screen provides you with a preview of 
what to expect at the desired location.  The dialog box below the terrain map 
contains a description and pertinent information regarding the highlighted airport. 

When you are satisfied with your selection, click OK to return to your flight using 
the new airport selection. 

The Cancel button will return you to the simulation at the previously selected flying 
site. 

MOVEMENT MODES 
If applicable to the respective airports, Generation 3.5’s Movement Modes allow you 
to explore the scenery without an aircraft.  Movement is not possible at PhotoField 
airports. 

To select a  Movement Mode, press the ‘Q’ key on your keyboard.  You can press 
the ‘Q’ key repeatedly to cycle through the available modes:  Walk and Fly. 

Walk mode simulates the effect of you, the pilot, physically walking across the field, 
complete with sound effects.  The Fly mode allows you to move through the air and 
position the camera anywhere that you desire. 

Once you have entered the desired Movement Mode, use the ‘W’, ‘S’, ‘A’ and ‘D’ 
keys on your keyboard to control the movements.  If you wish to increase the speed 
of your movement, press and hold the Shift key at the same time you are using the 
‘W’, ‘S’, ‘A’ or ‘D’ key. 

 
The mouse wheel controls the angle or height at which you traverse the scenery.  To 
increase the altitude, roll the wheel away from you.  This is known as the Hover 
Mode. 
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You may also control the zoom levels during your travels.  Press the [+] (plus) key 
to Zoom In and the [-] (minus) key to Zoom Out.  The Backspace key resets the 
zoom level to its default value. 

EEDDIITT  CCUURRRREENNTT  AAIIRRPPOORRTT……  
RealFlight G3.5 offers unparalleled freedom to edit flying sites.  You can add and 
remove objects, alter their location, rotate, and even resize items.  It is also possible 
to alter the atmospheric or lighting conditions at the various flying locations.  The 
first several times you access the airport editing function, the possibilities might 
seem daunting.  It will require some getting used to before you are comfortable with 
this feature and its related functions.  The best way to do so is to simply dive in and 
experiment. 

To modify the currently selected flying location, click the Simulation menu 
followed by the Edit Current Airport… menu item.  This activates RealFlight 
G3.5’s FlexiField flying site editor, with the currently active airport loaded and ready 
to edit. 

 

Airport Editor Menus 

Selecting the Edit Current Airport option activates the screen shown above.  There 
are five menus in the Airport Editor dialog: 

• File 

• Edit 

• View 

• Options 

• Window 
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FILE MENU- 
This menu and its menu items are used to manipulate and control the various folders 
and related items in the airport editor. 

OPEN- 
This menu item is used to open existing and edited airports.  Selecting this menu 
item opens the Select Airport dialog. 

 

SAVE- 
This option becomes active once you have renamed and saved the edited airport.  
Prior to doing so this option remains inactive and grayed out. 

SAVE AS- 
Upon completion of the airport editing, click this menu item to save the 
modifications.  You will be asked to create a name for this new airport.  After you 
have renamed the airport, click OK to accept the new name.  Afterwards, the airport 
will appear in the airport listings found in the Select Airport… which the 
Simulation menu. 

SAVE FOLDER- 
This option allows you to select an entire sub-folder in an airport and save it off to a 
new file.  For example, you could select the entire “Objects” sub-folder in RealFlight 
Ranch and save it off to a disk. 

To save the folder, right click on the existing folder and select Save Folder.  This 
brings forth a dialog that allows you to determine the new folder’s name as well as 
the location where it will be saved. 
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Alternatively, with the respective folder highlighted click on the File menu and 
select Save Folder menu item from the pull-down menu. 

LOAD FOLDER- 
This option allows you to load a folder from the saved folders.  To do so, right click 
on an existing folder.  Next, select the folder from the list. 

Alternatively, with the respective folder highlighted click on the File menu and 
select Load Folder menu item from the pull-down menu. 

Please note:  G3.5 defaults its searches to the Recordings folder location.  If you 
have saved the folder elsewhere, you will need to modify the search location. 

RETURN TO SIMULATOR- 
Use this option to quit editing the airport and return to the simulation.  If you have 
not made any changes to the airport, you will return directly to the simulation.  If you 
have unsaved changes, a message box will ask for confirmation before returning to 
the simulation. 

EDIT MENU- 
This menu may be used for some simple editing functions on the selected airport. 

 
Highlight an item at the airport either by selecting it from the list in the Folder 
Listing window or by clicking on the respective item within the airport itself. 

SET AS DEFAULT- 
Use this option to set a pilot spawn as default.  For example, the RealFlight Ranch 
airport includes a number of different spawn points in its Spawn Folder.  To set a 
new default spawn point, select one of these points by clicking it with the mouse.  
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Then select Edit followed by Set As Default.  This will become the new default 
spawn point for the airport. 

DELETE- 
This menu option deletes the highlighted object.  RealFlight does not ask you to 
verify the selection prior to deletion. 

VIEW MENU- 
This menu allows you to make alterations and modifications related to the 
perspective of the simulation during the editing process.  Modifications to the 
vantage point do not have any effect on the simulation during its operation. 

  

MODE- 
The Mode menu is utilized to alter the camera perspective when viewing the scene.  
There are three distinct view modes in G3.5:  Pan Camera, Pivot Camera and Normal 
Camera.  These modes, as well as the methods to access them will be discussed in 
depth in the sections that follow. 
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PAN CAMERA- 
The Pan Camera option allows the camera to shift the vantage point on the selected 
scenery. 

There are several ways to access the Pan Camera mode.  The first, and probably the 
easiest, is to press the ‘C’ key on your keyboard.  Alternatively, you may right click 
on the scene and select Pan Camera from the available options.  The final method 
that may be used is to select Pan Camera through the View menu and Mode menu 
item. 

To increase the pan view, rotate the mouse wheel towards the computer screen.  
Alternatively, you may also press the [-] (minus) key on the number pad of the 
keyboard.  This causes the camera to pan out incrementally. 

Conversely, to decrease the pan view, either rotate the mouse wheel away from the 
computer screen or press the [+] (plus) key on the keyboard’s number pad.  This 
causes the camera to pan in incrementally. 

To move an object within the scene, left click on the object with the mouse, continue 
to hold the button down, and move the mouse within the scene.  The selected object 
will move along with the mouse cursor. 

You can exit this mode by using the menus or by hitting the ‘Z’ key, which returns 
you to the normal viewing mode. 

PIVOT CAMERA- 
The Pivot Camera mode, as the name suggests, pivots or rotates the camera in 
relationship to a particular object or location. 

There are several ways to access the Pivot Camera mode.  The first, and probably the 
easiest, is to press the X key on your keyboard.  Alternatively, you may right click on 
the scene and select Pivot Camera from the available options.  The final method that 
may be used is to select Pivot Camera View menu and Mode menu item. 
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To increase the pivot view, rotate the mouse wheel towards the computer screen.  
Alternatively, you may also press the [-] (minus) key on the number pad of the 
keyboard.  Doing so will cause the camera to shift incrementally. 

Conversely, to decrease the pivot view, either rotate the mouse wheel away from the 
computer screen or press the [+] (plus) key on the keyboard’s number pad.  Again, 
this will shift the camera incrementally. 

To exit the Pivot Camera feature, right click in the editing view once again and then 
mouse click the desired option in the popup menu.  You can also exit this mode by 
hitting the ‘Z’ key, which returns you to the normal viewing mode. 

NORMAL CAMERA- 
This mode returns the camera to its normal, or default perspective. 

There are several ways to access the Normal Camera mode.  The easiest is to simply 
press the ‘Z’ key on the keyboard.  Alternatively, you may right click in the scene 
and select Normal Camera from the options listed.  Finally, you may select Normal 
Camera through the View menu and Mode menu item. 

CENTER VIEW ON SELECTION- 
This option centers the vantage point on a particular object.  This is useful for 
repositioning, resizing, rotating, etc. 

If you have not selected an object from the Folder Listing or highlighted an object in 
the scene, this option will remain inactive or grayed out.  If, however, you have made 
a selection or highlighted an object, there are several ways to select the Center View 
on Selection option. 

Simply right click on the selected object or folder in the Folder Listing.  
Alternatively, in the scene, right click on the highlighted object and select the Center 
View on Selection from the options listed.  The final option is to use the View menu 
and select the Center View on Selection option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

FIT SELECTION IN VIEW- 
This option is utilized to ensure that your selection fits in the view.  If, for example, 
your zoom magnification is at an extremely high level, the object may not 
completely fit on the screen.  This feature ensures that it will. 

To access the Fit Selection In View, right click on the highlighted object in the scene 
and select the Fit Selection In View from the options listed.  The final option is to 
use the View menu and select the Fit Selection In View option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 
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To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

ZOOM IN- 
Click this menu item to magnify or zoom in on the selected item.  Alternatively, you 
may magnify the view or zoom in on the selected item by pressing the [+] (plus) key 
on the keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu 
item, the zoom level increases incrementally. 

ZOOM OUT- 
Click this item to reduce the magnification, or zoom out of the current view.  
Alternatively, press the [–] (minus) key on the keyboard.  Alternatively, you may 
zoom out via G3.5’s menus.  Each time the [-] (minus) key or the Zoom Out menu 
item are pressed or selected, the view will decrease incrementally. 

ZOOM RESET- 
This menu item resets the view to the default magnification.  Alternatively, you may 
also press the Backspace on the keyboard to reset the zoom to its default value. 

OPTIONS MENU- 

SELECTABLE ITEMS- 
The Selectable Items menu determines whether a particular type of object may be 
mouse clicked and selected on-screen. 

 
Selectable Items are listed as: 
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• Objects 

• Overlays 

• Trees 

 
To eliminate the possibility of selecting an item, simply mouse click on the desired 
listing in the pull-down menu.  This capability is useful if there are many objects 
clustered in a small area and you want to select just one of them.  For example, 
suppose that an airport has a tight cluster of trees with a dirt pile in the middle.  If 
you want to select the dirt pile, it may be easier to turn off the tree selection first.  
This will allow you to easily select the dirt pile without the trees getting in the way. 

ADD OBJECT GROUPING- 
The items available for addition in RealFlight G3.5 are all grouped or organized 
accordingly.  This menu item determines the methodology by which they are 
grouped in the Object Palette window.  You may group items by three distinct 
methods: 

• Product, Type, Name 

• Type, Name 

• Name 
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Each grouping type affects how the Object Palette window lists the objects. 

PRODUCT, TYPE, NAME- 
Selecting this option causes the objects in the Object Palette to be displayed by the 
Product then by the Type and finally by the Name.  That is, objects are first listed 
within the product in which they appear (e.g., G3.5, Add-Ons, etc.).  Within the 
product, the objects are then classified by Type (e.g., Buildings, Trees, etc.).  Once 
you’ve selected the Product and Type of object that is desired, the objects are then 
listed alphabetically by Name. 

For information on adding objects and how to use the Object Palette, please refer to 
the Object Palette section of this manual. 

TYPE, NAME- 
This option causes the objects in the Object Palette to display by the Type and the 
Name designations only.  They are not sorted by the Product in which they appear.  
Objects that appear in G3.5, Add-Ons, etc. will be included on one extensive listing. 

This option is useful if you are unsure as to which product included a particular 
object. 

NAME- 
Selecting this option causes the objects to be listed in alphabetical order by their 
name designations (e.g., Barn).  This listing is extensive as it includes all of the 
objects available to you. 

This option is useful if you are unsure as to which product contained the object or if 
you are unsure as to the type of object that you wish to utilize.  It also offers a rapid 
overview as to the number and breadth of objects available to you. 
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ROTATION SNAP- 
When rotating an object on the flying site, you have the ability to control the amount 
of rotation with the Rotation Snap.  There are four snap settings that may be utilized 
in the editor to provide quick orientation settings for placing objects.  The options 
are: 

 
- None 
The object rotates without any restrictions.  This is useful for making minor 
refinements to object placement. 

- 45 Degrees  
The object will rotate 45 degrees each time you select this option.  This is useful for 
making large changes to object position. 
- 15 Degrees 
The object will rotate 15 degrees each time you select this option. 

- 5 Degrees 
The object will rotate 5 degrees each time you select this option. 

DISPLAY METRIC UNITS- 
Click this item with your mouse to switch the measurement indicators in the 
Properties pane from SAE (feet, inches, pounds) to metric (meters, centimeters, 
kilograms). 

WINDOW MENU- 
This menu item activates or eliminates items from the display or window.  For 
example, if you were to mouse click the Properties item in the pull-down menu this 
would eliminate the Properties window from the screen. 
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The Folder Listing, Properties, Pilot Preview and Object Palette windows appear by 
default. 

FOLDER LISTING- 
This listing includes all of the folders available to you for use in the airport editor.  
Selecting this item from the pull-down menu will remove the Folder Listing dialog 
from the screen. 

OBJECT PALETTE- 
The Object Palette includes the complete selection of objects available to you for use 
in editing an airport.  Selecting this item from the pull-down menu will remove the 
Object Palette dialog from the screen. 

PILOT PREVIEW- 
Selecting this item from the pull-down menu will add a pilot’s perspective to the 
screen. 

PROPERTIES- 
Selecting this item from the pull-down menu will remove the Properties dialog from 
the screen. 

RESET WINDOW POSITION- 
This menu item resets the positions of the airport editing windows back to their 
default locations.  Additionally, if you have removed any of the default windows, 
they will return to the screen at this time. 
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AACCCCEESSSSIINNGG  AANNDD  UUTTIILLIIZZIINNGG  TTHHEE  EEDDIITTOORR  
Opening the airport editor reveals four distinct windows.  For the purpose of clarity, 
we will examine each window individually.  It is, however, important to note that 
these windows interact with one another. 

FOLDER LISTING WINDOW- 
The Folder Listing window consists of the folders and items (objects) that comprise 
the currently selected airport.  The RealFlight Ranch folder, for example, has two 
folders underneath it:  Objects and Clouds. 

 
To determine what items are contained within the Objects and Clouds folders, click 
on the [+] (plus) or double-click on the name itself (e.g., Objects).  Doing so brings 
up the various sub-folders that are contained within the main item. 

As denoted by the [+] (plus) symbols, these folders, in turn, also have another level.  
Again, to open these respective levels, click on the [+] (plus) icon or double-click 
the folder name. 

Alternatively, clicking on an object in the scene will highlight the respective object.  
It will also open the folder that contains the object.  The converse is also true, 
clicking the folder or object in the Folder Listing menu will highlight the respective 
item as well. 

If you wish to move an object from one folder to another, mouse click and hold the 
object to be moved.  Next, drag the object to the desired location (folder) using the 
mouse and release.  The object will be listed at the bottom of the folder in which it 
has been situated.  Please note:  this removes the object from the original folder. 
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You may use either of two methods to delete an object from the folder, and therefore 
the scene as well. 

First, you can highlight the object or sub-folder (e.g., Fences) in the Folder Listing 
and press the Delete key on the keyboard. 

Alternatively, with the object or sub-folder highlighted, right click and select the 
Delete Object pull-down option. 

Right clicking on a folder will bring forth the following options: 

 
• Center View on Object 

• Fit Object In View 

• Delete Object 

• Add Folder 

• Save Folder… 

• Load Folder… 

CENTER VIEW ON OBJECT- 
As the name suggests, this option centers the vantage point on a particular object.  
This is useful for repositioning, resizing, rotating, etc.  Please note: the Center View 
on Object and Center View on Selection options perform the same function. 

If you have not selected an object from the Folder Listing or highlighted an object in 
the scene, this option will remain inactive or grayed out.  If, however, you have made 
a selection or highlighted an object, there are several ways to select the Center View 
on Object option. 
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Simply right click on the selected object or folder in the Folder Listing.  Next, select 
the Center View on Object option. 

Alternatively, in the scene, right click on the highlighted object and select the Center 
View on Selection from the options listed.  The final option is to use the View menu 
and select the Center View on Selection option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To reduce the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

FIT OBJECT IN VIEW- 
This option ensures that your selection fits in the view.  If, for example, your zoom 
magnification is at an extremely high level, the object may not completely fit on the 
screen.  This feature ensures that it will.  Please note:  the Fit Object in View and 
Fit Selection in View options perform the same function. 

To access the Fit Selection In Window, right click on the highlighted object in the 
scene and select the Fit Selection In Window from the options listed.  Alternatively, 
you may right click on the highlighted object in the Folder Listing and select Fit 
Object in View from the options that appear.  The final option is to use the View 
menu and select the Fit Selection In View option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

DELETE OBJECT- 
This option allows you to delete the folder or object that you have selected.  If you 
delete a folder, all sub-folders and objects inside will also be deleted. 

ADD FOLDER- 
This option is used to create new folders in the root directory.  When a folder is 
added to the directory you may rename it as desired.  To do so, simply enter the 
desired name in the highlighted ‘New Folder’ location. 

SAVE FOLDER…- 
Selecting this option allows you to save a folder that you have either modified or 
created.  It also allows you to save a folder in an alternative location, which is ideal 
for sharing folders with other RealFlight users. 

We suggest that you provide the saved folder a distinctive name that will allow you 
to easily and rapidly identify the contents. 
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LOAD FOLDER…- 
Selecting this option allows you to load an additional folder for the scene.  If, for 
example, a friend has provided you with one of his/her folders, this will allow you to 
upload the shared folder. 

CENTER VIEW ON OBJECT- 
As the name suggests, this option is utilized to center the vantage point on a 
particular object.  This is useful for repositioning, resizing, rotating, etc.  Please note:  
the Center View on Object and Center View on Selection options perform the 
same function. 

Simply right click on the selected object or folder in the Folder Listing.  Next, select 
the Center View on Object option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

FIT OBJECT IN VIEW- 
This option ensures that your selection fits in the view.  If, for example, your zoom 
magnification is at an extremely high level, the object may not completely fit on the 
screen.  This feature ensures that it will.  Please note:  the Fit Object in View and 
Fit Selection in View options perform the same function. 

Right click on the highlighted object in the Folder Listing.  Select the Fit Object in 
View from the options that appear. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

DELETE OBJECT- 
This option removes the selected object from the scene. 

PROPERTIES WINDOW- FLYING SITE ROOT DIRECTORY 
The Properties window indicates the detailed information for the item highlighted in 
the Airport Editor window.  Consequently, the contents of the Properties window 
vary depending upon the selection in the Folder Listing window. 

The example below indicates what is displayed if the flying site’s root or top-level 
folder is highlighted.  Regardless of what is selected, the Properties are all very 
similar in nature and in their method of modification. 
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An asterisk to the left of an item indicates that it has been modified.  Right clicking 
the item will bring up the Restore Original Value or Set to Default Value options. 

 

DESCRIPTION- 
This is a description of the airport.  Using the example above, this would be a 
description of the RealFlight Ranch flying site. 
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When you edit an airport, we suggest that you modify the description accordingly.  
This will assist you in keeping track of the modifications without having to return to 
the airport editor to see what has changed. 

To alter the Description, click the text in the value box.  The default description box 
will then appear.  Next, using the keyboard input the new description as you see fit.  
The modified description will be saved when the edited airport is saved. 

DEFAULT PILOT SPAWN- 
This option allows you to choose which pilot location will be the default takeoff 
position. 
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To select the location, click the value corresponding to the Default Pilot Spawn.  
This will bring forth the drop-down menu selections.  Using your mouse, select the 
location you would like to use as the default location. 

DETAIL GRUNGE TEXTURE- 
The Detail Grunge Texture is a fixed value and may not be altered.  This simply 
represents what is utilized as the default texture. 

DETAIL 1, DETAIL 2 FAR TEXTURES- 
There are actually two textures that make up the textures in the distance away from 
your flying site.  They are aptly named Detail 1 Far Texture and Detail 2 Far 
Texture. 

To change the respective textures, click on the respective texture in the value 
column.  This will bring forth the pull-down menu selections.  Using your mouse, 
select the texture that you wish to utilize. 
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DETAIL 1, DETAIL 2 NEAR TEXTURES- 
G3.5 uses two textures to make up the ground textures closest to your flying site.  
They are named Detail 1 Near Texture and Detail 2 Near Texture. 

To change the respective textures, click on the respective texture in the value 
column.  This will bring forth the pull-down menu selections.  Using your mouse, 
select the texture that you wish to utilize. 

DETAIL TEXTURE INNER RADIUS- 
This value defines the radius from the center of the airport where the detailed 
textures display most vividly.  Outside of this radius, the detail textures fade out until 
they are gone. 

To change the radius of the detailed texture, click the existing value.  Next, enter the 
desired value directly from the keyboard or via the mouse wheel. 
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DETAIL TEXTURE OUTER RADIUS- 
This value defines the radius from the center of the airport where the detailed 
textures will completely fade away.  At the specified distance, only the underlying 
terrain texture remains. 

To change the radius of the detailed texture, click the existing value.  Next, enter the 
desired value directly from the keyboard or via the mouse wheel. 

INNER FOLIAGE EXCLUSION ZONE- 
Defines the radius from the center of the airport for which trees will not appear.  
Foliage items that were added to the airport as individual objects will not be affected 
by this setting. 

To change the radius, click the existing value.  Next, enter the desired value directly 
from the keyboard or via the mouse wheel. 

OUTER FOLIAGE EXCLUSION ZONE- 
This defines the radius from the center of the airport for which the trees will begin 
appearing in increasingly larger numbers.  It is important to note that the largest 
quantity of trees is defined by the global tree density setting. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or use the mouse wheel to adjust this number. 

FOLIAGE SEED- 
Modifying the value of the Foliage Seed results in trees being randomly created, or 
seeded, at different locations. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or use the mouse wheel to adjust this number. 

SUN INCLINATION (DEG)- 
This value determines the angle at which the sun shines on the field.  A value of 90 
degrees places the sun directly overhead. 

To modify the location of the sun, click the respective value.  Next, input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 

SUN AZIMUTH (DEG)- 
This value is used to determine the location of the sun on the horizon.  It is measured 
in a clockwise direction starting at due north. 

To modify the location of the sun, click the respective value.  Next, input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 

SUN HALO- 
This value determines whether the halo effect of the sun will be utilized.  If ‘Yes’ is 
selected, the sun will have a visible halo.  Selecting ‘No’ removes the halo effect 
from the airport. 

To set this value, click on the respective value column.  This brings forth a drop-
down menu.  Select either Yes or No from the drop-down menu. 
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UPPER SKY COLOR- 
This represents the color of the sky above the pilot’s position with the sun directly 
overhead.  In a PhotoField airport, adjusting these values will have no effect. 

To modify this setting, click on the respective value.  Click the more options button 
(the gray folder with the ellipsis) to bring forth the palette of available colors.  This 
will reveal a screen that appears as follows: 

 
To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the Value column. 

LOWER SKY COLOR- 
This represents the color of the sky on the horizon with the sun directly overhead.  In 
a PhotoField airport, adjusting these values will have no effect. 

To modify this setting, follow the directions found in the “Upper Sky Color” section. 

WIND DIRECTION (DEG)- 
This value determines which direction the global wind is blowing. 

To modify the wind direction, click on the respective value.  Input the desired value 
directly from the keyboard or use the mouse wheel to adjust this number.  It is 
important to note that 0 degrees represents the wind blowing from the North. 

WIND VELOCITY- 
This value indicates the average global wind velocity.  The measurement is taken 
approximately two meters above the flying site.  G3.5’s wind gradient causes the 
wind closer to the terrain’s surface to move slower than the global wind velocity.  
Conversely, at higher altitudes the wind will move faster. 

To modify the wind velocity, click on the respective value.  Input the desired value 
directly from the keyboard or use the mouse wheel to adjust this number. 
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RENDER TERRAIN HEIGHTMAP- 
This setting determines whether the terrain will be colored utilizing terrain aligned 
textures and detail grunge textures.  If ‘No’ is selected, the terrain will be colored 
with the panoramic image textures (if any) only. 

To do so, click on the respective value column.  This brings forth a drop-down menu.  
Select either Yes or No from the drop-down menu. 

FIXED CAMERA ONLY- 
This setting determines whether the camera will offer a fixed view only.  If ‘No’ is 
selected, you will be allowed to alter the vantage point of the camera using the View 
menus options.  If ‘Yes’ is selected, the user is not allowed to alter the camera 
perspective. 

To do so, click on the respective value column.  This brings forth a drop-down menu.  
Select either Yes or No from the drop-down menu. 

PANORAMIC IMAGE- 
This determines which panoramic image the airport will utilize.  If <None> is 
selected, the airport will not use a panoramic background. 

To select a panoramic image, click on the respective value.  Use either the Up/down 
arrow keys on the keyboard, or the mouse to select the desired background.  If you 
have imported an image into G3.5, it will appear in this listing as well. 

PANORAMIC IMAGE X ALIGNMENT (DEG)- 
This value, in conjunction with the Panoramic Image Y Alignment adjustments, is 
utilized to modify the axis of the panoramic background.  These values will serve to 
ensure that the panoramic image’s horizon is level with G3.5’s horizon. 

To modify the X-axis alignment, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust the number. 

PANORAMIC IMAGE Y ALIGNMENT (DEG)- 
This value, in conjunction with the Panoramic Image X Alignment adjustments, is 
utilized to modify the axis of the panoramic background.  These values will serve to 
ensure that the panoramic image’s horizon is level with G3.5’s horizon. 

To modify the Y-axis alignment, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust the number. 

PANORAMIC IMAGE FACING (DEG)- 
This setting determines the direction that the panoramic image is rotated with respect 
to the airport’s North direction. 

To modify the direction, click on the respective value.  Input the desired value 
directly from the keyboard or use the mouse wheel. 

SURFACE FRICTION COEFFICIENT- 
This value sets the friction coefficient for all off-runway areas of the airport.  A high 
friction coefficient means that the surfaces will be sticky:  aircraft will slow down 
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rapidly and have high wheel traction.  A low value will allow them to slide freely 
along the surface. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

ROLLING RESISTANCE COEFFICIENT- 
This value determines the amount of force required to cause the aircraft wheels to 
move.  Increasing the value means that it will require more force to move the 
aircraft.  Lowering the value will allow the aircraft to move more easily, causing it to 
roll farther when taxiing. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

BUMP AMPLITUDE COEFFICIENT- 
This value determines the roughness of the surface.  The higher the value, the 
rougher the surface will be. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

BUMP FREQUENCY COEFFICIENT- 
This value sets the size of the bumps on the surface of the airport.  A larger 
coefficient produces bigger and more spread out bumps. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

SURFACE DUST COLOR- 
When landing hard, or during a crash, your aircraft may kick up some dust.  Use this 
value to determine the color of the dust coming from the surface. 

To modify this setting, click on the respective value.  Click the more options button 
(the gray folder with the ellipsis) to bring forth the palette of available colors.  This 
will reveal a screen that appears as follows: 

To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the Value column. 

SURFACE DUSTINESS- 
This value determines how much dust is kicked up from the surface.  A lower value 
means less dust. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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PROPERTIES WINDOW- OBJECT SELECTION 
The Properties window is capable of displaying the properties for a folder (such as 
an airport) or the properties for a particular object within an airport.  The following 
example is based upon selecting an object (a fence) in the Folder Listing window. 

Clicking on the [+] (plus) or double-clicking the respective folder name (i.e., Objects 
and then Fences) will bring forward the pull-down menu of the items contained 
within the specified folder. 

Alternatively, clicking and highlighting a particular item in the scene will also bring 
forth the folder and Properties window information. 

 
Additionally, RealFlight will highlight the selected item on the screen for ease of 
reference. 
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RELATIVE POSITION- 
The X, Y, and Z values refer to the coordinate location of the object selected in 
relationship to that of its parent.  A parent is the folder in which the selected object is 
located. 

To modify the location of the item, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value will shift the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward. 

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

Using the previous example above, the parent folder would be the Objects directory. 
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RENDER TO DEPTH BUFFER ONLY- 
This setting determines whether the to render the object only to the depth buffer.  
Selecting ‘Yes’ allows the objects to cover items behind them on the scene but 
allows the panoramic image and sky to be drawn over them. 

For example, you could use this to place an “invisible” object into a PhotoField 
airport that coincides with the location of an object in the panoramic image.  You 
would then be able to collide with that object.  This also allows you to fly behind the 
object and allows the object to cast shadows.  The van placed in the Sod Farm airport 
is a good demonstration of this feature. 

To select whether an object will render to the depth buffer only, click on the 
respective value.  Either use the Up/down arrow keys on the keyboard or click with 
the mouse to select the desired option. 
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RENDER DEPTH BUFFER ONLY (INHERITED)- 
This value is non-adjustable.  It is determined by the Render to Depth Buffer value 
associated with folders above the current folder or object.  For example, if a shack 
has this property set to ‘Yes’ than the folder above the shack or any folder above that 
folder has the Render to Depth Buffer Only property (described above) set to ‘Yes’. 

CAST SHADOW- 
This value determines whether the object will cast a visible shadow.  Selecting ‘Yes’ 
allows the item to cast a shadow in the simulation. 

To determine whether the object casts a shadow, click on the respective value.  
Either use the Up/down arrow keys on the keyboard or click with the mouse to select 
the desired option. 

CAST SHADOW (INHERITED)- 
This value is non-adjustable.  It is determined by the Cast Shadow value above.  To 
ensure that shadows are visible, select ‘Yes’ in the Cast Shadow value for the parent 
folder. 

ORIENTATION (DEG)- 
This is the orientation of the object on the scenery.  You can freely modify the 
orientation of the object to suit your needs. 

The Z-axis represents the height of the item.  Changing the X-axis value adjusts the 
position of the object to the left or right.  The Y value moves the object forward or 
backwards.  Please note:  these changes are in relationship to the scene rather than 
the parent folder. 

Several methods may be utilized to adjust the orientation values.  Highlight the item 
in the scene.  Next, click on the respective value column for the Orientation.  After 
determining which value you wish to modify, choose the value in the corresponding 
column (e.g., ‘X’).  Enter the desired value directly from the keyboard or via the 
mouse wheel. 

Alternatively, using the Normal Camera mode, highlight the object by clicking on 
it.  Hold the keyboard’s shift key and press/hold the mouse button simultaneously.  
Move the mouse to alter the orientation. 

SCALE (%)- 
This value modifies the scale of an object.  Modifications made to the scale 
percentage have a corresponding effect on the Height, Width and Length values that 
follow. 

To modify the scale of the object, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 

HEIGHT- 
This value modifies the height of an object.  Modifications made to the height have a 
corresponding effect on the Scale, Width and Length values. 

To modify the height of the object, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 
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WIDTH- 
This value modifies the width of an object.  Modifications made to the width have a 
corresponding effect on the Scale, Height and Length values. 

To modify the width of the object, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 

LENGTH- 
This value modifies the length of an object.  Modifications made to the length value 
have a corresponding effect on the Height, Width and Scale values. 

To modify the length of the object, click on the respective value.  Input the desired 
value directly from the keyboard or use the mouse wheel to adjust this number. 

ABSOLUTE POSITION- (READ ONLY) 
This X, Y, and Z values represent the physical location of the object in the 
simulation.  These values will change in relationship to the Relative Position. 

It is not possible to manually adjust these values as they are determined by the 
modifications and alterations implemented in the simulation. 

OBJECT TYPE- (READ ONLY) 
This indicates the type, or genre, of the object. 

The Object Type is not manually adjustable.  The selected object dictates this 
property. 

OBJECT LOCATION- (READ ONLY) 
This value indicates the object location for editing purposes.  In our example, the 
fence is located in the RealFlight G3.5 root folder. 

The Object Location is not manually adjustable.  The root folder in which the object 
resides dictates this property. 

ZBOOST- 
Runways and other decal objects that are “painted” over the ground utilize the 
ZBoost parameter.  It determines the order in which the simulation draws 
overlapping items. 

Setting ZBoost to a positive number makes the object draw later. A negative ZBoost 
forces the object to draw earlier. 

SURFACE FRICTION COEFFICIENT- 
This value appears only for runway and surface objects.  It sets the friction 
coefficient for the particular surface.  As long as the airplane is on this surface, the 
friction coefficient will override the value given for the airport as a whole. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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ROLLING RESISTANCE COEFFICIENT- 
This value appears only for runway and surface objects.  It sets the friction 
coefficient for the particular surface.  As long as the airplane is on this surface, the 
friction coefficient will override the value given for the airport as a whole. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

PROPERTIES WINDOW- CLOUD SELECTION 
RealFlight allows you to modify a variety of parameters pertaining to the cloud cover 
found in the scenery.  There are two levels of clouds available in G3.5:  Tropospheric 
and Stratospheric.  Tropospheric clouds are those found in the lower level of the 
atmosphere.  Stratospheric clouds, on the other hand, are the clouds that are located 
in the upper levels of the atmosphere. 



R/C Simulator RealFlight Chapter 6.  The Simulation Menu  •  67 

 

STARTING ALTITUDE- 
This value represents the altitude, or height at which the cloud cover begins.  The 
higher the value entered the higher the altitude where the clouds start. 

To modify the altitude at which the cloud cover starts, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 

Please note:  the maximum value for the starting altitude is controlled by the value 
entered in the Ending Altitude dialog.  For example, if the Ending Altitude value is 
7,000 feet, the maximum Starting Altitude is 7,000 feet. 

ENDING ALTITUDE- 
This value represents the maximum altitude at which the clouds will be present. 

To modify the altitude at which the cloud cover ends, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 
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Please note:  the minimum value for the ending altitude is controlled by the value 
entered in the Starting Altitude dialog.  For example, if the Starting Altitude value is 
7,000 feet, the minimum Ending Altitude is 7,000 feet. 

RELATIVE DENSITY- 
This value modifies the thickness of the clouds.  A higher value represents a heavier, 
denser cloud cover. 

To modify the cloud density, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

RELATIVE BRIGHTNESS- 
This value modifies the color, or brightness, of the clouds.  A higher numerical value 
produces a lighter and brighter color.  For example, a value of 20% produces clouds 
that are darker than clouds with a value of 50%. 

To modify the brightness, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel.  

RELATIVE SIZE- 
The Relative Size parameter determines the size of the clouds.  Higher values 
produce clouds that are larger in size and shape. 

To modify the size, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

RELATIVE SPEED- 
This value determines the speed of the clouds in the scene.  Higher values produce 
clouds that traverse the sky more rapidly. 

To modify the speed, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

TYPE- 
This setting specifies the type of cloud cover at the respective altitude.  G3.5 offers a 
variety of clouds for each of the atmospheric regions. 

Cumulus clouds are a dense, fluffy, white cloud.  Stratus clouds are generally a low-
level cloud formation with a horizontal layer of darker gray clouds. 

To alter the type of clouds at a given altitude, click on the corresponding value.  
Next, select the desired cloud type from the pull-down list that appears. 

ATMOSPHERIC REGION-(READ ONLY) 
This value reflects the atmospheric region for which the modifications are being 
performed.  This value is non-adjustable.  Rather it is determined by the selection 
performed in the Cloud directory. 
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OBJECT PALETTE WINDOW- 
The Object Palette window is used to add a new object or objects to the airport.  The 
object window consists of two separate sections:  the preview box in the top section 
of the window, and the objects list in the bottom section. 

The icon that appears in the Object Palette window is dependent upon whether you 
have highlighted the Objects or the Clouds directory in the Folder Listing window.  
For the purposes of this section, we will highlight the Objects directory. 

OBJECTS LIST- 
All objects are grouped according to their root directory.  Within the root directory 
the grouping is further refined.  For example, you will find all available benches in 
the Benches, Chairs and Tables group.  This, of course, assumes that you are 
utilizing the Product, Type, Name or Type, Name as determined by the Add Object 
Grouping Selection in the Options menu. 

  
Each object group is preceded with a [+] (plus) and an icon.  The [+] (plus) indicates 
that there is another expansion level, or selection, available to you.  Clicking on the 
[+] (plus) or double-clicking the respective root directory name (e.g., RealFlight 
G3.5) will bring forward the pull-down menu of the items contained within the 
specified folder. 

If, for example, you wanted to add a bench to the current airport, take the following 
steps: 
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1. Click on the [+] (plus) icon in front of the Benches, Chairs and Tables 
group (or, double-click the group name itself).  This reveals the next 
expansion level to you. 

2. From this expansion list, select the ‘Bench’ object.  The selected object 
appears in the preview box. 

3. Click Add, which adds the object to the scene. 

You can find additional information pertaining to object placement, positioning, etc., 
in the Properties section of this chapter. 

PREVIEW BOX- 
Once an object has been selected, it appears in the preview dialog box.  The object 
will rotate continuously unless you decide to alter the view. 

Click on the preview box to stop the rotation of the object.  Use the mouse wheel to 
zoom the view in or out on the object. 

Additionally, you may use the mouse to modify the vantage point of the object so 
that you may view it from a different perspective.  To do so, click and hold the 
mouse button.  Next, move the mouse until you achieve the desired angle/position.  
To start the object rotation once again, right click in the preview box. 

If you wish to add this object to the simulation, click the Add button.  The object 
will appear in the airport.  It will be highlighted as well, since it is the currently 
selected object.  For information on how to place the object, please refer to the 
Object Placement section that follows. 

OBJECT PLACEMENT- 
You may use any one of several available methods to change the location of an 
object in the airport.  To use the drag and drop method, click on the object to 
highlight it, as shown below.  Once you have highlighted the object, press and hold 
the mouse button.  Move the mouse to the desired location and then release the 
button to drop the object in the new location. 
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Alternatively, you may right click the mouse elsewhere in the scenery.  This brings 
up a pop-up menu with several options available to you.  To move the selected 
object, point the mouse to the location that you desire and click the Move Here 
option. 

OBJECT DUPLICATION- 
G3.5 also allows you to easily replicate the selected objects.  To do so, hold the 
‘Ctrl’ key down, click and hold the mouse button and use the mouse to drag the 
object to a new location.  You will see that the original object stays in place.  Release 
the mouse button and the ‘Ctrl’ key to drop the new item in place. 

OBJECT MODIFICATION- 
Once you have added an object to the airport, you can modify it freely.  Refer to the 
Properties Window – Object Selection section for information on how to do so. 

PILOT PREVIEW- 
This window provides you with the ability to view the scene from the pilot’s 
perspective.  It is very useful when editing PhotoField airports. 

The number of pilot perspectives available to you varies; dependent upon the 
selected scene.  For example, RealFlight Ranch offers:  Runway Center, Runway 
End and Helipad as the viewing options.  To select amongst these options, open the 
Spawn Folder in the Folder Listing.  Use the up/down arrow keys on the keyboard 
or the mouse to select the desired perspective. 

It is also possible to modify the selected vantage points.  For example, you may 
Zoom In and Out, or simply scan the horizon.  Note that in order to modify the 
vantage point, the Pilot Preview window must be the active window.  To ensure that 
the Pilot Preview window is the active window, simply click on, or in, this window. 
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To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally. 

RealFlight also allows you to scan the scene.  To do so, press and hold the mouse 
button.  Moving the mouse will shift the scenery. 

CCRREEAATTEE  NNEEWW  AAIIRRPPOORRTT  
This menu enables you to create an entirely new airport, starting with a fresh canvas.  
The FlexiField flying site editor provides you with virtually unlimited editing 
options, limited only by your imagination. 

The options available to you when creating an airport are identical to those found in 
the section pertaining to the aircraft editor above.  As such, we will avoid duplicating 
these instructions.  Instead, we encourage you to experiment with the options, 
settings and choices as you see fit. 

After you have finished creating your airport, click the file menu and save the 
airport.  The airport name will appear in your RealFlight G3.5 directory for future 
use. 

 

CCAAPPTTUURREE  SSCCRREEEENNSSHHOOTT  
Just like the perfect photo opportunity at the local flying field, RealFlight G3.5 offers 
the chance to snap off screenshots.  Captured screenshots are great to share with 
friends, add as your desktop wallpaper, or put on the internet for the world to see. 
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To snap a screenshot, click Capture Screenshot menu item.  Alternatively, press the 
Tab key on the keyboard. 

Screenshots are stored in the RealFlight directory.  By default, this directory is 
located in C:\Program Files\RealFlightG3. 

FFLLIIGGHHTT  FFAAIILLUURREESS  
RealFlight G3.5 offers the ability to simulate common failures for your aircraft.  This 
feature aids in teaching you how to remain calm and react appropriately when an 
actual failure occurs at your R/C field.  RealFlight G3.5 allows you to determine 
both the types of flight failures that you will face as well as how often those failures 
will occur. 

ADJUSTING THE RATE OF OCCURRENCE 
There are several methods available to adjust the frequency at which flight failures 
will occur.  To use the first method, click on the Simulation menu followed by the 
Flight Failures menu item.  This brings up a sub-menu as shown in the screen 
below.  Once the sub-menu is visible, simply mouse click on one of the options in 
the pull-down menu. 

 
Alternatively, you can adjust the rate of occurrence in the Settings… menu item.  To 
access this menu item, click on the Simulation menu followed by the Settings… 
menu item.  Next, mouse click on the Flight Failures listing.  You can bring forth 
the Flight Failures options by clicking on the [+] (plus) or by double-clicking on the 
Flight Failures listing itself.  To adjust the frequency of occurrence, click on the 
value as indicated in the column to the right of the probability indicator.   

The Settings… section discusses the Flight Failures options in detail. 

If you do not wish to experience any flight failures, click the Never option in the 
drop-down menu.  Conversely, if you wish to gain a great deal of experience at 
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handling emergencies, click the Always option.  The Always options means that 
each time you reset the aircraft, something is guaranteed to go wrong.  Maybe not 
right away – a kill engine failure will usually wait until some entirely inconvenient 
time to manifest, but it will happen.  The Rarely option corresponds to roughly a 5% 
chance per reset that something will fail. 

SELECTING THE TYPE OF FLIGHT FAILURES 
As noted previously, RealFlight G3.5 also allows you to determine the type of flight 
failures that you will experience.  To do so, click the Simulation menu followed by 
the Settings… menu item.  Next, double-click on the Flight Failures or click on the 
[+] (plus) to bring up the types of Flight Failures options. 

 
By default, all Flight Failure modes are enabled.  Each failure mode can be disabled 
individually.  To do so, click on the respective flight failure, which appears below 
the Flight Failures pull-down menu.  Next, click the values column.  Select either 
Yes or No from the pull-down menu. 

CCAAUUSSEE  FFLLIIGGHHTT  FFAAIILLUURREESS  
This feature causes a flight failure to occur.  To access this menu item, click on the 
Simulation menu, and then click on the Cause Flight Failures menu item.  As an 
alternative, press the ‘F’ key on your keyboard to cause a flight failure. 
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SSUUNN  
RealFlight G3.5 gives you the ability to adjust the position of the sun in the sky.  By 
change the Azimuth, you can rotate the sun around you.  Change the Inclination to 
adjust how high in the sky the sun should be, or make it night time by moving the 
sun below the horizon. 

ADJUSTING THE SUN AZIMUTH 
If you customize an airport, and find that the sun is always in your flight path, 
adjusting the sun’s Azimuth is a good way to move it around the sky, out of your 
way. 
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To adjust the Azimuth, select the Sun menu.  This will bring forth the Azimuth and 
Inclination options.  Highlight the Azimuth menu item in the pull-down selections.  
To rotate the sun to the right, click Increase.  Clicking Decrease will rotate the sun 
to the left. 

Alternatively, you may increase or decrease the Azimuth by pressing Shift + Home 
or Shift + End. 

When altering the Azimuth, the simulation temporarily displays the new location in 
the lower left corner of the window. 

ADJUSTING THE SUN INCLINATION 
To put the sun higher in the sky, or set it below the horizon, modify the Inclination.   
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To adjust the Inclination, select the Sun menu.  This will bring forth the Azimuth 
and Inclination options.  Highlight the Inclination menu item in the pull-down 
selections.  To raise the sun higher into the sky, click Increase.  Click Decrease 
lower the sun, or to set it below the horizon to make it night time. 

At night time, RealFlight G3.5 will automatic turn on the lighting effects on objects 
and aircraft that have lighting abilities. 

Alternatively, you may increase or decrease the Inclination by pressing Shift + 
Page Up or Shift + Page Down. 

When altering the Inclination, the simulation temporarily displays the new location 
in the lower left corner of the window. 

You cannot adjust the Inclination or Azimuth when the Fixed Camera property is set 
as it is in all stock PhotoField airports. 

 

WWIINNDD  
RealFlight G3.5’s TruFlo Wind Dynamics offers the most realistic wind model of 
any R/C simulator.  Its five components work together to capture this complex, ever-
changing force with unmatched realism.  Just as it would at the field, your model will 
encounter a variety of wind forces as it soars across the skies in RealFlight.  
Sailplane enthusiasts will appreciate the lifelike effect of the winds as they follow the 
drafts on the slopes and hills of G3.5. 

RealFlight offers you the ability to adjust both the speed and direction of the wind.  
To access the Wind settings, click on the Simulation menu followed by the Wind 
menu item.  Several methods may be utilized to adjust the wind speed and direction. 

Alternatively, you may adjust the Wind through the Settings… menu item.  For 
information on how to do so, please refer to the Settings… section which follows. 



78  •  Chapter 6.  The Simulation Menu R/C Simulator RealFlight 

ADJUSTING THE WIND DIRECTION- 
RealFlight G3.5 also allows you to alter the direction (expressed in degrees) of the 
wind as well.  This function is perfect for practicing crosswind landings. 

Selecting the Wind menu item brings up the Speed and Direction options.  To 
adjust the wind direction, highlight the Direction menu item in the drop-down 
selections.  To increase the degree of wind direction, click on the Increase option in 
the drop-down selections.  Likewise, clicking the Decrease option lowers the degree 
of wind direction.  The wind direction degree increases and decreases in 15-degree 
increments. 

You may also adjust the Direction through the Settings… menu item.  This method 
allows you to adjust the direction in one-degree increments. 

 
Alternatively, you may increase the angle of the wind direction by pressing the 
Home key on the keyboard.  To decrease the angle of the wind direction, press the 
End key on the keyboard. 

When altering the wind direction, the simulation temporarily displays the new wind 
direction in the lower left corner of the window. 

ADJUSTING THE WIND SPEED- 
Increasing the wind speed is an ideal way to learn to fly in the less-than-perfect wind 
conditions that frequently occur at an R/C field.  To adjust the speed of the wind, 
select the Wind menu.  This will bring forth the Speed and Directions options.  To 
adjust the speed of the wind, highlight the Speed menu item in the pull-down 
selections.  To increase the speed of the wind, click on the Increase option in the 
pull-down selections.  Clicking the Decrease option reduces the wind speed. 
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Note:  the wind speed is increased or decreased in random increments. 

Alternatively, you may increase the wind speed by pressing the Page Up key on your 
keyboard.  To decrease the speed of the wind, press the Page Down key on your 
keyboard.  Each time the Page Up or Page Down is pressed the wind is increased or 
decreased incrementally. 

When altering the wind speed, the simulation temporarily displays the new wind 
speed in the lower left corner of the window. 

IIMMPPOORRTT  
 

The Import menu item allows you to utilize, or import, content created by other 
users.  There are three types of files that are associated with RealFlight G3.5; each 
will be covered in the section that follows. 
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Raw Panoramic Image- 

This file type refers to the panoramic image that helps generate the PhotoField flying 
sites.  This option allows you to create a PhotoField using a panoramic image that 
you may have downloaded or created yourself.  It works best with large images 
(8000x4000) that are equirectangular, spanning 360 degrees horizontal by 180 
degrees vertical.  Click on the Raw Panoramic Image… selection to import an 
image into the simulation.  Browse to the location of the image you would like to 
import.  The image may be either a bit map (.bmp), targa (.tga) or a JPEG (.jpg) file 
extension.   

Once you have located the appropriate folder and desired image, double-click the 
image.  Alternatively, select this image and click Open.  The conversion process can 
take several minutes for large images.  When the process is complete, G3.5 will 
automatically create a new PhotoField airport that uses your newly imported image. 

To edit the new PhotoField airport (for image alignment, object placement, etc.), 
access the Airport Editor.  To do so, click the Simulation menu, followed by the Edit 
New Airport menu item.  To see the image from the pilot’s perspective, refer to the 
Pilot Preview window.  This will make it easier to place objects and adjust the 
image correctly.  If necessary, adjust the image using the Panoramic Image Y 
Alignment, Panoramic Image X Alignment and/or the Panoramic Image Facing 
options located in the Properties window. 

 

KEX- 

Knife Edge software has created a plug-in, or software module that functions with 
popular 3D modeling tools to create subject matter for the RealFlight Generation 3.5 
software.   

The KEX importer is used to bring the model from the plug-in into the simulation 
itself. 

 

G3X- 
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G3X is the file extension that is used for all files exported from RealFlight G3.5.  
This menu option allows you to import a G3X file.  You will use this for all files that 
you have downloaded from a share site.  There is nothing special you need to know 
about the file beforehand; the G3X importer handles all types of content, including 
planes, color schemes, airports, PhotoFields, and recordings.   

After choosing menu item Import followed by G3X, you will be presented with an 
Open file dialog.  Use this dialog to find the file that you want to import.  Double-
click the file or click the file and click Open.  The import process will start 
immediately and once it’s finished you will see a message confirming its success. 

 

 
 

EEXXPPOORRTT  
 

The Export menu item allows you to share user-created content.  It is provided in 
the menu as a shortcut to using the Manage User Files dialog. 

G3.5 users may share the following items:  Color Schemes, Aircraft Variant, Entire 
Aircraft, Airport and Panoramic Images.  If one or more of these options on the list is 
grayed out, it is because the currently loaded color scheme, aircraft, or airport is part 
of the simulation by default and not available for export. 

 
Color Scheme 

This option allows you to share the current aircraft color scheme (a.k.a. trim scheme) 
with other RealFlight users.  

To export a Color Scheme, select the Export menu item followed by the Color 
Scheme option.  A save dialog will appear so that you can choose where you would 
like to save the exported color scheme and determine the filename.  After saving, a 
message will appear on-screen advising you whether or not the export was 
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successful.  This message will also list the location and name of the file that was 
exported.  You may then upload the exported file to a web site for others to enjoy. 

 

Aircraft Variant 

This option enables you to export an aircraft that has undergone structural 
modifications such as lengthened wing span, more prop thrust, different airfoils, etc.  
It is important to note in addition to any wire frame modifications, the Aircraft 
Variant file option also includes any modifications to the aircraft powerplant, 
batteries, etc. 

To export an aircraft variant, select the Export menu item followed by the Aircraft 
Variant option.  A save dialog will appear so that you can choose where you would 
like to save the exported color scheme and determine the filename.  A verification 
message will appear on-screen advising you whether or not the export was 
successful.  This verification message will also list the location and name of the file 
that was exported.  You may then upload the exported file to a web site for others to 
enjoy. 

 

Entire Aircraft 

This option enables you to export the entire contents of an aircraft such as trim 
scheme, structural changes, etc. 

 To do so, select the Export menu item followed by the Entire Aircraft option.  A 
save dialog will appear so that you can choose where you would like to save the 
exported color scheme and determine the filename.  A verification message will 
appear on-screen advising you whether or not the export was successful.  This 
verification dialog will also list the location and name of the file that was exported. 
You may then upload the exported file to a web site for others to enjoy. 

 

Airport 

This option enables you to export a modified airport.  Note that any custom 
panoramic image you may be using with this airport will not be exported.  To export 
an airport with a custom panoramic image, use “Airport (include Panoramic Image).” 

To export an airport, select the Export menu item followed by the Airport option.  
A save dialog will appear so that you can choose where you would like to save the 
exported color scheme and determine the filename.  After saving, a verification 
message will appear on-screen advising you whether or not the export was 
successful.  This verification message will also list the location and name of the file 
that was exported. You may then upload the exported file to a web site for others to 
enjoy. 

 

Airport (include Panoramic Image) 

This option enables you to export an airport along with its custom panoramic image.  
To do so, select the Export menu item followed by the Airport (include Panoramic 
Image) option.  A save dialog will appear so that you can choose where you want to 
export the airport and what you want to name the file.  A verification message will 
appear on-screen advising you whether or not the export was successful.  This 
verification message will also list the location and name of the file that was exported. 
You may then upload the exported file to a web site for others to enjoy.  
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MMAANNAAGGEE  UUSSEERR  FFIILLEESS  
 

The Manage User Files menu item allows you to modify the new user content that 
you have added to the simulation.  You will find that the Manage User Files menu 
item is a handy tool as it maintains all such files in one, easy to find and access 
location. 

 

 
 

The Manage User Files dialog allows you to copy, rename, delete, or export any 
custom resource that exists in the simulation.  It is important to note that the various 
Manage User Files buttons will be inactive until a modification to one of the files 
exists.  That is, this menu item is only utilized to modify user-created items.  It will 
not allow you to modify the airports or vehicles included in the RealFlight 
Generation 3.5 software. 
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Copy- 

This option duplicates the information and data pertaining to the currently selected 
item.  If, for example, you wish to duplicate a flying site located in the User Files, 
click the Copy button.  

Once you have copied the respective file, enter a name for the new item.  Using our 
previous example, simply rename the flying site as desired.  This new name will then 
be used in the Select Airport dialog.   

 

Rename- 

This option is utilized to rename a user-created item.   

To do so, highlight the desired item (flying site, etc.) and click Rename.  Enter the 
desired name for the respective item in the dialog provided.    The item will now 
appear in its respective list of offerings with the new name.   

 

Delete- 

This option is utilized to delete an item entirely.  All files associated with the item 
will be removed from your computer. 

Again, it is important to note that users are only allowed to delete items which they, 
or other users, have created.  That is, you are not allowed to delete default items that 
are included with the software. 

To delete a user-created item, select the respective item in the User File menus and 
click Delete.  If you wish to delete this item, click Yes in the verification dialog.  
Please note: once deleted this resource will no longer be available in the simulation.   

 

Export- 

This button is used to Export, or place the airport/aircraft/recording in a location so 
that the user may share it with others.  If you have created interesting or unusual 
content, we encourage you to share your designs with other RealFlight users.  The 
more content that is shared the more enjoyment everyone will experience. 

To export a user-created item, select the respective item in the User File menus and 
click Export.  A verification dialog will appear on-screen advising you whether or 
not the export was successful and the location and name of the file that was exported.  
You may upload the exported file to a web site, move it to another computer, or 
email it for others to enjoy. 

 

SSEETTTTIINNGGSS  
The Settings options are an integral part of the G3.5 software.  This menu item 
allows you to adjust a multitude of features and functions within the simulation.  To 
access this menu item, click on the Simulation menu followed by the Settings… 
menu item.  The Settings dialog will appear, showing the available options. 
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The Settings that are available to you are as follows: 

• Camera 

• Flight Failures 

• Graphics 

• Language 

• Multiplayer 

• Physics 

• Sound 

• System Messages 

• Wind and Weather 

CAMERA 
The camera options available to you are designed to enhance the field of view when 
utilizing the Keep Ground in View zoom mode.  For more information on this 
option, please refer to the View menu section of this manual. 
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MINIMUM FIELD OF VIEW (DEG)- 
This setting determines the absolute minimum field of view when utilizing the Keep 
Ground in View zoom option. 

To adjust the minimum field of view, click the existing value.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

CAMERA LAG (%)- 
This controls how quickly the camera reacts to the aircraft’s movements.  If the lag is 
set to zero, the camera always looks directly at the aircraft.  At all other values, the 
camera will have a spring-like reaction to the aircraft during flight. 

At very high values, the camera hardly ever looks directly at the aircraft, and often 
the aircraft will fly off the screen as the camera tries to catch up.  At lower values, 
the effect is very subtle and yet still softens the camera movement enough so that 
minor changes in the aircraft’s speed/position are more noticeable. 

Please note:  these settings apply to fixed view cameras only.  They are not 
applicable to the cockpit or chase views. 

FLIGHT FAILURES 

Adjusting the Probability and Notify When settings- 
To adjust the Probability options or the Notify When settings, click on the Flight 
Failures root directory. 

ACCESSING THE FLIGHT FAILURES OPTIONS- 
Double-click on the Flight Failures name or click on the [+] (plus) to expand the 
list and show the Flight Failures options.  RealFlight defaults all Flight Failures to  
enabled (active).  Each item may be enabled or disabled individually.  To disable a 
specific flight failure, click on the respective failure located within the pull-down 
list.  Next, click on the Yes value as indicated in the value column.  This brings forth 
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the Yes/No pull-down list.  To disable the respective failure, simply choose the No 
option.  For example, to disable the Reverse Servo flight failure: 

1. Select the Reverse Servo option in the Flight Failures sub-menu  

2. Click the Yes in the right hand pane 

3. Select No from the pull-down list 

 

PROBABILITY- 
To adjust the frequency of occurrence, click on the value as indicated in the column 
to the right of the probability indicator. 

 
If you do not wish to experience any flight failures, select the Never option in the 
drop-down menu.  Conversely, if you wish to gain a great deal of experience at 
handling emergencies, click the Always option. 
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NOTIFY WHEN- 
This setting allows you to determine if or when RealFlight notifies you as to the 
flight failure experienced. 

To adjust the settings of this feature, click on the value as indicated in the column to 
the right of the Notify When indicator.  Your options are: 

After Flight - RealFlight will advise you as to the flight failure experienced upon the 
completion of the flight. 

Before Flight - RealFlight will tell you which flight failure you are about to 
experience before the flight begins. 

No -RealFlight G3.5 will never advise you as to the flight failure that you have 
experienced, or are about to experience.  A little mystery is a good thing. 

On Failure - RealFlight will tell you about the flight failure just as it occurs. 

DEFINING THE FLIGHT FAILURES- 
Reverse Servo - The travel direction of one of your servos is reversed. 

Kill Engine - The engine will fail or quit in flight, which means that you will have to 
perform a dead stick landing. 

Servo Stuck - A servo will become fixed, or stuck, in a certain position. 

Servo Trim - A servo alters the trim settings, modifying the flight control position. 

Channel Swap - This failure simulates the effect of inadvertently swapping two 
channels.  As an example, you may find that your rudder controls the throttle, and 
vice versa. 

Radio Lockout (PCM) - The receiver will experience intermittent radio dropouts 
during which time the aircraft will fail to respond to control inputs. 

Radio Interference (FM) - The receiver will experience intermittent radio 
interference during which time the servos will behave erratically. 

Radio Range - The receiver will experience interference proportional to the distance 
between the pilot and the aircraft.  If the aircraft is close to the pilot’s position, the 
range problems will be minimal, increasing as the aircraft gets farther away. 

Reverse Channel - One of the channels, selected at random, will operate in reverse 
direction. 

GRAPHICS- 
Double-click on the Graphics name or click on the [+] (plus) to expand the menu 
and display the various Graphics options available to you. 

QUALITY OPTIONS- 
The Quality options are quite useful in fine-tuning your simulator to ensure that it 
runs as efficiently and realistically as possible.  Use the settings in the Graphics 
options to obtain the perfect blend of optimal visuals and performance from your PC.  
If you are experiencing slow frame rates or other performance issues, it may be 
prudent to turn down some graphics quality options. 
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Note that many of the adjustments will not take place immediately.  In many cases, 
you will need to restart the simulator to get the option to take effect. 

To select the quality options, click on the Quality name.  This will call up the 
following options: 

• Clouds 

• Particles 

• Scenery Objects 

• Shadows Enabled 

• Terrain Detail 

• Trees 

• Terrain (%) 

• Foliage Density (%) 

• Shadow Quality 

• Particles Quality 

• Streamer Quality 

• Textures Quality 

• Night Flying Quality 

• Misc. Graphics Quality 

• Brightness (%) 

• Contrast (%) 

CLOUDS- 
This option determines whether your flying sites will include clouds in the skyline. 

Click on the respective value indicator.  From the pull-down options select either 
Yes (clouds will be present) or No (clouds will not be present). 
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PARTICLES- 
This option determines whether RealFlight will utilize engine smoke. 

Click on the respective value indicator.  From the pull-down options select either 
Yes (G3.5 will display smoke) or No (G3.5 will not display smoke). 

SCENERY OBJECTS- 
This option determines whether the simulation displays background objects such as 
buildings, rocks, benches, etc.  If Yes is selected, the background objects will be 
present.  If No, the background objects will not appear in the simulation. 

To change this setting, first click on the respective value indicator.  From the pull-
down options select either Yes or No. 

SHADOWS ENABLED- 
The Shadows option determines whether the simulation displays shadows. 

To change the Shadows setting, click the value located to the right of the Shadows 
name.  Next, click Yes to display the shadows or No to eliminate shadows from the 
simulation. 

TERRAIN DETAIL- 
This option determines whether RealFlight G3.5 displays the details found in the 
textures.  Modify the Terrain Detail setting by clicking on the value located to the 
right of the Terrain Detail name.  Click Yes to display the terrain detail texture or No 
to eliminate the terrain details. 

TREES- 
The Trees setting determines whether RealFlight G3.5 display trees.  To change the 
Trees setting, click the value located to the right of the Trees.  Select No if you do 
not wish to display the trees in your simulation.  If you wish to view the trees during 
flight, select Yes. 

Please note:  the display of trees does have an effect on the frame rate of your 
simulation. 

TERRAIN (%)- 
This setting determines the density and drawing time of the scenery.  Lowering the 
percentage will ensure that the scenery draws faster.  This is particularly useful if 
you experience low frame rate. 

To adjust the percentage, click on the value located to the right of the Terrain (%) 
name.  Enter the desired input directly from your keyboard, or use the mouse wheel. 

FOLIAGE DENSITY (%)- 
This setting determines the density and drawing time of the trees and the grass.  
Lowering the percentage will ensure that the scenery is drawn faster.  Again, if you 
are experiencing low frame rates, lowering this value will speed up the simulation. 

To adjust the percentage, click on the value located to the right of the Foliage 
Density (%) name.  Enter the desired input directly from your keyboard, or use the 
mouse wheel. 
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SHADOWS QUALITY- 
This setting specifies the quality of the shadows in the simulation.  RealFlight G3.5 
attempts to automatically optimize the settings for your PC.  However, it may be 
necessary for you to perform some manual fine-tuning in order to obtain the best 
possible performance. 

To modify the quality of the shadows, click on the value indicated in the column to 
the right of the Shadows name.  Select the desired level for your simulation from the 
pull-down list.  The Highest setting will render the best shadows, but it requires 
significant processing power.  If your frame rate is low, we suggest you reduce the 
shadow quality. 

PARTICLES QUALITY- 
This setting adjusts the quality of the smoke, debris and other small objects during 
the simulation.  If the frame rate drops when the smoke is thick, try lowering the 
quality of the smoke until you achieve an acceptable frame rate. 

To do so, click on the existing particle quality.  Next, from the pull-down menu, 
select the desired quality level. 

STREAMER QUALITY- 
This setting adjusts the quality of the streamers during the simulation.  If the frame 
rate drops when flying an aircraft with streamers, try lowering the quality of the 
streamers until you achieve an acceptable frame rate. 

To do so, click on the existing streamer quality.  Next, from the pull-down menu, 
select the desired quality level. 

TEXTURE QUALITY- 
Use this setting to add the realistic textures to the items and various other objects 
found in the simulation. 

To do so, click on the existing texture quality level.  Next, from the pull-down menu, 
select the desired quality option. 

Please note: you must restart the simulation for the new setting to take effect. 

NIGHT FLYING QUALITY- 
This setting adjusts the bloom effect (the glow from the light) from the lighted 
objects and aircraft when flying at night.   

To do so, click on the existing particle quality.  Next, from the pull-down menu, 
select the desired quality level. 

MISC GRAPHICS- 
This setting adjusts the quality level of miscellaneous items in your simulation. 

To alter the Miscellaneous Graphics level, click on the value located to the right of 
the Misc. Graphics name.  Next, select the desired level to utilize for the graphics.  

Please note: you must restart the simulation for the new setting to take effect. 
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BRIGHTNESS (%)- 
This setting adjusts the brightness of the ambient lighting found in the simulation.  If 
dark colors appear to be overly dark, increase the brightness percentage. 

To adjust the brightness percentage, click on the current brightness percentage.  
Enter the desired value directly from the keyboard or use the mouse wheel. 

CONTRAST (%)- 
The contrast percentage brightens the lighter colored items in the simulation.  It does 
not affect the darker items in the simulation. 

To adjust the contrast percentage, click on the contrast percentage.  Enter the desired 
value directly from the keyboard or use the mouse wheel. 

HARDWARE- 
The Hardware settings are used to adjust the non-software settings to achieve the 
best possible simulation for your PC. 

 

HARDWARE OPTIONS- 
To select the Hardware options, click on the Hardware name.  This will call up the 
following options: 

• Graphics Adapter 

• Graphics Device 

• Full Screen 

• Resolution 

• Refresh Rate 

• Vertical Sync 
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GRAPHICS ADAPTER- 
The Graphics Adapter is the device that RealFlight utilizes to run the simulation, 
generically referred to as a video card.  Most PC’s have only one video card; 
however, some PC’s are equipped with multiple cards. 

To determine if your PC has an additional video card available to you, click on the 
video card information located in the values column to the right of the Graphics 
Adapter name.  If multiple cards appear in the drop-down selection there is another 
option for you.  If not, your PC is equipped with only one video card. 

GRAPHICS DEVICE- 
Some video cards offer multiple devices.  HAL (Hardware Abstraction Layer) is the 
preferred device to use for the graphics rendering.  In general, you should never need 
to modify this setting. 

To determine if your PC offers alternative devices, click on the value indicated in the 
column to the right of the Graphics Device name. 

FULL SCREEN- 
This option determines whether RealFlight will run using the entire monitor screen 
for the simulation.  If you decide to run in the Full Screen mode, RealFlight’s menus 
will not appear on the screen. 

To access the menu while in Full Screen mode, press either the ESC key or the ALT 
key on the keyboard. 

To adjust the Full Screen option, click on the value as indicate in the column to the 
right of the Full Screen name.  From the pull-down menu, select Yes to run in Full 
Screen or No to run in the Windowed mode. 

Alternatively, you may access the Full Screen mode by pressing the Alt and Enter 
keys simultaneously on the keyboard.  To exit Full Screen mode, press the Alt and 
Enter keys simultaneously. 

RESOLUTION- 
This control adjusts the screen resolution and color depth.  If your frame rate is 
unacceptably low, you can improve it by reducing the resolution or color depth.  This 
will reduce some of the rendering processes required of your video card. 

To adjust the resolution for your simulation, click the value indicated in the column 
to the right of the Resolution name.  Select the desired level for your simulation from 
the drop-down list. 

Please note:  this option is only effective when using RealFlight in the Full Screen 
mode. 

REFRESH RATE- 
The refresh rate is the number of times per second that your monitor retraces its 
video display.  Your video hardware (monitor and graphics card) dictates what 
refresh rates you are able to utilize in the simulation.  As with Resolution, this option 
is only effective when running RealFlight in the Full Screen mode. 

To adjust the refresh rate, click the value that is indicated in the column to the right 
of the Refresh Rate name.  If there are multiple options in this list, you might opt for 
a lower value to determine if this improves the frame rate of your simulation. 
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We suggest that you test a variety of resolutions and color options to achieve the 
optimum performance and setup for your system. 

VERTICAL SYNC- 
This option dictates where the monitor will draw the next vertical line.  Activating 
Vertical Synchronization slows the simulation slightly, but it prevents the ‘tearing’ 
of onscreen images. 

To adjust the Vertical Sync, click the respective value.  Select Yes or No from the 
pull-down menu that appears. 

LANGUAGE- 
Clicking on the Language settings option allows you the change the language used 
for the menus and dialog windows throughout the simulator. 

 
To change the language, click on the click on the current language listed.  Select the 
desired language directly from the keyboard or use the mouse wheel. 

 

MULTIPLAYER- 
Clicking on the Multiplayer settings option brings up the following options: 
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PILOT NAME- 
This setting allows you to enter a name for the multiplayer sessions.  To do so, click 
on the value that appears to the right of the Pilot Name column.  Click the more 
options button (the gray folder with the ellipsis).  Enter a name of your choosing.  
When satisfied, press the Enter button on your keyboard. 

Please note:  when participating in a multiplayer session, other players may be able 
to view the name you have selected. 

MULTIMODE SCREEN LAYOUT- 
This setting specifies the layout of the screen for the MultiMode option.  If you 
select Vertical, the computer screen will split in half on its vertical axis.  If you 
select Horizontal, the computer screen will split in half on the horizontal axis. 

To select which mode best suits your tastes, click on the value displayed to the right 
of the MultiMode Screen Layout column.  Next, select either Horizontal or Vertical 
from the pull-down options. 

COLLISIONS- 
The Collisionws option allows you to enable or disable the collisions between 
aircraft in Multiplayer sessions.  If you are connected via dialup, or have a slow 
network connection, Select No as this may spend up the performance of the 
simulator. 

CHAT 
A chat is a real-time communication, via computer, between G3.5 users.  The 
settings here determine the appearance of the messages sent and/or received during a 
chat session. 
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We suggest using two very distinct colors for the messages that are sent versus those 
received.  This allows you to rapidly distinguish amongst the messages.  For 
example, use red for the messages that you are transmitting and blue for the 
messages received. 

LOCAL MESSAGE TEXT COLOR- 
This setting adjusts the color of the text for chat messages keyed on this PC. 

To modify this setting, click on the respective value.  Click the more options button 
(the gray folder with the ellipsis) to bring forth the palette of available colors.  This 
will reveal a screen that appears as follows: 

 
To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the value column. 
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LOCAL MESSAGE TEXT SIZE- 
As the name suggests, this setting determines the font size of the chat messages on 
this PC.  Larger values mean that the font size will increase. 

To modify the size, click on the respective value.  Input the value directly from the 
keyboard or use the mouse wheel. 

REMOTE MESSAGE TEXT COLOR- 
This setting determines the color of the chat messages sent to your PC.  That is, 
when another user sends a chat message to you, this is the color of the text. 

To modify this setting, see the instructions in the “Local Message Text Color” 
section. 

REMOTE MESSAGE TEXT SIZE- 
This setting determines the font size of the chat messages sent from other G3.5 users.  
Larger values mean that the font size will increase. 

To modify the size, click on the respective value.  Input the value directly from the 
keyboard or use the mouse wheel. 

CHARACTER CAPACITY- 
This value determines the maximum number of characters allowed on-screen during 
a chat session. 

To modify the maximum number of characters, click on the respective value.  Input 
the desired value directly from the keyboard or use the mouse wheel. 

PHYSICS- 
The physics options are quite useful in fine-tuning the items applicable to the physics 
of your simulated aircraft. 
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PHYSICS OPTIONS- 
To select the Physics options, click on the Physics name.  This calls up the following 
options: 

• Airplane Physics Quality 

• Helicopter Physics Quality 

• Unlimited Fuel 

• Use Metric Units 

• Physics Speed (%) 

• Reset Delay (sec) 

AIRPLANE PHYSICS QUALITY- 
This setting determines the detail level of physics utilized for the airplanes in the 
simulation.  When the physics level is adjusted to the highest setting, the simulation 
performs the aircraft calculations more accurately and more frequently.  Unless you 
are running the simulation on an older, slower PC, we suggest using either the ‘high’ 
or ‘highest’ settings.  Lowering the physics level will reduce the quality and detail 
level used in the simulation, thereby allowing the simulation to run at a faster rate for 
slower PC’s. 

To alter the physics options, click on the value indicated in the column to the right of 
the Airplane Physics Quality name.  Using either the up/down arrow keys on the 
keyboard, or the mouse, select the level for your simulation from the pull-down list.  
If using the up/down arrow keys, press Enter to finalize your selection. 

HELICOPTER PHYSICS QUALITY- 
This setting determines the detail level of physics utilized for the airplanes in the 
simulation.  When the physics level is adjusted to the highest setting, the simulation 
performs the aircraft calculations more accurately and more frequently.  Unless you 
are running the simulation on an older, slower PC, we suggest using either the ‘high’ 
or ‘highest’ settings.  Lowering the physics level will reduce the quality and detail 
level used in the simulation, thereby allowing the simulation to run at a faster rate for 
slower PC’s. 

To lower the physics option, click on the value indicated in the column to the right of 
the Helicopter Physics Quality name.  Using either the up/down arrow keys on the 
keyboard, or the mouse, select the level for your simulation from the drop-down list.  
If using the up/down arrow keys, press Enter to finalize your selection. 

UNLIMITED FUEL- 
This option determines whether your aircraft will run out of fuel.  If you select Yes, 
the engine will run indefinitely – assuming, of course, that you do not crash.  If you 
select No, the aircraft will indeed run out of fuel.  The length of time required to do 
so is based upon a number of factors including the engine utilized and throttle 
management, just as it would at the flying field. 

To determine whether your aircraft will run out of fuel, click on the value column to 
the right of the Unlimited Fuel option.  Using either the up/down arrow keys on the 
keyboard, or the mouse, select either Yes or No from the pull-down listings. If using 
the up/down arrow keys, press Enter to finalize your selection. 



R/C Simulator RealFlight Chapter 6.  The Simulation Menu  •  99 

USE METRIC UNITS- 
This option determines the unit of measurement for the various displays found in the 
simulation.  RealFlight defaults to display measurement in SAE units.  You can 
easily change this to use metric units. 

To do so, click on the value column to the right of the Use Metric Units name.  
Using either the up/down arrow keys on the keyboard, or the mouse, select either 
Yes or No from the pull-down listings. If using the up/down arrow keys, press Enter 
to finalize your selection. 

PHYSICS SPEED- 
Expressed as a percentage, this value controls the time scale of the simulation.  
Reducing the value allows you to create a slow-motion effect.  This is useful when 
learning new skills or maneuvers, as you may slow the aircraft’s reaction time. 

It is important to note that these adjustments do not affect RealFlight during 
multiplayer sessions or events. 

To adjust the Physics Speed, click the respective value.  Enter the desired value 
directly from the keyboard or use the mouse wheel. 

RESET DELAY (SEC)- 
This setting will force RealFlight to automatically reset the aircraft after a crash 
where a piece of the aircraft has broken off. 

To adjust the Reset Delay, click the respective value.  Enter the desired value 
directly from the keyboard or use the mouse wheel. 

SOUND- 
The Sound settings control the various options related to the miscellaneous sounds 
within the simulation.  RealFlight allows you to make modifications to the various 
sounds based upon your preferences. 

 
Selecting the Sound menu item brings forth the following menu items. 
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• Engine Sounds Volume (%) 

• Environment Sounds Volume (%) 

• Sound Effect Volume (%)  

• Voiceover Volume (%) 

• Walk Sound Volume (%) 

• Wind Sound Volume (%)  

• Engine Sounds Enabled 

• Crash Sounds Enabled 

• Wind Sounds Enabled 

• Walk Sounds Enabled 

• 3D Rolloff Factor 

• Doppler Factor 

ENGINE SOUND VOLUME (%)- 
This option adjusts the sound level of the engines in comparison to the other sounds 
found within the simulation.  Increasing the percentage causes the engine sounds to 
be more prevalent.  Likewise, decreasing the value softens the engine sounds in 
comparison to the other sounds. 

To adjust the Engine Sound Volume, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

ENVIRONMENT SOUNDS VOLUME (%)- 
This option adjusts the sound level of the environment sound effects in comparison 
to the other sounds found within the simulation.  Increasing the percentage causes 
the environment sounds to be more prevalent.  Likewise, decreasing the value 
softens the environment sounds in comparison to the other sounds. 

To adjust the Environment Sound Volume, click on the respective value indicator.  
The desired values may be input directly from the keyboard or modified using the 
mouse wheel. 

SOUND EFFECT VOLUME (%)- 
The adjustments made to this volume control affect the items that do not have 
individual settings or adjustments.  For example, this setting affects the crash and 
collision sounds heard in RealFlight G3.5. 

To adjust the Sound Effect Volume, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

VOICEOVER VOLUME (%)- 
This setting adjusts the voiceover sounds within the simulation.  This will affect the 
voiceovers found in the Virtual Flight Instruction area as well as any Event narration. 
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To adjust the Voiceover Volume, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

WALK SOUND VOLUME (%)- 
This setting adjusts the sound of the ‘steps’ that are heard when you enter the ‘walk’ 
mode. 

To adjust the Walk Sound Volume, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

ENGINE SOUNDS ENABLED- 
This setting determines whether to play the various engine sounds.  Enabling the 
engine sounds adds to the realism of the simulation.  Slower PC’s may benefit from 
not having the engine sounds activated, however. 

To determine whether or not to play the engine sounds, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or the mouse, 
select either Yes (engine sounds audible) or No (engine sounds inaudible) from the 
pull-down listings.  If using the up/down arrow keys, press Enter to finalize your 
selection. 

CRASH SOUNDS ENABLED- 
This setting determines whether to play the various crash sound effects. 

To determine whether or not to play the crash sounds, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or the mouse, 
select either Yes (crash sounds audible) or No (crash sounds inaudible) from the 
pull-down listings.  If using the up/down arrow keys, press Enter to finalize your 
selection. 

WIND SOUNDS ENABLED- 
This setting determines whether to play the various wind sounds. 

To determine whether or not to play the wind sounds, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or the mouse, 
select either Yes (wind sounds audible) or No (wind sounds inaudible) from the pull-
down listings.  If using the up/down arrow keys, press Enter to finalize your 
selection. 

WALK SOUNDS ENABLED- 
This setting determines whether to play the various walk sound effects. 

To determine whether or not to play the walk sounds, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or the mouse, 
select either Yes (walk sounds audible) or No (walk sounds inaudible) from the pull-
down listings.  If using the up/down arrow keys, press Enter to finalize your 
selection. 
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3D ROLLOFF FACTOR- 
This is the rate at which sounds attenuate on their way back to the user.  Increasing 
the value exaggerates the effect.  Conversely, decreasing the number reduces the 
effect. 

To modify the existing Rolloff Factor, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

DOPPLER FACTOR- 
This setting controls the affect of the Doppler sound shift as a direct result of the 
proximity of the source in relationship to the pilot.  As with the 3D Rolloff Factor, 
increasing the number exaggerates the shift.  A decreased value reduces the effect.  
To disable it altogether, simply input a Value of 0. 

To modify the existing Doppler Factor, click on the respective value indicator.  The 
desired values may be input directly from the keyboard or modified using the mouse 
wheel. 

SYSTEM MESSAGES 
The System Messages options and settings allow you to perform a number of 
modifications to the messages that appear on-screen while running the simulation. 

 

ADJUSTING THE SHOW AT MOST AND THE CLEAR ON RESET SETTINGS- 
To adjust the Show At Most options or the Clear On Reset settings, click on the 
System Messages name. 

SHOW AT MOST- 
This numerical value indicates the maximum number of messages that will appear on 
your screen at any given time.  When the maximum number is surpassed, an older 
message will be removed and the most recent message will take its place on-screen. 
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To adjust the number of messages displayed on-screen at one time, click on the value 
as indicated in the column to the right of the Show At Most indicator.  Input the 
desired value directly from the keyboard or use the mouse wheel. 

CLEAR ON RESET- 
This setting controls whether all the on-screen messages are cleared when the aircraft 
resets.  This prevents the screen from becoming overly cluttered with messages and 
information. 

Using either the up/down arrow keys on the keyboard, or the mouse, select either 
Yes (messages automatically clear) or No (messages remain on-screen after a reset) 
from the pull-down listings.  If using the up/down arrow keys, press Enter to finalize 
your selection. 

ACCESSING THE SYSTEM MESSAGES INFORMATION- 
Double-clicking on the System Messages name or clicking on the [+] (plus) will 
bring forth the following screen: 

• Instructions 

• Notifications 

• Warnings 

• Errors 
Each of the System Messages screens is independently adjustable and may be 
tailored to suit your personal preferences.  For information on how to do so, please 
read the following section. 

INSTRUCTIONS- 
As the name suggests, modifications will affect only the System Instructions. 

To select the Instructions options, click on the Instructions name.  This calls up the 
following options: 
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• Font Size 

• Foreground Color 

• Background Color 

• Background Alpha (%) 

• Message Duration (sec) 

• Enabled 

FONT SIZE- 
This option allows you to adjust the font size for the messages pertaining to the 
instructions.  Please note:  this only affects the Instructions.  It does not affect any 
other system messages. 

To access the Font Size options, click on the value shown in the respective column.  
The desired values may be input directly from the keyboard or modified using the 
mouse wheel. 

FOREGROUND COLOR- 
This option allows the user to adjust the color of the foreground for the Instructions 
messages. 

To access the options pertaining to the foreground color, click on the current value.  
Click the more options button (the gray folder with the ellipsis) to bring forth the 
palette of available colors.  This will reveal a screen that appears as follows: 

 
To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the value column. 

BACKGROUND COLOR- 
As with the Foreground Color, this setting allows the user to adjust the color of the 
background for the Instructions messages. 
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To access the options pertaining to the background color, click on the current 
displayed color. 

Click the more options button (the gray folder with the ellipsis) to bring forth the 
palette of available colors.  To select a color, click the desired color on the palette.  If 
you wish to make a custom color, click the Define Custom Colors button and create 
the color or colors to suit your tastes.  Click OK to finalize the selection.  The 
selected color will be reflected immediately in the value column. 

BACKGROUND ALPHA (%)- 
This option adjusts the transparency of the text background for the message. 

The desired values may be input directly from the keyboard or modified using the 
mouse wheel.  The higher the value, the more transparent the text background will 
become. 

MESSAGE DURATION (SEC)- 
This option adjusts the length of time that a message remains on-screen before it 
disappears. 

You may input desired values directly from the keyboard or modify them using the 
mouse wheel.  Of course, the higher the value, the longer the message remains on-
screen. 

ENABLED- 
This option determines whether Instructions messages are displayed or not. 

To determine whether this is enabled, click on the respective value indicator.  Using 
either the up/down arrow keys on the keyboard, or the mouse, select either Yes 
(Instructions messages are enabled) or No (Instructions messages are disabled) from 
the pull-down listings. If using the up/down arrow keys, press Enter to finalize your 
selection. 

NOTIFICATIONS- 
To select the Notifications options, click on the Notifications name.  This will call 
up the following options: 

• Font Size 

• Foreground Color 

• Background Color 

• Background Alpha (%) 

• Message Duration (sec) 

• Enabled 
These options function in the same way as the options for the Instructions messages, 
except that they only affect Notification messages. 

WARNINGS- 
This option determines the settings for the system warning messages. 
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To select the Warnings options, click on the Warnings name.  This will call up the 
following options: 

• Font Size 

• Foreground Color 

• Background Color 

• Background Alpha (%) 

• Message Duration (sec) 

• Enabled 
These options function in the same way as the options for the Instructions messages, 
except that they only affect warning messages. 

ERRORS- 
This option allows you to modify the behavior of system error messages. 

To select the Errors options, click on the Errors name.  This will call up the 
following options: 

• Font Size 

• Foreground Color 

• Background Color 

• Background Alpha (%) 

• Message Duration (sec) 

• Enabled 
These options function in the same way as the options for the Instructions messages, 
except that they only affect Error messages. 

WIND AND WEATHER- 
The wind and weather options control the atmospheric conditions encountered in the 
simulation.  You can adjust these to match the conditions typically found at your 
local flying site. 

Double-clicking on the Wind and Weather name or clicking on the [+] (plus) will 
bring forth the various options available to you.  The screen appears as follows: 
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Global Wind- 
These options determine the global wind conditions for the current airport.  Please 
note:  the adjustments made here will temporarily override the airport’s default 
values.  Upon selecting an alternative airport or closing RealFlight, the default values 
will be restored. 

WIND DIRECTION (DEG)- 
To adjust the wind direction, click on the value indicated to the right of the Wind 
Direction name.  Next, input a numerical value between 0 and 359 degrees to modify 
the wind direction.  Alternatively, the mouse wheel may be used to alter the input 
value. 

You may also adjust the wind direction from the keyboard.  Press the Home key to 
increase the wind direction.  The End key will reduce the direction of the wind. 

The direction that the wind comes from is expressed in degrees; where 0 is north, 90 
is east, 180 is south and 270 is west.  It is also possible to adjust the wind direction to 
any angle in between. 

WIND VELOCITY (MPH)- 
This setting adjusts the average winds that prevail over the entire simulation.  The 
velocity here is the speed of the wind approximately 6.5 feet (2 meters) above the 
terrain.  RealFlight G3.5’s wind gradient ensures that the wind below this level is 
slightly slower and that the wind at higher altitudes is faster. 

To adjust the wind velocity, click on the value indicated to the right of the Wind 
Velocity (MPH) name.  Next, input a numerical value between 0 and 50, using either 
your keyboard or the mouse wheel.  This will be the wind speed in MPH. 

You may also increase/decrease the wind velocity in smaller increments by pressing 
the Page Up/Page Down keys on the keyboard. 
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WIND VARIATION (%)- 
This adjustment represents the variation in the wind speed and direction in 
correlation to the average speed.  Just as the winds that you experience at the local 
field are not constant, neither are the winds in RealFlight. 

To adjust this variable, click on the value indicated to the right of the Wind Variation 
(%).  Using either your keyboard or the mouse wheel input a numerical value 
between 0 (unchanging) and 200.  A higher value produces more dramatic changes 
in the wind. 

WIND GUST (%)- 
This value represents the change of the wind speed and direction corresponding to a 
proportion of the wind speed it calculates in one second. 

To adjust this variable, click on the value indicated to the right of the Wind Gust 
(%).  Using either your keyboard or the mouse wheel input a numerical value 
between 0 (no changes) and 100 (large changes). 

Thermal System- 
Use the parameters in this section to adjust the various settings and parameters for 
G3.5’s thermal winds. 

 
Thermals are rising air currents used by sailplane pilots to enable their aircraft to 
gain altitude.  The thermals allow the aircraft to stay aloft much, much longer than 
would otherwise be possible. 

THERMAL PATTERN SPEED RATIO (%)- 
This option allows you to adjust the speed with which the pattern of the thermal 
traverses the terrain.  This is expressed as a percentage of the Global Wind speed 
discussed previously. 

It is important to note that thermals generally move faster than the wind speeds at the 
surface, yet slower than the wind speeds encountered above ground.  To allow the 
thermal to remain in one location, adjust the Thermal Pattern Speed Ratio (%) to 0%.  
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A value of approximately 50% represents the typical thermal movement across a 
given area. 

To modify this option, click on the value found to the right of the Thermal Pattern 
Speed Ratio (%).  The desired values may be input directly from the keyboard or 
modified using the mouse wheel. 

THERMAL STRENGTH PROPORTION (%)- 
This setting indicates the strength of the thermals at the respective location.  If the 
Value is set at 0%, you will not encounter any thermal activity.  If this value is set to 
100%, you will experience the full strength of a thermal. 

Click on the value indicated to the right of the Thermal Strength Proportion (%) to 
adjust the percentages.  The desired values may be input directly from the keyboard 
or modified using the mouse wheel. 

SINK STRENGTH PROPORTION (%)- 
This setting indicates the rate of the sink between thermals.  In these regions, the 
aircraft will lose altitude during flight due to a lull in the thermal activity. 

Click on the value indicated to the right of the Sink Strength Proportion (%) to adjust 
the percentages.  The desired values may be input directly from the keyboard or 
modified using the mouse wheel.  Full normal sink strength is represented by a value 
of 100%. 

CYCLONIC STRENGTH PROPORTION (%)- 
This option allows you to adjust the cyclonic strength (rotation) of the thermal 
activity.  A value of 0% indicates that the thermal will go straight up.  As this 
percentage increases, however, the helical (rotational) airflow will become more 
noticeable. 

Click the value indicated to the right of the Cyclonic Strength Proportion (%) to 
adjust the percentages.  The desired values may be input directly from the keyboard 
or modified using the mouse wheel. 

CONVECTIVE LAYER HEIGHT- 
The convective layer indicates the upper most height at which the thermal stops 
offering lift to the aircraft.  Prior to reaching this limit, the current begins to diffuse 
and will therefore slow the rate of climb of the aircraft within this thermal. 

Click the value indicated to the right of the Convective Layer Height to adjust the 
percentages.  The desired values may be input directly from the keyboard or 
modified using the mouse wheel. 

Turbulence System- 
RealFlight’s wind model is so authentic that it even recreates the turbulence which 
your aircraft will experience when out at the field. 
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TURBULENT LAYER HEIGHT- 
Use this setting to mimic the turbulence level at your local flying site.  This setting 
represents the maximum height above the ground at which your aircraft will 
experience the effects of G3.5’s turbulent winds. 

To adjust the Turbulent Layer Height settings, click on the value indicated in the 
column to the right of this respective option.  The desired values may be input 
directly from the keyboard or modified using the mouse wheel. 

TURBULENCE STRENGTH PROPORTION (%)- 
This option allows you to adjust the strength of the medium-level turbulence.  Since 
this setting represents a median, some turbulence will be more severe than this, and 
some turbulence will be less noticeable. 

To adjust the Turbulence Strength Proportion (%) settings, click on the value 
indicated in the column to the right of this respective option.  The desired values may 
be input directly from the keyboard or modified using the mouse wheel.  A value of 
0% indicates that there will not be any mid-level turbulence. 

MICRO-TURBULENCE STRENGTH PROPORTION (%)- 
This option allows you to adjust the strength of the lower level turbulence.  Some 
turbulence will be more severe.  This is the lowest level of turbulence that you will 
experience, however. 

To adjust the Micro-Turbulence Strength Proportion (%) settings, click on the value 
indicated in the column to the right of this respective option.  The desired values may 
be input directly from the keyboard or modified using the mouse wheel.  A value of 
0% indicates that no micro-turbulence will occur. 

Weather- 
The settings contained within this option allow you to adjust the existence and/or 
distance at which the haze occurs in your simulation. 
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HAZE DISTANCE- 
This option allows you to adjust the distance from the pilot position at which the 
haze begins.  A higher value means that the haze begins further away from the pilot’s 
position. 

To adjust the Haze Distance, click the value column on the right.  The desired values 
may be input directly from the keyboard or modified using the mouse wheel. 

HAZE ENABLED- 
This adjustment determines whether the haze option is active. 

To determine whether or not the Haze is enabled, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or the mouse, 
select either Yes (Haze enabled) or No (Haze disabled) from the pull-down listings. 
If using the up/down arrow keys, press Enter to finalize your selection. 

 

 

 

 
 

 

 

EEXXIITT  
Use this menu item to exit the program entirely. 
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AAIIRRPPOORRTT  MMRRUU  
If you have previously selected an alternative flying location, or locations, you will 
note that it will appear on a list in the Simulation menu.  This list is at the very 
bottom of the menu and is commonly referred to as a Most Recently Used, or MRU 
list.  It is limited to the eight most recently selected locations.  If you wish to fly at 
one of these locations simply click on the respective location and it will begin 
loading. 
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CCHHAAPPTTEERR  77..    TTHHEE  AAIIRRCCRRAAFFTT  MMEENNUU  

AAIIRRCCRRAAFFTT  MMEENNUU  OOVVEERRVVIIEEWW  
This menu accesses a variety of aircraft-related features, functions and options.  
Clicking the Aircraft menu brings forth a pull-down menu similar to the following 
screen shot. 

 

The menu items in this menu are: 

• Select Aircraft… 

• Edit Current Aircraft… 

• Select Color Scheme 

• Save Color Scheme As… 

• Remember Aircraft Position 

• Clear Aircraft Position 
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• Reset Position 

• Kill Engine 

• Aircraft MRU 
The following sections describe the function or purpose of each of these menu items. 

AAIIRRCCRRAAFFTT  SSEELLEECCTTIIOONN……  
When you click on Select Aircraft… the following dialog appears: 

 

This dialog allows you to select the aircraft that you wish to fly. 

The list on the left of the dialog box displays all of the aircraft available to you.  If 
you have created any customized aircraft, they will also appear in this list. 

By default, the aircraft are listed in files and directories in accordance with the 
software from which they were loaded.  If, for example, you have installed Add-Ons 
2, the aircraft from this disk will be listed, alphabetically, beneath the Add-Ons 2 
directory. 

Click the [+] (plus) or [-] (minus) symbol to reveal or hide the aircraft within these 
directories and folders. 

AIRCRAFT SELECTION 
Every aircraft has its own unique flying characteristics, special features and 
functions.  To view an aircraft from the listings, simply use the mouse to click on the 
aircraft name.  Alternatively, use the up/down keys on the keyboard to scroll through 
the list, one aircraft at a time. 

The first time an aircraft is selected, G3.5 must create a collision mesh for the 
aircraft.  This process may take a few seconds to complete.  A progress bar will 
appear while the collision mesh is being calculated. 
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Click the [+] (plus) symbol to reveal the aircraft contained within the folder.  Using 
either the up/down arrow keys on the keyboard or the mouse, select the desired 
aircraft from the listings.  If utilizing the up/down arrow keys, click OK to finalize 
your selection.  Alternatively, if using the mouse, double-click on the aircraft to load 
it. 

AIRCRAFT PREVIEW  
The rotating image on the right side of the page allows you to preview the aircraft 
you have tentatively selected.  You can manipulate this preview for a better look at 
your aircraft. 

  
Drag the Image- To position the image to the desired viewing location, mouse click 
and hold.  Using the mouse, drag the image in the direction you wish. 

Resize the Image- To resize the image use the mouse wheel.  To zoom in, rotate the 
wheel towards you.  To zoom out, rotate the wheel away from you. 

Restart the Image Rotation- To restart the aircraft rotation preview, right click in 
the preview box. 

DESCRIPTION/SPECIFICATIONS 
The pane below the Aircraft Preview box shows either the aircraft description or 
aircraft specifications.  This box provides you with a brief history of the aircraft (if 
applicable) and serves to provide you with specific information pertaining to the 
model selected. 

Using the mouse, select either the Description or Specifications tab. 

GROUPING 
This list controls how the dialog organizes the list of available aircraft.  By default, 
the aircraft are sorted by Product.  Here is an explanation of the different sorting 
methods: 

Product, Airframe: Aircraft are grouped first by which product they are found in 
(all custom aircraft will be in the “Custom Aircraft” folder).  Within each product, 
the aircraft are further grouped by airframe.  For example, “NextSTAR” and 
“NextSTAR with AFS” are both found in the NexSTAR airframe folder.   

Product: Aircraft are grouped by product alone.   

Airframe: Aircraft are grouped by airframe, not by product.  Individual aircraft are 
grouped inside each airframe folder. 

None: There is no grouping at all.  All aircraft are sorted alphabetically. 
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COLOR SCHEME 
If applicable, this list contains the alternative trim schemes for the selected model.  If 
the Color Scheme dialog is grayed out, there are no alternative trim schemes 
available for this particular aircraft. 

If the list control is active, click on the down arrow to reveal the alternate trim 
scheme(s).  To select an alternate trim scheme, use either the up/down arrow keys on 
the keyboard or select one with the mouse.  When an alternative trim scheme is 
selected, this scheme will appear immediately in the ReadySelect preview box, 
replacing the previous trim scheme. 

Additionally, modelers may create their own trim schemes in RealFlight using a 
third-party bitmap editor capable of manipulating Targa (*.tga) files.  Please see the 
section titled “Save Color Scheme As….”. 

 

EEDDIITT  CCUURRRREENNTT  AAIIRRCCRRAAFFTT……  AAIIRRPPLLAANNEE  
RealFlight G3.5 offers the user unparalleled freedom to edit or modify their aircraft.  
It’s possible to add and remove components, alter their location, change airfoils and 
much, much more!  The first several times that you access the aircraft editor, the task 
might seem daunting.  It may require some getting used to before you are 
comfortable with this feature and its related functions.  The best way to do so is to 
simply dive in and experiment. 

To modify the currently selected aircraft, click the Aircraft menu followed by the 
Edit Current Aircraft menu item.  This brings up the Aircraft Editor dialog, which 
will allow you to modify any of the hundreds of parameters for the currently selected 
aircraft. 

 
The Aircraft Editor dialog will have an appearance similar to the picture shown 
below.  It may deviate slightly depending upon the type of aircraft that you are 
editing (i.e., biplane, electric model, etc.).  However, all aircraft are edited in a 
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similar manner.  As such, this section presents you with the general information 
necessary to edit any aircraft found in G3.5. 

 

AIRCRAFT EDITOR MENUS 
Selecting the Edit Current Aircraft option activates the screen shown above.  The 
Aircraft Editor dialog has four menu options: 

• File 

• Edit 

• Options 

• View 

FILE MENU- 
This menu and its menu items are used to manipulate and control the various folders 
and related items in the aircraft editor. 

OPEN…- 
This menu item is used to open existing and edited aircraft.  Selecting this menu item 
opens the Select Aircraft dialog.  To select an aircraft from this list, follow the 
procedure described in the Aircraft Selection section of this manual. 
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SAVE- 
This option becomes active once you have renamed and saved the edited aircraft.  
Prior to doing so this option will remain inactive or grayed out.  This allows you to 
make further modifications to the aircraft without renaming it each time. 

SAVE AS…- 
Upon completion of the aircraft editing, click this menu item to rename and save the 
modifications.  You will be asked to create a name for this new aircraft.  After you 
have renamed the aircraft, click OK to accept the new name.  Afterwards, the aircraft 
will appear in the aircraft listings found in the Select Aircraft… in the Aircraft 
menu. 

REVERT- 
This menu item allows you to revert, or go back to the settings the last time that the 
aircraft was saved.  If you have not previously saved the aircraft, the aircraft will 
return to the default settings. 

To use this menu item, open the File menu and click Revert.  This will bring forth 
the verification dialog. 

Click Yes if you wish to return to the last saved version of this model.  Please note: 
any modifications performed after the last time that this model was saved will be 
lost.  Clicking No will allow you to save the modifications or continue refining the 
aircraft. 

EXIT- 
This menu item returns you to the simulation.  If you have performed any 
modifications to the aircraft and have not saved these modifications, a verification 
dialog will appear.  Choose Yes to save the modifications.  If you those No, the 
modifications will be lost.  Selecting Cancel will return you to the editing dialog. 
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EDIT MENU- 
As is suggested by the name, this menu is utilized to edit the aircraft.  The available 
options depend upon which item or folder is highlighted in the directory.  If you have 
not highlighted an item or folder, the Edit menu will remain grayed out or inactive. 

For example, if the aircraft name is highlighted and the Edit menu is selected, there 
will not be any actions available to you.  If the airframe is highlighted, the aircraft 
editor will allow you to add various components to the airframe. 

 
Alternatively, if you wish to either add or remove an item from one of the aircraft 
components, right click on the respective component.  This will bring forth the 
available options. 

OPTIONS MENU- 
This menu provides you with a number of choices, or options, available to you for 
use in the aircraft editor. 

Selecting the Options menu brings forth the drop-down menu items discussed below: 
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PLAY ENGINE SOUNDS- 
Selecting this menu item plays the respective engine sounds during the editing of this 
aircraft.  Please note:  this setting is only temporary.  That is, this setting is not 
retained after you exit the aircraft editor. 

To select this option, click the Play Engine Sounds menu item.  This will place a 
check mark before the setting and return to the aircraft editor.  Additionally, the 
engine sounds will become audible. 

Additionally, you may also press the P key on the keyboard to enable or disable the 
engine sounds. 

DISPLAY ADVANCED PROPERTIES- 
This option displays advanced properties for the components in the airframe.  Using 
the advanced properties you may tune the physics calculations performed by 
RealFlight, in order to adjust the flight performance to your liking.  When this option 
is checked, additional component properties will be displayed in the property listing 
area of the aircraft editor dialog.  These properties are marked as “Advanced” in the 
following sections. 

Additionally, you may also press the D key on the keyboard to display or eliminate 
the advanced properties from the dialog. 

UNITS- 
This option toggles the units of measure between metric and SAE units.  It is 
important to note that modifying this option affects all measurements in the 
simulation.  For example, changing from SAE to metric in the editor also affects the 
airport editor dialogs. 

To modify this option, click the Display Metric Units setting.  Then select the unit 
of measurements you would prefer from the drop down menu.  The options are 
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English or Metric.  A check mark will appear next to the unit that is currently 
displayed. 

Alternatively, you can press the U key on the keyboard to switch between the 
different units of measurement. 

RELOAD COLOR SCHEME- 
This option allows you to view the results of an edited trim scheme. 

There are two ways that you can do so.  The first is to use the Select Color Scheme 
menu, which is found within the Aircraft menu.  Simply click on the color scheme 
that you have just edited, and RealFlight will reload the color scheme onto your 
aircraft and reset the aircraft back on the runway. 

Alternatively, within the aircraft editor click on the Options menu item.  Select 
Reload Color Scheme.  Clicking this reloads the color scheme, showing any 
changes you have made to the aircraft.  To improve visibility of the trim scheme, you 
may wish to remove the wire frame from the preview.  To do so, please follow the 
procedure noted in the description for “Show Wire frame.” 

You can also press the R key on the keyboard to reload the color scheme. 

 

VIEW MENU- 

LOOK AT- 
This option allows you to determine the view of the aircraft being edited.  There are 
three options that are available from this menu. 

 
 

Aircraft Center- Check this option if you wish to keep the entire aircraft centered in 
the view. 
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Component Center- Check this option to center the view around the component you 
are editing.  For example, if you are modifying the rudder, the aircraft will shift so 
the rudder appears in the center on the preview area. 

Component Origin- Checking this option will focus the view on the root, or origin, 
of the component you are currently modifying.  For example, if you have the Main 
Gear selected, the preview area will be centered at the location the Main Gear is 
attached to the fuselage. 

To adjust the Look At perspective, click the Look At menu item and select the 
desired view.   

 
Alternatively, you may use the A key on the keyboard to toggle through the 
selections. 

LOOK FROM- 
When editing aircraft, you can click and drag the mouse in the preview area to rotate 
the aircraft to different angles.  This helps to better see components you might be 
modifying.   
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Alternatively, you can select from pre-select angles from the Look From menu item.  
They include: 

• Above – Look from above the aircraft.  Or press the Q key to quickly 
change to this view. 

• Below – Look from below the aircraft.  Or press the Shift-Q keys to quickly 
change to this view. 

• Right – Look from right side of the aircraft.  Or press the W key to quickly 
change to this view. 

• Left – Look from left side of the aircraft.  Or press the Shift-W keys to 
quickly change to this view. 

• Front – Look from the front of the aircraft.  Or press the E key to quickly 
change to this view. 

• Back – Look at the back of the aircraft.  Or press the Shift-E keys to 
quickly change to this view. 

SHOW WIRE FRAME- 
This option determines whether the aircraft displayed in the preview box is shown as 
a wire frame or is rendered complete with textures, etc.  The wire frame option is 
automatically selected by default. 

If you would prefer to view the fully rendered image, click the Show Wire frame 
option from the pull-down list.  This will eliminate the check mark from the setting 
and return to the aircraft editor.  Additionally, the preview aircraft window will show 
the rendered image of the aircraft. 

Alternatively, you may press the S key on the keyboard to display or eliminate the 
wire frame view. 

 



124  •  Chapter 7.  The Aircraft Menu R/C Simulator RealFlight 

AIRCRAFT ROOT DIRECTORY- 
The item that is highlighted in the far left column is the item for which the Name and 
corresponding value information is shown. 

With the aircraft name highlighted, the first dialog displays general information 
about the aircraft itself: 

DESCRIPTION-  
As the name suggests, this is the description of the aircraft.  When you edit an 
aircraft, we suggest that you modify the description.  This will assist you in keeping 
track of the modifications without having to return to the AccuModel editor to see 
what has changed. 

 
To alter the Description, click the text in the value box.  The default description box 
will appear.  Next, use the keyboard to input the new description as you see fit. 

LAUNCH METHOD- 
This setting determines the launch method for this aircraft.  There are two launch 
methods available - From Ground and Hand Launch. 

The From Ground launch means that the aircraft will takeoff from the ground.  Use 
this method for aircraft that have either skids or wheels on the undercarriage. 

The Hand Launch method means that the aircraft will launch from a virtual pilot’s 
hands.  If the aircraft does not have wheels or skids, select Hand Launch. 

To determine the launch methodology, click on the respective value.  Use either the 
mouse or the up/down arrow keys on the keyboard to select the desired launch 
procedure.  If using the up/down arrows, press the Enter button to finalize your 
selection. 
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POWER PLANT TYPE- 
The value here determines the type of power plant (propulsion system) used in the 
aircraft.  The selection in the value column also determines the parameters available 
for adjustment when referencing the power plant options. 

 
To change the Power Plant Type, click on the existing power plant in the value 
column.  From the drop-down menu, select the new power plant desired.  Your 
choices are: 

• Electric Motor - for electric-powered aircraft. 

• Internal Combustion Engine - for gasoline and nitro-methane 
powered aircraft. 

• Turbine Engine - for turbine-powered aircraft. 

• Turboprop Engine - for turboprop-powered aircraft. 

• Unpowered - for sailplanes and gliders. 

RADIO TYPE-  
This setting determines which radio connection to use in the simulation.  There are 
two Radio Type options that are available to you:  Software Radio and Pass Through. 
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To change the Radio Type, click on the existing Radio Type and select the desired 
radio from the drop-down list.  For more information pertaining to the differences 
between the Software Radio and Pass Through modes, please refer to the chapter 
pertaining to the Controller menu. 

VEHICLE GRAPHICAL SCALE (%) (ADVANCED)- 
This value represents the actual visual scale of the model and is used to scale the 
model up or down visually.  This has no effect on the physics of the simulation. 

Note: the Visual Graphics Scale does NOT affect the flight characteristics of the 
model.  If you increase the size of an aircraft and would like to have it fly like the 
larger aircraft adjust the Vehicle Physics Scale to match. 

VEHICLE PHYSICS SCALE (%) (ADVANCED)- 
This value represents a scale factor applied to the physics components, in 
comparison to their original dimensions. 

Note: you are modifying the physics for the aircraft when you adjust this parameter, 
not the visual scale. 

To modify the Vehicle Physics Scale, click on the value in the value box.  If your 
personal aircraft flies ‘larger’, we suggest that you increase the Vehicle Physics 
Scale.  This will cause the aircraft to fly like a bigger aircraft.  The converse is also 
true. 

CURRENT GRAPHICAL WIDTH (READ ONLY)– 
This value represents the graphical width of your aircraft.  This value cannot be 
adjusted manually.  Instead, it corresponds to graphical changes in the wingspan. 
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CURRENT MASS WITH CHILDREN (WET) (READ ONLY)– 
This value represents the total overall weight of the aircraft when it is ready for 
takeoff.  This value cannot be adjusted manually. 

CURRENT PHYSICS WIDTH (READ ONLY)– 
This represents the width of your aircraft.  It is calculated based upon the Physics 
Dimension Scale.  This value cannot be adjusted manually.  It is controlled by 
changes to the length of the wings. 

WING LOADING (DRY) (READ ONLY)– 
This value represents the wing loading of your aircraft.  This value cannot be 
adjusted manually.  In SAE units, this is usually measured in oz/ft2. 

AIRFRAME- 
 

The airframe options modify the various aspects of the components that make up the 
model.  The airframe consists of the fuselage, the wing(s), and the vertical and 
horizontal tails. 

The airframe folder is preceded with a [+] (plus).  The [+] (plus) indicates that 
another expansion level is available to you.  To access the complete list of airframe 
items for a respective model, simply click the [+] (plus) or double-click the airframe 
name. 

CG ADJUSTMENT- 
RealFlight’s RealPhysics engine automatically calculates the Center of Gravity (CG) 
location based upon all of the components on the respective aircraft.  If, however, the 
CG of your aircraft is different, use the X, Y or Z-axis values to manually adjust the 
overall CG. 
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To adjust the X, Y or Z value, click on the value column next to CG Adjustment. 

The X value adjusts the CG left/right on the airframe, the Y value moves it fore/aft, 
and the Z value moves the CG up/down on the airframe.  The larger the number in 
the X value, the further to the right the CG moves.  A positive number in the Y 
column moves the CG towards the front of the aircraft.  To increase the height of the 
CG, insert a positive value in the Z column.  You may input desired values directly 
from the keyboard or modify them using the mouse wheel. 

MASS SCALING FACTOR (ADVANCED)- 
This advanced property adjusts aircraft response in certain flight load calculations.  It 
is particularly useful for large models and models with low wing loadings.  Engine 
torque is also affected by this property to avoid unintended side-effects in the power 
to weight ratio. 

Adding or Removing Airframe Items- 
To add or remove components on the airframe, right click on the existing 
component.  If you want to add another engine to your aircraft to create a twin, for 
example, right click on the fuselage directory and then select the Add Single Engine 
option when it appears.  To alter its location, adjust the physical location of the 
respective component.  AccuModel’s wire frame will indicate the location of the 
added item as you move it around. 

Alternatively, with the airframe highlighted, click the Edit menu.  This will bring 
forth the list of options available to you. 

 
You may add a variety of items to your airframe.  Item availability is based upon a 
number of factors such as aircraft design, power plant options, and directory 
selected.  If you right click on fuselage, for example, the options available to you 
will be different than if you had right clicked on the horizontal tail.  

You may use either of two methods to add items to the airframe:  Add Single Item 
or Add Symmetrical Item.  The Add Symmetrical Items selection adds two items 
to the aircraft.  These selections are useful when you want to add twin engines or 
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similar objects.  Rather than having to add and modify each one individually, 
RealFlight adds both engines simultaneously.  You are only required to modify one 
of them.  The other engine will mirror the modifications. 

ADD SINGLE ITEM SELECTIONS- 
Add Single Wing - Adds one additional wing to the aircraft. 

Add Single Fuselage - Adds one single fuselage to the aircraft. 

Add Single Engine - Adds one engine to the aircraft. 

Add Single Thruster - Adds one turbine unit to the fuselage. 

Add Single Movable Pod - Adds a movable object to the aircraft.  You can slave a 
servo to this object so that you can rotate a particular component.  As an example, 
you could add a movable pod between the fuselage and an engine, which would 
allow you to rotate the engine in flight. 

Add Single Gear - Adds one landing gear to your aircraft.  This would allow you to 
turn a bicycle-geared craft into a tricycle-geared airplane, for example. 

Add Lift Component - Adds one item that will serve to lift the airframe. 

Add Mass Component - Adds one object that serves to add mass to your aircraft.  
This replicates the effect of adding ballast to the model. 

ADD SYMMETRICAL ITEM SELECTIONS- 
Add Symmetrical Smoke Component- Adds a smoke component to the wing of the 
aircraft. 

Add Symmetrical Streamer Component- Adds a streamer component to the wing 
of the aircraft. 

Add Symmetrical Wing - Adds two wings; one to either side of the aircraft in 
identical locations. 

Add Symmetrical Fuselage - Adds an additional two fuselages; one on either side 
of the aircraft. 

Add Symmetrical Engine - Adds two additional engines; one on either side of the 
aircraft. 

Add Symmetrical Movable Pod - Adds two movable pods; one on either side of the 
aircraft.  

Add Symmetrical Gear - Adds a second set of landing gear; one on either side of 
the aircraft. 

Add Symmetrical Thruster - Adds two additional thrusters; one on either side of 
the aircraft. 

Add Smoke Component - Adds a smoke emitter to your aircraft. 

Add Control Surface - Adds a control surface such as an elevator, aileron, or flap to 
the aircraft. 

Add Spoiler - Adds spoilers to the aircraft. 

Delete Component - Used to remove or eliminate a component from your aircraft. 
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VERTICAL TAIL-  
To add or remove components on the vertical tail, right click on the existing 
component. 

AIRFOIL AT ROOT- 
This setting determines the airfoil utilized at the root.  The root is the section of the 
tail closest to the fuselage. 

To select an airfoil, click on the current airfoil selection and on the ellipsis (three 
dots) that appear.  This brings forth the list of options available to you.  Select an 
airfoil from this alphabetical list. 

Please note:  the airfoil will blend to the airfoil selected for the tip, assuming that a 
different airfoil is selected. 

AIRFOIL AT TIP- 
This setting determines which airfoil the vertical tail will utilize at the tip.  The tip of 
the tail is the section of the tail furthest from the fuselage. 

To select an airfoil, click on the current airfoil selection and on the ellipsis (three 
dots) that appear.  This brings forth the list of options available to you.  Select an 
airfoil from this alphabetical list. 

Please note:  the airfoil will blend to the airfoil selected for the root, assuming that a 
different airfoil is selected. 

CHORD AT ROOT- 
This option adjusts the chord of the vertical tail at the root. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the tail at the root. 

CHORD AT TIP- 
This option adjusts the chord of the vertical tail at the tip. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the tail at the tip. 

DIHEDRAL (DEG)- 
Use this option to adjust the dihedral of the vertical tail.  Dihedral (generally 
expressed in degrees) refers to the v-shaped bend in the vertical tail where it 
intersects the fuselage.  This value is usually set to 90 degrees for the vertical tail. 

To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the tail. 
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INCIDENCE AT ROOT (DEG)- 
This option adjusts the incidence of the vertical tail at the root where it meets the 
fuselage.  Incidence is the fixed AOA, or angle of attack when the aircraft is at 0° 
angle of attack. 

To adjust the incidence, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the incidence. 

LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the vertical tail as measured from the leading 
edge. 

To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° indicates 
that the tail features a straight leading edge.  A positive number indicates that the 
vertical tail will sweep backwards toward the tail.  A negative number causes the 
vertical tail to sweep forward toward the nose of the aircraft. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the vertical tail. 

To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  
Generally, the value for the vertical tail will be set to zero; washout is not necessary 
for this component. 

WEIGHT- 
This indicates the weight of the vertical tail. 

To adjust the weight of the panel, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

WING LENGTH- 
This value represents the length of the vertical tail. 
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To modify the length of the vertical tail, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the vertical tail. 

Clicking on the respective value column activates the pull-down menu for selecting 
the various Component Frames. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the wing.  RealFlight 
uses the selected airfoil and numerous sophisticated algorithms to automatically 
calculate the lift generated at various angles of attack.  It is not normally necessary to 
adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft, such as sailplanes, 
may need to have this value lowered.  Very draggy aircraft, such as a biplane with a 
radial engine, struts, and flying wires, may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%)(ADVANCED)- 
This value controls the strength or ability of the vertical tail to resist damage.  
Increasing this value increases the strength of the tail. 

To adjust the strength of the tail, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
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values increase the strength of the vertical tail, thus making it more resistant to 
damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of the vertical tail. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the vertical tail. 

Rudder- 
To remove the rudder from the aircraft, right click on the Rudder directory.  Select 
the Delete Control Surface option that appears. 

DEFLECTION CENTERED (DEG)- 
This value determines the degree of deflection of the rudder when it is centered.  In 
most cases you will set this value to zero. 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

DEFLECTION MAXIMUM (DEG)- 
This setting adjusts the travel of the rudder to the left.  Please note:  this value is 
expressed in degrees.  Higher values mean that the travel of the rudder to the left will 
increase. 

To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DEFLECTION MINIMUM (DEG)- 
This setting adjusts the travel of the rudder to the right.  Please note:  this value is 
expressed in degrees.  Higher negative values mean that the travel of the rudder to 
the right will increase. 

To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE TO TIP- 
This value determines the distance from the end of the rudder to the tip of the wing 
in which it is situated (usually a vertical tail). 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A value of 
zero indicates that the rudder extends completely to the tip of the vertical tail.  A 
value that is greater than zero indicates that the rudder ends before the tip of the 
vertical tail. 

LENGTH- 
This value represents the length of the rudder. 

To modify the length of the rudder, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 
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PERCENT OF CHORD AT ROOT (%)- 
This value determines the percent of vertical tail chord that the rudder occupies at the 
closest position to the fuselage. 

To modify the percentage of chord that the rudder accounts for, click the existing 
value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel. 

PERCENT OF CHORD AT TIP (%)- 
This value determines the percent of wing chord that the rudder occupies at the tip of 
the vertical tail. 

To modify the percentage of chord that the rudder accounts for, click the existing 
value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel. 

SERVO- 
This option determines which servo controls the rudder for the aircraft. 

To select the servo, click the value box.  This will bring forth the drop-down menu.  
Click on one of the options in the pull-down menu or use the up/down arrow keys on 
the keyboard.  If using the up/down arrows, press the Enter button to finalize your 
selection. 

SERVO REVERSE- 
Once you have selected a servo to control the rudder, this option allows you to 
dictate whether to reverse the output of the rudder servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the rudder. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

CURRENT DEFLECTION (DEG) (READ ONLY) – 
This value indicates the current degree of deflection of the rudder.  A positive value 
indicates that the rudder is deflected to the left, so the aircraft will tend to turn to the 
left. 

It is not possible to manually adjust this value within the editor.  This value is 
controlled by the various modifications made to the elevator.  However, you can use 
the trim controls on the InterLink Plus controller to make minor adjustments to this 
value. 

HORIZONTAL TAIL- 
To add or remove components on the horizontal tail, right click on the existing 
component. 
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AIRFOIL AT ROOT- 
This setting determines which airfoil to utilize at the root of the horizontal tail.  The 
root is (usually) the section of the horizontal tail closest to the fuselage.  RealFlight 
includes over 1,500 different airfoils from which to choose.  This data adds to the 
real-world authenticity of the simulation. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will automatically blend along the length of the surface. 

AIRFOIL AT TIP- 
This setting determines which airfoil to use at the tip of the horizontal tail.  The tip of 
the horizontal tail is the section of the wing furthest from the fuselage. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the root is different from the airfoil at the tip, the two 
airfoils will blend along the length of the surface. 

CHORD AT ROOT- 
This option adjusts the chord of the root of the horizontal tail.  Chord is defined as 
the width of the surface; the root of the horizontal tail is the section closest to the 
fuselage.  A wider chord offers increased lift.  However, a wider chord also generates 
more drag when the aircraft rolls. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the wing. 

CHORD AT TIP- 
This option adjusts the chord of the horizontal tail at the tip.  The tip of the 
horizontal tail is the section furthest from the fuselage. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the wing. 

DIHEDRAL (DEG)- 
This option adjusts the dihedral of the horizontal tail.  Dihedral is generally 
expressed in degrees.  It refers to the v-shaped bend in the wing when viewed from 
the front of the plane.  Increased dihedral usually offers better aerodynamic stability, 
yet decreases the aerobatic ability of the aircraft as a result. 

To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the wing. 
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INCIDENCE AT ROOT (DEG)- 
Adjust the incidence of the horizontal tail at the root where it meets the fuselage 
using this option.  Incidence is the fixed AOA, or angle of attack when the aircraft is 
at 0° angle of attack.  

To adjust the incidence, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the incidence. 

LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the horizontal tail as measured from the leading 
edge. 

To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° corresponds 
to a wing with a straight leading edge.  As the leading edge sweep increases in value, 
the wing sweeps, or angles back towards the tail.  A negative value for the leading 
edge sweep will cause the horizontal tail to sweep forward towards the nose of the 
aircraft. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the wing.  Washout 
is an intentional twist induced into the wing, which causes the tips to offer a lower 
angle of attack.  This helps to prevent the aircraft from tip-stalling. 

To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the amount of washout. 

WEIGHT- 
This indicates the weight of one of the wing panels. 

To adjust the weight of the horizontal tail panel, click the existing value in the value 
box.  Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 
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WING LENGTH- 
This value represents the length of one of the horizontal tail panels. 

To modify the length of the horizontal tail panel, click the existing value in the value 
box.  Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

BREAK OFF TOGETHER (ADVANCED)- 
This option determines whether the horizontal tails will break off together, or 
individually, when an in-flight failure occurs. 

If you would like the wings to break off together, select Yes.  If not, please select 
No.  To make your selection, click the respective value box.  Select either Yes or No 
from the pull-down menu. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item. 

Clicking on the respective Value column will bring forth the pull-down menu 
selection of the various Component Frames. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the horizontal tail.  
RealFlight uses the selected airfoil and numerous sophisticated algorithms to 
automatically calculate the lift generated at various angles of attack.  It is not 
normally necessary to adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft, such as sailplanes, 
may need to have this value lowered.  Very draggy aircraft, such as a biplane with a 
radial engine, struts, and flying wires, may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 
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STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value indicates the strength or ability of the horizontal tail to resist damage.  
Increasing this value increases the strength of the wing. 

To adjust the strength of the wing, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the wings, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of one horizontal tail panel. 

You may not manually adjust this value.  This value is controlled by the various 
modifications made to the wings. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY) – 
This value represents the combined mass of both horizontal tail panels. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the wings. 

Elevator- 
To eliminate the elevator from the aircraft, right click on the elevator folder.  Next, 
select the Delete Control Surface option that appears. 

DEFLECTION CENTERED (DEG)- 
This value determines the degree of deflection of the elevator when it is centered.  In 
general, you should set this value to zero.  In some cases, you may want to set a non-
zero value for trim control. 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

DEFLECTION MAXIMUM (DEG)- 
This setting sets a limit on the upward travel of the elevator.  Please note:  this value 
is expressed in degrees.  Higher values mean that the upward travel of the elevator 
will increase as well. 

To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 
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DEFLECTION MINIMUM (DEG)- 
This setting adjusts the downward travel of the elevator.  Please note:  this value is 
expressed in degrees.  Higher negative values mean that the downward travel of the 
elevator will increase as well. 

To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE TO TIP- 
This value determines the distance from the end of the elevator to the tip of the wing 
in which it is situated. 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A value of 
zero indicates that the aileron extends completely to the end of the wing.  A non-zero 
value indicates that the aileron does not extend to the wing tip. 

LENGTH- 
This value represents the length of one of the elevator halves. 

To modify the length of the elevator, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

PERCENT OF CHORD AT ROOT (%)- 
This value determines the percent of wing chord that the elevator occupies at the 
closest position to the fuselage. 

To modify the percentage of chord that the elevator occupies, click the existing value 
in the value box.  Next, enter the desired value either directly from the keyboard or 
via the mouse wheel. 

PERCENT OF CHORD AT TIP (%)- 
This value determines the percent of wing chord that the elevator occupies at the 
wing tip. 

To modify the percentage of chord that the elevator accounts for, click the existing 
value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel. 

SERVO (LEFT)- 
This dialog indicates which servo controls the left elevator half for the aircraft. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SERVO (RIGHT)- 
This option determines which servo controls the right elevator half for the aircraft. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
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mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SERVO REVERSE (LEFT)- 
Once you have selected a servo to control the left elevator, this setting dictates 
whether to reverse the output of the respective servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

SERVO REVERSE (RIGHT)- 
Once you have selected a servo to control the right elevator, this option dictates 
whether to reverse the output of the elevator servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the left elevator. 

Clicking on the respective value column will bring up the pull-down menu selection 
of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the right 
elevator. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

CURRENT DEFLECTION MASTER (DEG) (READ ONLY) – 
This value indicates the current degree of deflection for the right elevator half.  A 
positive value here means that the aircraft will tend to climb. 

You may not manually adjust this value.  The various modifications made to the 
elevator determine this value. 

CURRENT DEFLECTION SLAVE (DEG) (READ ONLY) – 
This value indicates the current degree of deflection for the left elevator half.  A 
positive value here means that the aircraft will tend to climb. 

You may not manually adjust this value.  The various modifications made to the 
elevator determine this value. 

MAIN WING- 
To add or remove components relating to the Main Wing, right click on the existing 
component.  If you want to add another engine to your aircraft to create a twin, for 
example, right click on the fuselage directory and then select the Add Single Engine 
option when it appears.  To alter its location, adjust the physical location of the 
respective component.  AccuModel’s wire frame will indicate the location of the 
added item as you move it around. 
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AIRFOIL AT ROOT- 
This setting determines which airfoil to utilize at the root of the wing.  The root is 
(usually) the section of the wing closest to the fuselage.  RealFlight includes over 
1,500 different airfoils from which to choose.  This data adds to the real-world 
authenticity of the simulation. 

 
To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

AIRFOIL AT TIP- 
This setting determines which airfoil to use at the wing tip.  The tip of the wing is the 
section of the wing furthest from the fuselage. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the root is different from the airfoil at the tip, the two 
airfoils will blend along the length of the surface. 

CHORD AT ROOT- 
This option adjusts the chord of the wing at the root.  Chord is defined as the width 
of the surface; the root of the wing is the section closest to the fuselage.  A wider 
chord offers increased lift.  However, a wider chord also generates more drag when 
the aircraft rolls. 
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To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the wing. 

CHORD AT TIP- 
This option adjusts the chord of the wing at the tip.  The tip of the wing is the section 
furthest from the fuselage. 

  
To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the wing. 

DIHEDRAL (DEG)- 
This option adjusts the dihedral of the wing.  Dihedral is generally expressed in 
degrees.  It refers to the v-shaped bend in the wing when viewed from the front of 
the plane.  Increased dihedral usually offers better aerodynamic stability, yet 
decreases the aerobatic ability of the aircraft as a result. 

  
To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the wing. 

INCIDENCE AT ROOT (DEG)- 
Adjust the incidence of the wing at the root where it meets the fuselage using this 
option.  Incidence is the fixed AOA, or angle of attack when the aircraft is at 0° 
angle of attack.  

To adjust the incidence, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the incidence. 
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LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the wing as measured from the leading edge. 

  
To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° corresponds 
to a wing with a straight leading edge.  As the leading edge sweep increases in value, 
the wing sweeps, or angles back towards the tail.  A negative value for the leading 
edge sweep will cause the wing to sweep forward towards the nose of the aircraft. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the wing.  Washout 
is an intentional twist induced into the wing, which causes the tips to offer a lower 
angle of attack.  This helps to prevent the aircraft from tip-stalling. 
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To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the amount of washout. 

WEIGHT- 
This indicates the weight of one of the wing panels. 

To adjust the weight of the wing panel, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

WING LENGTH- 
This value represents the length of one of the wing panels. 

  
To modify the length of the wing panel, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 
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BREAK OFF TOGETHER (ADVANCED)- 
This option determines whether the wings will break off together, or individually, 
when an in-flight failure occurs. 

If you would like the wings to break off together, select Yes.  If not, please select 
No.  To make your selection, click the respective value box.  Select either Yes or No 
from the pull-down menu. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the left wing half. 

Clicking on the respective Value column will bring forth the pull-down menu 
selection of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the right wing half. 

Clicking on the respective Value column will bring forth the pull-down menu 
selection of the various Component Frames. 

FIT TO FRAME (ADVANCED)- 
To automatically adjust the wing measurements to fit the graphical model, click the 
more options button (the gray folder with the ellipsis).  The aircraft editor will 
calculate the best fit to the model. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the wing.  RealFlight 
uses the selected airfoil and numerous sophisticated algorithms to automatically 
calculate the lift generated at various angles of attack.  It is not normally necessary to 
adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft, such as sailplanes, 
may need to have this value lowered.  Very draggy aircraft, such as a biplane with a 
radial engine, struts, and flying wires, may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 
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SNAP ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%)(ADVANCED)- 
This value indicates the strength or ability of the wing to resist damage.  Increasing 
this value increases the strength of the wing. 

To adjust the strength of the wing, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the wings, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of one wing panel. 

You may not manually adjust this value.  This value is controlled by the various 
modifications made to the wings. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY) – 
This value represents the combined mass of both wing panels. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the wings. 

Aileron- 
To eliminate the ailerons from the wing, right click on the aileron directory.  Next, 
select the Delete Control Surface option that appears. 

DEFLECTION CENTERED (DEG)- 
This value determines the degree of deflection of the aileron when it is centered.  In 
general, you should set this value to zero.  In some cases, you may want to set a non-
zero value for trim control. 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

DEFLECTION MAXIMUM (DEG)- 
This setting sets a limit on the upward travel of the ailerons.  Please note:  this value 
is expressed in degrees.  Higher values mean that the upward travel of the ailerons 
will increase as well. 
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To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DEFLECTION MINIMUM (DEG)- 
This setting adjusts the downward travel of the ailerons.  Please note:  this value is 
expressed in degrees.  Higher negative values mean that the downward travel of the 
ailerons will increase as well. 

To modify this setting, click the respective value box.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE TO TIP- 
This value determines the distance from the end of the aileron to the tip of the wing 
in which it is situated. 

To modify this value, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A value of 
zero indicates that the aileron extends completely to the end of the wing.  A non-zero 
value indicates that the aileron does not extend to the wing tip. 

LENGTH- 
This value represents the length of one of the ailerons. 

To modify the length of the aileron, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

PERCENT OF CHORD AT ROOT (%)- 
This value determines the percent of wing chord that the aileron occupies at the 
closest position to the fuselage. 

To modify the percentage of chord that the ailerons account for, click the existing 
value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel. 

PERCENT OF CHORD AT TIP (%)- 
This value determines the percent of wing chord that the aileron occupies at the wing 
tip. 

To modify the percentage of chord that the ailerons account for, click the existing 
value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel. 

SERVO (LEFT)- 
This dialog indicates which servo controls the left aileron for the aircraft. 
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To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SERVO (RIGHT)- 
This option determines which servo controls the right aileron for the aircraft. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SERVO REVERSE (LEFT)- 
Once you have selected a servo to control the left aileron, this setting dictates 
whether to reverse the output of the aileron servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

SERVO REVERSE (RIGHT)- 
Once you have selected a servo to control the right aileron, this option dictates 
whether to reverse the output of the aileron servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the left aileron. 
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Clicking on the respective value column will bring up the pull-down menu selection 
of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the right aileron. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

CURRENT DEFLECTION MASTER (DEG) (READ ONLY) – 
This value indicates the current degree of deflection for the right aileron.  A positive 
value here indicates that the aircraft is performing a right turn.  In this case, the right 
aileron is up and the left aileron is down. 

You may not manually adjust this value.  The various modifications made to the 
ailerons determine this value. 

CURRENT DEFLECTION SLAVE (DEG) (READ ONLY) – 
This value indicates the current degree of deflection of the left aileron.  A positive 
value here indicates that the aircraft is performing a left turn.  In this case, the left 
aileron is up and the right aileron is down. 

It is not possible to manually adjust this value.  The various modifications made to 
the ailerons determine this value. 

MAIN FUEL TANK-  
To modify the various items associated with this item, select the Main Fuel Tank 
folder. 
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FUEL TANK SIZE- 
This parameter indicates the capacity of the fuel tank. 

To modify the fuel tank capacity, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

LENGTH– 
This value represents the length of the fuel tank.  Note that adjusting this value will 
affect the CG of the aircraft. 

To modify the length of the tank, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT– 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value represents the weight of the fuel tank.  Please note:  this weight does not 
include the fuel.  Rather it is the weight of the fuel tank only. 

To modify the weight of the tank, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

WIDTH– 
This value represents the width of the fuel tank. 

To modify the width of the tank, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)– 
This value represents the mass of the fuel tank.  It does not include the weight of the 
fuel. 

You may not manually adjust this value.  The various modifications made to the 
weight control this value. 

FUSELAGE DIRECTORY-  
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The Fuselage menu items contain the various items related to, or situated on, the 
fuselage.  You can make a number of modifications to the fuselage itself.  They are 
as follows: 

 

DIMENSIONS– 
This value represents the height, length and width of the fuselage.  It does not 
include the landing gear or vertical tail in the calculations. 

To modify the Dimensions, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT– 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value represents the weight of the fuselage itself.  It does not include the 
children (engine, gear, etc.). 
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To modify the weight, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

AIRFOIL (SIDES) (ADVANCED)- 
This setting determines which airfoil to use at the side of the fuselage.  Changing this 
parameter will affect how the aircraft flies in 3D maneuvers. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils from which to select. 

AIRFOIL (TOP/BOTTOM) (ADVANCED)- 
This setting determines which airfoil to use at the top and bottom of the fuselage.  
Changing this parameter will affect how the aircraft flies in 3D maneuvers. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame (graphical object) of the item. 

Clicking on the respective value column brings forth the pull-down menu selection 
of the various Component Frames. 

FRONTAL DRAG (%) (ADVANCED) –  
This value represents the frontal drag percentage.  A lower frontal drag is 
representative of a very sleek, aerobatic aircraft.  A larger frontal drag percentage 
causes the aircraft to slow more rapidly and decreases the top end speed.  Based on 
the given measurements, G3.5 attempts to compute an appropriate frontal drag for 
your aircraft.  However, if your aircraft flies differently than the simulated model, 
increase or decrease the frontal drag as necessary to achieve a closer match. 

To modify the Frontal Drag (%), click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

FUSELAGE AERODYNAMICS PERCENT (%)(ADVANCED) – 
This value represents the amount that the wind affects the fuselage. 

To modify the Fuselage Aerodynamics Percent (%), click the existing value in the 
value box.  Next, enter the desired value either directly from the keyboard or via the 
mouse wheel. 

FUSELAGE LIFT LOCATION (%)(ADVANCED)– 
The value here represents the center of lift for the fuselage. 

To modify the Fuselage Lift Location (%), click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel.  If the fuselage on your aircraft lifts behind this point, enter a number less 
than 100%. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  153 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
fuselage component.  RealFlight normally calculates this value based on the 
dimensions and overall shape of the fuselage.  You may adjust RealFlight’s 
calculation to better match your expectations for the aircraft.  Some very sleek 
aircraft, such as sailplanes, may need to have this value lowered.  Very draggy 
aircraft, such as a biplane with a radial engine, struts, and flying wires, may perform 
more realistically when this value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (ADVANCED)- 
This value represents the strength or structural integrity of the fuselage.  If, for 
example, you wish to make the fuselage more susceptible to breakage, reduce the 
value of the strength multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

WETTED SCALE FACTOR (ADVANCED)- 
These advanced properties adjust the amount of lift produced by the fuselage in a 
given dimension.  RealFlight automatically calculates a value based on the fuselage 
shape, but sometimes it is helpful to adjust this value in order to produce desired 
results. 

CURRENT MASS OF SELF (READ ONLY)– 
This value represents the mass of the object.  It does not include the children - 
engine, gear, etc. 

You may not manually adjust this value.  The various modifications made to the 
fuselage control this value. 
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CURRENT MASS WITH CHILDREN (READ ONLY)– 
This value is the overall mass of the fuselage, including any child components. 

You may not manually adjust this value.  The various modifications made to the 
fuselage control this value. 

STEERING GEAR- 
To add a smoke component, add a single wheel or to delete the gear from the 
aircraft, right click on the Gear directory.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired option.  If using the arrow keys, press 
Enter to finalize your selection. 

LANDING GEAR LENGTH- 
This setting determines the length of the landing gear itself.  It does not include the 
wheel. 

To change the length of the landing gear, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

MAX STEERING ANGLE (DEG)- 
This value determines the maximum angular travel values for the nose wheel. 

To modify the steering angle (throw) of the nose gear, click the existing value in the 
value box.  Next, enter the desired value either directly from the keyboard or via the 
mouse wheel.  Larger values allow the wheel to travel further.  Lower values limit 
the amount of control throw. 

RETRACT SERVO- 
This drop down list indicates which servo (if any) controls the retractable landing 
gear. 

To select the servo, click the value box.  This will bring forth the drop-down menu.  
Mouse click on one of the options in the drop-down menu or use the up/down arrow 
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keys on the keyboard.  If using the up/down arrows, press the Enter button to 
finalize your selection. 

RETRACT SERVO REVERSE- 
Once you have selected a servo to control the retractable landing gear, this setting 
allows you to dictate whether to reverse the output of the retract servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

ROTATION ABOUT X (GEAR DOWN) (DEG)- 
This value indicates the degree of rotation around the X-axis when the gear is in the 
down position. 

To adjust the rotational degree about the X-axis when the gear deploys, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
towards the front of the fuselage when it deploys. 

ROTATION ABOUT X (GEAR UP) (DEG)- 
This value indicates the degree of rotation around the X-axis when the gear is in the 
up position. 

To adjust the rotational degree about the X-axis when the gear retracts, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
towards the front of the fuselage when it retracts. 

ROTATION ABOUT Y (GEAR DOWN) (DEG)- 
This value indicates the degree of rotation around the Y-axis when the gear is in the 
down position. 

To adjust the rotational degree about the Y-axis when the gear is deployed, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
outwards, towards the left wing tip.  A negative value will cause the gear to sweep 
towards the right wing tip. 

ROTATION ABOUT Y (GEAR UP) (DEG)- 
This value indicates the degree of rotation around the Y-axis when the gear is in the 
up position. 

To adjust the rotational degree about the Y-axis when the gear retracts, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
outwards, towards the left wing tip.  Negative values will cause the gear to sweep 
towards the right wing tip. 

STEERING SERVO- 
This option determines which servo controls the steering for the aircraft. 
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To select the servo, click the value box.  This will bring forth the drop-down menu.  
Mouse click on one of the options in the drop-down menu or use the up/down arrow 
keys on the keyboard.  If using the up/down arrows, press the Enter button to 
finalize your selection. 

STEERING SERVO REVERSE- 
Once you have decided which servo will control the steering, this setting allows you 
to dictate whether or not to reverse the output of the steering servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

WEIGHT- 
This value indicates the weight of the gear itself.  It does not include the weight of 
the wheels. 

To adjust the weight of the landing gear, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the steering 
(nose) gear. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

LANDING GEAR TYPE (ADVANCED)- 
This option selects the type of landing gear for your aircraft.  Each landing gear type 
offers unique characteristics relative to the materials utilized. 

To select the type of landing gear utilized on your model, click the value for this 
item.  This will bring forth the pull-down menu selections for the various materials.  
Select the desired type from the list. 

STIFFNESS (ADVANCED)- 
This option allows you to determine the ‘springiness’ of the gear.  Higher values 
mean that the gear is relatively stiff.  If your gear is ‘springy’, we suggest lowering 
the values. 

To adjust the stiffness of the gear, click the respective value.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (ADVANCED)- 
This value indicates the strength or ability of the gear to resist damage.  Increasing 
this value will increase the strength of the gear. 

To adjust the strength of the gear, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the gear, making them more resistant to damage. 
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CURRENT MASS OF SELF (READ ONLY) – 
This indicates the mass of the individual landing gear.  It does not include the wheel. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the gear. 

CURRENT MASS WITH CHILDREN (READ ONLY) – 
This indicates the mass of the item including any additional items (children) that are 
attached. 

STEERING WHEEL- 
To add a smoke component or to delete the wheel from the aircraft, right click on the 
Wheel directory.  Use either the Up/down arrow keys on the keyboard, or the mouse 
to select the desired option.  If using the arrow keys, press Enter to finalize your 
selection. 

BRAKE SERVO- 
This option indicates which servo controls the braking of the aircraft. 

To select the servo, click the value box.  This will bring forth the pull-down menu.  
Using your mouse, select the servo that you wish to utilize. 

BRAKE SERVO REVERSE- 
Once you have selected a servo to control the braking, this setting allows you to 
dictate whether or not to reverse the output of the steering servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

BRAKE SERVO STRENGTH (%)- 
The value of this setting indicates the power and effectiveness of the brake servo. 

To adjust the strength of the brakes, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel.  A 
higher value will stop the aircraft in a shorter distance; a lower value will increase 
the distance the aircraft rolls upon landing. 

HAS WHEEL PANT- 
This option determines whether the wheel is equipped with wheel pants. 

If it is equipped with wheel pants, select Yes.  If not, please select No.  To make 
your selection, click the respective value box.  Select either Yes or No from the pull-
down menu. 

ROTATION ABOUT Y (CAMBER) (DEG)- 
This value indicates the angle of the wheel with respect to the landing gear. 

To adjust the rotational degree about the Y-axis, click the existing value in the value 
box.  Next, enter the desired value either directly from the keyboard or via the mouse 
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wheel.  Larger positive values will increase the angle of the wheel towards the wing 
tip. 

ROTATION ABOUT Z (TOE-IN) (DEG)- 
This value is used to adjust the amount of toe-in for the wheels.  Increasing the 
positive value increases the amount of toe-in exhibited. 

To adjust the amount of toe-in, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

WEIGHT- 
This value represents the weight of the wheel itself.  It does not include the landing 
gear. 

To modify the weight, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

WHEEL DIAMETER- 
This value determines the diameter of the wheel. 

To modify the diameter of the wheel, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

WHEEL WIDTH- 
This value adjusts the width of the wheels. 

To modify the width of the wheel, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CAMBER THRUST COEFFICIENT (ADVANCED)- 
This setting controls the effect of the wheel’s camber on the lateral movement of the 
wheel.  A higher value means that this will have a more significant impact. 

To adjust the camber thrust coefficient, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the values for 
the nose wheel. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

FRICTION COEFFICIENT (ADVANCED)- 
As the name suggests, this setting is utilized to adjust the amount of friction for the 
wheels.  Higher values mean that the wheels exhibit more friction. 

To adjust the friction, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 
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ROLLING RESISTANCE COEFFICIENT (%)(ADVANCED)- 
This option adjusts the amount of resistance that the wheels exhibit when rolling on 
the ground.  A higher value means that the wheels offer more resistance to forward 
movement. 

To adjust the amount of resistance, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CURRENT BRAKE PERCENT (%) (READ ONLY) – 
This value indicates the current braking percent of the aircraft. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the brakes. 

MAIN GEAR- 
To adjust the components for the gear, click on the Main Gear folder. 

To add a single wheel or to delete the gear from the aircraft, right click on the Main 
Gear folder.  Use either the Up/down arrow keys on the keyboard, or the mouse to 
select the desired option.  If using the arrow keys, press Enter to finalize your 
selection. 

LANDING GEAR LENGTH- 
This setting determines the length of the landing gear itself, not including the 
wheel(s).  Please note:  when adjusting the main gear both sides are affected 
simultaneously. 

To change the length of the landing gear, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

MAX STEERING ANGLE- 
Angle of wheel when steering is at maximum 
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RETRACT SERVO- 
This dialog indicates which servo (if any) controls the retractable landing gear. 

To select the servo, click the value box.  This will bring forth the drop-down menu.  
Mouse click on one of the options in the drop-down menu or use the up/down arrow 
keys on the keyboard.  If using the up/down arrows, press the Enter button to 
finalize your selection.  Please note:  if using fixed gear, No Servo should be 
selected. 

RETRACT SERVO REVERSE- 
Once you have decided which servo controls the retractable landing gear, this setting 
dictates whether to reverse the output of the retract servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

ROTATION ABOUT X (GEAR DOWN) (DEG)- 
This value indicates the degree of rotation around the X-axis when the gear is in the 
down position. 

To adjust the rotational degree about the X-axis when the gear is deployed, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
towards the front of the fuselage when they deploy. 

ROTATION ABOUT X (GEAR UP) (DEG)- 
This value indicates the degree of rotation around the X-axis with the gear in the up 
position. 

To adjust the rotational degree about the X-axis when the gear is retracted, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
towards the front of the fuselage when they retract. 

ROTATION ABOUT Y (GEAR DOWN) (DEG)- 
This value indicates the degree of rotation around the Y-axis with the gear in the 
down position. 

To adjust the rotational degree about the Y-axis when the gear is deployed, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
outwards, away from the fuselage towards the wing tips. 

ROTATION ABOUT Y (GEAR UP) (DEG)- 
This value indicates the degree of rotation around the Y-axis when the gear is in the 
up position. 

To adjust the rotational degree about the Y-axis when the gear is retracted, click the 
existing value in the value box.  Next, enter the desired value either directly from the 
keyboard or via the mouse wheel.  Larger positive values will sweep the gear 
outwards, away from the fuselage towards the wing tips. 
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STEERING SERVO- 
This option indicates which servo, if any, controls the steering for the aircraft. 

To select the servo, click the value box.  This will bring forth the drop-down menu.  
Mouse click on one of the options in the drop-down menu or use the up/down arrow 
keys on the keyboard.  If using the up/down arrows, press the Enter button to 
finalize your selection. 

STEERING SERVO REVERSE- 
Once you have selected a servo to control the steering, this option allows you to 
dictate whether or not to reverse the output of the steering servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

WEIGHT- 
This indicates the weight of the gear itself, not including the weight of the wheels or 
any child components. 

To adjust the weight of the landing gear, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

BREAK OFF TOGETHER (ADVANCED)- 
This option determines whether the main gear will fail simultaneously or if they will 
be treated as individual components.  Please note:  this option is only applicable to 
symmetrical components (e.g., main gear, wings, etc.). 

To determine whether the main gear will be treated as one unit, click on the value.  
From the pull-down menu, select Yes if you wish to have the components fail 
simultaneously. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the left hand side of the main gear. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the right hand side of the main gear. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

LANDING GEAR TYPE (ADVANCED)- 
This option selects the type of landing gear for your aircraft.  Each landing gear type 
will offer unique characteristics relative to the materials utilized. 
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To select the type of landing gear utilized on your model, click the value for this 
item.  This brings up a drop-down menu with selections for the various materials.  
Select the desired gear from the list. 

STIFFNESS (ADVANCED)- 
This option allows you to determine the ‘springiness’ of the gear.  Higher values 
mean that the gear is relatively stiff.  If your gear is ‘springy’, we suggest lowering 
the values. 

To adjust the stiffness of the gear, click the respective value.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (ADVANCED)- 
This value indicates the strength or ability of the gear to resist damage.  Increasing 
this value will increase the strength of the gear. 

To adjust the strength of the gear, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the gear, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This indicates the mass of the individual landing gear.  It is for one side only and 
does not include the wheel. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the gear. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY) – 
This indicates the mass of the gear for both sides, inclusive. 
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It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the gear. 

CURRENT MASS WITH CHILDREN (READ ONLY) – 
This indicates the mass of the item including any additional items (children) that are 
attached to the landing gear. 

CURRENT MASS WITH CHILDREN (BOTH SIDES) (READ ONLY) – 
This indicates the mass of the gear, both sides, including any additional items 
(children) that are attached. 

The various modifications made to the gear control this value; you may not manually 
adjust it. 

Main Wheel- 
To add a smoke component, or to delete the main wheel, right click on the Main 
Wheel directory.  Use either the Up/down arrow keys on the keyboard, or the mouse 
to select the desired option.  If using the arrow keys, press Enter to finalize your 
selection. 

BRAKE SERVO- 
This dialog indicates which servo, if any, controls the brakes for the aircraft. 

To select the servo, click the value box.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired option.  If using the arrow keys, press 
Enter to finalize your selection. 

BRAKE SERVO REVERSE- 
Once you have selected a servo to control the braking, this option allows you to 
dictate whether or not to reverse the output of the steering servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

BRAKE SERVO STRENGTH (%)- 
The value of this setting indicates the power and effectiveness of the brake servo. 

To adjust the strength of the brakes, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel.  A 
higher value stops the aircraft in a shorter distance; a lower value increases the 
distance the aircraft rolls upon landing (with the brakes activated, of course). 

HAS WHEEL PANT- 
This option determines whether the aircraft is equipped with wheel pants. 

If the wheel pants are present, select Yes.  If the aircraft is not equipped with wheel 
pants, please select No.  To make your selection, click the respective value box.  
Select either Yes or No from the pull-down menu. 
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ROTATION ABOUT Y (CAMBER) (DEG)- 
This value indicates the angle of the wheel in relation to the landing gear. 

To adjust the rotational degree about the Y-axis, click the existing value in the value 
box.  Next, enter the desired value either directly from the keyboard or via the mouse 
wheel.  Larger positive values will increase the angle of the wheel towards the wing 
tip. 

ROTATION ABOUT Z (TOE-IN) (DEG)- 
This value adjusts the amount of toe-in for the wheels.  Increasing the positive value 
increases the amount of toe-in exhibited. 

To adjust the amount of toe-in, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

WEIGHT- 
This value represents the weight of the wheel itself.  It does not include the landing 
gear.  

To modify the weight, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

WHEEL DIAMETER- 
This value determines the diameter of the wheel. 

To modify the diameter of the wheel, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

WHEEL WIDTH- 
This value adjusts the width of the wheels. 

To modify the width of the wheel, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CAMBER THRUST COEFFICIENT (ADVANCED)- 
This setting controls the effect of the wheel’s camber on the lateral movement of the 
wheel.  A higher value means that this will have a more significant impact. 

To adjust the camber thrust coefficient, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the left wheel. 

Clicking on the respective value column will bring forth the drop-down menu 
selection of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the right wheel. 
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Clicking on the respective value column will bring forth the drop-down menu 
selection of the various Component Frames. 

FRICTION COEFFICIENT (ADVANCED)- 
As the name suggests, this setting is utilized to adjust the amount of friction for the 
wheels.  Higher values mean that the wheels exhibit more friction. 

To adjust the friction, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

ROLLING RESISTANCE COEFFICIENT (%) (ADVANCED)- 
This option adjusts the amount of resistance that the wheels exhibit when rolling on 
the ground.  A higher value means that the wheels offer more resistance to forward 
movement. 

To adjust the amount of resistance, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CURRENT BRAKE PERCENT (%) (READ ONLY) – 
This option indicates the current braking percentage of the aircraft. 

This various modifications made to the brakes control this value.  You may not 
manually adjust this value. 

CURRENT MASS OF SELF (READ ONLY) – 
This value indicates the mass of the wheel, individually.  That is, this value 
represents one side only. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the wheel. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY) – 
This value indicates the mass of both wheels collectively. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the wheel. 

ENGINE-  

The engine options modify the various aspects of the power plant (if any) for your 
aircraft. In our example, we will utilize the Hobbico NexSTAR.  If you have selected 
a turbine-powered aircraft, the options available to you will vary. 

Adding Or Removing Engine Components 
To add a smoke component, or to delete the component, right click on the Engine 
directory.  Doing so will display the options available to you.  Alternatively, with the 
Engine directory highlighted, you may opt to click the Edit menu.  This will bring 
forth the same list of options. 
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Once you have added a component, you may edit its properties just as you would 
with any other editable item in the simulation.  The options available to you vary 
depending upon the component added. 

DOWN THRUST (DEG)- 
This represents the downward angle of the engine in relationship to the centerline of 
the airplane. 

To modify the amount of down thrust, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel.  The higher the value, the more down thrust the engine has.  Down thrust aids 
in overcoming the normal climbing tendencies of flat bottom wings. 

GEAR RATIO- 
This value represents the gear ratio of the engine and propeller.  This value 
represents the number of revolutions of the engine per revolution of the propeller.  If 
your engine is not geared, the number should remain at 1. 

If you use a geared motor, change the ratio in the respective value box.  To do so, 
click the existing value in the value box.  Next, enter the desired value either directly 
from the keyboard or via the mouse wheel. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 
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The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

NUMBER OF BLADES- 
This option adjusts the number of blades on the propeller.  The number of propeller 
blades will alter the performance of the aircraft accordingly. 

  
To adjust the number of propeller blades, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

PROP DIAMETER– 
This value indicates the diameter of the propeller.  Propellers are designated by two 
numbers.  As an example, consider a 10-6 propeller.  The first number (10) is the 
diameter of the propeller in inches.  The second number is the pitch or angle of the 
blades.  The pitch indicates the forward movement of the propeller in one revolution 
in ideal conditions. 

To adjust the propeller diameter, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

PROP PITCH– 
This value indicates the angle, or pitch, of the propeller blades.  For additional 
information pertaining to propeller pitch, please reference the Prop Diameter 
description above. 

To adjust the propeller pitch, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel.  

PROP SPINS CLOCKWISE- 
This setting determines the direction of rotation of the propeller.  The direction is 
dictated by looking from the back of the aircraft towards the front. 

If it is a standard engine and propeller set-up, select Yes.  If the unit is set-up with 
counter-rotating propellers, i.e. a twin-engine installation, please select No.  To make 
your selection, click the respective value box.  Select either Yes or No from the pull-
down menu. 
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PROPELLER TYPE- 
The selection determines the propeller type and/or manufacturer. 

RIGHT THRUST (DEG)- 
The value here determines the amount right thrust used by this aircraft.  Airplanes 
generally use a slight amount of right thrust to counteract the torque of the engine. 

To adjust the amount of right thrust, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

SOUND PROFILE- 
The setting here dictates the sound profile used for this respective aircraft.  G3.5 
includes a multitude of actual sound choices. 

 
To select a sound profile, click the existing sound profile in the value box.  This will 
bring forth the pull-down menu.  Using your mouse, select the sound profile you 
wish to utilize. 

THROTTLE SERVO- 
This dialog determines which servo controls the throttle setting of your aircraft. 

To select a throttle servo, click the existing selection in the value box.  This will 
bring forth the pull-down menu selections.  Using your mouse, select the servo you 
wish to utilize. 

THROTTLE SERVO REVERSE- 
Once you have decided which servo will control the throttle, this setting allows you 
to dictate whether to reverse the output of the throttle servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  169 

TORQUE GENERATOR- 
The Torque Generator setting determines the torque performance settings for your 
engine.  RealFlight includes a wide variety of real-world torque data pertaining to 
some of R/C’s most popular engines.  RealFlight G3.5 uses this data (gathered from 
a variety of sources) to bring real-world performance to life within the simulation. 

To access the Torque Generator, click the respective value.  Next, click the more 
options button (the gray folder with the ellipsis) to bring forth the engine parameters 
and values.  The currently selected engine will be highlighted in the listing and its 
respective data will appear in the pane on the right side of the window. 

If you wish to replace the existing power plant in the aircraft, simply select an 
alternative from this list.  Click OK when finished. 

If, however, you wish to modify the existing engine, you should access the Torque 
Curve.  For information on how to do so, please refer to the Torque Curve section 
below.  

 
Copy- 

This option duplicates the information and data pertaining to the currently selected 
engine.  This is the first step in creating a customized engine and/or Torque Curve.  

To copy an engine, click Copy.  Next, enter a name for the new engine.  After you 
enter the desired name, click OK.  The engine will now appear in the listing of 
available engines. 

Creating a Custom Engine and/or Torque Generator- 

While G3.5 includes a multitude of engines, it is impossible to include every engine 
from every manufacturer.  This option allows you to create a Torque Generator that 
matches the performance of your actual R/C engine. 

To do so, access the Torque Generator using the process mentioned above.  Click the 
Copy button and rename the engine in the dialog that appears. 
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Fuel Consumption- 

This value represents the amount of fuel used by the engine when it is running at full 
throttle for one minute. 

To change the amount of fuel consumed, click the existing value.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

Idle Percentage of Curve- 

This value represents the shift of the torque curve when the engine is at idle.  A 
higher value represents a greater shift. 

To change the idle percentage, click the existing value.  Next, enter the desired value 
either directly from the keyboard or via the mouse wheel. 

Idle Torque- 

When the engine is at idle, this value represents how much the torque should be 
reduced from its maximum amount. 

To change the Idle Torque, click the existing value.  Next, enter the desired value 
either directly from the keyboard or via the mouse wheel. 

Weight-  

This value represents the weight of the engine. 

To alter the weight of the engine, click the existing value.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel. 

Torque Curve- 

This option is used to alter the existing Torque Curve Values.  That is, it is used to 
adjust the performance of the engine to suit your personal needs. 

To access the Torque Curve, click the <<Graph Points>>.  Next, click the more 
options button (the gray folder with the ellipsis) to bring forth the Torque Curve 
editor. 
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Adjusting the Custom Torque Curve- 

The Torque Curve, as noted previously, is completely customizable.  There are 
several methods that may be utilized to adjust the Torque Curve.  The method you 
select is a matter of personal preference. 

Prior to adjusting the Torque Curve, it is important to understand exactly what it is 
that you will be adjusting. 

Speed- 

Speed represents the RPM’s, or revolutions per minute, of the engine.  This is how 
fast the engine is rotating the propeller. 

Torque- 

Torque affects the amount of pull that the engine generates at a given RPM.  

You may adjust the engine’s performance using either pure numerical values or 
using the graphical representations on the graph itself. 

Numerical Adjustment- 

G3.5 allows you to adjust both the speed and the torque of the engine independently 
of one another. 

To adjust the RPM’s (speed), click on the respective value.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  If, for example, you 
wanted to adjust the lowest RPM from 2000 to 1500, simply click on the 2000 RPM 
value and modify the value.  Please note:  the graphical representation of the RPM’s 
will also be modified to reflect this change. 

Engine torque is adjusted following the same methodology.  Simply select the torque 
value that you wish to modify and adjust accordingly. 
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Graphical Adjustment- 

Rather than entering specific numerical values, this method allows you to alter the 
engine’s performance graphically. 

To adjust the RPM of any given point, press and hold the Ctrl (Control) button on 
the keyboard.  Using the mouse, select the point to be modified.  Hold down the 
mouse button and drag the point to the desired location.  When satisfied, release the 
mouse button.  As with the Numerical Adjustment, altering the RPM’s graphically 
will also be reflected in the numerical values column. 

You can adjust Torque in a similar manner.  Click on the point to be modified.  Hold 
down the mouse button and drag the point vertically to the desired torque setting.  To 
finalize your setting, release the mouse button. 

These methods allow you to modify single points along the curve.  G3.5 also offers 
the ability to perform a sweeping change to the RPM’s and torque settings.  To do 
so, click on the first point that you wish to modify.  Next, hold the mouse button 
down and move the mouse across the graph.  The points will follow the movement of 
the mouse. 

Add Point- 

This option is utilized to add points to the numerical and graphical charts.  This 
allows fine-tuning of the engine’s performance. 

To add a point to the Torque Curve, click the Add Point button.  Select the value 
column for the Speed indicator and input the value for the desired RPM’s at which 
you’d like the point to appear on the chart.  Next, input the desired Torque value for 
the new point.  When completed, click OK. 
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Re-Sample- 

This option is utilized to determine the number of points, as well as the spacing 
between the points, included in the Torque Curve. 

Please note:  the Resample To and Interval values interact with one another. 

 
Delete this Point- 

This option removes points from the Torque Curve. 

To do so, right click on the point to be removed.  Next, select the Delete this point 
dialog that appears.  The point will be removed from both the numerical and 
graphical charts. 
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Rename- 

This option is utilized to rename a user-created engine profile. 

To do so, highlight the desired profile and click Rename.  Enter the new name for 
this engine in the dialog provided.  After you have entered the desired name, click 
OK.  The engine will now appear in the listing of available engines. 

Delete- 

As the name suggests, this option deletes an engine profile. 

Please note:  users are only allowed to delete engines that they have created.  That is, 
you are not allowed to delete stock engines. 

To delete a user-created profile, select the respective profile.  Next, click Delete.  If 
you wish to delete this engine profile, click Yes in the verification dialog.  

To view the Torque Curve for this engine, click the <<Graph Points>> value.  Next, 
click the more options button (the gray folder with the ellipsis) to bring forth the 
Torque Curve. 

BACK TORQUE FACTOR (ADVANCED)- 
This value represents the amount of engine torque that is transferred back in to the 
airplane frame.  Modifying this parameter can affect the trim and stability of the 
aircraft. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame (graphical object) of the item. 

Clicking on the respective value column brings forth the pull-down menu selection 
of the various Component Frames. 
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ENGINE TO SHOW (ADVANCED)- 
This determines which engine that the simulation shows as a graphical 
representation.  It has no effect on the performance of the aircraft. 

 
To change engine visuals, click the respective value box.  This brings forth the pull-
down engine selections available to you.  From this list, choose the engine you 
desire.  If your engine is situated within a cowling, you should choose None. 

HAS SPEED CONTROL BRAKE (ELECTRIC MOTORS ONLY) (ADVANCED)- 
This property controls the speed control brake value. When set to “Yes” the electric 
motor will act as a brake at low throttle.  This is particularly useful for folding props. 

HELICAL WASH ROTATION FACTOR (ADVANCED)- 
This advance parameter will change the amount of helical airflow from the propeller.  
Higher values will cause more left yaw during takeoffs. 

IS DUCTED FAN (ADVANCED)- 
This option determines whether the propeller is in a duct or in the open (as is the 
case with a standard R/C engine). 

If it is a ducted fan unit, select Yes.  If not, select No.  To make your selection, click 
the respective value box.  Select either Yes or No from the drop-down menu. 

IS PUSHER PROP (ADVANCED)- 
This option determines whether the propeller is a pusher propeller. 

If it is a standard tractor propeller, select No.  If the unit is a pusher propeller, select 
Yes.  To make your selection, click the respective value box.  Select either Yes or 
No from the drop-down menu. 
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LATERAL DRAG FACTOR (ADVANCED)- 
This property adjusts RealFlight’s calculation for the amount of drag produced by 
airflow across the prop disk.  It is sometimes useful to reduce this value.  

PROP VISUAL SCALE (ADVANCED)- 
This value determines the graphical look (size) of the on-screen propeller.  Please 
note that the graphical changes do not alter the flight performance of the model.  It 
only affects the appearance of the propeller. 

To adjust the propeller size, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

PROP WASH FACTOR (ADVANCED)- 
This setting allows you to adjust the speed of the propwash behind the engine.  
Higher values produce higher velocity airflow. 

TORQUE FROM ENGINE MODIFICATION (%)(ADVANCED)– 
This setting allows you to modify the Torque Curve of the engine without adjusting 
the individual points along the curves.  It provides a constant scaling factor all along 
the curve. 

To refine the torque from the Torque Curve, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

CURRENT MASS OF SELF (READ ONLY)– 
This represents the mass of the object, not including any children. 

It is not possible to manually adjust this value. 

CURRENT MASS WITH CHILDREN (READ ONLY) – 
This is the overall mass of the engine, including any child components. 

It is not possible to manually adjust this value.  The various modifications made to 
the engine control this value. 

CURRENT POWER (READ ONLY) – 
Indicates the current power produced by the propeller.  Power is usually measured in 
horsepower. 

It is not possible to manually adjust this value.  The various modifications made to 
the engine control this value. 

CURRENT PROP RPM (RPM) (READ ONLY) – 
This value indicates the revolutions per minute (RPMs) of the propeller. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the engine. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  177 

CURRENT THRUST (READ ONLY) – 
This value indicates the thrust (SAE:  in pounds) produced by the propeller. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the engine. 

CURRENT TORQUE GENERATOR RPM (RPM) (READ ONLY) – 
This indicates the current torque generator RPMs, or revolutions per minute. 

It is not possible to manually adjust this value.  Rather this value is controlled by the 
various modifications made to the engine. 

Exhaust- 
This option allows you to make modifications to the exhaust settings of your aircraft.  
To access these settings, click the Exhaust option. 

If you wish to remove the exhaust from the aircraft, right click on the Exhaust 
component and click the Delete Component dialog that appears.  Next, click Yes in 
the verification box. 

 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 
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The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

MINIMUM SMOKE PERCENT (%)- 
This value indicates the minimum amount of smoke generated by the aircraft 
regardless of the servo position. 

To refine this minimum smoke, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

SMOKE COLOR- 
To modify this setting, click on the respective value.  Click the more options button 
(the gray folder with the ellipsis) to bring forth the palette of available colors.  This 
will reveal a screen that appears as follows: 

 
To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the value column. 

SMOKE LIFE SPAN (SEC)- 
This controls the length of time that smoke remains on the screen.  A lower value 
means that the smoke will disappear rapidly. 

To refine the life span, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

SMOKE ON/OFF SERVO- 
This option indicates which servo (if any) controls the activation of the smoke. 
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To select the servo, click the value box.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired servo. 

SMOKE QUANTITY SERVO- 
This option allows you to determine which servo controls the smoke quantity. 

To select the servo, click the value box.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired servo. 

SMOKE QUANTITY SERVO REVERSE- 
Once you have decided which servo controls the smoke quantity, this setting dictates 
whether to reverse the output of the smoke servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the drop-down menu. 

SMOKE SIZE RATE (%)- 
This option adjusts the speed at which the smoke expands. 

To modify the size rate, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value indicates that the smoke will expand faster. 

STARTING OPACITY (%)- 
This value indicates the opacity of the smoke at its starting point. 

To modify the opacity, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value means that the smoke will be thicker when it first appears on the screen. 

STARTING SIZE- 
This value defines the starting size of the smoke. 

To modify the starting size, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value increases the diameter of the smoke initially. 

 

    EEDDIITT  CCUURRRREENNTT  AAIIRRCCRRAAFFTT……  HHEELLIICCOOPPTTEERR  
Many of the functions in the Edit Current Aircraft… Helicopter sections are 
similar to those found in the Airplane section.  Please refer to that section for a 
general introduction to the menus and basic functions. 

If you select Edit Current Aircraft… with a helicopter loaded into the simulation, 
this will bring forth a screen similar to the one below.  It may deviate slightly 
depending upon the type of aircraft that you are editing (i.e., scale model, electric 
model, etc.).  However, all aircraft are refined in a similar manner.  As such, this will 
present you with the general information necessary to edit any aircraft found in G3.5. 
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Since the Airplane section fully covers the basic menu functions, this section begins 
with a discussion of the helicopter-specific material. 

AIRCRAFT ROOT DIRECTORY- 
The item that is highlighted in the far left column is the item for which the Name and 
corresponding value information is shown. 

With the aircraft name highlighted, the first dialog displays general information 
about the aircraft itself: 

DESCRIPTION- 
As the name suggests, this is the description of the aircraft.  When you edit an 
aircraft, we suggest that you modify the description.  This will assist you in keeping 
track of the modifications without having to return to the AccuModel editor to see 
what has changed. 
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To alter the Description, click the text in the value box.  The default description box 
will appear.  Next, use the keyboard to input the new description as you see fit. 

LAUNCH METHOD- 
This setting determines the launch method for this aircraft.  There are two launch 
methods available - From Ground and Hand Launch. 

The From Ground launch means that the aircraft will takeoff from the ground.  Use 
this method for aircraft that have either skids or wheels on the undercarriage. 

The Hand Launch method means that the aircraft launches from the hand of a virtual 
pilot.  If the aircraft does not have wheels or skids, select Hand Launch. 

To determine the launch methodology, click on the respective value.  Use either the 
mouse or the up/down arrow keys on the keyboard to select the desired launch 
procedure.  If using the up/down arrows, press the Enter button to finalize your 
selection. 

Most helicopters should use the From Ground launch option. 

POWER PLANT TYPE- 
The value determines the type of power plant (propulsion system) used in the 
aircraft.  The selection in the value column also determines the parameters available 
for adjustment when referencing the power plant options. 
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To change the Power Plant Type, click on the existing power plant in the value 
column.  From the drop-down menu, select the new power plant desired.  Your 
choices are: 

• Electric Motor - utilized for electric-powered aircraft. 

• Internal Combustion Engine - utilized for gasoline and nitro-
methane powered aircraft. 

• Turbine Engine - utilized for turbine-powered aircraft. 

• Turboprop Engine - utilized to create turboprop-powered aircraft. 

• Unpowered - utilized for sailplanes and gliders.  Not 
recommended for helicopters. 

RADIO TYPE- 
This setting determines which radio connection to use in the simulation.  There are 
two Radio Type options are available to you:  Software Radio and Pass Through. 
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To change the Radio Type, click on the existing Radio Type and select the desired 
radio from the drop-down list.  For more information pertaining to the differences 
between the Software Radio and Pass Through modes, please refer to the chapter 
pertaining to the Controller menu. 

VEHICLE GRAPHICAL SCALE (%) (ADVANCED)-  
This value represents the actual visual scale of the model and is used to scale the 
model up or down visually.  This has no effect on the physics of the simulation. 

To modify the Vehicle Graphical Scale, click the existing scale in the value box.  
Next, enter the desired values either directly from the keyboard or via the mouse 
wheel. 

Please note:  the Visual Graphics Scale does NOT affect the flight characteristics of 
the model.  If you increase the size of an aircraft and would like to have it fly like the 
larger aircraft, adjust the Physics Dimension Scale to match. 

VEHICLE PHYSICS SCALE (%) (ADVANCED)- 
The value here represents the scale factors applied to the physics components, in 
comparison to their original dimensions. 

Please note:  you are modifying the physics for the aircraft when you adjust this 
parameter, not the visual scale! 

To modify the Vehicle Physics Scale, click on the value in the value box.  If your 
personal aircraft flies ‘larger’, we suggest that you increase the Vehicle Physics 
Scale.  This will cause the aircraft to fly like a bigger aircraft.  The converse is also 
true.  If the RealFlight aircraft is a larger scale and you wish to have it fly like a 
smaller, .30 size aircraft, decrease the Vehicle Physics Scale.  The desired values 
may be input directly from the keyboard or modified using the mouse wheel. 
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CURRENT GRAPHICAL WIDTH (READ ONLY)– 
This value represents the graphical width of your aircraft.  This value cannot be 
adjusted manually.  Instead, it corresponds to graphical changes in the wingspan. 

CURRENT MASS WITH CHILDREN (WET) (READ ONLY)– 
This value represents the total overall weight of the aircraft when it is ready for 
takeoff.  This value cannot be adjusted manually. 

CURRENT PHYSICS WIDTH (READ ONLY)– 
This represents the width of your aircraft.  It is calculated based upon the Physics 
Dimension Scale.  This value cannot be adjusted manually.  It refers to the width of 
the helicopter without the main rotor blades. 

ROTOR DISC LOADING (DRY) (READ ONLY)– 
This vale represents the rotor disc loading of the helicopter before fuel is added.  
This value cannot be adjusted manually.  In SAE units, this is usually measured in 
oz/ft2. 

AIRFRAME- 
 

The airframe options are used to modify the various aspects of the components that 
make-up the model. 

The airframe folder is preceded with a [+] (plus).  The [+] (plus) indicates that 
another expansion level is available to you.  To access the complete list of airframe 
items for a respective model, simply click the [+] (plus) or double-click the airframe 
name. 

Adding or Removing Airframe Items- 
To add or remove components on the airframe, right click on the existing 
component. 

Alternatively, with the airframe highlighted, click the Edit menu.  This will bring 
forth the list of options available to you. 
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You may add a variety of items to your airframe.  Item availability is based upon a 
number of factors such as aircraft design, power plant options, and directory 
selected.  If you right click on fuselage, for example, the options available to you 
will be different than if you had right clicked on the heli mechanics.  

You may use either of two methods to add items to the airframe:  Add Single Item 
or Add Symmetrical Item.  The Add Symmetrical items selection will add two 
items to your aircraft.  These selections are useful when you want to add twin 
engines or similar objects.  Rather than having to add and modify each one 
individually, RealFlight adds both engines at the same time.  You are only required 
to modify one of them.  The other engine will mirror the modifications. 

ADD SINGLE ITEM SELECTIONS- 
Add Single Wing - Adds one additional wing to the aircraft. 

Add Single Fuselage - Adds one single fuselage to the aircraft. 

Add Single Engine - Adds another engine to the aircraft. 

Add Single Thruster - Adds one turbine unit to the fuselage. 

Add Single Movable Pod - Adds a movable object to the aircraft.  You can slave a 
servo to this object so that you can rotate a particular component.  As an example, 
you could add a movable pod between the fuselage and an engine, which would 
allow you to rotate the engine in flight. 

Add Single Gear - Adds one landing gear to your aircraft.  This allows you to turn a 
bicycle-geared craft into a tricycle-geared airplane, for example. 

Add Lift Component - Adds one item that serves to lift the airframe. 

Add Mass Component - Adds one object that serves to add mass to your aircraft.  
This replicates the effect of adding ballast to the model. 
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ADD SYMMETRICAL ITEM SELECTIONS- 
Add Symmetrical Wing - Adds two wings; one to either side of the aircraft in 
identical locations. 

Add Symmetrical Fuselage - Adds an additional two fuselages; one on either side 
of the aircraft. 

Add Symmetrical Engine - Adds two additional engines; one on either side of the 
aircraft. 

Add Symmetrical Thruster - Adds two additional thrusters; one on either side of 
the aircraft. 

Add Symmetrical Movable Pod - Adds two movable pods; one on either side of the 
aircraft.  

Add Symmetrical Gear - Adds a second set of landing gear; one on either side of 
the aircraft. 

Add Smoke Component - Adds a smoke emitter to your aircraft. 

CG ADJUSTMENT- 
RealFlight’s RealPhysics engine automatically calculates the Center of Gravity (CG) 
location based upon all of the components on the respective aircraft.  If, however, the 
CG of your aircraft is different, use the X, Y, and Z-axis values to manually adjust 
the overall CG. 

 
To adjust the X, Y or Z value, click on the Value column next to CG Adjustment.  
The X value adjusts the CG left/right on the airframe, the Y value moves it fore/aft 
and the Z value moves the CG up/down on the airframe.  The larger the number in 
the X value, the further to the right the CG moves.  A positive number in the Y 
column moves the CG towards the front of the aircraft.  To increase the height of the 
CG, insert a positive value in the Z column.  You may input desired values directly 
from the keyboard or modify them using the mouse wheel. 

MASS SCALING FACTOR (ADVANCED)- 
This advanced property adjusts aircraft response in certain flight load calculations.  It 
is particularly useful for large models and models with low wing loadings.  Engine 
torque is also affected by this property, to avoid unintended side-effects in the power 
to weight ratio. 

MAIN FUEL TANK-  
To modify the various items associated with this item, select the main fuel tank in 
the listing. 

FUEL TANK SIZE- 
This parameter indicates the capacity of the fuel tank. 
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To modify the fuel tank capacity, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

LENGTH– 
This value represents the length of the fuel tank.  Please note:  adjustment to the 
length of the fuel tank will have an impact on the helicopter’s CG. 

To modify the length of the tank, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT– 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value represents the weight of the fuel tank.  Please note:  this weight does not 
include the fuel.  Rather it is the weight of the fuel tank only. 

To modify the weight of the tank, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

WIDTH– 
This value represents the width of the fuel tank. 

To modify the width of the tank, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)– 
This value represents the mass of the fuel tank.  It does not include the weight of the 
fuel. 

You may not manually adjust this value.  The various modifications made to the 
weight control this value. 

FUSELAGE DIRECTORY-  
 

The Fuselage menu items contain the various items related to, or situated on, the 
fuselage.  You can make a number of modifications to the Fuselage itself.  They are 
as follows: 
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DIMENSIONS– 
This value represents the height, length and width of the fuselage.  It does not 
include the shape of the canopy. 

To modify the Dimensions, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT– 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value represents the weight of the fuselage itself.  It does not include the 
children (engine, gear, etc.). 

To modify the weight, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  189 

AIRFOIL (SIDES) (ADVANCED)- 
This setting determines which airfoil to use at the side of the fuselage.  Changing this 
parameter will affect how the aircraft flies in 3D maneuvers. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

AIRFOIL (TOP/BOTTOM) (ADVANCED)- 
This setting determines which airfoil to use at the top and bottom of the fuselage.  
Changing this parameter will affect how the aircraft flies in 3D maneuvers. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame (graphical object) of the item. 

Clicking on the respective value column brings forth the pull-down menu selection 
of the various Component Frames. 

FRONTAL DRAG (%) (ADVANCED) –  
This value represents the frontal drag percentage.  A lower frontal drag is 
representative of a very sleek, aerobatic aircraft.  A larger frontal drag percentage 
causes the aircraft to slow more rapidly and decreases the top end speed.  Based on 
the given measurements, G3.5 attempts to compute an appropriate frontal drag for 
your aircraft.  However, if your aircraft flies differently than the simulated model, 
adjust the frontal drag up or down as necessary to achieve a closer match. 

To modify the Frontal Drag (%), click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

FUSELAGE AERODYNAMICS PERCENT (%)(ADVANCED) – 
This value represents the amount that the wind affects the fuselage. 

To modify the Fuselage Aerodynamics Percent (%), click the existing value in the 
value box.  Next, enter the desired value either directly from the keyboard or via the 
mouse wheel. 

FUSELAGE LIFT LOCATION (%)(ADVANCED)– 
The value here represents the center of lift for the fuselage. 

To modify the Fuselage Lift Location (%), click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel.  If the fuselage on your aircraft lifts behind this point, enter a number less 
than 100%. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
fuselage component.  RealFlight normally calculates this value based on the 
dimensions and overall shape of the fuselage.  You may adjust RealFlight’s 
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calculation to better match your expectations for the aircraft.  Some very sleek 
aircraft, such as sailplanes, may need to have this value lowered.  Very draggy 
aircraft, such as a biplane with a radial engine, struts, and flying wires, may perform 
more realistically when this value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (ADVANCED)- 
This value represents the strength or structural integrity of the fuselage.  If, for 
example, you wish to make the fuselage more susceptible to breakage, reduce the 
value of the strength multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

WETTED SCALE FACTOR (ADVANCED)- 
These properties adjust the amount of lift produced by the fuselage in a given 
dimension.  RealFlight automatically calculates a value based on the fuselage shape, 
but sometimes it is helpful to adjust this value in order to produce desired results.  

CURRENT MASS OF SELF (READ ONLY)– 
This value represents the mass of the object.  It does not include the children - 
engine, gear, etc. 

You may not manually adjust this value.  The various modifications made to the 
fuselage control this value. 

CURRENT MASS WITH CHILDREN (READ ONLY)– 
This value is the overall mass of the fuselage, including any child components. 

You may not manually adjust this value.  The various modifications made to the 
fuselage control this value. 
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CANOPY- 
This component includes all the parameters for the helicopter’s canopy and the 
option to add or remove specific canopy components. 

To add items to the Canopy, or to eliminate it altogether, right click on the Canopy 
directory.  Next, select the desired option from the pull-down menu that appears. 

DIMENSIONS – 
This value represents the average height, length, and width of the canopy.  It does 
not include the skids. 

To modify the Dimensions, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents the width of the canopy. The value of the Y-axis 
represents the length.  And the Z-axis value controls the height of the canopy. 

LOCATION IN PARENT– 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value represents the weight of the canopy itself.  It does not include the children 
(engine, gear, etc.). 

To modify the weight, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

AIRFOIL (SIDES) (ADVANCED)- 
This setting determines which airfoil to use at the side of the fuselage.  Changing this 
parameter will affect how the aircraft flies in 3D maneuvers. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

AIRFOIL (TOP/BOTTOM) (ADVANCED)- 
This setting determines which airfoil to use at the top and bottom of the fuselage.  
Changing this parameter will affect how the aircraft flies in 3D maneuvers. 
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To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis).  This brings forth an alphabetically 
organized list of airfoils for you to select. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the Canopy. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

FRONTAL DRAG (%) (ADVANCED)– 
This value represents the frontal drag percentage.  A lower frontal drag is 
representative of a very sleek, aerobatic aircraft.  A larger frontal drag percentage 
will cause the aircraft to slow more rapidly and will decrease the top end speed.  
Based on the given measurements, G3.5 attempts to compute the appropriate frontal 
drag for your aircraft.  However, if your aircraft flies differently than the simulated 
model, adjust the frontal drag. 

To modify the Frontal Drag (%), click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

FUSELAGE AERODYNAMICS PERCENT (%) (ADVANCED)– 
This value represents the amount that the fuselage, or canopy in this instance, is 
affected by the wind. 

To modify the Fuselage Aerodynamics Percent (%), click the existing value in the 
value box.  Next, enter the desired value either directly from the keyboard or via the 
mouse wheel. 

FUSELAGE LIFT LOCATION (%) (ADVANCED)– 
The value here represents the center of lift for the canopy. 

To modify the Fuselage Lift Location (%), click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel.  If the fuselage on your aircraft lifts behind this point, enter a number less 
than 100%. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft may need to have 
this value lowered.  Very draggy aircraft may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 
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SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value represents the strength or structural integrity of the canopy.  If, for 
example, you wish to make the canopy more susceptible to breakage, reduce the 
value of the strength multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

WETTED SCALE FACTOR (%) (ADVANCED)- 
This value affects the aerodynamic calculations of the canopy.  Changing this value 
will change the way the surface of the canopy interacts with the air.  

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)– 
This value represents the mass of the object.  It does not include the children - 
engine, gear, etc. 

You may not manually adjust this value.  The various modifications made to the 
fuselage control this value. 

HELI MECHANICS COMPONENT 
 

This component is required before you can add any helicopter specific parts to the 
aircraft.  The mechanics component encompasses the power train of the helicopter.  
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ADD OR REMOVE HELI MECHANICS ITEMS- 
To add or remove items on the Heli Mechanics, right click on the Heli Mechanics or 
click the Edit menu to bring up the following options:  Add Smoke Component, 
Delete Component.  Select the function that you wish to perform. 

Once you have added a component, it is possible to edit its properties just as you 
would with any other editable item in the simulation.  The options available to you 
vary depending upon the component added. 

DIMENSIONS- 
The settings here represent a rough approximation of the helicopter mechanics 
without the canopy attached.  The X value determines the width of the heli 
mechanics.  The Y value determines the depth of the heli mechanics.  The Z value 
determines the height of the mechanics. 

To adjust these measurements, click on the Dimensions value.  Next, select the X, Y 
or Z value.  Enter the desired value directly from the keyboard or via the mouse 
wheel.  If using the keyboard, press the Enter button on your keyboard. 

ENGINE SOUND VOLUME (%)- 
This option allows you to fine-tune the volume of the helicopter engine in the 
simulation. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

ENGINE TO ROTOR RATIO- 
This setting allows you to adjust the ratio of the engine revolutions as compared to 
one complete revolution of the rotor blades.  For example, a value of 10 indicates 
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that the engine turns 10 times for every one time that the rotor head spins.  As a point 
of reference, most nitro methane-powered helicopter engines turn about 8-10 times 
for every turn of the rotor. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FULLY DISENGAGED RPM (RPM)- 
This value represents the revolutions per minute, or RPM’s at which the clutch 
becomes completely disengaged, or is no longer spinning from the engine’s power. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FULLY ENGAGED RPM (RPM)- 
This value represents the revolutions per minute, or RPM’s at which the clutch 
becomes completely engaged, or causes the main blades to rotate. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

HAS CLUTCH- 
This value determines whether the helicopter features a clutch in the drive chain.  
Most nitro-powered helicopters utilize a clutch, so G3.5 defaults to Yes. 

To modify this setting, click the respective value.  Use either the mouse or the 
up/down arrow keys on the keyboard to determine whether the helicopter utilizes a 
clutch.  If using the up/down arrows, press the Enter button to finalize your 
selection. 

HAS ONE WAY BEARING- 
This setting indicates whether there is a one-way bearing between the engine and the 
main rotor.  The helicopter will not be able to perform autorotations without a one-
way bearing. 

Use the mouse or the up/down arrow keys on the keyboard to determine whether or 
not the helicopter utilizes a one way bearing.  If using the up/down arrows, press the 
Enter button to finalize your selection. If a one way bearing exists in the heli, choose 
Yes for this option. 

LOCATION IN PARENT- 
This value represents the location of the item with respect to the parent or main 
object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with respect to the parent 
object.  A negative value shifts the location to the left.  A positive value shifts the 
location to the right. 

The value of the Y-axis represents a movement forward or backward with respect to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  
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The Z-axis value moves the location up or down with respect to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

MOTOR GEAR BOX RATIO- 
This parameter is for electric motors with embedded or built-in gearboxes.  This 
value represents the number of revolutions of the electric motor per revolution of the 
clutch. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

SOUND PROFILE- 
The setting here dictates the sound profile for this particular helicopter.  G3.5 
includes a multitude of actual recording choices. 

 
To select a profile, click the value box for the existing profile.  Next, select the 
desired profile from the drop-down list that appears.  Use either the mouse or the 
up/down arrow keys on the keyboard.  If using the up/down arrows, press the Enter 
button to finalize your selection. 

THROTTLE SERVO- 
This determines which servo controls the throttle setting of the helicopter. 

To select a profile, click the value box for the existing profile.  Use either the mouse 
or the up/down arrow keys on the keyboard to select the desired profile.  If using the 
up/down arrows, press the Enter button to finalize your selection. 

THROTTLE SERVO REVERSE- 
Once you have decided which servo will control the throttle, this setting allows you 
to dictate whether or not to reverse the output of the throttle servo. 
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To make your selection, click the respective value box.  Select either Yes or No from 
the drop-down menu. 

TORQUE GENERATOR- 
For information pertaining to the Torque Generator features, functions, etc. please 
refer to the Torque Generator section located in the Edit Current 
Aircraft…Airplane section of this help file. 

WEIGHT OF MECHANICS- 
This setting allows you to adjust the weight of the mechanics, including the engine.  
Usually this accounts for 70-80% of the weight of the entire helicopter. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

TORQUE FROM ENGINE MODIFICATION (%) (ADVANCED)- 
This allows you to modify the torque curve of the engine without adjusting the 
individual points along the curves.  It provides a constant scaling factor throughout 
the curve. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)- 
The weight of the mechanics, including the engine, but not including any sub-parts 
listed under Heli Mechanics. 

CURRENT MASS WITH CHILDREN (READ ONLY)- 
The weight of the mechanics, including the engine and all other parts attached to the 
helicopter mechanics. 

CURRENT TORQUE GENERATOR RPM (RPM) (READ ONLY)- 
This value displays real-time RPM data.  Move the throttle up or down to see the 
effects of your input on the RPMs. 
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TAIL BOOM COMPONENT 
This component includes all the parameters for the tail boom and the option to add or 
remove tail specific components. 

To add a fin, or fins, or to eliminate the tail boom component, right click on the tail 
boom directory.  Next, select the desired option from the pull-down menu that 
appears. 

 

DIMENSIONS (DIAMETER)- 
This option controls the diameter, or width of the tail boom. 

To modify the diameter, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

DIMENSIONS (LENGTH)- 
This option controls the length of the tail boom. 

To modify the length, click the existing value.  Next, enter the desired value directly 
from the keyboard or via the mouse wheel. 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 
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The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with regards to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WEIGHT- 
This value specifies the weight of the tail boom. 

To modify the weight, click the existing value.  Next, enter the desired value directly 
from the keyboard or via the mouse wheel. 

COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item.  In the case of the tail boom, 
the Component Frame is ~CS_TAILBOOM1.  The components in a RealFlight G3.5 
aircraft are assembled using a component-frame hierarchy. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

STRENGTH MULTIPLIER (ADVANCED)- 
This value represents the strength or structural integrity of the tail boom.  If, for 
example, you wish to make the tail boom more susceptible to breakage, reduce the 
value of the Strength Multiplier. 

To modify the Strength Multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)- 
This indicates the mass of the tail boom only, not including any child components. 

It is not possible to manually adjust this value.  The various modifications made to 
the tailboom components control this value. 

CURRENT MASS WITH CHILDREN (READ ONLY)- 
This indicates the mass of the tail boom and any child components attached to it. 

It is not possible to manually adjust this value.  The various modifications made to 
the tail boom control this value. 

VERTICAL FIN- 
This component includes all the parameters for the vertical fin and the option to add 
or remove tail specific components. 

To add items to the vertical fin, or to eliminate it altogether, right click on the 
Vertical Fin directory.  Next, select the desired option from the drop-down menu that 
appears. 
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AIRFOIL AT ROOT- 
This setting determines which airfoil the vertical fin will utilize at the root.  The root 
of the tail is the section of the tail closest to the tail boom. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

AIRFOIL AT TIP- 
This setting determines which airfoil the vertical fin will utilize at the tip.  The tip of 
the tail is the section of the tail furthest from the tail boom. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

CHORD AT ROOT- 
This option adjusts the chord of the vertical fin at the root.  Chord is defined as the 
width of the surface; the root of the fin is the section closest to the fuselage.  A wider 
chord offers increased lift.  However, a wider chord also generates more drag when 
the aircraft rolls. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the fin. 
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CHORD AT TIP- 
This option adjusts the chord of the vertical fin at the tip.  The tip of the fin is the 
section furthest from the fuselage. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the fin. 

DIHEDRAL (DEG)- 
This option adjusts the dihedral of the vertical fin.  Dihedral is generally expressed in 
degrees.  It refers to the v-shaped bend in the fin when viewed from the front of the 
aircraft. 

To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the fin. 

INCIDENCE AT ROOT (DEG)- 
This setting adjusts the incidence of the vertical fin at the root where the vertical fin 
meets the fuselage.  Incidence is the fixed AOA, or angle of attack when the aircraft 
is at 0° angle of attack.  

To adjust the incidence, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the incidence. 

LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the vertical fin as measured from the leading 
edge. 

To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° corresponds 
to a fin with a straight leading edge.  As the leading edge sweep increases in value, 
the fin sweeps, or angles back towards the tail.  A negative value for the leading edge 
sweep will cause the fin to sweep forward towards the nose of the aircraft. 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with regards to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 
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WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the vertical fin.  
Washout is an intentional twist induced into the fin, which causes the tips to offer a 
lower angle of attack. 

To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values will increase the amount of washout. 

WEIGHT- 
This indicates the weight of the vertical fin.  

To adjust the weight of the fin, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

WING LENGTH- 
This value represents the length of the vertical fin itself.  The length does not reflect 
the dimensions of the Top. 

To modify the length of the vertical fin, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

COMPONENT FRAME (ADVANCED)- 
This value represents the Component Frame of the item; in this case, the vertical fin. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

FIT TO FRAME (ADVANCED)- 
To automatically adjust the wing measurements to fit the graphical model, click the 
more options button (the gray folder with the ellipsis).  The aircraft editor will 
calculate the best fit to the model. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the wing.  RealFlight 
uses the selected airfoil and numerous sophisticated algorithms to automatically 
calculate the lift generated at various angles of attack.  It is not normally necessary to 
adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft may need to have 
this value lowered.  Very draggy aircraft may perform more realistically when this 
value is increased. 
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POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%)(ADVANCED)- 
This value indicates the strength or ability of the vertical fin to resist damage.  
Increasing this value increases the strength of the fin. 

To adjust the strength of the fin, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the wings, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of the vertical fin. 

You may not manually adjust this value.  The various modifications made to the 
vertical fin control this value. 

CURRENT MASS WITH CHILDREN – 
This value represents the overall mass of the vertical fin, including any child 
components. 

You may not manually adjust this value.  The various modifications made to the fin 
determine this value. 

TOP- 
This component includes all the parameters for the top fin and the option to add or 
remove fin specific components. 

To add items to the top fin, or to eliminate it altogether, right click on the top fin 
directory.  Next, select the desired option from the pull-down menu that appears. 

AIRFOIL AT TIP- 
This setting determines which airfoil the vertical fin will utilize at the root.  The root 
of the tail is the section of the tail closest to the tail boom. 
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To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

CHORD AT TIP- 
This option adjusts the chord of the top fin at the tip.  The tip of the fin is the upper-
most section furthest from the tail boom. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the fin. 

DIHEDRAL (DEG)- 
This option adjusts the dihedral of the top fin.  Dihedral is generally expressed in 
degrees.  It refers to the v-shaped bend in the fin when viewed from the front of the 
aircraft. 

To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the fin. 

LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the top fin as measured from the leading edge. 

To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° corresponds 
to a fin with a straight leading edge.  As the leading edge sweep increases in value, 
the fin sweeps, or angles back towards the tail.  A negative value for the leading edge 
sweep will cause the fin to sweep forward towards the nose of the aircraft. 

WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the top fin.  Washout 
is an intentional twist induced into the fin, which causes the tips to offer a lower 
angle of attack. 

To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values will increase the amount of washout. 

WEIGHT- 
This indicates the weight of the top fin. 

To adjust the weight of the fin, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

WING LENGTH- 
This value represents the length of the top fin.  

To modify the length of the top fin, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 
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COMPONENT FRAME (ADVANCED)- 
This value represents the component frame of the item; in this case, the top fin.  
RealFlight G3.5 does not allow you to alter the component frame for the top fin. 

FIT TO FRAME (ADVANCED)- 
To automatically adjust the fin measurements to fit the graphical model, click the 
more options button (the gray folder with the ellipsis).  The aircraft editor will 
calculate the best fit to the model. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the wing.  RealFlight 
uses the selected airfoil and numerous sophisticated algorithms to automatically 
calculate the lift generated at various angles of attack.  It is not normally necessary to 
adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft, such as sailplanes, 
may need to have this value lowered.  Very draggy aircraft, such as a biplane with a 
radial engine, struts, and flying wires, may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value indicates the strength or ability of the top fin to resist damage.  Increasing 
this value will increase the strength of the fin. 
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To adjust the strength of the fin, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the fin, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of the top fin. 

You may not manually adjust this value.  The various modifications made to the top 
fin control this value. 

HORIZONTAL FIN- 
This component includes all the parameters for the horizontal fin and the option to 
add or remove tail specific components. 

To add items to the horizontal fin, or to eliminate it altogether, right click on the 
horizontal fin directory.  Next, select the desired option from the pull-down menu 
that appears. 

 

AIRFOIL AT ROOT- 
This setting determines which airfoil the horizontal fin will utilize at the root.  The 
root of the tail is the section of the tail closest to the tail boom. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the root is different from the airfoil at the tip, the two 
airfoils will blend along the length of the surface. 
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AIRFOIL AT TIP- 
This setting determines which airfoil the horizontal fin will utilize at the tip.  The tip 
of the tail is the section of the tail furthest from the tail boom. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

CHORD AT ROOT- 
This option adjusts the chord of the horizontal fin at the root.  Chord is defined as the 
width of the surface; the root of the fin is the section closest to the fuselage.  A wider 
chord offers increased lift.  However, a wider chord also generates more drag when 
the aircraft rolls. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the fin. 

CHORD AT TIP- 
This option adjusts the chord of the horizontal fin at the tip.  The tip of the fin is the 
section furthest from the fuselage. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the fin. 

DIHEDRAL (DEG)- 
This option adjusts the dihedral of the horizontal fin.  Dihedral is generally expressed 
in degrees.  It refers to the v-shaped bend in the fin when viewed from the front of 
the aircraft. 

To adjust the dihedral, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the dihedral or v-bend of the fin. 

INCIDENCE AT ROOT (DEG)- 
This setting adjusts the incidence of the horizontal fin at the root where the 
horizontal fin meets the fuselage.  Incidence is the fixed AOA, or angle of attack 
when the aircraft is at 0° angle of attack.  

To adjust the incidence, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  Larger 
values will increase the incidence. 

LEADING EDGE SWEEP (DEG)- 
This setting determines the sweep of the horizontal fin as measured from the leading 
edge. 

To adjust the sweep, click the existing value in the value box.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel.  A value of 0° corresponds 
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to a fin with a straight leading edge.  As the leading edge sweep increases in value, 
the fin sweeps, or angles back towards the tail.  A negative value for the leading edge 
sweep will cause the fin to sweep forward towards the nose of the aircraft. 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with regards to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

WASHOUT AT TIP (DEG)- 
This value dictates the amount of washout, or twist, at the tip of the horizontal fin.  
Washout is an intentional twist induced into the fin, which causes the tips to offer a 
lower angle of attack. 

To adjust the amount of washout, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values will increase the amount of washout. 

WEIGHT- 
This indicates the weight of one half of the horizontal fin.  

To adjust the weight of the fin, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

WING LENGTH- 
This value represents the length of one half of the horizontal fin.  That is, it is not the 
overall length of the horizontal fin. 

To modify the length of the horizontal fin, click the existing value in the value box.  
Next, enter the desired value either directly from the keyboard or via the mouse 
wheel. 

BREAK OFF TOGETHER (ADVANCED)- 
This option determines if both sides of the horizontal tail will fail simultaneously or 
if they will be treated as individual components.  Please note:  this option is only 
applicable to symmetrical components (e.g., main gear, wings, etc.). 

To determine whether the horizontal tail will be treated as one unit, click on the 
value.  From the pull-down menu, select Yes if you wish to have the components fail 
simultaneously. 
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COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the left half of 
the horizontal fin. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the item; in this case, the right half of 
the horizontal fin. 

Clicking on the respective value column will bring forth the drop-down menu 
selection of the various Component Frames. 

FIT TO FRAME (ADVANCED)- 
To automatically adjust the wing measurements to fit the graphical model, click the 
more options button (the gray folder with the ellipsis).  The aircraft editor will 
calculate the best fit to the model. 

OVERALL WING LIFT (ADVANCED)- 
This advanced property adjusts the amount of lift produced by the fin.  RealFlight 
uses the selected airfoil and numerous sophisticated algorithms to automatically 
calculate the lift generated at various angles of attack.  It is not normally necessary to 
adjust this value. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the component.  You may adjust RealFlight’s calculation to better 
match your expectations for the aircraft.  Some very sleek aircraft may need to have 
this value lowered.  Very draggy aircraft may perform more realistically when this 
value is increased. 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 
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To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value indicates the strength or ability of the horizontal fin to resist damage.  
Increasing this value will increase the strength of the fin. 

To adjust the strength of the fin, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the strength of the wings, making them more resistant to damage. 

CURRENT MASS OF SELF (READ ONLY) – 
This value represents the mass of one half of the horizontal fin. 

You may not manually adjust this value.  The various modifications made to the 
horizontal fins control this value. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY) – 
This value represents the combined mass of both halves of the horizontal fin.  

It is not possible to manually adjust this value.  The various modifications made to 
the horizontal fins control this value. 

TAIL ROTOR 
This component allows you to adjust all parameters for the tail rotor.  While many of 
these options are similar to the Main Rotor, a few are specific to the tail rotor. 

To remove the tail rotor from the helicopter, right click on the tail rotor listing.  
Select Delete Component. 
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AIRFOIL- 
This setting determines which airfoil to utilize for the tail rotor.  RealFlight includes 
over 1,500 different airfoils to from which to choose.  This data adds to the real-
world authenticity of the simulation. 

 
To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

CHORD AT ROOT- 
This option adjusts the chord of the tail rotor at the root.  The root of the tail rotor is 
the section that is closest to the tail rotor hub. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the tail rotor. 

CHORD AT TIP- 
This option adjusts the chord of the tail rotor at the tip.  The tip of the tail rotor is the 
section that is farthest from the tail rotor hub. 

To adjust the chord, click the existing value in the value box.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel.  Larger values will 
increase the chord of the tail rotor. 

DEFLECTION (CCW PIROUETTE) (DEG)- 
This value determines the amount of deflection, expressed in degrees, that causes a 
counter-clockwise pirouette of the helicopter. 
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To adjust the deflection, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

DEFLECTION (CW PIROUETTE) (DEG)- 
This value determines the amount of deflection, expressed in degrees, that causes a 
clockwise pirouette of the helicopter. 

To adjust the deflection, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

DIAMETER- 
This value determines the distance from the tip of one tail rotor blade to the tip of the 
opposite tail rotor blade.  This includes the tail rotor hub, etc. 

To adjust the diameter, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value moves the location up or down with regards to the parent.  A 
positive value moves the location up.  A negative value moves the location down. 

PERCENT DRIVEN IN AUTOS (%)- 
Choose whether the tail rotor receives power during auto rotations.  A value of 100% 
means the tail rotor turns if the main rotor is turning.  A value of 0% means that the 
tail rotor movement ceases during auto rotations.  A value in between indicates a 
partially driven tail. 

To adjust the drive percentage, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

PITCH SERVO- 
This setting indicates which servo (if any) controls the pitch input for the tail rotor. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 
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PITCH SERVO REVERSE- 
Once you have decided which servo controls the pitch input, this setting allows you 
to dictate whether to reverse the output of the servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

ROTATION AROUND BOOM (DEG)- 
This option determines the rotation of the tail rotor around the boom.  If set to zero, 
the tail rotor spins perpendicular or straight up and down.  

To adjust the rotation, click the existing value in the Value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  

TAIL ROTATES AGAINST DOWNWASH- 
This option determines whether the tail rotor will rotate against the downwash of the 
main rotor blades. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

TAIL ROTOR VOLUME (%)- 
This value determines the sound volume of the tail rotor blades.  Please note:  this 
change does not impact the volume of the engine. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

TAIL TO MAIN ROTOR RATIO- 
This value indicates the number of rotations that the tail rotor blades make in 
comparison to the main blades.  If the ratio is 6, this means that the tail rotor spins 
six times for every one time that the main rotor blade rotates. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

VISUAL BLADE TYPE- 
This setting determines the appearance of the tail rotor blades.  G3.5 offers a number 
of blades to select amongst, each with their own unique look.  Please note: this is 
only a graphical option.  It will not affect the helicopter’s flight performance. 

To select a new blade visual, click the value box for the existing profile. In the pull-
down menu, use either the Up/down arrow keys on the keyboard, or the mouse to 
select the desired option.  If using the arrow keys, press Enter to finalize your 
selection. 

HUB GRAPHICAL NAME (ADVANCED)- 
This setting determines the graphical representation of the hub utilized in the 
simulation.  Please note:  this setting does not have an affect on the physics, only on 
the appearance of the hub. 
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To select the desired hub graphic, click on the respective value.  Using either the 
up/down arrow keys on the keyboard, or the mouse, select the graphic for your 
simulation from the pull-down list.  If using the up/down arrow keys, press Enter to 
finalize your selection. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the airfoil 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the airfoil.  You may adjust RealFlight’s calculation to better match 
your expectations for the aircraft 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value represents the strength or structural integrity of the tail rotor.  If you wish 
to make the tail rotor more susceptible to breakage, reduce the value of the strength 
multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)- 
This indicates the mass of the tail rotor only.  It does not include any of the child 
components. 

It is not possible to manually adjust this value.  Rather, this value is controlled by the 
various modifications made to the tailboom components, etc. 

PIROUETTE DIRECTION (READ ONLY)- 
Looking from the top of the helicopter, this value displays the direction the 
helicopter will rotate with the current tail rotor deflection input from the radio. 
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SKIDS COMPONENT 
This component controls the behavior of skids on a helicopter.  If you wish to make 
modifications to the skids settings of your aircraft, click the Skids option. 

If you wish to eliminate the skids from the aircraft, right click on the Skids 
component and click the Delete Component dialog that appears.  Next, click Yes in 
the verification box. 

 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the Value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value is used to move the location up or down with regards to the parent.  
A positive value will move the location up.  A negative value will move the location 
down. 

ROTATION ABOUT Y (DEG)- 
This value determines the angle of the skids on the helicopter at their attachment 
point on the fuselage.  Increasing the value causes the skids to spread out more. 

To modify the angle, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 
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SKID HEIGHT- 
This value determines the height of the skids as measured from the attachment point 
on the helicopter. 

To modify the height, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

SKID WIDTH- 
This value determines the width of the skids.  That is, the actual length of the skids. 

To modify the width, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

STIFFNESS (%)- 
This option allows you to determine the ‘springiness’ of the skids.  Higher values 
mean that the skids are relatively stiff.  If your skids are ‘springy’, we suggest 
lowering the values. 

To adjust the stiffness of the skids, click the respective value.  Next, enter the desired 
value either directly from the keyboard or via the mouse wheel. 

WEIGHT- 
Specifies the weight of the skids. 

BREAK OFF TOGETHER (ADVANCED)- 
This option determines if the skids will fail simultaneously or if they will be treated 
as individual components. 

To determine whether the skids will be treated as one unit, click on the value.  From 
the pull-down menu, select Yes if you wish to have the components fail 
simultaneously. 

COMPONENT FRAME (LEFT) (ADVANCED)- 
This value represents the component frame of the item.  In the case of the left skid, 
the Component Frame is ~CS_LEFTSKID.  The components in a RealFlight G3.5 
aircraft are assembled using a component-frame hierarchy. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 

COMPONENT FRAME (RIGHT) (ADVANCED)- 
This value represents the component frame of the item.  In the case of the right skid, 
the Component Frame is ~CS_RIGHTSKID.  The components in a RealFlight G3.5 
aircraft are assembled using a component-frame hierarchy. 

Clicking on the respective value column will bring forth the pull-down menu 
selection of the various Component Frames. 
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STRENGTH MULTIPLIER (%) (ADVANCED)- 
This value represents the strength or structural integrity of the skids.  If you wish to 
make the skids less susceptible to breakage, increase the value of the strength 
multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

CURRENT MASS OF SELF (READ ONLY)- 
This indicates the mass of the skid only, not including any child components. 

It is not possible to manually adjust this value.  Rather, this value is controlled by the 
various modifications made to the skids. 

CURRENT MASS OF SELF (BOTH SIDES) (READ ONLY)- 
This indicates the mass of both skids together, not including any child components. 

It is not possible to manually adjust this value.  The various modifications made to 
the skids control this value. 

EXHAUST- 
If you wish to make modifications to the exhaust settings of your aircraft, click the 
Exhaust option. 

If you wish to eliminate the exhaust from the aircraft, right click on the Exhaust 
component and click the Delete Component dialog that appears.  Next, click Yes in 
the verification box. 

 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 
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To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value is used to move the location up or down with regards to the parent.  
A positive value will move the location up.  A negative value will move the location 
down. 

MINIMUM SMOKE PERCENT (%)- 
This value indicates the minimum amount of smoke generated by the helicopter 
regardless of the servo position. 

To refine this minimum smoke, click the existing value in the value box.  Next, enter 
the desired value either directly from the keyboard or via the mouse wheel. 

SMOKE COLOR- 
To modify this setting, click on the respective value.  Click the more options button 
(the gray folder with the ellipsis) to bring forth the palette of available colors.  This 
will reveal a screen that appears as follows: 

 
To select a color, click the desired color on the palette.  If you wish to make a 
custom color, click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected color will be 
reflected immediately in the value column. 

SMOKE LIFE SPAN (SEC)- 
This indicates the length of time that the smoke remains on the screen.  A lower 
value means that the smoke disappears rapidly.  
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To refine the life span, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

SMOKE ON/OFF SERVO- 
This option indicates which servo (if any) controls the activation of the smoke. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SMOKE QUANTITY SERVO- 
This option determines which servo controls the smoke quantity. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SMOKE QUANTITY SERVO REVERSE- 
Once you have decided which servo controls the smoke quantity, this setting allows 
you to dictate whether to reverse the output of the smoke servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

SMOKE SIZE RATE (%)- 
This option adjusts the speed at which the smoke expands. 

To modify the size rate, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value indicates that the smoke will expand faster. 

STARTING OPACITY (%)- 
This value indicates the opacity of the smoke at its starting point. 

To modify the opacity, click the existing value in the Value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value means that the smoke is thicker when it first appears on the screen. 

STARTING SIZE- 
This value defines the starting size of the smoke. 

To modify the starting size, click the existing value in the value box.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel.  A larger 
value increases the diameter of the smoke initially. 

MAIN ROTOR COMPONENT 
 

These are the settings and values for the main rotor of the helicopter.  The main rotor 
is an integral component.  Without it the helicopter cannot leave the ground. 
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To delete this component, right click on the main rotor listing.  Select Delete 
Component. 

 

BLADE SPIN DIRECTION (FROM ABOVE)- 
This parameter specifies the direction the rotor will spin, when viewing it from 
above the helicopter. 

This value can be changed to Clockwise or Counter-Clockwise. 

Blade Type- 
The rotor blades have a tremendous impact on the flight characteristics of the 
helicopter.  This setting allows you to select the type of rotor blades used by the 
helicopter. 

G3.5 offers a number of preset rotor blades for use during the simulation.  You may 
also create custom rotor blades. 

To select an alternative pair of rotor blades, click on the respective value box.  Next, 
click the more options button (the gray folder with the ellipsis) to bring forth the 
available options.  Use either the Up/down arrow keys on the keyboard, or the mouse 
to select the desired option. 

Creating Custom Rotor Blades- 

RealFlight includes a variety of real-world rotor blade data pertaining to many of the 
most popular rotor blades available.  This data brings real-world performance to the 
simulation. 

Copy- 

This option duplicates the information and data pertaining to the currently selected 
rotor blades.  This is the first step in creating customized rotor blades. 
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To copy the rotor blades, click Copy.  Next, enter a name for the new blades.  After 
you have entered the desired name, click OK.  This name will now appear in the 
listing of available rotor blades 

Rename- 

This option allows the user to rename a user-created rotor blade profile. 

To do so, highlight the desired profile and click Rename.  Enter the new name for 
this rotor blade in the dialog provided.  After you have entered the desired name, 
click OK.  The blades will now appear in the listing of available rotor blades. 

Delete- 

As the name suggests, this option deletes a rotor blade profile. 

Please note:  users are only allowed to delete rotor blades that they have created.  
That is, you are not allowed to eliminate default rotor blades. 

To delete a user-created profile, select the respective profile.  Next, click Delete.  If 
you wish to eliminate this rotor blade profile, click Yes in the verification dialog.  

BLADE LENGTH- 
This setting represents the length of one half of the main rotor blades.  That is, this 
represents the length of only one blade.  This measurement is taken from the blade 
bolt hole to the tip of the rotor blade. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

ROTOR ROOT CHORD- 
This value determines the chord of the main rotor blades at the root of the blade.  
The root is the section of the blade closest to the rotor hub. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

ROTOR TIP CHORD- 
This value represents the chord of the main rotor blade at the tip of the blades.  The 
tips is the section of the rotor blade farthest from the center of the rotor hub. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

ROOT AIRFOIL- 
This setting determines which airfoil to use at the root of the rotor blade. 

To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Note:  if the airfoil at the tip is different from the airfoil at the root, the two airfoils 
will blend along the length of the surface. 

TIP AIRFOIL- 
This setting specifies the airfoil at the tip of the rotor blade. 
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To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Note:  if the airfoil at the root is different from the airfoil at the tip, the two airfoils 
will blend along the length of the surface. 

BLADE WEIGHT WITH LEAD- 
This is the overall weight of one of the rotor blades.  Please note:  this weight 
includes any lead that has been added to the rotor blades. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

WEIGHT OF LEAD- 
This value represents the weight of the lead blades utilized in the rotor blades.  If the 
blades are unweighted, this value should be set to zero. 

You may calculate the weight of a cylindrical piece of lead using the formulas 
below: 

SAE- weight = 20.52 x radius in inches x radius in inches x length inches 

Metric- weight = 35.5 x radius in centimeters x radius in centimeters x length 
centimeters 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE FROM TIP TO LEAD- 
This value represents the distance from the outer tip of the blade to the closest tip of 
the lead weight in the blade. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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LENGTH OF LEAD- 
This value represents the actual length of the lead weight, if any, present in the rotor 
blade. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

 

WASHOUT- 
This setting determines the amount of twist in the rotor blades.  A small amount of 
washout will improve the hovering and upright flight characteristics of the 
helicopter.  Unfortunately, this is at the expense of performance in inverted flight 
maneuvers. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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BLADE FLEX- 
This setting determines how much torque is generated per degree of blade flex.  
Higher values mean that the rotor blade is stiffer. 

To input the proper amount of blade flex, we suggest measuring your existing pair of 
rotor blades.  Click the more options button (the gray folder with the ellipsis) to 
bring forth the Torque options.  If known, you may enter the Torque value directly 
into the respective value box.  If you do not know this figure, G3.5 will calculate this 
for you using the procedure below. 

Measuring blade flex: 

1. Remove one of the rotor blades from your actual R/C helicopter. 

2. Clamp the end of the blade that attaches to the hub to the end of the 
table.  Use a soft clamp or one with rubber ends to prevent from 
damaging your blades.  Only use enough clamping force to hold the 
blade in place.  Approximately 95% of the blade should hang over the 
edge of the table. 

3. Measure the distance from the tip of the blade to the ground. 

4. Add mass to the blade tip (around 100-200 grams, enough to get a good 
reading, but not enough to break anything!).  

5. Again, measure the distance from the tip of the blade to the ground. 

6. Enter the mass used in the weight category. 

7. Take the total distance traveled and enter this value into the deflection 
category. 

8. Take the distance from the weight to the clamp and enter it into the 
arm category. 

Please note:  exercise extreme caution to not damage your rotor blade when 
performing these tasks.  Neither Great Planes nor Knife Edge Software will be 
responsible for any consequential damages to your equipment. 

COLLECTIVE PITCH (MAX (DEG))- 
This setting determines the amount of blade deflection caused by a full collective 
input.  For example, a value of 10 degrees means that the blades will deflect 10 
degrees positive when the transmitter stick moves to its complete range of motion.  
Please note:  if the rotor blade design incorporates washout, then the deflections 
should be measured at the root of the rotor blade. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel.  This is generally a positive 
value. 

COLLECTIVE PITCH (MIN) (DEG)- 
This setting determines the amount of blade deflection that taking out all of the 
collective input will cause.  For example, a value of -10 degrees means that the 
blades will deflect 10 degrees negative when the transmitter stick is moved to its 
complete range of motion.  Please note:  if the rotor blade design incorporates 
washout, then the deflections should be measured at the root of the rotor blade. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel.  This is generally a negative 
value. 
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COLLECTIVE SERVO- 
This setting is used to indicate which servo, if any, controls the collective pitch input. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

COLLECTIVE SERVO REVERSE- 
Once you have decided which servo will control the collective, this setting allows 
you to dictate whether or not to reverse the output of the collective servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

CYCLIC PITCH DEFLECTION (DEG)- 
This setting indicates the amount of blade deflection that a full cyclic pitch input will 
cause.  A value of seven, for example, causes the blades to deflect seven degrees 
positive and seven degrees negative.  This assumes that there is 100% servo travel in 
both directions.  

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

CYCLIC ROLL DEFLECTION (DEG)- 
This setting indicates the amount of blade deflection caused by a full cyclic roll 
input.  A value of seven, for example, causes the blades to deflect seven degrees 
positive and seven degrees negative.  This assumes that there is 100% servo travel in 
both directions. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE FROM FLAP TO LEAD LAG- 
This value represents the measurement of the distance from where the blade flaps 
hinge to the lead lag bolt itself. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE FROM HUB CENTER TO FLAP HINGE- 
This value represents the measurement of the distance from the center of the hub to 
the flap hinge. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FLAP ANGLE (MAX) (DEG)- 
This value represents the angle that the blades are allowed to flap freely, in an 
upward direction, beyond the static coning angle before encountering resistance from 
the hubs.  For example, a value of five allows the blade to flap upward by five 
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degrees.  Please note:  helicopters that utilize damped flaps generally have a value of 
zero.  This is because the rotor blades will encounter resistance almost immediately. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FLAP ANGLE (MIN) (DEG)- 
This value represents the maximum angle that the blades are allowed to flap freely, 
in a downward direction, beyond the static coning angle before encountering 
resistance from the hubs.  For example, a value of five allows the blade to flap 
downward by five degrees.  Please note: helicopters that utilize damped flaps 
generally have a value of zero.  This is because the rotor blades will encounter 
resistance almost immediately. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

INITIAL AZIMUTH (DEG)- 
This setting adjusts the azimuth of the rotor blades.  That is, this setting determines 
the staggering rotations for multi-bladed helicopters.  This is important for aligning 
multiple rotors in a multiple rotor helicopter.  Please note:  two-bladed helicopters 
should be set to zero. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

LOCATION IN PARENT- 
This value represents the location of the item in regards to the parent or main object. 

To modify the location of the item, click the existing value in the value box.  Next, 
enter the desired value either directly from the keyboard or via the mouse wheel. 

The X-axis value represents a movement, left or right, with regards to the parent 
object.  A negative value will shift the location to the left.  A positive value will shift 
the location to the right. 

The value of the Y-axis represents a movement forward or backward with regards to 
the parent object.  A negative value shifts the location rearward.  A positive value 
shifts the location forward.  

The Z-axis value is used to move the location up or down with regards to the parent.  
A positive value will move the location up.  A negative value will move the location 
down. 

PITCH SERVO- 
This setting specifies which servo, if any, controls the pitch input. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  227 

PITCH SERVO REVERSE- 
Once you have decided which servo controls the collective, this setting allows you to 
dictate whether to reverse the output of the collective servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

ROLL SERVO- 
This setting specifies which servo (if any) controls the roll input. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

ROLL SERVO REVERSE- 
Once you have decided which servo controls the roll, this setting allows you to 
dictate whether or not to reverse the output of the roll servo. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

ROTOR SOUND- 
The setting here dictates the rotor sound profile used by this particular helicopter.  
G3.5 includes a multitude of actual recording choices. 

 
To select a profile, click the value box for the existing profile.  Use either the 
Up/down arrow keys on the keyboard, or the mouse to select the desired option from 
the pull-down menu.  If using the arrow keys, press Enter to finalize your selection. 
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ROTOR SOUND VOLUME (%)- 
This value determines the volume of the rotor blades.  Please note:  this change does 
not affect the volume of the engine; that is adjusted separately. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

VISUAL BLADE TYPE- 
This setting determines the appearance of the main rotor blades.  G3.5 offers a 
number of blades to select amongst, each with their own unique look.  Please note:  
this is only a graphical option.  It will not affect the helicopter’s flight performance. 

To select a new blade visual, click the value box for the existing profile.  Use either 
the Up/down arrow keys on the keyboard, or the mouse to select the desired option.  
If using the arrow keys, press Enter to finalize your selection. 

DELTA OFFSET (DEG) (ADVANCED)- 
This setting represents the pitch degree per degree of flap.  When the rotor blade 
flaps up and down, the angle of attack (AOA) may change because of the mechanical 
linkages between the hub and the rotor blade itself. 

To determine this value, utilize a pitch gauge and measure the angle at full minimum 
flap and again at full maximum flap of the blade.  Divide by the total number of 
degrees of flap of the blade.  Usually this is a negative number that yields a 
dampening effect.  Positive numbers will make the helicopter more aggressive. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

HEAD STIFFNESS (ADVANCED)- 
This value represents the amount of torque generated per degree of flexing of the 
hub.  The higher the value, the stiffer the rotor head. 

To input the proper amount of stiffness, we suggest measuring your existing pair of 
rotor blades.  Click the more options button (the gray folder with the ellipsis) to 
bring forth the Torque options. If known, you may enter the Torque value directly 
into the respective value box.  If you do not know this figure, G3.5 will calculate this 
for you using the procedure below. 

For Articulating Hubs  

1. Measure the blade flex as described previously.  

2. Put the helicopter on a flat, hard surface.  Position the blades so they 
are in the front and back of the helicopter. 

3. Measure the distance from the tip of the front blade to the ground. 

4. Now put an equal mass on both blade tips (around 100-200 grams, 
enough to get a good reading, but not enough to break anything!).  
Make sure the helicopter does not move or tilt when you do this.  Use 
the same mass that you used when you measured the blade flex. 

5. Measure the distance from the tip of the front blade to the ground. 

6. Enter this value into the Mass category. 
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7. Take the total distance traveled, subtract the distance traveled by the 
blade, and enter that value into the Deflection category.  This cancels 
out any deflection caused by the bending of the blade. 

8. Take the distance from the weight to the flapping hinge and enter it into 
the Arm category.  

For Solid Axle Hubs 

1. Remove the blades from the hub. 

2. Put the helicopter on a flat, hard surface. Position the rotor head so that 
the hub blanks are in the front and back of the helicopter. 

3. Measure the distance from the tip of the hub to the ground.  

4. While holding the helicopter perfectly still, take a spring scale and pull 
the tip of the hub down. 

5. While holding the hub in this position, measure the distance from the 
tip of the front hub to the ground.  

6. Take the reading on the spring scale and enter that value into the 
Weight category.  

7. Take the total distance traveled and enter that into the deflection 
category.  

8. Take the distance from where the weight was attached to the center of 
the hub and enter it into the Arm category.  

HUB GRAPHICAL NAME (ADVANCED)- 
This setting determines the graphical representation of the hub utilized in the 
simulation. 

Some of the scale helicopters have multiple hubs that you can select.  Please note:  
this setting does not have an affect on the physics, only on the appearance of the hub. 

To select the desired hub graphic, click on the existing selection in the value box to 
bring up the pull-down menu selections.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired option.  If using the arrow keys, press 
Enter to finalize your selection. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the airfoil 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the airfoil.  You may adjust RealFlight’s calculation to better match 
your expectations for the aircraft 

POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 
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SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

STATIC CONING ANGLE (DEG) (ADVANCED)- 
This value represents the coning angle of the rotor blades with the helicopter at rest.  
This value is usually zero or close to zero. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

STRENGTH MULTIPLIER (%)(ADVANCED)- 
This value represents the strength or structural integrity of the main rotor.  If you 
wish to make the main rotor more susceptible to breakage, reduce the value of the 
strength multiplier. 

To modify the strength multiplier, click the existing value.  Next, enter the desired 
value directly from the keyboard or via the mouse wheel. 

COLLECTIVE PITCH (DEG) (READ ONLY)- 
This setting displays real-time data for the collective pitch.  Move the collective 
control on the radio to see this value change. 

CURRENT MASS WITH CHILDREN (READ ONLY)- 
This it the current weight of the main rotor blade include any other items that are 
attached to it. 

CURRENT ROTOR RPM (RPM) (READ ONLY)- 
This setting displays the real-time data for the rotor blade RPM’s.  Movement of the 
throttle stick will vary the current RPM’s. 

CYCLIC PITCH (FORE/AFT) (DEG) (READ ONLY)- 
This setting displays real-time cyclic data for the fore and aft controls.  Move the 
cyclic control on the radio to see this value change. 

CYCLIC PITCH (LEFT/RIGHT) (DEG) (READ ONLY)- 
This setting displays real-time cyclic data for the left and right direction.  Move the 
cyclic control on the radio to see this value change. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  231 

PADDLES COMPONENT 
This component represents the flybar and flybar paddles attached to the main rotor 
component for the helicopter. 

To eliminate the flybar paddles from the helicopter, right click on the Paddles listing.  
Select Delete Component. 

 

AIRFOIL- 
This setting determines which airfoil to utilize for the paddles.  RealFlight includes 
over 1,500 different airfoils to from which to choose.  This data adds to the real-
world authenticity of the simulation. 



232  •  Chapter 7.  The Aircraft Menu R/C Simulator RealFlight 

 
To select an airfoil, click the value for the existing airfoil.  Next, click the more 
options button (the gray folder with the ellipsis). This brings forth an alphabetically 
organized list of airfoils for you to select. 

Please note:  if the airfoil at the tip is different from the airfoil at the root, the two 
airfoils will blend along the length of the surface. 

CYCLIC PITCH DEFLECTION (DEG)- 
This setting indicates the amount of paddle deflection caused by a full cyclic pitch 
input.  A value of seven causes the paddles to deflect seven degrees positive and 
seven degrees negative.  This assumes that there is 100% servo travel in both 
directions. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

CYCLIC ROLL DEFLECTION (DEG)- 
This setting indicates the amount of paddle deflection caused by a full cyclic roll 
input.  A value of seven causes the paddles to deflect seven degrees positive and 
seven degrees negative.  This assumes that there is 100% servo travel in both 
directions.  

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FLAP ANGLE (MAX) (DEG)- 
This value represents the maximum angle that the paddles are allowed to flap freely, 
in an upward direction, beyond the static coning angle before encountering resistance 
from the hubs.  For example, a value of five allows the paddles to flap upward by 
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five degrees.  Please note:  helicopters that utilize damped flaps generally have a 
value of zero.  This is because the paddles encounter resistance almost immediately. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FLAP ANGLE (MIN) (DEG)- 
This value represents the angle that the paddles are allowed to flap freely, in a 
downward direction, beyond the static coning angle before encountering resistance 
from the hubs.  For example, a value of five allows the paddles to flap downward by 
five degrees.  Please note:  helicopters that utilize damped flaps generally have a 
value of zero.  This is because the paddles encounter resistance almost immediately. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

FLYBAR DIAMETER- 
This setting adjusts the diameter (thickness) of the flybar rod.  Most .30-sized 
helicopters use flybar that is 3 mm in diameter.  A .60-sized heli will generally 
include a 4 mm flybar. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

HEIGHT OF PADDLES- 
This value determines the height of the paddles relative to the main rotor.  If the 
paddles are situated below the main rotor, the value will be a negative number.  If the 
paddles are above the main rotor, this value will be positive. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

MIXING RATIO (%)- 
This value determines the amount of flapping that the flybar paddles affects the pitch 
of the main rotor blades, expressed as a ratio. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

PADDLE CHORD- 
This value represents the average width, or chord, of the flybar paddles. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

PADDLE LENGTH- 
This value represents the length of one of the flybar paddles. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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PADDLE WEIGHT - 
This value determines the weight of one of the flybar paddles.  Generally, heavier 
paddles offer increased stability, particularly in forward flight.  However, heavier 
paddles have a negative impact on aerobatic performance. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

STATIC INCIDENCE (DEG)- 
This setting determines the incidence of the flybar paddles when the helicopter is at 
rest.  Typically, this value will be set at, or near zero degrees.  There are some fixed 
pitch helicopters that use a positive incidence. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

TOTAL PADDLE SYSTEM DIAMETER- 
This value represents the distance from the tip of one paddle to the tip of the opposite 
paddle.  That is, it is the overall length of the paddles and the respective flybar on the 
helicopter. 

To modify this setting, click the respective value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

VISUAL BLADE TYPE- 
This setting determines the appearance of the flybar paddles.  G3.5 offers a number 
of flybar paddles to select amongst, each with a unique look.  Please note:  this is 
only a graphical option.  It does not affect the flight performance of the helicopter. 

To select a new paddle visual, click the value box for the existing profile.  Next, 
select the desired profile from the pull-down list that appears.  Use either the 
Up/down arrow keys on the keyboard, or the mouse to select the desired option from 
the pull-down menu.  If using the arrow keys, press Enter to finalize your selection. 

HUB GRAPHICAL NAME (ADVANCED)- 
This setting determines the graphical representation of the hub utilized in the 
simulation. 

Some of the scale helicopters have multiple hubs that you can select.  Please note:  
this setting does not have an affect on the physics, only on the appearance of the hub. 

To select the desired hub graphic, click on the existing selection in the value box to 
bring up the pull-down menu selections.  Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired option.  If using the arrow keys, press 
Enter to finalize your selection. 

PARASITIC DRAG FACTOR (ADVANCED)- 
This advanced property adjusts the amount of parasitic drag generated by the airfoil 
component.  RealFlight normally calculates this value based on the dimensions and 
overall shape of the airfoil.  You may adjust RealFlight’s calculation to better match 
your expectations for the aircraft 
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POST-STALL MOMENT FACTOR (ADVANCED)- 
Since most airfoil tables do not include data for extremely high angles of attack, 
RealFlight is forced to make certain assumptions about the aerodynamic coefficients 
associated with the post-stall flight regime.  The “post-stall” properties adjust these 
assumptions and can be useful in correcting flight behavior near or beyond the stall 
angle. 

SNAP-ROLL BOOST FACTOR (ADVANCED)- 
This advanced property modifies the depth of the stall valley on the descending wing 
in a snap roll.  It is not normally necessary to adjust this value, but it can be useful to 
either increase or decrease the snap roll potential of an aircraft. 

STALL SEVERITY (ADVANCED) – 
This advanced parameter modifies the depth and abruptness of the post-stall loss of 
lift. 

To modify the stall severity, click the existing value.  Next, enter the desired value 
directly from the keyboard or via the mouse wheel. 

CURRENT MASS WITH CHILDREN (READ ONLY)- 
This is the current weight of the paddles including any other objects attached to 
them. 

CURRENT ROTOR RPM (RPM) (READ ONLY)- 
This setting displays real-time RPM data of the Rotor.  Making changes to the 
paddles can affect the RPM. 

ELECTRONICS- AIRPLANE AND HELICOPTER 
The Electronics folder allows you to modify a multitude of information pertaining to 
the aircraft’s electronics items and their respective functionality. 

ADDING ITEMS TO THE ELECTRONICS- 
To add components (e.g., servo, gyro, etc.) to the electronics offerings, right click on 
Electronics.  Next, select the desired option from the pull-down menu. 

Alternatively, with the electronics directory highlighted, click the Edit menu.  This 
will bring forth the list of available options. 
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You may add a variety of items to the Electronics of your aircraft.  Item availability 
is based upon a number of factors such as aircraft genre, design specifications, etc.  
Each added item offers the same features, functionality, etc. as the items that are 
commonly found on the aircraft.  For example, when adding a Physical Servo, you 
will be able to select the input and the Servo Speed. 

Add Physical Servo - Adds a servo to the aircraft. 

Add Gyro - Adds a gyro to the airplane. 

Add AFS Gyro - Adds the Active Flight Stabilization system to your aircraft. 

Add Fixed Output Servo - Adds a servo that employs a fixed output. 

Add Governor - Adds a governor to the aircraft.  This is useful for controlling the 
RPM’s (speed) of the aircraft. 

Add Servo Mixer - Adds a servo mixer to the aircraft. 

Add Wave Generator -  Adds a Wave Generator to the aircraft. 

Add Signal Modifier -  Adds a Signal Modifier to the aircraft. 

SERVOS- 
All servos in RealFlight offer the same functionality.  As such, this help file covers 
one specific example. 
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INPUT FOR THIS SERVO- 
This option determines which servo controls the respective channel.  In our example, 
Channel 1 on the receiver controls the right aileron. 

To change the input, click on the value (e.g., Receiver Channel 1).  Next, select the 
desired option from the pull-down menu. 

Please note:  it is important to pay attention to the assigned channels.  Failure to do 
so may cause conflicting input.  Therefore, the results may not be the original 
intention.  If, for example, you alter the input value to Receiver Channel 2, each time 
the elevator input is given, the right aileron will respond. 

To select a servo, click the existing selection in the value box to bring up the pull-
down menu selections.  Use either the Up/down arrow keys on the keyboard, or the 
mouse to select the desired option.  If using the arrow keys, press Enter to finalize 
your selection. 

SERVO SPEED- 
This setting determines the speed of the servo’s response time in seconds per 60° of 
rotation. 

To increase the servo speed, click on the existing value.  Next, input the desired 
value directly from the keyboard or via the mouse wheel.  Increasing the numerical 
values decreases the servo speed.  Conversely, lower numerical values serve to 
increase the speed of the servo. 

CURRENT OUTPUT (READ ONLY)- 
The value reflects the status of the output for the respective servo.  This is a real-time 
output value.  As such, deflecting the respective control will vary this value. 

You may not manually adjust this value. 
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SERVO MIXER 
The Electronics component mixes or combines servos accordingly. 

 

INPUT 1- 
This value determines the first input selection for the Servo Mixer. 

To determine Input 1, click the existing value.  Next, select the desired input channel 
from the pull-down menu. 

REVERSE 1- 
This value determines whether or not to reverse the Input 1 value. 

To do so, click the existing value.  Select Yes from the pull-down menu to reverse 
the value. 

STRENGTH 1- 
This value sets the scale percentage for Input 1.  A setting of 100% represents a 
100%, or a 1:1 ratio.  A setting of 200% means that the input will be 2:1. 

To adjust the strength, click on the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

INPUT 2- 
This value determines the second input selection for the Servo Mixer. 

To determine Input 2, click the existing value.  Next, select the desired input channel 
from the pull-down menu. 
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REVERSE 2- 
This value is used to determine whether or not to reverse the Input 2 value. 

To do so, click the existing value.  Select Yes from the pull-down menu to reverse 
the value. 

STRENGTH 2- 
This value determines the scaling percentage for Input 2.  A setting of 100% means 
that it will be a 100%, or a 1:1 ratio.  A setting of 200% means that the input will be 
2:1. 

To adjust the strength, click on the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

CURRENT OUTPUT (READ ONLY)- 
The value here reflects the status of the output for the respective servo.  This is a 
real-time output value.  As such, deflecting the respective control will vary this 
value. 

You may not manually adjust this value.  

GYRO- 
A gyroscope, or gyro as they are frequently called, is utilized to dampen the controls 
of an aircraft.  It is ideal for assisting in the stabilization of the aircraft. 

AXIS TO DAMPEN- 
 This value determines which axis the gyro will respond to. 

To change the value, click the existing value.  Next, select the desired axis 
from the pull-down menu. 

CONTROL INPUT- 
This parameter determines which servo is used to control the gyro.  
Normally, this would be the rudder or elevator servo. 

To change the value, click the existing value.  Next, select the desired 
control from the pull-down menu. 

GAIN INPUT- 
This value determines the input that controls both the gain and the 
operational mode of the gyro. 

To select the Gain Input, click the existing value.  Next, select the desired 
Gain Input control from the pull-down menu. 

RATE GAIN- 
This value sets the rate, or amount of dampening, for the gyro.  Increased 
values provide increased dampening of movement upon the axis selected. 

To adjust the gain, click on the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 
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CONTROL OVERRIDE- 
This value determines the amount of input necessary before the controller 
(or other input device) will override the gyro gain.  For example, this could 
be utilized to eliminate gyro control during severe rudder deflections. 

To adjust the override, click on the existing value.  Next, input the desired 
value directly from the keyboard or via the mouse wheel. 

GYRO REVERSE- 
This value determines whether to reverse the compensation from the gyro.  
Utilize this setting if the gyro accelerates the rotation of the given axis 
rather than dampening it as it should. 

To do so, click the existing value.  Select Yes from the pull-down menu to 
reverse. 

HEADING HOLD MIX- 
This value controls the amount of dampening when the heading hold gyro is 
active.  

To adjust the percentage, click on the existing value.  Next, input the 
desired value directly from the keyboard or via the mouse wheel. 

HEADING HOLD GAIN- 
This value is used to control the amount of dampening when utilizing the 
heading hold gyro. 

To adjust the percentage, click on the existing value.  Next, input the 
desired value directly from the keyboard or via the mouse wheel. 

HEADING HOLD ARRESTING GAIN- 
This value controls the amount of gain necessary to stop the respective 
movement.  Slower tail rotor servos use higher values. 

To adjust the percentage, click on the existing value.  Next, input the 
desired value directly from the keyboard or via the mouse wheel. 

HEADING HOLD ROTATION RATE- 
This value dictates the speed of the model’s rotation with full input.  For 
example, a value of 100 indicates that the model will rotate 100 degrees per 
second when full stick input is induced. 

To adjust, click on the existing value.  Next, input the desired value directly 
from the keyboard or via the mouse wheel. 

HEADING HOLD ROTATION ACCELERATION- 
This value determines how quickly the model accelerate in the rotation 
direction.  A higher value means that the model will accelerate more rapidly 
in the rotation.  

To adjust, click on the existing value.  Next, input the desired value directly 
from the keyboard or via the mouse wheel. 
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HEADING HOLD RANGE- 
This value determines the amount of error, or drift, which occurs before the 
gyro disregards the course. 

To adjust, click on the existing value.  Next, input the desired value directly 
from the keyboard or via the mouse wheel. 

CURRENT OUTPUT (READ ONLY)- 
The value here reflects the status of the output for the respective servo.  
This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value. 

CURRENT GAIN FROM TX (READ ONLY)- 
This value reflects the current gain amount.  This is controlled by the Gain 
Input Servo. 

This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value. 

CURRENT RATE GAIN (READ ONLY) - 
This value reflects the current gain amount as received from the Rate Gain 
Settings. 

This is a real-time output value. You may not manually adjust this value. 

CURRENT HEADING HOLD GAIN (READ ONLY) -  
This value reflects the Heading Hold Gain when the Heading Hold gyro is 
activated. 

This is a real-time output value. You may not manually adjust this value. 

AFS GYRO- 
The Active Flight Stabilization system allows the aircraft to return to straight and 
level flight. 

AXIS TO OPERATE IN- 
This determines which axis as well as the direction in which to point the 
sensor for the AFS system. 

To determine the axis and direction, click the existing value.  Next, select 
the desired setting from the pull-down menu. 

CONTROL INPUT- 
This value determines which input controls the AFS.  For example, if 
elevator is selected, the AF will be activated whenever the elevator input is 
provided. 
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To select the Control Input, click on the existing value.  Next, select the 
desired Control Input from the pull-down menu. 

GAIN INPUT- 
This value determines the input that controls both the gain and the 
operational mode of the gyro. 

To select the Gain Input, click the existing value.  Next, select the desired 
Gain Input control from the pull-down menu. 

MASTER GAIN- 
This value sets the rate, or amount of dampening, for the gyro.  Increased 
values will provide increased dampening of movement upon the axis 
selected. 

To adjust the gain, click on the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

GYRO REVERSE- 
This value determines whether to reverse the compensation from the gyro.  
For example, if the gyro causes the aircraft to rotate faster rather than 
dampening the motion, it is necessary to reverse the gyro. 

To do so, click the existing value.  Select Yes from the drop-down menu to 
reverse. 

CURRENT OUTPUT (READ ONLY)- 
The value here reflects the status of the output for the respective servo.  
This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value.  

CURRENT GAIN (READ ONLY) - 
This value reflects the current gain amount as received from the Master 
Gain Settings. 

This is a real-time output value. You may not manually adjust this value.  

GOVERNOR- 
A governor is a device used to maintain a constant RPM.  Governors are more 
commonly associated in helicopter applications.  They are gaining increased 
popularity in certain airplane segments, however. 

THROTTLE INPUT- 
This value determines the input that controls the throttle setting.  Please 
note:  the throttle will pass through directly if the governor is not currently 
activated. 

To determine the Throttle Input, click the existing selection in the value 
box.  This will bring forth the pull-down menu selections.  Use either the 
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Up/down arrow keys on the keyboard, or the mouse to select the desired 
option.  If utilizing the arrow keys, press Enter to finalize the selection. 

RPM INPUT- 
This value determines the input that controls the RPM of the governor.  
Please note:  if No Servo is selected, G3.5 will automatically default to the 
RPM2 setting. 

To determine the RPM Input, click the existing selection in the value box.  
This will bring forth the drop-down menu selections.  Use either the 
Up/down arrow keys on the keyboard, or the mouse to select the desired 
option.  If utilizing the arrow keys, press Enter to finalize the selection. 

ARMED INPUT- 
This value determines whether the governor is armed (capable of 
functioning) or disarmed (non-functional).  If No Input is selected, the 
Throttle Armed Threshold will be utilized to arm the governor. 

RPM1- 
This value represents the low-speed RPM settings, assuming that the 
governor is armed and active. 

To adjust the RPM’s, click the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

RPM2- 
This value represents the mid-range RPM settings, assuming that the 
governor is armed and active. 

To adjust the RPM’s, click the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

RPM3- 
This value represents the high-speed RPM settings, assuming that the 
governor is armed and active. 

To adjust the RPM’s, click the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

GAIN (%)- 
This value determines how rapidly the governor reacts to a lag in the motor 
speed. 

To adjust the gain, click on the existing value.  Next, input the desired value 
directly from the keyboard or via the mouse wheel. 

THROTTLE ARMED THRESHOLD- 
This value is used to determine when the governor is armed. 

To adjust the threshold, click on the existing value.  Next, input the desired 
value directly from the keyboard or via the mouse wheel. 
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COMPONENT FOR RPM- 
This value determines which component provides the governor with RPM 
readings. 

To determine the component, click the existing selection in the value box.  
This will bring forth the drop-down menu selections.  Use either the 
Up/down arrow keys on the keyboard, or the mouse to select the desired 
option.  If utilizing the arrow keys, press Enter to finalize the selection. 

CURRENT OUTPUT (%) (READ ONLY)- 
The value here reflects the status of the output for the respective servo.  
This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value.  

CURRENT RPM (RPM) (READ ONLY)- 
This value displays the current RPM’s for the governor.  If, for example, 
you have selected an engine as the Component for RPM, the engine RPM’s 
will be displayed here. 

This is a real-time output value.  You may not manually adjust this value. 

REQUESTED RPM (READ ONLY)- 
This value displays the Requested RPM’s at which the governor will 
become armed and/or active. 

This is a real-time output value.  You may not manually adjust this value. 

GOVERNOR ARMED (READ ONLY)- 
This value indicates whether the governor is armed.  If Yes, the governor is 
armed.  If No, the governor is not currently armed.  

This is a real-time output value.  You may not manually adjust this value. 

GOVERNOR ACTIVE (READ ONLY)- 
This value indicates whether the governor is active.  If Yes, the governor is 
active.  If No, the governor is not currently active.  

This is a real-time output value.  You may not manually adjust this value. 

WAVE GENERATOR – 
A Wave Generator is useful for creating part that move periodically.  Basically a 
timer that is programmed by a signal curve. 

 SIGNAL CURVE – 
 This parameter modifies the curve the wave generator will follow. 
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 WAVE PERIOD (SEC) – 
This value determines the number of seconds that the wave pattern, or curve 
is to repeat. 

 ON/OFF INPUT – 
This value determines the channel that control whether the wave generator 
is on or off.  If the input value is above 0, then the generator is enabled. If 
there is no input for this channel, then the generator is always on. 

 CURRENT OUTPUT (READ ONLY)– 
The value here reflects the status of the output for the respective servo.  
This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value 

SIGNAL MODIFIER – 
A Signal Modifier is a mixer that takes an input value and maps that to an output 
value. By providing a function, or curve, the Signal Modifier determines the output 
value for a given input. 

 SIGNAL CURVE – 
 This parameter modifies the curve the wave generator will follow. 

ON/OFF INPUT – 
This value determines the channel that control whether the wave generator 
is on or off.  If the input value is above 0, then the generator is enabled. If 
there is no input for this channel, then the generator is always on. 

 CURRENT OUTPUT (READ ONLY)– 
The value here reflects the status of the output for the respective servo.  
This is a real-time output value.  As such, deflecting the respective control 
will vary this value. 

You may not manually adjust this value 

ADD FIXED OUTPUT SERVO- 
This value adds a non-linear servo to the Electronics.  To utilize this servo, select the 
component in the airframe listings and modify the servo listing. 

To modify the output of this servo, click on the existing value.  Next, input the 
desired value directly from the keyboard or via the mouse wheel. 

ADD PHYSICAL SERVO- 
This function adds an additional servo to the simulation.  Unlike the Fixed Output 
Servo, this servo offers linear operation. 
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INPUT FOR THIS SERVO- 
This option determines which channel controls the servo.  In our example, Channel 1 
on the receiver controls the right aileron. 

To change the input, click on the value (e.g., Receiver Channel 1).  Next, select the 
desired option from the pull-down menu. Use either the Up/down arrow keys on the 
keyboard, or the mouse to select the desired option.  If utilizing the arrow keys, press 
Enter to finalize the selection. 

Please note:  it is important to pay attention to the assigned channels.  Failure to do 
so may cause conflicting input.  Therefore, the results may not be the original 
intention.  If, for example, you alter the input value to Receiver Channel 2, each time 
the elevator input is given, the right aileron will respond. 

To select a servo, click the existing selection in the value box.  This will bring forth 
the pull-down menu selections.  Use either the Up/down arrow keys on the keyboard, 
or the mouse to select the desired option.  If utilizing the arrow keys, press Enter to 
finalize the selection. 

SERVO SPEED- 
This setting determines the speed of the servo’s response time in seconds per 60° of 
rotation. 

To increase the servo speed, click on the existing value.  Next, input the desired 
value directly from the keyboard or via the mouse wheel.  Increasing the numerical 
values decreases the servo speed.  Conversely, lower numerical values serve to 
increase the speed of the servo. 

CURRENT OUTPUT (READ ONLY)- 
The value here reflects the status of the output for the respective servo.  This is a 
real-time output value.  As such, deflecting the respective control will vary this 
value. 

You may not manually adjust this value 

SOFTWARE RADIO- 
The Software Radio allows RealFlight G3.5 to simulate the channel processing 
normally performed by a high-end computer radio.  The sections below provide an 
overview of the various displays found in the Software Radio option.  Further 
information on the Software Radio may be found in Chapter 8:  The Controller 
Menu. 

To access the Software Radio, either click on the [+] (plus) or double-click the 
respective folder name.  This activates the pull-down menu of the items contained 
within the Software Radio folder. 

To add an output channel, or to delete the last output channel, right click on the 
Software Radio Directory.  Select the desired option from the pull-down menu. 

Radio Display- 
The Radio Display indicates the various radio values both before and after software 
mixing, if applicable. 
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Click on the Radio Display to examine the radio channels, their respective values 
and the effect that they have on the aircraft. 

PARAMETER- 
Indicates where the raw input comes from.  As an example, examine the Transmitter 
CH 1 (Roll) (%) line.  This indicates that the horizontal movement of the right stick 
controls Channel 1.  The item within the parentheses indicates the controlling 
channel.  You can examine this information to determine if multiple channels are 
mapped to the same location. 

VALUE- 
This numeral indicates the current value of the input received from the named 
transmitter channel. 

RADIO OUTPUT- 
This value represents the output of the radio after it has undergone the software 
mixing (if applicable).  For example, if you have increased the percent to scale input, 
the value here may exceed 100%. 

OUTPUT CHANNEL (CHANNEL NUMBER)- 
To add an Input Feed to the Output Channel, right click on the Output Channel 
number.  Select Add Simple Input Feed or Add Complex Input Feed from the 
pull-down menu. 

To view the current output for a particular channel, click on the respective channel.  
This will open a new branch, as shown below: 
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• Trim (%) 

• Low Rates (%) 

• Expo During Low Rates (%) 

• Expo During High Rates (%) 

• Current Value (%) 

TRIM (%)- 
This value represents the amount of trim applied to the selected channel. 

To adjust the trim percentage, click the existing value in the value box.  Next, enter 
the desired value directly from the keyboard or via the mouse wheel.  Higher values 
will increase the amount of trim; lower values will decrease the amount of trim. 

LOW RATES (%)- 
This value indicates the amount of control throw for the respective channel when the 
low rates are active. 

To adjust the percentage of the control throw when the low rates are active, click the 
existing value in the value box.  Next, enter the desired value directly from the 
keyboard or via the mouse wheel.  Higher values increase the amount of control 
throw for the low rates; lower values decrease the amount of throw. 

EXPO DURING LOW RATES (%)- 
This value represents the amount of exponential applied when the low rates are 
active.  Exponential softens the controls and smoothes the flight characteristics of the 
aircraft. 

To adjust the amount of exponential, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
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values increase the amount of exponential; lower values decrease the amount of 
exponential utilized. 

EXPO DURING HIGH RATES (%)- 
This value represents the amount of exponential applied when the high rates are 
active.  Exponential softens the controls and smoothes out the flight characteristics of 
the aircraft. 

To adjust the amount of exponential, click the existing value in the value box.  Next, 
enter the desired value directly from the keyboard or via the mouse wheel.  Higher 
values increase the amount of exponential; lower values decrease the amount of 
exponential utilized. 

CURRENT VALUE (%) (READ ONLY)- 
This parameter represents the current value of the respective channel. 

This value may not be modified manually.  Rather, it is controlled by the status of 
the input value and its respective modifications. 

Determining when Low and High Rates are Active- 
To access the Output Channel (current channel), click on the [+] (plus) or double-
click the respective folder name (i.e., Output Channel 1).  This activates the pull-
down menu of the items contained within the specified folder. 

Modifications to the respective channels are accomplished through the various 
Output channels.  If you are unsure as to which channel maps to which controller 
input, refer to the Radio Display.  It provides a rapid, graphical representation of the 
relationships between the channels and the outputs. 

LOW RATES WHEN- 
The settings here determine when to use the low rates and their values. 
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ACTIVATED WHEN- 
This value determines the conditions when the low rates will be active.  The 
available options are: 

• Always 

• Never 

• Dependent upon the values set for Value 1 (%) and/or Value 2 (%) 

 
To determine when the low rates are active, click the existing value in the value box.  
Next, from the pull-down list, select the condition when the low rates will apply.  If 
you opt to allow the activation to be controlled by the value in 1 and/or 2, you will 
need to adjust the respective value(s).  If you select Never, the low rates will never 
activate. 

CONDITIONAL CHANNEL- 
This setting selects the channel used to determine when the low rates will activate.  
For example, a setting of Input Channel 5 (Front 2-pos Switch) indicates that the 
Front 2-pos Switch will control the low rates. 
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To determine which stick, switch or knob controls the low rates activation, click the 
existing value in the value box.  This brings forth the pull-down menu selections.  
Use either the Up/down arrow keys on the keyboard, or the mouse to select the 
desired option.  If utilizing the arrow keys, press Enter to finalize the selection. 

CONDITIONAL CHANNEL VALUE (%) (READ ONLY)- 
This field indicates the current value of the conditional channel. 

VALUE 1 (%) AND VALUE 2 (%)- 
The values here are used as the determining factor as to whether the conditions for 
activation are met.  If the conditions are met, then ‘Yes’ appears in the Conditions 
Satisfied Value column.  If not, a value of ‘No’ appears. 

CONDITION SATISFIED (READ ONLY) – 
As noted above, the value here indicates whether the condition is satisfied. 

EXPONENTIAL WHEN- 
The settings here determine when the exponential values activate.  In most cases 
exponential is always active.  However, RealFlight G3.5 allows you to activate them 
in another manner if so desired.  To do so, follow the same procedure as used for the 
Low Rates When settings in the previous section. 

Input Channel- 
Select the Input Channel to view the current settings for the respective channel.  If 
you wish to delete this input, right click on the respective input, and choose Delete 
Input Feed. 

RealFlight G3.5 allows you to select any of the controller’s sticks, switches, or knobs 
as the Input Channel. 
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To modify the channel that controls the input, click the existing value in the Value 
box.  This brings forth the pull-down menu selections.  Use either the Up/down 
arrow keys on the keyboard, or the mouse to select the desired option.  If utilizing 
the arrow keys, press Enter to finalize the selection. 

INPUT CHANNEL VALUE (%) (READ ONLY)- 
This indicates the value of the current input channel. 

This value may not be modified manually.  It is controlled by the status of the input 
value and its respective modifications. 

PERCENT- 
This value indicates the percent to scale the input.  If left at 100%, the input will 
remain unchanged.  If you set the value to 50%, the input throw would scale 
accordingly. 

To adjust the percentage, click the existing value in the value box.  Next, enter the 
desired value directly from the keyboard or via the mouse wheel. 

REVERSE- 
This value specifies whether to reverse the input. 

To make your selection, click the respective value box.  Select either Yes or No from 
the pull-down menu. 

LOGIC- 
This value determines whether the input feed is combined with others. 
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To make your selection, click the respective value box.  Select either Add to other 
feeds or Override all other feeds. 

INPUT FEED WHEN- 
To access the Input Feed When item, click on the [+] (plus) or double-click the Input 
folder name. 

ACTIVATED WHEN- 
This will usually be set to Always.  If Always is selected, the only other active value 
will be the Condition Satisfied.  The remaining settings will be grayed out, as they 
are not relevant at this point. 
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RealFlight G3.5 allows you to adjust the values and settings if you so desire.  To do 
so, follow the same procedure utilized for modifying the Low Rates When and the 
Exponential When settings. 

ADDING INPUT FEED (S)- 
RealFlight G3.5 also allows you the ability to add Input Feed to the various Output 
Channels.  To do so, right click on the respective Output Channel.  This presents 
you with two options:  Add Simple Input Feed and Add Complex Input Feed.  Select 
the Input Feed type that you wish to utilize. 
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The Simple Input Feed offers the same options and adjustments as discussed 
previously.  The Complex Input Feed, however, offers incredible flexibility. 

COMPLEX INPUT FEED- 
This option allows you to customize the channel mixing curves and points along the 
desired locations. 

To access the servo curve, click the respective <<Graph Points>>.  Next, select the 
more options button (the gray folder with the ellipsis) to bring forth the servo curve. 

 
The servo curve is used to alter the travel of the respective servo.  That is, it is 
utilized to adjust the servo’s linearity to suit your personal taste. 

ADJUSTING THE SERVO CURVE- 
Any of several methods may be utilized to adjust the servo curve.  The 
method you select is a matter of personal preference. 

Prior to adjusting the servo curve, it is important to understand what it is 
that you will be adjusting. 

INPUT- 
This is the input from the controller; the input ranges from -100% to 100%.  
This exemplifies the full range of motion for the respective control input.  
The zero value represents placing the gimbal stick (and therefore servo) in 
the neutral position. 

OUTPUT- 
This exemplifies the motion of the servo, or servo travel, at a given point 
along the controller’s input. 
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NUMERICAL ADJUSTMENT- 
To adjust the Input %, click on the respective value in the Input % column 
for the given output.  Next, enter the desired value, either directly from the 
keyboard or via the mouse wheel.  Please note:  G3.5 will only allow you to 
adjust the mid-points.  It is not possible to adjust either of the extreme 
ranges. 

If, for example, you wanted to adjust the mid-point of the Input to 20%, 
simply click on the zero value.  Modify this value to reflect the changes.  
Please note:  the graphical representation will also be modified to reflect 
this change. 

The Output of the servo curve is adjusted following the same methodology.  
Simply select the Output point that you wish to modify. 

GRAPHICAL ADJUSTMENT- 
Rather than entering specific numerical values, this method will allow you 
to alter the servo curve graphically. 

To adjust the output value, click and hold on the respective point.  Next, 
utilize the mouse to alter the output.  When satisfied, release the mouse 
button.  As with the numerical adjustment, altering the output graphically 
will also be reflected in the numerical values column. 

RE-SAMPLE- 
The re-sample button is used to add points to the servo curve, or to alter the 
spacing between these points. 

LOGIC- 
This value determines whether the settings for the Input Channel are added 
to the other servo feeds or if they will simply override all other feeds. 

To do so, click on the respective value.  Next, select either Override all 
other feeds or Add to other feeds from the pull-down menu. 

SOUND RESONANCE- 
G3.5 allows you to adjust the intensification and prolongation of the sounds that you 
will experience in the simulation. 

To access the Sound Resonance, click on the [+] (plus) or double-click the Sound 
Resonance folder.  This will bring forth the Resonance 1 and Resonance 2 listings. 

Resonance 1- 

MAX RESONATION SPEED- 
The value here represents how rapidly the sound reaches its maximum pitch and 
volume in the simulation. 

To adjust the Max Resonation Speed, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 
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MAX VOLUME %- 
This value adjusts the maximum volume of the sounds. 

To adjust the Max Volume, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

MIN RESONATION SPEED- 
This value represents the speed at which the resonation will occur. 

To adjust the Min Resonation Speed, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

PITCH- 
This value allows you to alter the frequency of the resonating sounds. 

To adjust the Pitch, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

RESONANCE SOUND- 
This value determines which resonance to utilize in the simulation.  

To adjust the Resonance Sound, click on the corresponding value.  Select the desired 
resonance from the drop-down menu. 

Resonance 2- 
Resonance 2 is adjusted in exactly the same way as Resonance 1.  For information 
on how to do so, please refer to the previous section. 

 

SSEELLEECCTT  CCOOLLOORR  SSCCHHEEMMEE  
This menu item allows you to choose an alternative trim scheme (if available) for the 
current aircraft. 

To view the alternative color schemes, click the Select Color Scheme menu item.  
To select an alternate trim scheme, click the existing selection in the value box.  This 
will bring forth the pull-down menu selections.  Use either the Up/down arrow keys 
on the keyboard, or the mouse to select the desired option.  If utilizing the arrow 
keys, press Enter to finalize the selection.  The new trim scheme will appear 
immediately on the aircraft.  Please note:  if only one scheme appears in the pull-
down menu, alternative schemes are not available for this aircraft.    
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SSAAVVEE  CCOOLLOORR  SSCCHHEEMMEE  AASS……  
This menu item is used to create an editable version of the currently selected trim 
scheme. 

 
RealFlight G3.5 allows you to create a custom paint/decal scheme for your aircraft.  
The color schemes you create are limited only by your imagination. 



R/C Simulator RealFlight Chapter 7.  The Aircraft Menu  •  259 

However, only individuals that own, and know how to use, a third-party bitmap 
editing program such as Adobe® Photoshop®, should attempt to create a custom 
color scheme.  Your editor must be able to read and edit Targa (“.tga”) files. 

To create a custom color scheme click the Save Color Scheme As… menu item.  
Enter the desired name in the dialog box that appears.  The location of the file will 
appear in the lower left corner of the RealFlight screen. 

To access the file that contains the custom color scheme, open Windows Explorer 
and then open your RealFlight folder (usually “C:\Program Files\RealFlight”).  
Next, open the Color Schemes folder.  This will bring up all of the custom color 
schemes that have been stored in RealFlight.  Click on the file for which you wish to 
modify the trim scheme. 

Once you have finished editing and saving your color scheme, you will probably 
want to see the results of your work.  There are two ways that you can do so.  One is 
to use the Select Color Scheme menu, which is found within the Aircraft menu.  
Simply click on the color scheme that you have just edited, and RealFlight will 
reload the color scheme onto your aircraft and reset the aircraft back on the runway.  
Within seconds, you are flying with your new color scheme. 

Alternatively, access the Aircraft Editor (see section “Aircraft Editor”).  Within the 
aircraft editor, look for Reload Color Scheme which is located in the Options menu.  
Clicking this will reload the color scheme, showing any changes you have made to 
the aircraft.  You can disable the wire frame using the Options menu to improve your 
view. 

While looking in the Color Schemes directory for your new color scheme, you may 
also notice a “.colorscheme” file with the same name as the “.tga” file.  This file can 
be opened in a text editor such as Notepad.  Within, you will find six values to edit:  
Specular, Reflectivity, PowerSpecularOff, PowerSpecularOn, PowerReflectiveOff, 
and PowerReflectiveOn. 

Specular - A multiplier for the overall specularity of the aircraft.  Specular=1 is 
neutral, Specular=0 disables specular highlights. 

Reflectivity - A multiplier for the overall reflectivity of the aircraft.  Reflectivity=1 is 
neutral, Reflectivity=0 disables reflections. 

Specular highlights ramp from fully off to fully on as the specular power of each 
piece of the aircraft goes from the value PowerSpecularOff to PowerSpecularOn. 

Reflections ramp from fully off to fully on as the specular power of each piece of the 
aircraft goes from the value PowerReflectiveOff to PowerReflectiveOn. 

TIPS FOR COLOR SCHEMES 
• A quick and easy way to change a color scheme is to replace one color with 

another.  Photoshop has a command that can easily do this called “Replace 
Color”. 

• Make sure you save the file as 32 bit TGA files so that the Alpha Channels are 
preserved (See below). 

• You are only allowed a single Alpha Channel. 

• Do NOT alter the resolution of the image. 

• Other formats (JPG, BMP, etc) are not allowed. 
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ALPHA CHANNELS 
Almost all of the color schemes for the aircrafts incorporate an Alpha Channel, 
which defines what areas of the color scheme are opaque and what areas are 
transparent.  White portions of the alpha channel will be 100% opaque and Black 
portions of the alpha channel will be 100% transparent.  Shades in-between will be 
partially transparent. 

Consult the image editor’s manual to determine how to use Alpha Channels. 

Note:  RealFlight uses TGA files instead of the BMP format.  This is because BMP 
formats do not support alpha channels. 

RREEMMEEMMBBEERR  AAIIRRCCRRAAFFTT  PPOOSSIITTIIOONN  
The Remember Aircraft Position menu item saves the current position of the 
aircraft.  When you reset the aircraft, it will return to the same position (speed, 
attitude, heading, etc.) as when this menu item was selected.  This feature is ideal for 
practicing maneuvers. 

 
To activate this menu item, click the Remember Aircraft Position menu item when 
the aircraft is in the desired location and altitude.  Alternatively, pressing the ‘P’ key 
on the keyboard will also remember the aircraft’s position. 

Each time the aircraft is reset it will begin flying from the saved location.  Please 
note:  the saved position is only temporary.  If you select another airport, aircraft, or 
if you exit the simulation and restart, you will need to save the desired position once 
again. 

CCLLEEAARR  AAIIRRCCRRAAFFTT  PPOOSSIITTIIOONN  
This menu item clears the position saved in the Remember Aircraft Position 
without exiting the simulation, changing flying sites and/or aircraft. 
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To do so, simply click the Clear Aircraft Position menu item.  When the aircraft is 
reset, it will return to one of the default starting positions. 

RREESSEETT  PPOOSSIITTIIOONN  
There are three ways to reset the aircraft to its takeoff position: 

1. Press the red button on the InterLink Plus controller.  This is probably the 
fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Position menu item. 
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KKIILLLL  EENNGGIINNEE  
Click on this item to instantly stop the motor from running.  This is useful when you 
are practicing dead-stick landings in airplanes and when practicing autorotations for 
helicopters.  Alternatively, you may also press the keyboard’s ‘K’ key. 
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AAIIRRCCRRAAFFTT  MMRRUU  
The final items in the Aircraft menu indicate the most recently used aircraft.  The 
first item is the aircraft that you are currently flying; successive items are aircraft you 
have previously flown.  The MRU shows only the eight most recently selected 
aircraft. 

You can load an aircraft by selecting it from this list.  This shortcut allows you to 
switch between your favorite aircraft without using the Select Aircraft dialog. 
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CCHHAAPPTTEERR  88..    TTHHEE  CCOONNTTRROOLLLLEERR  MMEENNUU  

CCOONNTTRROOLLLLEERR  OOVVEERRVVIIEEWW  
The Controller menu allows you to select the method of control, calibrate the 
controller and to map the channels for your desired method of control for RealFlight 
G3.5. 

 
The menu items in this dialog are: 

• Select Controller 

• Controller Calibration… 

• Channel Mapping… 
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SSEELLEECCTT  CCOONNTTRROOLLLLEERR  
When you click on the Select Controller menu item, the following sub-menu 
appears: 

 
To choose the method of control, click on the Select Controller menu item from the 
Controller menu.  The selection(s) will vary depending on whether or not you have 
attached an actual R/C transmitter to the interface adapter for the InterLink Plus. 

Please note:  if you have attached a controller to the interface port, RealFlight will 
pause briefly while it detects the transmitter. 

The selections are (usually) InterLink Joystick and InterLink Transmitter X Channel.  
If you are using the InterLink Plus controller for the simulation, please select the 
InterLink Joystick option.  If you will be using your own controller in the 
simulation, choose the InterLink Transmitter X Channel.  The sections that follow 
will explain the differences between the various modes and methods of control and 
the means and ways to access and utilize them. 

Please note:  if you have attached a Generation 2 InterLink controller in addition to 
the G3.5 InterLink Plus, there will be an option for this controller as well.  It will 
specify, InterLink Joystick (G2). 

CCOONNTTRROOLLLLEERR  CCAALLIIBBRRAATTIIOONN  
The Controller Calibration… menu item allows you to adjust  your controller for 
use in the simulation.  Calibration is the method of fine-tuning the controller input 
for the simulation, so that you will achieve the desired responses. 
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With the InterLink Joystick mode selected, the screen appears as follows: 

 
As directed, place all trim levers in their neutral, or centered, position.  Click Next 
when finished. 
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Center all gimbal sticks and the rotary knob.  When finished, click Next. 

 
Move all of the sticks through their complete range of motion several times.  This is 
the key to a properly calibrated controller.  When completed, click Finish.  You will 
now be returned to the simulation with the previous aircraft and airport. 

CCHHAANNNNEELL  MMAAPPPPIINNGG……  
G3.5’s Channel Mapping… feature allows for incredible flexibility and 
adjustability regardless of radio manufacturer or flight mode utilized.  This menu 
item enables you to define the functionality of the transmitter when utilized in the 
simulation. 
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To access the Channel Mapping… menu item, click the Controller menu.  Next, 
select the Channel Mapping… option.  This will bring forth the following screen. 

 
It is important to have a basic understanding of the Channel Mapping… screen 
prior to actually modifying the actual mapping itself. 
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CHANNEL- 
This column corresponds to the actual channel of the transmitter used to control the 
functionality, as defined in the Map To column. 

For example, radio channel 3 on a Futaba radio corresponds to the throttle.  As such, 
the Map To value is defined as throttle.  On the other hand, radio channel 3 on a JR 
radio controls the pitch (elevator). 

The radio channel values serve as placeholders, or reminders, for the functionality of 
your transmitter with regards to the Map To functions. 

MAP TO- 
The values here define the function or duties that will be performed by the 
transmitter.  Using the example from the Radio Channel above, the Map To for 
Futaba’s Channel 3 dictates that this will control the throttle of the desired aircraft.  
For JR radios, Channel 3 on the transmitter controls the pitch (elevator). 

If your transmitter varies from the default definitions, it is necessary to modify the 
Map To functions.  To do so, click on the Map To channel that corresponds to the 
channel you wish to adjust.  Using either the up/down arrow keys on the keyboard or 
the mouse, select the desired Map To channel.  If using the up/down keys, press 
Enter to finalize your selection. 

If the channels are mapped, or defined properly but control input produces results 
that are backwards (e.g., increasing the throttle stick actually decreases the throttle 
on the aircraft), please refer to the Reverse Channel section that follows. 

REVERSE CHANNEL- 
The value here determines whether to reverse the input received from the radio 
channel.  If checked, the input will be reversed. 

To adjust the input direction, click on the corresponding Reverse Channel as 
necessary. 

USING REALFLIGHT’S CHANNEL MAPPING- 
Now that you have a basic understanding of the Channel Mapping, it is time to 
utilize this knowledge to program the software for your controller. 

While watching the channel values, move the gimbal stick that controls the throttle 
input for your aircraft.  Taking note of the value, map this channel to the throttle. 

Repeat this procedure for ALL corresponding channels on the transmitter.  When 
you have finished, click OK.  Next, return to the simulation and test the Channel 
Mapping to ensure that all channels are mapped correctly and that all function as 
desired.  If not, please return to the Channel Mapping…menu item and refine 
accordingly. 

After you have correctly mapped the channels, it is best to re-calibrate your 
controller.  To do so, please see the Controller Calibration… section. 
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IINNTTEERRLLIINNKK  JJOOYYSSTTIICCKK  MMOODDEE  VVSS..  IINNTTEERRLLIINNKK  TTRRAANNSSMMIITTTTEERR  
MMOODDEE  

In single-player mode, RealFlight allows you to quickly and easily change the 
method used to control the action in the simulation.  RealFlight G3.5 offers two 
control modes: 

• InterLink Joystick Mode.  Using the InterLink Plus in InterLink 
Joystick Mode, RealFlight G3.5 accepts control input from the sticks, 
switches, knob and push-button on the InterLink Plus controller.  This 
is the default mode when you install RealFlight.  We suggest that you 
fine-tune the calibration of the controller.  For information on how to 
do so, please refer to the Controller Calibration… section above. 

• InterLink Transmitter Mode.  Using the InterLink Plus in the 
InterLink Transmitter Mode, RealFlight G3.5 accepts commands 
from your actual R/C transmitter.  To use this mode, your transmitter 
must be connected to the InterLink Plus controller via the InterLink’s 
built-in interface.  This is an optional use of the InterLink, and we have 
provided the necessary cables for using most popular R/C transmitters.  
Using the InterLink Transmitter Mode takes slightly more setup and 
understanding of your radio than does using the InterLink Joystick 
Mode. 

To switch between these modes, highlight the Select Controller menu item.  The 
InterLink Plus controller will automatically test to determine whether an R/C 
transmitter is present.  After the detection testing completes, select the mode that you 
wish to utilize for your flight -- either InterLink Transmitter Mode or InterLink 
Joystick Mode.  Regardless of which mode you selected, you will return to the 
simulation and be ready to start flying immediately. 

We suggest that you calibrate your controller using the Controller Calibration… 
process.  For more information on how to calibrate the controller, please refer to 
Controller Calibration on page 266.  If the channels are not mapped correctly, or 
you wish to make changes, please refer to the Channel Mapping… section of this 
manual. 

TTHHEE  IINNTTEERRLLIINNKK  PPLLUUSS  CCOONNTTRROOLLLLEERR  ((IINNTTEERRLLIINNKK  JJOOYYSSTTIICCKK  
MMOODDEE))  

In InterLink Joystick Mode, RealFlight accepts control input from the sticks, 
switches, rotary knob and push-button found on the InterLink Plus controller.  This is 
the default mode when you install RealFlight G3.5. 

The RealFlight G3.5 software, working in conjunction with the InterLink Plus 
controller, actually does all the radio processing to measure the raw stick, switch, 
knob and push-button input from the controller.  It then processes this input to 
produce the servo outputs that are used to control the aircraft. 

Helicopters, for example, ordinarily require a great deal of mixing to achieve flight; 
this mixing is normally the function of a computer radio.  When RealFlight G3.5 
uses the InterLink Plus InterLink Joystick Mode, the mixing is done by the 
RealFlight G3.5 software itself and not by the InterLink Plus controller. 



272  •  Chapter 8.  The Controller Menu R/C Simulator RealFlight 

CHANNEL MODIFICATION 
It is possible to modify the mixing of the radio in the Software Radio menu.  To 
access the Software Radio menu, click the Aircraft menu followed by the Edit 
Current Aircraft menu item.  Next, click on the Software Radio menu.  For 
information on how to perform various modifications to the Software Radio 
settings, please refer Software Radio- on page 246. 

Every aircraft in RealFlight has its own unique software radio program that maps 
(converts) the raw stick inputs from the InterLink Plus controller into the correct 
servo input for that particular aircraft. 

CONTROLLER CALIBRATION 
Occasionally it may become necessary to fine-tune your InterLink Plus controller’s 
calibration.  To do so, click on the Controller menu followed by the Controller 
Calibration… menu item.  Follow the directions that appear on-screen to complete 
the calibration procedure. 

STICK MAPPING 

Stick Mapping- 
As noted above, RealFlight’s Channel Mapping… feature allows you the flexibility 
to modify the operational mode of the transmitter.  Typical operation modes are as 
follows: 

• Transmitter Mode 1 (Europe, Asia) - Mode 1 transmitters have 
aileron and throttle on the right stick, and rudder and elevator on the 
left stick. 

• Transmitter Mode 2 (USA) - Mode 2 transmitters have aileron and 
elevator on the right stick; rudder and throttle on the left stick. 

• Transmitter Mode 3  - Mode 3 transmitters have rudder and elevator 
on the right stick; aileron and throttle on the left stick. 

• Transmitter Mode 4  - Mode 4 transmitters have rudder and throttle 
on the right stick, and aileron and elevator on the left stick. 

 

TTHHEE  IINNTTEERRLLIINNKK  PPLLUUSS  CCOONNTTRROOLLLLEERR  ((IINNTTEERRLLIINNKK  
TTRRAANNSSMMIITTTTEERR  MMOODDEE))  

This exciting feature allows you to plug your own R/C transmitter into the back of 
the InterLink Plus controller.  You can then use your own transmitter to control the 
RealFlight aircraft.  With Universal Serial Bus (USB) connectivity, the InterLink 
Plus controller offers high resolution, rapid data transfer from your transmitter to the 
PC, and immediate response from the simulated aircraft. 

When compared to the InterLink Joystick Mode, using your own radio adds a 
slight amount of complexity and initial configuration setup.  The advantage to this 
method is that it will allow you to become familiar with the programming on your 
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actual R/C transmitter.  Additionally, you will develop the ‘feel’ of using your 
transmitter rather than the InterLink Plus controller. 

TWO WAYS TO USE THE INTERLINK TRANSMITTER MODE 
There are two ways to use InterLink Transmitter Mode.  They are commonly 
referred to as the “Pass Through Interface” and “Joystick Emulation Interface” 
(not to be confused with the “InterLink Joystick Mode” in the previous section).  
Here is a quick chart that will help you decide which mode to use. 

 InterLink 
Joystick Mode 

InterLink 
Transmitter 
Mode:  Joystick 
Emulation 
Interface 

InterLink 
Transmitter 
Mode:  Pass 
Through Interface 

Radio used to Fly InterLink Plus 
Controller 

Your own R/C 
radio 

Your own R/C 
radio 

Ease of 
Configuration 

Very Easy Medium.  Must 
calibrate and 
setup radio once 

Harder.  Must 
separately calibrate 
and set up radio for 
each aircraft 

Fly Stock aircraft 
without 
Modification 

Yes Yes No 

Gives you the feel 
of your own radio 

No Yes Yes 

Puts “wear and 
tear” on your own 
transmitter 

No Yes Yes 

Allows you to 
perform mixing in 
your own radio 

No No Yes 

R/C transmitter 
required 

No Required: 4-8 
channels.  
Computer radio 
not required 

Required: computer 
radio with multiple 
model memory.  
Recommended: 
radio with 7-8 
channels. 

 

IINNTTEERRLLIINNKK  TTRRAANNSSMMIITTTTEERR  MMOODDEE::    JJOOYYSSTTIICCKK  EEMMUULLAATTIIOONN  
IINNTTEERRFFAACCEE  

The purpose of the Joystick Emulation Interface is to create a program on your own 
R/C transmitter to provide RealFlight with raw stick inputs.  This enables RealFlight 
to use its own software radio to control all of the stock aircraft. 

It also allows you to use a single model memory, or program, on your R/C 
transmitter to control, without modification, all of the stock aircraft in RealFlight.  
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We suggest that you perform the Channel Mapping and Controller Calibration 
procedures in this order, respectively.  This will prevent you from having to re-
calibrate your controller if one (or more) of the channels is not mapped correctly.  

CHANNEL MAPPING 
Before accessing the Channel Mapping… menu item, you will need to create a new 
program or model memory on your R/C transmitter.  We suggest that you call it 
RFJOY or something similar. 

Please make sure that this new program meets the following criteria: 

• Is an airplane program--you do not want a heli program with all of its 
mixing (since all the mixing will be performed by the RealFlight 
software) 

• Does not have any mixing programmed 

• Has trims centered 

• Has ATVs set to 100% 

• Has dual rates and expo turned off – as these may be emulated in the 
RealFlight software radio 

Prior to starting this wizard, make sure that your transmitter is attached to the 
Interlink Plus controller and that the controller is on.  Click the Controller menu 
followed by the Select Controller menu item.  There will be a momentary pause 
while RealFlight detects the R/C transmitter.  Next, click InterLink Transmitter X 
Channel.  After this is accomplished, click Channel Mapping… Follow the on-
screen instructions, making sure that you read all of the instructions in each step. 

Please note:  you may have to use the scroll bar to read the entire text content. 

Once you have finished, it is best if you never modify the RealFlight radio program 
in your transmitter again.  A change in this “RFJOY” program will affect every 
RealFlight aircraft flown with this transmitter.  Instead, edit the Software Radio in 
RealFlight instead.  Changes to the Software Radio only affect the aircraft whose 
radio you have edited. 

CONTROLLER CALIBRATION 
By calibrating the R/C transmitter for use with RealFlight’s software you are, in 
essence, advising RealFlight as to the minimum, maximum and center values for 
each channel on your particular radio. 

To calibrate your transmitter, click the Controller menu followed by the Controller 
Calibration… menu item.  Follow the on-screen instructions to complete the 
calibration procedure. 

You are now ready to fly any of the stock aircraft available in RealFlight. 

IINNTTEERRLLIINNKK  TTRRAANNSSMMIITTTTEERR  MMOODDEE::    PPAASSSS  TTHHRROOUUGGHH  
IINNTTEERRFFAACCEE  

This is the most advanced method for controlling the RealFlight aircraft.  It provides 
total control of an aircraft from your own radio and utilizes all of your radio’s mixing 
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functionality.  All values received by RealFlight are passed directly to the aircraft 
without modification from the RealFlight software.  The disadvantage is that you 
will have to create a new radio program (model memory) on your R/C transmitter for 
each aircraft you want to fly with this mode.  You must also set up your radio, 
mixes, trims, dual rates, etc. on the transmitter for each aircraft you want to fly with 
this mode. 

The advantage of this mode is that if you are mainly flying one or two aircraft on 
RealFlight, you use your own radio program for these aircraft and have complete 
control over them.  It also is a very good tool for learning how to use your own R/C 
radio as it forces you to set up the transmitter the same way you would have to set it 
up if you were going to control an actual R/C aircraft. 

BEFORE YOU USE THE PASS THROUGH INTERFACE 
IMPORTANT!   Make sure that you follow the procedures for both the Controller 
Calibration… AND the Channel Mapping… menu item in the previous sections 
BEFORE attempting to use the Pass Through Interface.  Failure to do so may result 
in an aircraft that either does not perform adequately or fails to perform at all. 

SETTING THE PASS THROUGH INTERFACE 
After completing the Controller Calibration… and the Channel Mapping… 
procedures, select the desired aircraft.  Next, select the Edit Aircraft menu item.  
Highlight the aircraft root (name of the aircraft) and select the value for the Radio 
Type. Using either the mouse or the up/down arrow keys on the keyboard, select the 
Pass Through option from the pull-down menu.  

MAPPING CHANNELS TO SERVOS 
If any channels are mapped to the wrong functions on the aircraft, edit the aircraft 
using the following procedure.  Click the Aircraft menu followed by the Select 
Aircraft… menu item.  Click the Edit Current Aircraft menu item.  Access the 
Electronics options.  Double-click the Electronics name or click on the [+] (plus).  
Select the incorrectly mapped channel from the pull-down list that activates.  To 
change the respective channel of operation, click on the corresponding value and 
select the appropriate option from the pull-down list. 

IMPORTANT!  Do not change the servo mapping using the Channel Mapping… 
menu item.  If you do so, the change will also affect ALL stock aircraft.  Instead, 
simply change the servo mapping using the Electronics options above for a single 
aircraft. 

SHARING AIRCRAFT THAT USE THE PASS THROUGH INTERFACE 
In most cases, when you make a custom aircraft that uses the Pass Through 
Interface option, you will not be able to provide that aircraft to your friends or 
submit it to the RealFlight Model Swap Page.  This is because the RealFlight 
software does not receive the necessary input for the radio programming.  
Consequently, you would have to provide other RealFlight users with all of your R/C 
radio’s settings for that particular aircraft.  Moreover, they would have to have the 
exact same R/C transmitter in order for them to use the aircraft.  These complications 
effectively prohibit swapping aircraft under these conditions. 



276  •  Chapter 8.  The Controller Menu R/C Simulator RealFlight 

IINNTTEERRLLIINNKK  PPLLUUSS  CCOONNTTRROOLLLLEERR  HHIINNTTSS  AANNDD  TTIIPPSS  

WHAT IF MY TRANSMITTER HAS FEWER CHANNELS THAN THE MODEL I 
SELECT?  

This issue can arise when you use your own transmitter to control RealFlight G3.5.  
In this situation, we highly recommend that you use the Interlink Plus controller. 

WHEN TO USE THE CHANNEL MAPPING, AND WHEN TO USE THE 
SOFTWARE RADIO OR SERVO PAGE 

This issue arises only if you use your own transmitter to control RealFlight.  When 
you use the InterLink Plus controller as a mockup transmitter, you should not alter 
the Channel Mapping. 

Remember that Channel Mapping is used to set the input channels for your 
transmitter.  This means that you are setting the channels used to monitor physical 
movements or positions of your transmitter’s sticks, switches, and knobs.  Unless 
you change transmitters, you should only need to set this once.  Only use the 
Channel Mapping… menu item to tell RealFlight which channel your controller is 
using for each stick/knob/switch input, not what control function you want that 
stick/knob/switch to perform. 

The Software Radio (see page 246) controls mixing, exponential, and other channel 
processing that a computer radio would normally perform.  The Software Radio 
determines the control function you want each stick/knob/switch setting to perform.  
You will most likely want to adjust this differently for various aircraft.  For example, 
the mixing utilized for your glider will probably not be very useful on a jet. 

The Electronics options (see page 235) modify the servo properties (e.g., servo 
speed) as well as adjusting the input channels in the same way as the Channel 
Mapping… wizard.  However, changes made using the Electronics options only 
apply to the particular aircraft that you are editing.  Use the Electronics options only 
when you want to edit a specific servo property (like servo speed) or if for some 
reason you need to reassign an input channel for one aircraft only.  In most cases, 
you should not need to do the latter.  Instead, you should normally use the software 
radio to configure control outputs. 

A good rule of thumb:  if a setting will not be the same for every aircraft, you should 
not try to implement the setting by using the Channel Mapping… menu item.  
Instead, adjust the Software Radio.
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  CCHHAAPPTTEERR  99..    TTHHEE  EEVVEENNTTSS  MMEENNUU  

EEVVEENNTTSS  MMEENNUU  OOVVEERRVVIIEEWW  
An event is an organized flying contest with a set of rules.  RealFlight G3.5 supports 
five types of events:  Autorotation/Deadstick, Limbo, Free Style, Pylon Racing and 
Spot Landing.  You can compete in these events by yourself or compete with other 
RealFlight G3.5 users over the Internet. 

To participate in an event alone, all you have to do is start the event.  RealFlight 
G3.5 does the rest. 

If you want to compete with other RealFlight G3.5 users, you must first start a 
multiplayer session (or join an existing one). 

When all of the participants have joined the session, the session host will start the 
event.  This enrolls every member of the multiplayer session in the Event.  If any 
multiplayer session members want to leave the event, they can do so while remaining 
a part of the multiplayer session. 

RealFlight G3.5 limits you to running only one event at a time.  This rule also 
applies to multiplayer sessions. 

The Events menu accesses all events, and event-related options.  When you open the 
menu, the items are: 
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• Autorotation/Deadstick 

• Limbo 

• Free Style 

• Pylon Racing 

• Spot Landing  

• Options… 

• End Current Event (grayed out) 

• Leave Current Event (grayed out) 

• Forfeit Turn (grayed out) 
Some of these items may be grayed out if they do not apply to the current situation.  
For example, you cannot end the current event unless an event is already running.  
Consequently, the End Current Event menu item will be grayed out. 

AUTOROTATION/DEADSTICK  
The Autorotation/Deadstick event is similar to the Spot Landing event mentioned 
below.  This event requires that you make a landing with all power off. 



R/C Simulator RealFlight Chapter 9.  The Events Menu  •  279 

 
The goal of this event is to land the airplane, or auto rotate the heli, into the marked 
zones.  The various landing zones have different point values assigned to them.  
Generally, the zones that are more difficult to target are awarded higher point values.  
If participating in a multiplayer event, the player with the highest points total at the 
end wins. 

It is possible to enable the software to “kill” the player’s engine when their aircraft 
passes a particular altitude. 

SELECTING YOUR NAME FOR THE EVENT 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, 
please do so in the space provided when you select an event.  Click OK when 
completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This brings up the 
multiplayer options.  Click the value found next to the Your Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

OPTIONS 
The Options… menu item adjusts the parameters and rules for each event.  To 
access the Options… menu item, click the Events menu followed by the Options… 
menu item.  Next, from the column on the left side, select the event that you wish to 
adjust.  The selections that appear will depend upon the event selected.  This section 
examines the selections available for the Autorotation/Deadstick Landing Options. 
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ZONE POINT VALUES- ZONES A THROUGH E 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of difficulty.  
Zone A is the smallest, most difficult target.  Therefore, it offers the highest point 
value.  Zone B, which surrounds the center, offers the second highest points, 
followed by Zone C, D and E. 

To adjust the values of these points, click on the values in the column to the right of 
the respective Zone Points.  For example, to adjust the points for Zone A, click on 
the corresponding Value in the column next to Zone A.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

TURNS PER EVENT- 
This option determines the number of turns that each player is allotted per event.  
When each player has taken the designated number of turns, the event is over.  The 
only exception is if the host activates the Crash Eliminates Player setting.  In this 
case, the event will end if all of the players crash before they reach the turn limit. 

To adjust the number of turns, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

THROTTLE CUT ALTITUDE- 
As mentioned previously, in an Autorotation/Deadstick event, the host can set the 
rules so that the throttle is cut manually or automatically.  This section refers to the 
settings for a manual throttle cut.  For information on automatic throttle cuts, please 
see the Player Kills Engine section below. 

To adjust the altitude at which the throttle is cut, click on the corresponding value.  
Enter the desired altitude value directly from the keyboard or via the mouse wheel. 

TIME TO COMPLETE TURN (SEC)- 
This is the amount of time allotted for each player to complete his or her turn. 
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Note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 

TARGET SCALE- 
This option determines the size of the landing targets. 

To modify the size of the landing area, enter a number in the corresponding value 
column.  Enter the desired value directly from the keyboard or via the mouse wheel.  
The size of the targets will scale proportionally. 

CRASH ELIMINATES PLAYER- 
This option determines whether a crash eliminates a player from the competition.  If 
No, the player will be able to continue his/her turn regardless of whether or not they 
have crashed.  If Yes, the event is over for them as soon as a crash occurs. 

To set Crash Eliminates Player option, click the value in the corresponding 
column.  From the pull-down list, select either Yes or No. 

PLAYER KILLS ENGINE 
This option determines whether you want to cut off the engine manually or allow 
RealFlight G3.5 to do so for you.  If enabled, the player must manually kill the 
engine above the Throttle Cut Altitude.  RealFlight will display the engine cut 
notification for you on-screen.  With automatic throttle cutting, RealFlight G3.5 will 
automatically cut the throttle as soon as the aircraft crosses the minimum altitude 
threshold.  Again, RealFlight will display the engine cut notification for you on-
screen. 

To set Player Kills Engine option, click the value in the corresponding column.  
From the drop-down list, select either Yes (manual cut required) or No (automatic 
cut at altitude). 

AUTOROTATION/DEADSTICK INSTRUCTIONS 

STARTING AN AUTOROTATION/DEADSTICK EVENT 
You can run an autorotation competition in either a single player or multiplayer 
environment. 

The person who starts the event decides upon the applicable rules and parameters.  
For example, you can set: 

• The time allotment for each player’s turn 

• How many turns each player receives 

• Whether a player’s engine is automatically or manually killed during a 
turn 

• The altitude at which an engine must be killed 

• The physical dimensions of the landing target 

• Whether or not a crash automatically disqualifies a player 

• Point values of the different zones within the landing target 
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RealFlight G3.5 automatically applies the rules you choose, and keeps track of 
scores.  During the event, the announcer’s voice will guide you through each phase 
of the competition. 

RULES  
The Autorotation/Deadstick course consists of a target: 

 

The object of the Autorotation/Deadstick event is to fly your model over the target, 
kill the engine, then touch down as close as possible to the center of the target.  
Players take turns making landing attempts.  When your turn comes, you will 
normally take off, gain altitude until you are above the minimum Throttle Cut 
Altitude, fly towards the target, and then kill your engine and auto rotate or glide to 
the ground. 

If the host so decides, you must kill your engine before dropping below the minimum 
altitude to kill engine.  Alternatively, the host can decide that your engine will 
automatically shut off when you pass below this altitude.  The host must also decide 
on the minimum Throttle Cut Altitude. 

A “touch down” occurs when any part of your airplane or heli touches ground.  Each 
touch down is marked with an ‘X’ on the spot at which the aircraft landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

An “attempt” means you have passed below the minimum altitude to kill your 
engine.  Once your engine is killed, you cannot reactivate it until your turn expires.  
Additionally, you must land successfully (without crashing) to receive any points for 
your attempt. 

Furthermore, you must complete your landing before your turn time expires.  If you 
do not touch down in time, you lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you will receive.  Your touch down point is 
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the point on the ground directly below the center of your aircraft, no matter what part 
of your aircraft touches first. 

The event continues until the players complete all of their turns, all of the players are 
disqualified (usually by crashing), or everyone has left the event.  The player with 
the highest point total at the end of the event is the winner. 

EVENTS VIEWPORT DISPLAY BOX 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes:  it indicates the player’s name, tracks the amount of time remaining 
to complete the event, and indicates the remaining altitude before the engine is cut. 

If you do not wish to view this information, double-click on the airplane icon in the 
upper left corner of the display box.  This will hide the information.  To view it once 
again, simply double-click the airplane icon. 

To reveal the statistics for the event, click the arrow button in the upper right corner 
of the box.  Click the arrow button one more time to hide this information. 

 
To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse, drag the frame according to your wishes.  If you drag it downward, the 
vertical size of the viewport will increase.  Dragging the frame to the right or left will 
increase/decrease the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the viewport will close the viewport. 

LIMBO 
A limbo event is a contest of piloting skill and courage.  Players attempt to maneuver 
their aircraft under a horizontal bar suspended across two vertical bars.  After each 
successive pass, the bar is lowered.  The event continues until only one pilot remains. 

When you select Limbo, you will see the following screen: 
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SELECTING YOUR NAME FOR THE EVENT 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, 
please do so in the space provided when you select an event.  Click OK when 
completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Your Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

OPTIONS 
The Options… menu item is used to adjust the parameters and rules for each of the 
Events.  See the Autorotation/Deadstick section for general notes about this screen.  
This section examines the specific selections available for the Limbo options. 
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MINIMUM BAR HEIGHT- 
This setting determines the lowest height that the bar will reach during the Event. 

To adjust the Minimum Bar Height, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

MAXIMUM BAR HEIGHT- 
This setting determines the highest setting (starting value) that the bar will reach 
during the event. 

To adjust the Maximum Bar Height, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

DISTANCE TO DROP BAR EACH ROUND- 
After a participant successfully passes under the limbo bar, on their next attempt the 
bar will lower by the amount indicated in this setting. 

To adjust the distance to lower the bar each round, click on the corresponding value.  
Enter the desired value directly from the keyboard or via the mouse wheel. 

COMMIT LINE DISTANCE- 
This indicates the distance between the commitment lines and the limbo bar.  There 
is a commitment line on either side of the limbo bar and participants may approach 
from either side.  These lines detect an attempted pass at the limbo bar. 

To adjust the distance, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE BETWEEN POLES- 
The value entered here indicates the distance between the two vertical poles that 
support the limbo bar.  The wider the space between the poles, the easier it is to pass 
through the gate, so to speak. 
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To adjust the distance, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

TIME TO COMPLETE TURN (SEC)- 
This is the amount of time allotted for each player to complete his or her turn. 

Please note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 

ATTEMPTS PER TURN- 
This value indicates the number of attempts that each pilot is allotted at any given 
height of the limbo bar before being eliminated for that turn. 

To adjust the number of attempts, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

TURNS PER EVENT- 
This option determines the number of turns per player for this event.  When this 
number is reached, the event is over.  If the host activates the Crash Eliminates 
Player option, however, the event may end sooner. 

To adjust the number of turns, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

CRASH ELIMINATES PLAYER- 
This option is used to determine whether a crash eliminates the player from the 
competition.  If No, the player will be able to continue his/her turn regardless of 
whether or not they have crashed.  If Yes, the event is over for them as soon as a 
crash occurs. 

To determine whether or not a crash eliminates a player, click the value in the 
corresponding column.  From the drop-down list, select either Yes or No. 

LIMBO INSTRUCTIONS 

STARTING A LIMBO EVENT 
A limbo competition can be run in either a single player or multiplayer environment. 

The limbo course consists of a limbo pole, and two attempt lines (also called 
commitment lines), one on each side of the limbo pole: 

The object of limbo is to fly an aircraft past the attempt line, then under the limbo 
bar, in the time allowed.  Players take turns attempting to fly under the bar.  When 
your turn comes, you will normally take off, circle back towards the limbo pole, then 
pass across the attempt line and under the bar, then land.  If you successfully fly 
under the bar, the bar height will be lower during your next turn. 

An “attempt” means you have crossed the attempt line, approaching the limbo bar.  
You can make multiple attempts, if necessary, during a turn. 
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You have anywhere from 10 seconds to five minutes between the moment you first 
lift off and the moment you successfully pass under the bar.  If you fail to make it 
under the bar in time, you lose your turn.  (Before the event begins, the host decides 
the exact time limit.) 

You can approach the limbo bar from either direction (i.e., you can cross either 
attempt line).  For an attempt to count, you must be approaching the limbo bar when 
you cross an attempt line.  Your aircraft must be airborne when it crosses the attempt 
line and when it passes under the bar (i.e., if you taxi, your attempt will not count). 

The event continues until each player has made it under the lowest bar height, or has 
been disqualified (usually by crashing), or has left the event.  

The player with the highest score wins.  Your score for each successful turn is: 

(time between first liftoff and successful pass) X (height cleared) / 100 

Notice that you will achieve or earn the highest score by passing under the bar as 
soon as possible after takeoff. 

If you did not make it under the bar, your score for that turn is zero. 

EVENTS VIEWPORT DISPLAY BOX 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes.  General notes on the functionality for this window were discussed 
in the Autorotation/Deadstick event section. 

 

 FREESTYLE 
RealFlight G3.5’s Freestyle event lets you make the rules.  When you start a 
Freestyle event, RealFlight G3.5 will allot every player a set of turns.  Each player’s 
turn ends when that player’s time expires (or if the player crashes).  When this 
occurs, the next player’s turn begins.  What players do during their respective turns 
is completely up to the participants.  We’ve included some possible freestyle 
examples below.  
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Whatever activity you pick, RealFlight will see that each player receives a timed 
turn.  You can use freestyle with any aircraft (airplanes or helis). 

SELECTING YOUR NAME FOR THE EVENT 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, 
please do so in the space provided when you select an event.  Click OK when 
completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Your Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

OPTIONS 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the events.  The Autorotation/Deadstick Event section discusses 
general notes for this option.  This section examines the selections available for the 
Freestyle options. 
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TIME TO COMPLETE TURN (SEC)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  the time begins at takeoff. 

To adjust the amount of time to complete the event, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 

TURNS PER EVENT- 
This option determines the number of turns that will be allotted to a player for the 
event.  The event is over when each player has taken this number of turns, or sooner 
if the host activates the Crash Eliminates Player option and a crash occurs. 

To adjust the number of turns, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

CRASH ELIMINATES PLAYER- 
This option determines whether a crash eliminates a player from the competition.  If 
No, the player will be able to continue his/her turn regardless of whether or not 
they’ve crashed.  If Yes, the event is over for them as soon as they crash. 

To determine whether a crash eliminates a player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

FREESTYLE INSTRUCTIONS 

STARTING A FREESTYLE EVENT  
You will usually want to use Freestyle in a multiplayer environment, but it works in 
single player mode as well. 

Before you start this event, you will ordinarily decide what the participants must do.  
You may just want to use the event to give everyone an equal chance to showcase his 



290  •  Chapter 9.  The Events Menu R/C Simulator RealFlight 

or her aerobatic skills.  This will prevent you from worrying about your scoring.  If 
you want to have a competition, we suggest that before you begin the event: 

• Everyone should agree on the rules. 

• The host may need to edit the airport to add any equipment (pylons, 
runways, fences, obstacle rings, limbo poles, etc.) that you will need for 
the event. 

• Everyone should agree how the event will be judged.  You could 
appoint one player to decide on a score for every other player, or have 
everyone in your session vote on the best maneuver, etc. 

The person who starts the Event (multiplayer session host) can pick: 

• How much time each player is allotted per turn 

• How many turns each player receives, and 

• Whether a player who crashes is automatically disqualified 

We emphasize, the only limit on the freestyle event is your imagination.  A few 
examples of what you might wish to do: 

• Touch and Go.  Appoint one partner to count runway touches, 
contestant with the most touches in a turn wins. 

• Aerobatics.  Players use their turns to perform any stunt they want.  At 
the end, everyone votes on the best stunt. 

• Obstacle course.  Set up a long obstacle (table, etc.) close to the ground 
and take turns flying under it; land or take off from ramps, circle 
around pylons, etc. 

It does not have to be a contest.  You might all just want to take an equal turn at 
using the runway (take off, land on alternate turns). 

EVENTS VIEWPORT DISPLAY BOX 
During the event, a situational screen will appear on your display.  General notes on 
this display were discussed in the Autorotation/Deadstick event section. 

PYLON RACING 
In pylon racing, pilots race their planes around a closed course.  Pylon Racing 
challenges the pilots’ nerves and skill as they attempt to round the pylons, avoid mid-
air collisions, and finish first, without cutting any pylons. 
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SELECTING YOUR NAME FOR THE EVENT 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, 
please do so in the space provided when you select an event.  Click OK when 
completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Your Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

OPTIONS 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the Events.  To access the Options… menu item, click the Events 
menu followed by the Options… menu item.  Next, from the left hand column, click 
on the event for which you wish to adjust the Options….  The selections that appear 
will be dependent upon the event selected.  This section examines the selections 
available for the Pylon Racing Options. 
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LAPS TO COMPLETE- 
This value determines the number of laps that each participant must complete in the 
event.  The person who completes the laps in the shortest amount of time (after 
penalties) is the winner. 

To adjust the number of laps, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

CUTS ALLOWED- 
This setting dictates the number of cuts (passes inside a pylon) that a racer is allowed 
before being eliminated from the event. 

To adjust the number of allowable cuts, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

CUT PENALTY (SEC)- 
This option determines the time penalty that a player receives for each cut they make 
during a race.  If the player exceeds the number of allowable cuts, they are 
eliminated from the race. 

To adjust the penalty seconds per cut, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

THREE PYLONS ON COURSE- 
This setting determines whether the course is a three-pylon course or a two-pylon 
course.  If Yes is selected, the course is a three-pylon course.  If No, the course is a 
two-pylon course. 

To set this option, click the value in the corresponding column.  From the pull-down 
list, select either Yes (three pylon course) or No (two pylon course). 
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THRESHOLD RULES- 
In threshold racing, the planes do not actually have to go around the pylon.  Rather, 
they only have to break the plane of the pylon.  This option is only enabled for two 
pylon courses.  It is grayed out (not applicable) on three pylon courses. 

To determine whether the Threshold Rules will be utilized, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

DISTANCE BETWEEN PYLONS 1 AND 2- 
If you have selected a two-pylon course, this option indicates the distance between 
the two pylons.  Increasing the value places the pylons farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE TO PYLON 1- 
This is the distance from the starting point to pylon number 1.  This option is only 
applicable to three-pylon courses. 

To adjust the distance, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

DISTANCE BETWEEN PYLONS 2 AND 3- 
If you have selected a three-pylon course, this option indicates the distance between 
the pylons two and three.  Increasing the value places the pylons farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired value 
directly from the keyboard or via the mouse wheel. 

PYLON RACING INSTRUCTIONS 

STARTING A PYLON RACING EVENT  
You can run a pylon race in either a single player or multiplayer environment. 

The person who starts the event (the host) decides upon the applicable rules and 
parameters.  For example, the host can set: 

• How many pylons mark the course (two or three) 

• Regular or threshold-style racing (two-pylon races only) 

• The number of laps in the race 

• The distances between pylons 

RealFlight G3.5 automatically applies the rules you choose, and keeps track of 
scores.  During the event, an announcer’s voice will guide you through each phase of 
the competition. 

PYLON RACING RULES 
A pylon-racing course consists of two or three pylons.  Here is an example of a three-
pylon course: 
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For both two-pylon and three-pylon races, the object is to take off and circle the 
pylons (without “cutting”) in the shortest amount of time.  A pylon race usually has 
two or more laps.  All racers start together.  The race continues until each player is 
either finished or disqualified (usually by cutting or crashing). 

All players start at the same point on the runway.  When you hear the horn sound, 
take off and start the race. 

In pylon racing, you always circle the pylons counterclockwise viewed from above—
that is, when you come to a pylon you always turn left.  As you approach each pylon, 
you will hear a voice telling you when to start your turn.  When you have made a 
successful turn, you will hear a brief tone. 

“Cutting” is illegal.  The first time you cut during a race, you are penalized one lap.  
The second time you cut, you are disqualified.  To avoid being called for a cut, your 
entire aircraft must normally go completely around each pylon. 

Exception:  in a two-pylon style course, you can choose to use threshold-racing 
rules.  In threshold racing, your aircraft only has to “break the plane” of the pylon to 
get credit for a legal turn.  This allows pilots to find independent race lines, which 
may reduce collisions during a race.  Before the race begins, the host chooses 
whether the race will follow regular or threshold rules. 

The pilot who finishes the required number of laps in the shortest amount of time 
wins the race. 

EVENTS VIEWPORT DISPLAY BOX 
During the Event, a situational screen will appear on your display.  This screen 
serves several purposes.  General notes on this screen were discussed in the 
Autorotation/Deadstick event section. 

 

SPOT LANDING  
In a Spot Landing event, pilots take turns trying to touch their aircraft down within 
marked zones.  Generally, the zones that are more difficult to target have higher 
point values.  In a multiplayer event, the player with the highest points total wins. 
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SELECTING YOUR NAME FOR THE EVENT 
To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Your Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

OPTIONS 
As the name suggests, the Options… menu item adjusts the parameters and rules for 
each of the Events.  To access the Options… menu item, click the Events menu 
followed by the Options… menu item.  Click on the event, located in the left column 
that you wish to adjust.  The options that appear are dependent upon the event 
selected.  This section discusses the selections available for the Spot Landing 
options. 
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ZONE POINT VALUES- ZONES A THROUGH E 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of difficulty.  
Zone A is the most difficult to hit.  Therefore, it offers the highest point value.  Zone 
B, which surrounds the center, offers the second highest points, followed by Zone C, 
D and E. 

To adjust the point values of the different zones, click on the values in the column to 
the right of the respective Zone Points.  For example, to adjust the points for Zone A, 
click on the corresponding value in the column next to Zone A.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

TARGET SCALE- 
This option determines the size of the landing targets.  To increase the size of the 
landing area, enter a larger number in the corresponding value column.  The target 
size will scale proportionally. 

TIME TO COMPLETE TURN (SEC)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  this time begins at takeoff. 

To adjust the amount of time to complete the event, click on the corresponding 
value.  Enter the desired value directly from the keyboard or via the mouse wheel. 

TURNS PER EVENT- 
This option determines the number of turns allotted to the player for the Event.  The 
event is over when each player has had this number of turns.  If the Crash 
Eliminates Players option is enabled, the event can also end when all of the players 
have been eliminated due to crashing. 

To adjust the number of turns, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel.  
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CRASH ELIMINATES PLAYERS- 
This option determines whether a crash eliminates a player from the competition.  If 
No, players will be able to continue their turns regardless of whether or not they 
crash.  If Yes, the event is over for them as soon as they crash. 

To determine whether a crash eliminates the player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

SPOT LANDING INSTRUCTIONS 

STARTING A SPOT LANDING EVENT  
A spot landing competition can take place in either a single player or multiplayer 
environment. 

The person who starts the event (the host) is responsible for selecting the rules.  For 
example, you can set: 

• How much time each player receives per turn 

• How many turns allowed per player 

• The physical dimensions of the landing target 

• Whether a crash automatically disqualifies the player 

• Point values of the different zones within the landing target 

RealFlight G3.5 automatically applies the rules you choose, and keeps track of 
scores.  During the event, the announcer’s voice will guide you through each phase 
of the competition. 

RULES 
The object is to touch down as close as possible to the center of the target.  Players 
take turns making landing attempts.  When your turn comes, you will normally take 
off, gain altitude and then fly towards the target on a landing approach. 

A “touch down” occurs when any part of your airplane or heli touches ground.  A 
large, visible ‘X’ marks each touch down on the spot where the aircraft landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

Furthermore, you must complete your landing before your turn time expires.  If you 
do not touch down in time, you lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you receive.  Your touch down point is the 
point on the ground directly below the center of your aircraft, no matter what part of 
your aircraft touches first. 

The event continues until each player has completed all of his or her turns, or has 
been disqualified (usually by crashing), or has left the event.  The player with the 
highest point total is the winner. 

You also have a limit on how many landing attempts you can make during your turn.  
The host sets this limit at the start of the event. 

You can approach the target from either direction (i.e., you can cross either attempt 
line).  For an attempt to count, you must be approaching the target when you cross an 
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attempt line.  The aircraft must be airborne when it crosses the attempt line (i.e., if 
you taxi, the attempt will not count). 

You can only touch down once per turn, so if it looks like you may miss the target, 
pull up, circle around, and try again. 

The event continues until the players have completed all of their turns, all of the 
players have been disqualified (usually by crashing), or everyone has left the event. 

The player with the highest total score wins. 

EVENTS VIEWPORT DISPLAY BOX 
During the event, a situational screen will appear on your display.  The 
Autorotation/Deadstick event section provides general notes on this display box. 

OOPPTTIIOONNSS    
The Options… menu item allows you to determine the various settings and 
parameters for the respective events.  The options available to you are dependent 
upon the event selected. 

 
To access the Options… menu item, click on the Events menu followed by the 
Options… menu item.  Next, select the Event for which you would like to view the 
Options….  For further information as to the Options… available for each event, 
see the applicable event as discussed previously. 

EENNDD  CCUURRRREENNTT  EEVVEENNTT  
This menu item immediately ends the current event.  If there are no events in 
progress, this menu item is grayed out.  If you are in a multiplayer session and are 
not the person hosting this session, the option is also grayed out. 
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LLEEAAVVEE  CCUURRRREENNTT  EEVVEENNTT  
This menu item enables you to leave any event that you did not start.  If you are a 
multiplayer participant and are not the host, use this as the method to leave the event 
before its completion. 

 
 

This item is grayed out if: 
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• You are the host of a multiplayer event (you can only exit by selecting 
End Current Event, which ends the event for everyone); or 

• You are the only participant in this event 

If you leave a multiplayer event, you will remain part of the multiplayer session.  
You will be able to fly, and you can watch the event continue, but you cannot re-
enter the event. 

FFOORRFFEEIITT  TTUURRNN  
This item allows you to forfeit one turn.  If you are a multiplayer participant, all 
other pilots will take their turns before you can participate again. 

 
This item is grayed out if you are playing an event where players do not take turns 
(e.g. Pylon Racing). 
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CCHHAAPPTTEERR  1100..    TTHHEE  MMUULLTTIIPPLLAAYYEERR  
MMEENNUU  

MMUULLTTIIPPLLAAYYEERR  MMEENNUU  OOVVEERRVVIIEEWW  
The Multiplayer option allows you to fly with others.  In fact, you are able to share 
the skies with up to seven additional pilots.  These other pilots can be across the 
street, around the block, or around the world! 

There are two ways to link up with the additional pilots; via a LAN (Local Area 
Network), or over the Internet.  In order to do so, you will need a TCP/IP connection, 
either through your LAN or an ISP (Internet Service Provider). 

Every session requires someone to serve as host.  The host initiates the multiplayer 
session.  When the Host starts a session, other participants may join in. 

The Multiplayer menu allows you to access a variety of multiplayer-related 
features, functions and options.  Clicking the Multiplayer menu brings forth a pull-
down menu, which will look similar to the following screen shot: 
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• Host… 

• Join… 

• Disconnect (grayed out) 

• Boot Player… (grayed out) 

• Publish Hosting Information (grayed out) 

• Enter MultiMode 
As noted above, some of these items will be grayed if they do not apply to the 
current situation.  For example, you cannot disconnect unless you are currently 
connected.  As such, the Disconnect menu item is grayed out unless you are in a 
multiplayer session. 

When you participate in multiplayer sessions, the menu commands you will access 
depend on whether you are the host or whether you opt to join someone else’s 
session.  These commands also depend upon whether you already know a specific 
session you want to join. 

Depending on what options the participants utilize, it is possible to have a private 
session that is only open to players who know the host’s IP address. 

Please note:  a computer’s IP address is its Internet “postal code”.  It tells other 
computers on the Internet how to contact that computer.  The following sections will 
explain more about IP addresses as necessary. 

It is also possible to participate in a public session using our list server.  The list 
server is a publicly available list of open RealFlight G3.5 sessions.  Currently we 
provide the list server to all RealFlight G3.5 owners, free of charge.  The list server 
allows you to participate in multiplayer sessions with other RealFlight G3.5 users 
anywhere in the world. 

IMPORTANT INFORMATION ABOUT THE LIST SERVER:  At the time of 
this writing we are providing the list server service on a trial basis.  This service 
may be modified, interrupted or cancelled at any time without notice.  In 
particular, we make no guarantee about the reliability of this service.  To use 
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this service you must register your product and may need to obtain product 
updates.  Inclusion of this manual on your RealFlight CD-ROM does not imply 
that this service will be available at the time you purchase this product.  
Moreover, we reserve the right to bar any individual user, or all users at 
individual IP addresses or domains, from using the list server at our discretion.  
Abusive behavior, for example, will not be tolerated. 

CHAT DIALOG BOX 
During Multiplayer sessions, a chat dialog box will appear on your display.  This 
screen allows you to chat with other participants in the multiplayer sessions. 

 
To send a chat message, click on the dialog box.  Next, using the keyboard, type the 
message you wish to send.  Press the Enter key on the keyboard to send the 
message. 

Please note:  all messages are viewable by all participants.  RealFlight G3.5 does not 
offer private chat. 

If you do not wish to view this dialog box, double-click on the airplane icon in the 
upper left corner of the display box to hide the box.  To view it once again, simply 
double-click the airplane icon. 

To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse drag the frame according to your wishes.  If you drag it downward, the 
vertical size of the viewport will increase.  Dragging the frame to the right or left 
increases or decreases the width of the viewport respectively. 
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Clicking on the ‘X’ in the viewport’s title tab removes it from the screen altogether. 

HHOOSSTT  
Every multiplayer session requires one participant to function as the host.  If you are 
the host, you will be the one who starts the session.  When you leave the session one 
of the remaining participants automatically assumes the role of host.  The host is also 
the one who starts and ends the events (Limbo, Pylon Racing, etc.). 

Once you have started the session, other players may join in as they wish. 

If you opt to broadcast the session to the list server, the session is known as a public 
session.  The session will be open to all G3.5 owners searching for multiplayer 
events. 

If you wish to keep the session private, only those participants to whom you have 
provided your IP address will be able to join. 

The procedures for starting public and private sessions are very similar.  In order to 
join your session, the participants will usually need to know the IP (Internet 
Protocol) address of your computer.  The exception is if you are holding the session 
over a LAN, in which case the other players do not need to know your IP address.  
For a public session, your partners can retrieve your IP from the list server.  For a 
private session, you must provide the IP address directly to the desired participants.  
When the session starts, RealFlight G3.5 will display your IP in the lower left corner 
of the main display. 
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To access the Host… menu item, click on the Multiplayer menu followed by the 
Host… menu item. 

HOST INFORMATION 

 

SESSION NAME 
Using the keyboard, enter the name of the session that you will be hosting. 

Please note:  this is the name of your session, not necessarily your personal name.  In 
fact, you might find it useful to use a descriptive name such as “3D Fun Fly.”  This is 
particularly useful when other participants are searching for a likely session to join. 

MAX PLAYERS 
To adjust the maximum number of players allowed in your session, click the down 
arrow.  Enter the number directly from your keyboard or use the mouse wheel. 
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Currently, a multiplayer session may not have more than eight members.  If the host 
computer is somewhat slow or has a poor Internet connection, you may want to limit 
the number of participants. 

OPTIONAL PORT NUMBER 
For users that are behind firewalls, you may want to use a port other than the default 
port (which is 2302).  Most users should leave this field blank. 

BROADCAST TO THE LIST SERVER 
Clicking this option allows your session to be posted on the list server.  This allows 
other RealFlight G3.5 users to join your session.  This is a good option if you are 
looking for new (or additional) partners to fly with.  If you check this box, you will 
be prompted for session information (see next section). 

If you leave this box unchecked, your session will not be posted on our list server 
and you will have a private session.  You will have to directly provide your IP 
address to your multiplayer partners (through phone, email, chat room, or whatever 
means you wish).  This is a good option if you want to limit your session to a private 
group of friends. 

If you do not want to broadcast your session information now, you can do so after 
the start of the session (see section pertaining to Publish Hosting Information…).  

Finally, please remember that at the time of this writing, we are providing the list 
server on a trial basis only.  This service may be modified, interrupted or 
discontinued at any time without notice. 

JJOOIINN  
This option allows you to participate in a Multiplayer session without being the Host 
of the session yourself. 
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To access the Join… menu item, click on the Multiplayer menu followed by the 
Join… menu item. 

Before you can join a session, you will need two things: 

• A network connection and 

• The IP address of the session Host (unless the session is taking place 
over a LAN [Local Area Network]). 

You can get the IP address directly from the Host (in the case of a private session), 
or from our list server (in the case of a public session). 

When you click Join, the following dialog will activate: 

JOIN SESSION 
This dialog allows you to select the multiplayer session that you wish to join.  It also 
provides you with a variety of information pertaining to the various sessions 
available to you. 

 

SEARCH FUNCTION- 
The Search function checks two distinct areas for multiplayer sessions.  RealFlight 
G3.5 (at your discretion) will search the list server and the Local Network for 
multiplayer sessions. 

To determine the Search area, click the down arrow next to the Start button.  This 
activates the pull-down selections.  Click on the location that you wish to search. 

After making your selection, click the Start button to begin the search.  When the 
search completes, the respective sessions and information appear in the dialog above.  
To select one of these sessions, click on the respective session and then click OK.  
Alternatively, you may double-click on the Session Name to join. 

Note:  if you are using an updated version of Windows XP (Service Pack 2 or later), 
you may have Windows Firewall installed and running.  If this is the case, Windows 
Firewall will pop up a warning dialog (similar to that shown below) the first time 
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you use the Search function.  You must select the Unblock option in order to allow 
RealFlight G3.5 to continue searching. 

 

SESSION NAME- 
The Session Name column displays the name of all available sessions.  If you have 
not searched (and found) a session, or entered an IP address, the Session Name will 
remain blank. 

HOST- 
This column shows the IP address of the host computer.  If you have accessed the 
address via the Search function, this information automatically fills in for you when 
you select the session.  If you participate in a multiplayer session via a LAN, you do 
not need to fill in the IP address.  If you participate in a private session, fill in the IP 
address here.  When completed, click OK to proceed. 

PORT- 
This information is important if you are attempting to participate in a multiplayer 
session and the computer is located behind a firewall or NAT.  The Port Number will 
route your computer’s data through the firewall.  It is imperative that this port 
number matches the port number of the host. 

PLAYERS- 
This column shows the users how many players are participating in a given 
multiplayer session.  The host determines the number of allowable participants. 

LATENCY- 
Latency is the amount of time it takes a packet of information to travel from its 
source to the destination.  The larger the number, the slower the information travels.  
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High latency can result in sluggishness and “lag” while running the simulation.  As 
such, you will want to avoid sessions where the latency number is high. 

DDIISSCCOONNNNEECCTT……  
This menu item is used to disconnect from or exit the multiplayer session. 

 
To access the Disconnect… menu item, click on the Multiplayer menu followed by 
the Disconnect… menu item. 

Please note:  if you are not currently participating in a multiplayer session, this item 
will be grayed out and will not be accessible. 

BBOOOOTT  PPLLAAYYEERR……  
This menu item is used to drop a participant from a multiplayer session.  It is only 
available if you are the host of the session.  Otherwise, this item is grayed out and 
inaccessible. 
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To access the Boot Player… menu item, click on the Multiplayer menu followed 
by the Boot Player… menu item.  

The booted player will receive an on-screen message advising him/her that the host 
has booted (removed) them from the session. 

PPUUBBLLIISSHH  HHOOSSTT  IINNFFOORRMMAATTIIOONN  
You can make your session public (placed on the list server) when you first start the 
session.  Alternatively, you can do this while the session is in progress by selecting 
this menu item.  When you click OK, RealFlight G3.5 publishes your session 
information to the list server, where everyone can see it. 
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Please note:  at the time of this writing, we are providing the list server on a trial 
basis only.  This service may be modified, interrupted or discontinued at any time 
without notice. 

  EENNTTEERR  MMUULLTTIIMMOODDEE  
MultiMode allows you to fly with another pilot on the same PC, with each pilot 
controlling his or her own aircraft.  This feature is ideal for offering personal flight 
instruction, practicing formation flights, or simply for chasing one another across the 
skies. 

 



312  •  Chapter 10.  The Multiplayer Menu R/C Simulator RealFlight 

To access the MultiMode menu item, click on the Multiplayer menu followed by 
the MultiMode menu item. 

 

SIMULATION- 
This menu allows you to adjust a variety of simulator-related features, functions and 
options as they relate to the MultiMode menu item. 

SELECT AIRPORT- 
To select an alternative airport, click on the Simulation menu followed by 
the Select Airport…menu item. 

Please note:  this will change the airport for both players in MultiMode. 

For more information on the Select Airport… menu item, please refer to 
Chapter 6:  The Simulation Menu. 

SETTINGS- 
The Settings… menu item modifies a variety of simulation-based settings.  
For example, the Settings… menu item switch from a horizontal orientation 
to a vertical orientation in the MultiMode screens. 

To access this menu item, click on the Simulation menu followed by the 
Settings… menu item. 

Please note:  this will change the Settings… for both players in MultiMode. 

For more information on the Settings… menu item, please refer to Chapter 
6:  The Simulation Menu. 

EXIT MULTIMODE- 
This option allows you to exit the MultiMode function and return to the 
single-player simulation mode. 
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To access this menu item, click on the Simulation menu followed by the Exit menu 
item. 

AIRCRAFT- 
This menu allows you to adjust a variety of aircraft-related features, functions and 
options as they apply to the MultiMode menu item. 

SELECT AIRCRAFT…- 
Again, for the purpose of MultiMode, RealFlight treats each aircraft 
independently.  As such, it is possible to perform modifications to the 
aircraft or select another model whenever you wish to do so. 

Prior to selecting an aircraft, click on the viewport that you wish to modify.  
This will become the active view in the simulation.  To select a new 
aircraft, click on the Aircraft menu followed by the Select Aircraft… 
menu item. 

For more information on selecting an aircraft, please refer to Chapter 7:  
The Aircraft Menu. 

RESET POSITION- 
This menu item resets the aircraft position for the active viewport.  To 
select the active view, use the mouse and click on the desired viewport.  
Next, click on the Reset Position menu item.  This will reset the aircraft 
position. 

If the aircraft that you wish to reset is controlled by the InterLink Plus 
controller, you can simply press the red push-button.  The aircraft will reset. 

KILL ENGINE- 
Use this menu item to cut the throttle of the aircraft in the currently active 
viewport.  To select the active view, use the mouse and click on the desired 
viewport.  Next, click the Kill Engine menu title.  This will kill the engine 
immediately. 

Alternatively, you can press the ‘K’ key to cut the throttle on the aircraft. 

CONTROLLER- 
This menu adjusts the controller-related functions for the simulation.  Each user must 
have a controller connected to the PC to take advantage of the MultiMode feature.  
These controllers must be plugged into the PC or InterLink Plus prior to accessing 
the MultiMode feature.  If this is not the case, you will receive an on-screen error 
message. 

One modeler must utilize the InterLink Plus controller; the other may use an 
additional InterLink Plus, a G2 InterLink or an actual R/C transmitter. 

SELECT CONTROLLER- 
To change controllers in MultiMode, click on the viewport that you wish to 
modify.  This will become the active view in the simulation.  To choose the 
method of control, click on the Select Controller menu item from the 
Controller menu title.  The selection(s) will vary depending on whether or 
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not you have attached an actual R/C transmitter to the interface adapter on 
the InterLink Plus. 

Please note: if you have attached a controller to the interface port, 
RealFlight G3.5 will pause briefly while it detects the transmitter. 

The selections are:  InterLink Joystick and InterLink Transmitter X 
Channel.  If you will be using the InterLink Plus controller for the 
simulation, please select the InterLink Joystick option.  If you will be using 
your own controller in the simulation, choose the InterLink Transmitter X 
Channel. 

CONTROLLER CALIBRATION…- 
This menu item is used to calibrate the controller for the active viewport.  
To calibrate the controllers in MultiMode, click on the viewport for which 
you wish to modify.  This will become the active view in the simulation.  
To calibrate your transmitter, click the Controller menu followed by the 
Controller Calibration… menu item.  Follow the on-screen instructions to 
complete the calibration procedure. 

CHANNEL MAPPING…- 
This menu item alters the channel input when using RealFlight’s InterLink 
Plus controller as an interface. 

Prior to mapping the channels for the controllers in MultiMode, first click 
on the viewport that you wish to modify.  Next, follow the Channel 
Mapping… procedure as described in Chapter 8 of this manual. 

VIEW- 
This menu adjusts the various view-related features and functions for the simulation.  
Simply put, the View menu adjusts what you are looking at as well as where you are 
looking from.  RealFlight G3.5’s MultiMode option allows you to adjust many of the 
View options independently for each of the viewports in the simulation. 

SHOW- 
The Show menu item determines whether to show or hide scenery objects in 
the airport.  The selections made here apply to both viewports in 
MultiMode.  Selecting this item activates a drop-down menu with a list of 
items that you can show (make visible) or hide (remove from visibility).  To 
show items, check them in the drop-down menu.  Conversely, to hide items 
uncheck them. 

If the frame rate slows dramatically when using the MultiMode feature, try 
turning off some of the items listed in the Show menu.  This will improve 
the frame rate. 

To access this menu item, click on the View menu followed by the Show 
menu item. 

CAMERA TYPE- 
This menu item determines the Camera Type for the active viewport.  Each 
viewport is independently adjustable.  Each pilot may select from a Fixed 
Position, Cockpit or a Chase view. 
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Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To access the Camera Type adjustments, click on 
the View menu followed by the Camera Type menu item.  Select your 
preferred view type from the pull-down list. 

Alternatively, you may press the keyboard’s ‘C’ key to toggle through the 
Camera Type options. 

CAMERA POSITION- 
This menu item determines where the position of the camera.  Depending 
upon the airport selected, there may be one or more Pilot Spawn views. 

Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To access the Camera Position adjustments, click 
on the View menu followed by the Camera Position menu item.  Select 
your preferred view position from the pull-down list. 

Alternatively, you may press the keyboard’s ‘X’ key to toggle through the 
Camera Position options available to you. 

LOOK AT- 
This menu item changes what the camera will concentrate on viewing.  You 
will usually want the camera to remain focused on your aircraft.  If you 
wish to look at the other player’s aircraft, the option exists to do so. 

Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To access the Look At adjustments, click on the 
View menu followed by the Look At menu item.  Select your preferred 
view from the pull-down list. 

QUICK LOOK- 
The Quick Look feature allows you to quickly glance at an object.  When 
you activate this option, the camera briefly looks at the selected item and 
then returns to the previous vantage point for the active viewport.  As an 
example, you can use it to sneak a quick look at the windsock and then 
return to viewing your aircraft. 

Click on the viewport that you wish to modify.  This will become the active 
view in the simulation.  To access the Quick Look menu item, click on the 
View menu followed by the Quick Look menu item.  Select the Quick 
Look option that accomplishes your goal. 

Alternatively, after you have activated the correct viewport, press the Down 
Arrow on your keyboard to take a quick glance towards the ground. 

ZOOM TYPE- 
The Zoom Type menu item allows you to change the type of zoom used by 
the simulation. 

Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To access the Zoom Type menu item, click on the 
View menu followed by the Zoom Type menu item.  Select the Zoom 
Type option that accomplishes your goal.  You may select between Manual, 
Autozoom, and Keep Ground in View. 
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Alternatively, after you have activated the correct viewport, press the 
keyboard’s ‘Z’ key.  Each time you press the Z key you will toggle to the 
next Zoom Type. 

ZOOM IN- 
Once you have selected the type of zoom that you will utilize, you can 
customize it further by zooming in, which causes the camera to zoom closer 
to the target. 

Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To magnify the view or zoom in on the selected 
item, press the [+] (plus) key on the keyboard.  Each time you press the [+] 
(plus) key or select the Zoom In menu item, the zoom level increases 
incrementally.  Alternatively, you may select the Zoom In option from the 
View menu. 

ZOOM OUT- 
Once you have selected the type of zoom that you will utilize, you can 
customize it further by zooming out.  This option zooms the view away 
from the target. 

Click on the viewport that you wish to modify.  This becomes the active 
view in the simulation.  To access the Zoom Out menu item, click on the 
View menu followed by the Zoom Out menu item. 

After you have activated the correct viewport, you may also press the [-] 
(minus) key on your keyboard’s number pad to zoom out.  Each time you 
press the [-] (minus) key you will Zoom Out incrementally, zooming away 
from the target object. 

ZOOM RESET- 
This selection resets the zoom magnification level.  This is useful if you are 
zoomed way in or way out and want to return quickly to the default level of 
magnification. 

Click on the viewport that you wish to modify.  This will become the active 
view in the simulation.  To access the Zoom Reset menu item, click on the 
View menu followed by the Zoom Reset menu item. 

Alternatively, after you have activated the correct viewport, press the 
Backspace key on your keyboard.  When you press the Backspace key, the 
camera zoom will return to the default level of magnification. 

MULTIPLAYER- 
This menu provides you with a way to end the MultiMode session.  To exit the 
MultiMode, click the Exit MultiMode menu item. 

HELP- 
This menu provides you with miscellaneous assistance and help with a variety of 
simulator-related issues. 

To access the Help files, click on the Help menu title. 
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CONTENTS…- 
This menu item accesses RealFlight G3.5’s Help files.  The Help files 
contain information similar to this manual. 

To access the Contents files, click on the Help menu title. 

ABOUT…- 
The About… menu item shows some miscellaneous information pertaining 
to your simulation.  For example, the About… menu contains your 
RealFlight serial number as well as the version number of the software 
which you are currently operating. 

To access the About… files, click on the Help menu title. 

LICENSE… 
This menu item contains the End Users License Agreement (EULA) for the 
RealFlight R/C Flight Simulator. 

To access the License files, click on the Help menu title. 

Portions of this software utilize SpeedTree technology.  (c)2002 Interactive 
Data Visualization, Inc.  All rights reserved. 

WEBSITES- 
The Websites menu item allows you to connect to several websites- Great 
Planes, Knife Edge and the RealFlight home page - directly from the 
software.  This, of course, assumes that you have an Internet connection. 

To access the Websites information, click the Help menu title.
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CCHHAAPPTTEERR  1111..    RREECCOORRDDIINNGGSS  

RREECCOORRDDIINNGGSS  MMEENNUU  OOVVEERRVVIIEEWW  
The Recordings menu is used to start and stop recordings to assist you in your R/C 
ventures.  RealFlight G3.5 also allows you to record your flights for later playback -- 
complete with audio voiceovers.  You can even share your flights with friends and 
fellow pilots. 

 

START RECORDING 
Click on the Recording menu followed by the Start Recording menu item.  
RealFlight G3.5 will start recording your flight immediately.  An on-screen message 
will confirm that the recording has started. 
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Alternatively, you may also press the keyboard’s ‘R’ key to start a recording. 

RealFlight will continue recording your flight until you select the Stop Recording 
menu item or press ‘R’ again to stop recording. 

STOP RECORDING 
The Stop Recording menu item is not visible until the Start Recording menu item 
activates.  To stop the recording of your flight at any time, click the Recording menu 
title, followed by the Stop Recording option.  RealFlight G3.5 will stop recording at 
this time.  RealFlight G3.5 automatically saves all recordings for playback later.  For 
information on how to delete a recording, please see the Open Recording… section 
which follows. 
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Alternatively, you may also press the keyboard’s ‘R’ key to stop recording. 

When RealFlight G3.5 stops recording, an on-screen message appears which 
indicates the default name of the just-completed recording.  For information on how 
to change the name of a recording, please see the Open Recording… section which 
follows. 

OPEN RECORDING… 
This menu item allows you to access the recordings.  It also allows you to perform a 
variety of modifications to the files such as renaming them or deleting them.  To 
access the recordings, click the Recording menu title, followed by the Open 
Recording… menu item. 
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To open a recording, click on the file name.  Next, click on the Open button.  
Alternatively, you may right click on the file name and select Open from the pull-
down list.  Regardless of which method you utilize, this will start RealFlight’s 
Playback Gadget.  For more information on the Playback Gadget, please refer to 
the information below. 

If you wish to rename the recording, simply right click on the respective Recording 
and rename the file. 

To delete a recording, right click on the Recording file and select Delete from the 
pull-down list. 

PLAYBACK GADGET- 
When you open a recording, RealFlight G3.5’s playback gadget appears on the 
screen.  This gadget allows you to control the playback of the recordings using 
simple mouse commands.  It features DVD-like controls that start, stop, or pause the 
playback.  It is also possible to modify the playback gadget. 

 
If you do not wish to view the playback information, double-click the title bar of the 
display box.  This will hide the information.  To view it once again, simply double-
click the airplane icon. 

To resize the playback gadget display, position the cursor over the arrow indication 
found in the lower right corner of the frame.  Click and hold on the arrow.  Using the 
mouse drag the frame according to your wishes.  Dragging the frame to the right or 
left increases or decreases the width of the viewport respectively. 
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Clicking on the ‘X’ in the viewport’s title tab removes it from the screen and exits 
the playback. 

Loop Play- 

The arrows that form a circle cause the recording to loop (i.e., play continuously).  
The continuous loop is activated when the arrows are illuminated.  To stop the 
looping, click on loop button again. 

 
Look at Recording- 

Click on the ‘eye’ to look at the respective Recording.  This causes the camera to 
treat the recording as its target object, rather than your aircraft.  If you have multiple 
recordings playing, choose the ‘eye’ of the Recording you wish to view. 

 
Left/Right Arrows- 

The left and right arrows rewind (left) or fast forward (right) the recording.  
Alternatively, you may click on the position indicator, hold the mouse button and 
drag the indicator to the desired position. 

 
Playback/Pause- 

If the recording is paused, the playback button will be the single arrow pointing to 
the right.  To resume playback of the recording, click this arrow. 

 
If the recording is playing, the playback button will switch to a pause button.  To 
pause playback, press this button.  You may continue at any time by pressing the 
playback button once again. 
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Position of Recording- 

The slider bar and position indicator are used to track the progress of the recording 
playback. 

It is also possible to use the position indicator to select the point at which you wish 
the recording to begin playing.  Using the mouse drag, position the slider bar to the 
position desired. 

RECORD MICROPHONE INPUT 
RealFlight G3.5 also allows you to add your voice or other audio to the recordings.  
If selected, the Record Microphone Input menu item activates and allows you to 
record audio input to accompany your recording. 

 
Adding your voiceover to the recordings is a fantastic way to create personalized 
training lessons.  This feature presents you with the ability to create your own Virtual 
Flight Instructions that you can share with other RealFlight G3.5 owners around the 
world! 

RECORDINGS MRU 
If you have previously selected a recording, you will note that it appears on a list in 
the Recordings menu title.  List such as this are commonly referred to as Most 
Recently Used, or MRU lists.  The MRU list is limited to the eight most recently 
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selected recordings.  If you wish to view one of these recordings simply click on the 
name of the recording and it will begin. 
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CCHHAAPPTTEERR  1122..    TTHHEE  TTRRAAIINNIINNGG  MMEENNUU  

TTRRAAIINNIINNGG  MMEENNUU  OOVVEERRVVIIEEWW  
RealFlight G3.5 offers a number of training aids.  These training aids are designed 
for modelers of all skill levels. 

 
Helicopter pilots will benefit from the Heli Hover Trainer, Heli Orientation Trainer 
and the helicopter Virtual Flight Instructions.  The Heli Hover Trainer and Heli 
Orientation Trainer offer modelers the chance to practice their stick control and 
helicopter attitude recognition.  With Virtual Flight Instructions, R/C professionals 
offer audio and visual instruction on how to perform basic, intermediate and 
advanced maneuvers. 

Airplane modelers will also benefit from the Airplane Hover Trainer and Virtual 
Flight Instructions. 
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HELI HOVER TRAINER 
The Heli Hover Trainer offers you a great way to learn how to control a heli in a 
hover.  With the Heli Hover Trainer, you pick which channels you wish to control 
and RealFlight will take care of the rest for you. 

 
To start the trainer, click Heli Hover Trainer…menu item from the Training menu.  
The trainer will start automatically.   

You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your heli ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also note an ‘X’ mark within the boundary.  This 
represents the location of your helicopter.  The goal is to control the heli in a stable 
hover, keeping it as close to the center of the circle as possible. 
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You’ll also notice the menus have changed, which we’ll explain here.7 

Trainer Menu 
The Trainer Menu contains the following menu items: 

• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 

Reset Aircraft 

If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the red button on the InterLink Plus controller.  This is probably the 
fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item. 

 

Boundary 

The Boundary menu item allows you to change the size of the circle, or 
eliminate it altogether.  To change the size or the boundary, select the 
Boundary menu item from the Trainer menu.  A drop down menu will 
appear with the following options. 

• None – eliminate the boundary circle 

• Small – Creates a ten foot circle. 

• Medium – Creates a twenty foot circle. 
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• Large – Creates a thirty foot circle. 

 

Crashes 

After a crash, RealFlight may automatically reset your aircraft for you, if so 
desired.  This option is on by default.  If you would prefer to turn this 
option off, select the Crashes menu item, then select the Automatically 
Reset Aircraft.  If a checkmark appears next to this menu item, then this 
feature is activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you can adjust how quickly the 
reset happens.  To adjust this delay, select the Crashes menu item followed 
by the Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset instantaneously. 

• Short – The aircraft will reset approximately one second after it 
crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it 
crashes. 

Exit 
 

If you wish to leave the Heli Hover Trainer and return to the simulator, 
select the Exit menu item. 
 

Orientation Menu 
The Orientation menu allows you the option to select the position and 
attitude of the heli when the session begins or the helicopter is reset. 

A checkmark will appear next to the currently selected orientation.  The 
options available are: 

• Random Upright – The heli will start in the upright position, but it will 
randomly face either to the right, left, nose out, or nose in. 

• Random Inverted – The heli will start in the inverted position, but it 
will randomly face either to the right, left, nose out, or nose in. 

• Nose Out – The heli will start upright, facing nose out.  This option is 
best for beginning heli pilots. 

• Nose In – The heli will start upright, facing nose in. 

• Left – The heli will start upright, facing to the left. 

• Right – The heli will start upright, facing to the right. 

• Nose Out Inverted – The heli will start inverted, facing nose out. 

• Nose In Inverted – The heli will start inverted, facing nose in. 

• Left Inverted – The heli will start inverted, facing to the left. 

• Right Inverted – The heli will start inverted, facing to the right. 



R/C Simulator RealFlight Chapter 12.  The Training Menu  •  331 

Control Menu 
 The Control menu allows you to select which channel or channels to 

control.  All other channels are controlled by RealFlight, allowing you to 
learn just the controls you wish, and adding more as you become more 
comfortable. 

 A checkmark will appear in the menu next to the currently selected item.  
Your options are: 

• Pitch Only – You control only the pitch of the heli, RealFlight will 
control the roll, yaw, and throttle. 

• Roll Only – You control only the roll of the heli, RealFlight will 
control the pitch, yaw, and throttle. 

• Yaw Only – You control only the yaw of the heli, RealFlight will 
control the roll, pitch, and throttle. 

• Throttle Only – You control only the throttle of the heli, RealFlight will 
control the roll, yaw, and pitch. 

• Throttle, Pitch – You control only the throttle and pitch of the heli, 
RealFlight will control the roll, and yaw. 

• Throttle, Roll – You control only the throttle and roll of the heli, 
RealFlight will control the pitch, and yaw. 

• Throttle, Yaw – You control only the throttle and yaw of the heli, 
RealFlight will control the roll, and pitch. 

• Throttle, Pitch, Roll, Yaw – You control all channels for the heli. 

 

AIRPLANE HOVER TRAINER 
The Airplane Hover Trainer offers you a great way to learn how to control an 
aerobatic airplane in a torque roll.  With the Airplane Hover Trainer, you pick which 
channels you wish to control.  RealFlight automatically controls the rest. 
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To start the trainer, click Airplane Hover Trainer…menu item from the Training 
menu.  The trainer will start automatically.   

You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your airplane ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also note an ‘X’ mark within the boundary.  This 
represents the location of your airplane.  The goal is to control the airplane in a stable 
hover, keeping it as close to the center of the circle as possible. 

 
You’ll also notice the menus have changed, which we’ll explain here. 
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Trainer Menu 
The Trainer Menu contains the following menu items: 

• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 

Reset Aircraft 

If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the red button on the InterLink Plus controller.  This is probably the 
fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item. 

Boundary 

The Boundary menu item allows you to change the size of the circle, or 
eliminate it altogether.  To change the size or the boundary, select the 
Boundary menu item from the Trainer menu.  A drop down menu will 
appear with the following options. 

• None – eliminates the boundary circle 

• Small – Creates a ten foot circle. 

• Medium – Creates a twenty foot circle. 

• Large – Creates a thirty foot circle. 

 

Crashes 

After a crash, RealFlight may automatically reset your aircraft for you, if so 
desired.  This option is on by default.  If you would prefer to turn this 
option off, select the Crashes menu item, then select the Automatically 
Reset Aircraft.  If a checkmark appears next to this menu item, then this 
feature is activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you can adjust how quickly the 
reset happens.  To adjust this delay, select the Crashes menu item followed 
by the Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset instantaneously. 

• Short – The aircraft will reset approximately one second after it 
crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it 
crashes. 

Exit 
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If you wish to leave the Airplane Hover Trainer and return to the simulator, 
select the Exit menu item. 
 

Orientation Menu 
The Orientation menu allows you the option to select the position and 
attitude of the heli when the session begins or the airplane is reset. 

A checkmark will appear next to the currently selected orientation.  The 
options available are: 

• Random – The airplane will start in a random position, with either the 
top, bottom, left side or right side facing you. 

• Top – The airplane will start with the top of the aircraft facing you. 

• Bottom – The airplane will start with the bottom of the aircraft facing 
you. 

• Left – The airplane will start with the left side of the aircraft facing 
you. 

• Right – The airplane will start with the right side of the aircraft facing 
you. 

Control Menu 
 The Control menu allows you to select which channel or channels to 

control.  All other channels are controlled by RealFlight, allowing you to 
learn just the controls you wish, and adding more as you become more 
comfortable. 

 A checkmark will appear in the menu next to the currently selected item.  
Your options are: 

• Elevator Only – Check this to control only the elevator of the aircraft.  
RealFlight will control the throttle, ailerons, and rudder for you. 

• Aileron Only – Check this to control only the ailerons of the aircraft.  
RealFlight will control the throttle, elevator, and rudder for you. 

• Rudder Only – Check this to control only the rudder of the aircraft.  
RealFlight will control the throttle, ailerons, and elevator for you. 

• Throttle Only – Check this to control only the throttle of the aircraft.  
RealFlight will control the elevator, ailerons, and rudder for you. 

• Throttle, Elevator – Check this to control the throttle and elevator of the 
aircraft.  RealFlight will control the ailerons and rudder for you. 

• Throttle, Aileron – Check this to control the throttle and ailerons of the 
aircraft.  RealFlight will control the elevator and rudder for you. 

• Throttle, Rudder – Check this to control the throttle and rudder of the 
aircraft.  RealFlight will control the elevator and ailerons for you. 

• Throttle, Aileron, Elevator, Rudder – Check this to control all four 
channels.  You will not receive any assistance from RealFlight. 
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HELI ORIENTATION TRAINER 
As you become more proficient hovering a heli, you can test your skills with the Heli 
Orientation Trainer.  The Heli Orientation Trainer challenges you to keep your heli 
in the same location as the trainer heli.  As you succeed in doing so, the trainer heli 
will move, and the level of difficulty will increase. 

 
To start the trainer, select Heli Orientation Trainer menu item from the Training 
menu. 

The Heli Orientation Trainer has a number of different levels, each with an 
increasing level of difficulty than the previous.  To pass a level you must hover your 
heli in close proximity to the trainer heli.  As you do so, the trainer heli will turn 
from blue to red, and the progress bar at the top of the screen will increase. 
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In the upper right corner, a countdown timer is visible.  This is the amount of time 
you have to fill the progress bar.  If you fail to do so, both the timer, and the progress 
bar will reset to zero.  You must begin once again. 

The number displayed in the upper left corner indicates the number of locations the 
trainer heli will stop for the current level.  It will also indicate how many of these 
locations you have completed.  For example, if it displays 1/3, you have successfully 
completed one spot out of three for the current level. 

As you advance to the next level, you may be responsible for controlling more 
channels, the allotted time might also decrease and the trainer heli will stop in more 
locations.  Additionally you might experience any combination of these 
circumstances to increase the difficulty. 

Heli Orientation Menu 
The Heli Orientation menu is the only menu accessible while the trainer is 
running.  Two options are available in the Heli Orientation menu: 

Select Level 

A drop-down menu will display the levels available to you.  For 
example, if you have only progressed to Level 2, you will not be able to 
access Level 3 or higher in this menu. 

A checkmark will appear next to the level you are currently flying. 

Exit 

To return to the simulator, select Exit to leave the Heli Orientation 
Trainer. 
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VIRTUAL FLIGHT INSTRUCTION  
RealFlight Generation 3.5 includes on-screen flight training from some of R/C’s best 
pilots.  Frank Noll Jr., Jason Shulman, Pete Niotis, Todd Bennett, Brian Bremer and 
Jim Bourke are your instructors taking you through every level of R/C.  There are 
basics for beginners as well as more advanced maneuvers for intermediate pilots.  
G3.5 also includes instructions on how to perform some of today’s hottest 3D flight 
maneuvers!  G3.5 includes voice instruction as well as an on-screen radio that shows 
the exact movements that the instructor is using.  VFI is the perfect training tool for 
pilots of all skill levels. 

 
To access the VFI menu item, click the Training menu followed by the Virtual 
Flight Instruction… menu item.  Determine whether you wish to participate in a 
helicopter or airplane training session.  Open the respective genre by clicking the [+] 
(plus) or double-clicking the listing.  Next, select the pilot you wish to view.  To 
select and begin your training, either double-click the respective maneuver or 
highlight the maneuver and click OK. 
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By default, G3.5’s radio gadget appears on-screen.  This digital transmitter is a 
visual guide to display the stick inputs, in real-time, utilized for the recordings.  For 
additional information, please refer to the Radio Mode (gadget only). 
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CCHHAAPPTTEERR  1133..    TTHHEE  VVIIEEWW  MMEENNUU  

VVIIEEWW  MMEENNUU  OOVVEERRVVIIEEWW  
This menu allows you to adjust the various view-related features and functions for 
the simulation.  The View menu adjusts what you are looking at as well as where you 
are looking from. 

 
• Gadgets  

• Show 

• Camera Type 

• Camera Position 

• Look At  

• Quick Look 

• Zoom Type 
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• Zoom In 

• Zoom Out 

• Zoom Reset 

• Head Tracking 

GGAADDGGEETTSS--  
A Gadget is an on-screen display that provides you with information pertaining to a 
certain item in your simulation.  To access the Gadgets menu item, click the View 
menu followed by the Gadgets menu item.  This will open the list of gadgets for the 
simulation. 

 
Selecting this menu item will bring up the Gadgets list as follows: 

• NavGuides 

• Radio 

• Binocular 

• Keyboard Commands 

• Edit NavGuides… 

• Radio Mode (gadget only) 
 

NAVGUIDES 
A NavGuide is an on-screen display that allows you to view some basic information 
pertaining to your aircraft.  If you wish to alter the contents of the NavGuide, please 
refer to the Edit NavGuides… section later in this chapter. 
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To access the NavGuides, click the View menu title, followed by the Gadgets menu 
item.  Next, click the NavGuides menu item.  You may also bring up the NavGuides 
by pressing the keyboard’s ‘1’ key. 

NAVGUIDES DISPLAY BOX 
When the NavGuides are active, an overlay screen will appear on your display.  This 
screen displays the NavGuides information to you. 

If you do not wish to view this information, double-click on the title bar of the 
display box.  This hides the information.  To view it once again, simply double-click 
the title bar. 

To resize the overlay, position the cursor over the arrow indication found in the 
lower right corner of the frame.  Click and hold on the arrow.  Using the mouse, drag 
the frame according to your wishes.  If you drag it downward, the vertical size of the 
viewport will increase.  Dragging the frame to the right or left increases or decreases 
the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

Items included in the basic NavGuides are as follows: 

ALTITUDE 
This option displays the altitude for the respective aircraft above sea level.  Even 
though the aircraft may be taxiing on the runway, the altitude may reflect hundreds 
or thousands of feet, if applicable. 

HEADING 
This option displays the heading of the aircraft.  The heading is displayed in degrees, 
as they would appear on a compass.  “0” degrees is North, “90” degrees is East, 
“180” degrees is South and “270” degrees is West. 

AIRSPEED 
This option displays the airspeed for the aircraft. 

RPM 
This option indicates the current revolutions per minute, or RPM’s, for the engine. 

FRAMES/SEC 
This is an abbreviated version of Frames per Second, or FPS.  While the data 
displayed is not relevant to your aircraft, it is used to provide you with feedback on 
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how your computer is performing at any given time.  The higher the frames per 
second, the smoother the simulation will appear. 

WIND 
This option displays the current wind speed at the flying site. 

RADIO- 
The on-screen radio display is useful for many facets of flight.  For example, when 
used in conjunction with Virtual Flight Instruction, this allows you to see real-time 
control input from the professionals.  Observing the link between controller 
movements and aircraft performance will advance your knowledge and 
understanding of a maneuver. 

 
To access the Radio, click the View menu title, followed by the Gadgets menu item.  
Next, click the Radio menu item. 

You may also bring up the Radio by pressing the keyboard’s ‘2’ key. 

RADIO DISPLAY BOX 
When the Radio is activated, an overlay screen appears on your display.  This screen 
displays the stick, switch and knob movements from your actual radio. 

If you do not wish to view this information, double-click on the title bar of the 
display box.  This hides the information.  To view it once again, simply double-click 
the title bar. 

To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow in the lower 
right corner.  Using the mouse, drag the frame according to your wishes.  If you drag 
it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left increases or decreases the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame removes it from the screen. 
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BINOCULAR- 
The Binocular option will show a perfectly zoomed aircraft, as if you were looking 
through a pair of binoculars.  The background of the viewport box becomes 
transparent.  This provides a visual indicator alerting you that you are using 
“binocular vision.” 

 
The Binocular option is a great way to see the control surfaces on an aircraft that is 
too far away to see in the Main View.  Although not realistic, it does help to see the 
control input. 

To access the Binocular menu item, click the View menu title, followed by the 
Gadgets menu item.  Next, click Binocular. 

You may also bring up the Binocular option by pressing the keyboard’s ‘3’ key. 

BINOCULAR DISPLAY BOX 
When the Binocular option is activated, an overlay screen will appear on your 
display.  This screen is utilized to display the aircraft and its control movements. 

If you do not wish to view this box, double-click on the title bar of the display box.  
This hides the box.  To view it once again, simply double-click the title bar. 

To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse drag the frame according to your wishes.  If you drag it downward, the 
vertical size of the viewport will increase.  Dragging the frame to the right or left 
increases or decreases the width of the viewport, as appropriate. 

Clicking on the ‘X’ in the title tab of the frame removes the frame from the screen. 

KEYBOARD COMMANDS 
RealFlight allows you to access menu and other commands from your computer’s 
keyboard.  A key that directly invokes a command is called a “quick key” or “hot 
key”. 
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For example, pressing the [+] (plus) key on the keyboard’s number pad 
incrementally zooms your view towards the aircraft.  This is exactly the same result 
that arises if you select Zoom In from G3.5’s View menu item.  Consequently, we 
say that the [+] (plus) is a hot key for the Zoom In command. 

To access the Keyboard Commands, click the View menu title, followed by the 
Gadgets menu item.  Next, click Keyboard Commands. 

Alternatively, you may also bring up the Keyboard Commands by pressing the 
keyboard’s ‘H’ key. 

The following overlay will appear: 

 

KEYBOARD COMMANDS DISPLAY BOX 
The Keyboard Commands screen contains all of the information pertaining to the 
hot keys. 
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If you do not wish to view this information, double-click on the title bar of the 
display box.  This will hide the information.  To view it once again, simply double-
click the title bar. 

To resize the overlay, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse drag the frame according to your wishes.  If you drag it downward, the 
vertical size of the overlay will increase.  Dragging the frame to the right or left will 
increase/decrease the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

EDIT NAVGUIDES- 
This menu item allows you to modify the data displayed in the NavGuides box. 

To access the Edit NavGuides feature, click the View menu title, followed by the 
Gadgets menu item.  Next, click the Edit NavGuides… menu item. 

 

MODIFYING THE NAVGUIDES- 
To add any of the options from the left column to the NavGuides display, click in 
the box next to the respective item. 

The pane on the right of the Edit NavGuides dialog box contains a description of the 
respective item. 

The Reset To Basic button returns all NavGuides to their default values and 
options. 

COLOR- 
This setting adjusts the Color for the selected item.  To select an alternate Color, 
click on the color swatch.  This will open the color palette dialog and allow you to 
choose a color for the item. 

SHOW ONLY WHEN VALUE IS BETWEEN - 
Click on the box to activate the option for Show Only When Value is between.  If 
the aircraft parameter falls within the specified range, the selected item will appear in 
the NavGuides.  If the parameter is not within the specified range, the item will not 
display. 
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To adjust the range, click on the respective value box and input the value via your 
keyboard. 

CHANGE COLOR WHEN VALUE IS BETWEEN- 
Click on the box to activate the option for Change Color When Value is between.  
If the aircraft parameter falls within the desired range, the selected item will appear 
in the NavGuides in the alternate color.  If the parameter is outside of the specified 
range, the item will display in the primary color. 

To adjust the range, click on the respective value box and input the value via your 
keyboard. 

Available NavGuides: 

 

Option Description 

Aircraft: Altitude of Aircraft Check this item to display the current altitude of the 
aircraft. 

Aircraft: Distance above Ground Check this item to display the vertical distance between 
the aircraft and the ground. 

Aircraft: G Force Check this item to display the number of G’s the aircraft 
is experiencing as felt by the pilot. 

Aircraft: G Force Total Check this item to display the number of G’s the aircraft 
is experiencing in any direction. 

Aircraft: Ground Speed Check this item to display the current ground speed of 
the aircraft. 

Aircraft: Heading of Aircraft Check this item to display the current heading of the 
aircraft.  This heading is displayed in degrees, as they 
would appear on a compass.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” 
degrees is West. 

Aircraft: X Position of Aircraft Check this item to display the current X position of the 
aircraft. 

Aircraft: Y Position of Aircraft Check this item to display the current Y position of the 
aircraft. 

Airspeed: Speed of Aircraft Check this item to display the current airspeed of the 
aircraft. 

Engine: Battery Remaining Check this item to display the capacity left in the battery 
pack. 

Engine: Current Draw Check this item to display the amount of current that the 
motor is drawing. 

Engine: Fuel Remaining Check this item to display the amount of fuel remaining. 

Engine: Motor Efficiency Check this item to display the efficiency of the electric 
motor. 

Engine: Power In Check this item to display the amount of power being 
transferred to the electric motor. 

Engine: Power Out Check this item to display the amount of power being 
generated by the engine. 

Engine: RPM Check this item to display the RPM’s of the engine.  
Note: this measurement does not take into account any 
gear reduction. 

Engine: Voltage Check this item to determine the voltage across the 
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electric motor. 

Helicopter  : Main Rotor RPM Check this item to display the current main rotor RPM of 
the helicopter. 

Helicopter: Tail Rotor RPM Check this item to display the tail rotor RPM of the 
helicopter. 

Pilot: Distance to Aircraft Check this item to display the distance from the pilot to 
the aircraft. 

Pilot: Field Of View Check this item to display the field of view angle for the 
main window. 

Pilot: Height above ground Check this item to display the height of the pilot above 
the ground. 

Pilot: Look Direction Check this item to display the compass direction in which 
the pilot is looking. 

Pilot: Zoom Magnification Check this item to display the amount of zoom being 
utilized; 1 is equivalent to normal eyesight. 

System: Frames Per Second Check this item to display the number of times the screen 
updates per second. 

Wind Direction Check this item to display the direction that the wind is 
blowing. 

Wind Speed Check this item to display the velocity of the wind at the 
current time. 

Wind Updraft Check this item to display the velocity of the wind in the 
upward direction. 

RADIO MODE (GADGET ONLY)- 
This option allows you to change the Mode in which the onscreen radio is displayed.  
For example, if you prefer to fly with the throttle and rudder on the left stick, and 
ailerons and elevator on the right stick, then you fly Mode 2.  Some people prefer 
Mode 1, which has the throttle and elevator switched from Mode 2. 

Whichever mode you fly, you will want the onscreen radio to match.  Select Radio 
Mode (gadget only) to show a list of radio modes.  Click the mode that is appropriate 
for you. 

SHOW- 
The Show menu item is used to determine whether to show or hide scenery objects 
in the airport. 
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Selecting this item brings forth a pull-down menu with a list of items you can show 
(make visible) or hide (remove from visibility).  To show items, check them in the 
drop-down menu.  To hide items, uncheck them. 

If the frame rate slows dramatically, try eliminating some of the items listed in the 
Show menu title.  This will improve the frame rate. 

To access this menu item, click on the View menu followed by the Show menu item. 

CAMERA TYPE- 
The Camera Type menu item determines the Camera Type for the active viewport.  
Each viewport is independently adjustable.  Select from a Fixed Position, Cockpit or 
a Chase view. 
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If more than one viewport is open, click on the viewport that you wish to modify.  
This becomes the active view in the simulation.  To access the Camera Type 
adjustments, click on the View menu followed by the Camera Type menu item.  
Select your preferred view from the pull-down list. 

Alternatively, you may press the keyboard’s ‘C’ key to toggle through the available 
Camera Type options. 

Please note:  some airports do not allow Camera Type adjustments. 

FIXED POSITION- 
In this mode, the camera remains in a fixed, stationary position.  The position is 
determined by the Camera Position setting. 

COCKPIT- 
The Cockpit selection places the camera inside the aircraft as if you were a full-scale 
pilot. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

CHASE- 
The Chase mode positions the camera behind the aircraft.  The camera will follow 
the aircraft as it moves. 
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To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you 
may select the Zoom Out option from the View menu. 

CAMERA POSITION- 
This menu item determines where the camera will be situated.  Depending upon the 
airport selected, there may be one or more Pilot Spawn locations to use as camera 
positions. 

 
RealFlight G3.5 automatically picks the Pilot Spawn location that is closest to where 
the aircraft lands (or crashes, as the case may be). 

To change the setting, click on the viewport to you wish to modify.  This becomes 
the active view in the simulation.  To access the Camera Position adjustments, click 
on the View menu followed by the Camera Position menu item.  Select your 
preferred view from the drop-down list. 

You may also press the keyboard’s ‘X’ key to toggle through the available Camera 
Position options.  If the airport has two pilot spawn locations, for example, pressing 
the ‘X’ key will toggle back and forth between these two locations. 

LOOK AT- 
This menu item changes what the camera looks at.  Usually you will want the camera 
to remain focused on your aircraft. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the list of things to look at, click on the View menu followed 
by the Look At menu item.  Then select an item to look at.  For example, if you are 
in a multiplayer or MultiMode session, the other players in the session will be listed 
in the popup menu.  Select a player to look at his/her aircraft. 

QUICK LOOK- 
This feature allows you to quickly glance at an object.  When you activate this 
option, the camera briefly looks at the selected item and then returns to the previous 
vantage point for the active viewport. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Quick Look menu item, click on the View menu followed 
by the Quick Look menu item.   

Alternatively, after you have activated the correct viewport, you can press a key on 
your keyboard to activate the Quick Look feature.  The left arrow will look at the 
windsock, and the down arrow will look at the ground. 

ZOOM TYPE- 
The Zoom Type menu item allows you to change the type of zoom used in the 
simulation. 

 
Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Type menu item, click on the View menu followed 
by the Zoom Type menu item.  Select the Zoom Type option that accomplishes 
your goal.  You may choose between Manual, Autozoom, and Keep Ground in View. 

Alternatively, after you have activated the correct viewport, press the keyboard’s ‘Z’ 
key.  Each time you press the ‘Z’ key you will toggle to the next Zoom Type. 

MANUAL- 
This enables the standard view with zoom capabilities.  See the Zoom In and Zoom 
Out sections below for more information. 

Autozoom – 
This zoom type adjusts the zoom range based on the distance of the aircraft from the 
pilot.  The camera automatically zooms in as the aircraft gets further from the pilot 
and then automatically zooms out as the aircraft gets closer to the pilot. 

Keep Ground in View –  
This zoom type adjusts the camera so that the aircraft and the ground are always in 
view.  This is the only zoom type that disallows zooming in and out. 
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ZOOM IN- 
Once you have selected the type of zoom that you want you can customize it further 
by zooming in. 

 
Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom In menu item, click on the View menu followed by 
the Zoom In menu item. 

Alternatively, after you have activated the correct viewport, press the [+] (plus) key 
on your keyboard.  Each time you press the [+] (plus) key you will zoom in 
incrementally. 

ZOOM OUT- 
Once you have selected the type of zoom that you want you can customize it further 
by zooming out.  Zooming Out decreases the magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Out menu item, click on the View menu followed 
by the Zoom Out menu item. 

After you have activated the correct viewport, you may also press the [-] (minus) 
key on your keyboard.  Each time you press the [-] (minus) key you will zoom out 
incrementally. 

ZOOM RESET- 
This selection resets the zoom magnification level to its default value.  This is useful 
if you are zoomed way in or way out and want to return quickly to the default level 
of magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Reset menu item, click on the View menu followed 
by the Zoom Reset menu item. 

Once you have activated the correct viewport, you may also press the Backspace 
key on your keyboard to reset the zoom level. 

HEAD TRACKING – 
RealFlight G3.5 is compatible with TrackIR from NaturalPoint.  With a TrackIR 
plugged into your computer, you can control the camera with the movement of your 
head as if you are at the field looking around. 

For example, if you are flying at a high altitude and wish to line up with the runway, 
at a flying field you would look down briefly.  With the TrackIR, you would do the 
same at your computer.  With a small movement of your head, you can look down at 
the runway and back up to your aircraft. 

For more information about TrackIR, and where to purchase one, visit NaturalPoint’s 
website at: 

http://www.naturalpoint.com/trackir/ 
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CCHHAAPPTTEERR  1144..    TTHHEE  WWIINNDDOOWW  MMEENNUU  

WWIINNDDOOWW  MMEENNUU  OOVVEERRVVIIEEWW  
The Window menu allows you to manage the existing windows or viewports, to 
create new ones, and to select from recently used Windows. 

 

CCRREEAATTEE  NNEEWW  VVIIEEWW    
The Create New View menu item allows you to create a new view. 
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Once you create a new viewport, you can resize or reposition it by dragging with 
your mouse.  You can also fully adjust all the viewport’s properties (zoom level, 
vantage point options, etc.), independent of any properties of the main window or 
other viewports.  You can create as many independent viewport windows as your 
video card and processor will allow.  Creating extra viewports does require 
additional computing power, so there are practical limits to how many viewports you 
will want to have open. 

To access the Create New View menu item, click on the Window menu followed by 
the Create New View menu item.  This will open a new viewport.  Note that the 
viewports are labeled in order of creation starting with the number one. 

VIEWPORT MODIFICATIONS 
To resize the viewport, position the cursor over the arrow indication found in the 
lower right corner of the viewport’s frame.  Click and hold on the arrow.  Using the 
mouse, drag the frame according to your wishes.  If you drag it downward, the 
vertical size of the viewport will increase.  Dragging the frame to the right or left 
increases/decreases the width of the viewport. 

To change the vantage point options and features, use the commands found in the 
View menu.  Ensure that the viewport you wish to modify is the active viewport, or 
the modifications will not take effect. 

Clicking on the ‘X’ in the viewport’s title tab removes it from the screen. 

AARRRRAANNGGEE    
This menu item allows you to organize the on-screen viewports.  This is especially 
helpful when there are multiple windows open that overlap one another. 
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Click on the Window menu followed by the Arrange menu item to activate this 
option. 

CCLLOOSSEE  AALLLL  
This menu item closes all Windows with the exception of the main Window.  It 
offers the user an easy method to clean up the screen without having to close the 
Windows individually. 
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To access the Close All menu item, click on the Window menu followed by the 
Close All menu item. 

SSHHOOWW  TTIITTLLEE  BBAARR  
This menu item determines whether the G3.5 title bar is displayed on the screen.  By 
default, the title bar is enabled. 

 
To access this menu item, click on the Window menu followed by the Show Title 
Bar will be removed from the screen.  Please note:  removing the title bar also 
removes the ability to minimize or maximize the screen. 

VVIIEEWWPPOORRTT  LLIISSTT  
As you add more viewports to the screen, note that they appear on a list in the 
Window menu title.  If you wish to change the active view to one of these viewports, 
simply click on the viewport name in the list. 



R/C Simulator RealFlight Chapter 14.  The Window Menu  •  363 

 
To determine the active window, simply search for the yellow outline that surrounds 
the active window.  In the example above, the active window is Viewport 2. 

To change the active window, click on or in the window that you wish to become 
active. 





R/C Simulator RealFlight Chapter 15.  The Help Menu  •  365 

CCHHAAPPTTEERR  1155..    TTHHEE  HHEELLPP  MMEENNUU  

HHEELLPP  MMEENNUU  OOVVEERRVVIIEEWW  
This menu provides you with miscellaneous assistance and guidance with a variety 
of simulator-related issues. 

To access the Help files, click on the Help menu title. 

 

• Contents… 

• About… 

• Credits… 

• License… 

• Websites 
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CCOONNTTEENNTTSS  
This menu item accesses RealFlight G3.5’s Help files.  The Help files contain 
information similar to the information found in this manual. 

 
To access the Contents… files, click on the Help menu title. 

AABBOOUUTT  
The About… menu item contains miscellaneous information pertaining to your 
software.  The About… menu contains your RealFlight serial number and the 
version number of the software that you are currently operating. 
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To access the About… files, click on the Help menu title. 

CCRREEDDIITTSS  
This menu item displays the names of the people that have worked together to bring 
you the world’s most realistic R/C simulator, RealFlight Generation 3.5. 

 
To access the Credits… files, click on the Help menu title.  For posterity, here are 
the credits: 
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Concept 
Scott Kemp 

Art 
Lance Bass 

Hays Clark 

Tony Elms 

Angela Kemp 

Dave Lauck 

Dana Loncto 

Aaron Moore 

Kevin Nagatani 

Mike Nagatani 

Paul Naton 

DJ Vegh 

Development 
Jim Coleman 

Ryan Douglas 

Mark Finch 

Scott Kemp 

Ed Koffeman 

Japhet Stevens 

Joe Teibel 

Travis Vitek 

Ted Zuvich 

Flight Testing 
Ryan Archer 

Augusto Arevalo 

Darrell Bell 

Todd Bennett 

Matthew Botos 

Brian Bremer 

Mike Cross 

Charles Dawson 

Greg Duitsman 
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Mark Fadely 

Jeff Fassbinder 

Miguel Frontera 

Kelly Gerber 

John Glezellis 

David A. Hourston 

Dan Landis 

Larry Markey 

Sean McMurtry 

Paul Naton 

Pete Niotis 

Frank Noll, jr. 

Jason Noll 

Adam Ranck 

Jason Shulman 

Dino Spadaccini 

Jeff Swartz 

Jon Zaretsky 

Malorie Zastrow  

Marketing 
Gordy Cockburn 

Nick Sans 

Product Artwork 
Wally Armstrong 

Mike Bowers 

Rick Burtis 

Seth Frederick 

Howard Golub 

Mike Johnson 

Denitra Luster  

Jeremy Motley 

Chris Slater-Vohs 
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Jack Quigg  

Project Management 
Jim Bourke 

Rick Piester 

Bryan Schlueter 

Mark Williams 

Production 
Rodney Clinton 

Dan Lane 

Dick Sumner 

Bill Vowels 

Technical Consultants 
Michael Giger 

Kevin Hisel 

Testing 
Corey Bruff 

James Doty 

Tim Emmerich 

Montana Harkin 

Terry McBride 

Mike McWethy 

Art Pesch 

George Rodriguez 

Alex Sanabrais 

Lisa Stirnemann 

Laura Sweet 

Jean Ward 

David Wright 

Dave Wolf  

Special Thanks 
Jill Brinkoetter 

Neal Cloud 

Teresa Fredericks 
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Ben Godwin 

Bounchanh Grant 

Bryan Heaton 

Martin Hepperle 

Daniel Kemphues 

Neal Kuechler 

Danielle LeFaivre 

P.B. Mink 

Ryan Reeder 

Jürgen Schrader 

Eric Smith 

Lisa "Weesa" Stirnemann 

The All-Seeing Gnome 

Stefan Vorkoetter 

Futaba Corporation  

Aircraft and Other Textures 
A-10 - Dennis Lassek 

Albatross DVa - Proctor Enterprises 

Caliber 30 - Kyosho 

Concept EP - Kyosho 

Edge 540 - Color Scheme Copyright FighterCombat.com 

Extra 330S - Matt Stek 

Extra 330S Color Scheme Copyright FighterCombat.com 

F-86: Michael Chan Su 

Fokker Triplane: Proctor Enterprises 

Huey: Steve Stuart-Doig and Larry Jolly (www.ljmp.com)  

P-38 - Dennis and Linda Crooks 

Raptor - Thunder Tiger Model Corporation 

Simple Flier: Alexandre Kolyvanov, Donald Miller 

Sopwith Camel: Proctor Enterprises 

Sukhoi - Michael Klautzsch 

Test Field - Champaign County R/C Club 

Legal 
Program (C) 1996-2006, Knife Edge Software 

Helicopter Paint Schemes (C) 1999-2006, Knife Edge Software 

Title Page, Box, CD Art, (C) 2006, Hobbico, Inc. 



372  •  Chapter 15.  The Help Menu R/C Simulator RealFlight 

FMOD sound and music system, (C) Firelight Technologies, Pty Ltd. 1994-2004 

Airfoil data courtesy UIUC Airfoil Coordinates Database, Prof Michael Selig, 
Department of Aerospace Engineering, University of Illinois at Urbana-Champaign, 
http://www.ae.uiuc.edu/.  Included under the terms of the GNU GENERAL PUBLIC 
LICENSE.  An ASCII readable version of this data can be found on your RealFlight 
G3.5 installation CD. 

Portions of this software utilize SpeedTree technology.  (c)2002 Interactive Data 
Visualization, Inc.  All rights reserved. 

Electric power system database courtesy of Capable Computing Inc., creators of 
MotoCalc. 

This software is based in part on the work of the Independent JPEG Group 

LLIICCEENNSSEE  
This menu item contains the End Users License Agreement (EULA) for the 
RealFlight R/C Flight Simulator.  Please read it carefully. 

 
To access the License… files, click on the Help menu title. 

REGISTERED VERSION: RealFlight(tm) R/C Simulator 

LIMITED USE SOFTWARE LICENSE AGREEMENT 

This Limited Use Software License Agreement (the "Agreement") is a legal 
agreement between you, the end-user, and Knife  Edge Software ("KES").  By 
continuing the installation of this game program, by loading or running the game, or 
by placing or copying the game program onto your computer hard drive, you are 
agreeing to be bound by the terms of this Agreement.  If you do not agree to the 
terms of this Agreement, promptly return the game program and the accompanying 
items (including all written materials), along with your receipt to the place from 
where you obtained them for a full refund. 

KES SOFTWARE LICENSE 
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1. Grant of License.  KES grants to you the limited right to use one (1) copy of 
the enclosed or foregoing game program (the "Software") on a single computer.  You 
have no ownership or proprietary rights in or to the Software or the written materials 
accompanying the Software.  For purposes of this section, "use" means loading the 
Software into RAM, as well as installation on a hard disk or other storage device.  
The Software shall be either returned to KES or destroyed when no longer used in 
accordance with this Agreement, or when the right to use the Software is terminated.  
You agree that the Software will not be shipped, transferred or exported into any 
country in violation of the U.S. Export Administration Act (or any other law 
governing such matters) and that you will not utilize, in any other manner, the 
Software in violation of any applicable law. 

2. Commercial Use is Prohibited.  Except as provided in paragraph 5. Herein 
below in regard to the Software, under no circumstances shall you, the end-user, be 
permitted, allowed or authorized to commercially exploit the Software, any data 
comprising the Software.  Neither you nor anyone at your direction shall do any of 
the following acts (any such acts shall be deemed void and a breach of this 
Agreement) with regard to the Software, or any portion thereof, such as a screen 
display or a screenshot: 

a. Rent the Software; 

b. Sell the Software; 

c. Lease or lend the Software; 

d. Offer the Software on a pay-per-play basis; 

e. Distribute, by electronic means or otherwise, the Software for money or any other 
consideration; or 

f. In any other manner and through any medium whatsoever commercially exploit 
the Software or use the Software for any commercial purpose.  

3. Additional Prohibited Uses.  Neither you nor anyone at your direction shall 
take the following action in regard to the Software, or any portion thereof, such as a 
screen display or a screenshot: 

a. Modify, disassemble, reverse engineer or decompile Software;  

b. Translate the Software; 

c. Reproduce the Software; 

d. Publicly display the Software;  

e. Prepare derivative works based upon the Software except Permitted Derivative 
Works); or 

f. Distribute, by electronic means or otherwise, the Software.  

4. Use of Other Material is Prohibited.  Use, in any manner, of the trademarks, 
such as RealFlight R/C Simulator (tm) logo, or symbols, art work, images, screen 
displays or screenshots, sound effects, music, and other such material contained 
within, generated by or relating to the Software is prohibited. 

5. To Receive Permission to Commercially Exploit.  If you desire to 
commercially exploit the Software, you may request a copy of and execute the 
Commercial Exploitation License Agreement for RealFlight R/C  Simulator (the 
"License") and forward the original License to KES Software at the address noted 
therein.  Please note that KES may refuse your request and not sign the License in 
KES's sole discretion.  
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6. Restrictions Apply to Third Parties.  The prohibitions and restrictions 
described herein apply to anyone in possession of the Software and/or Permitted 
Derivative Works.  

7. Copyright.  The Software and all copyrights related thereto (including all 
characters and other images generated by the Software or depicted in the Software) is 
owned by KES and is protected by United States copyright laws and international 
treaty provisions. You must treat the Software like any other copyrighted material. 
You may not otherwise reproduce, copy or disclose to others, in whole or in any part, 
the Software.  You may not copy the written materials accompanying the Software.  
The same restrictions and prohibitions regarding your use of the Software as 
provided in this Agreement apply to your use of the written materials accompanying 
the Software.  The written materials are owned by KES and are protected by United 
States copyright laws and international treaties.  You agree to use your best efforts to 
see that any user of the Software licensed hereunder complies with this Agreement. 

8. Limited Warranty.  KES warrants that if properly installed and operated on 
a computer for which it is designed, the Software will perform substantially in 
accordance with the accompanying written materials for a period of ninety (90) days 
from the date of purchase of the Software.  KES's entire liability and your exclusive 
remedy shall be, at KES's option, either (a) return of the price paid or (b) repair or 
replacement of the Software that does not meet KES's Limited Warranty.  To make a 
warranty claim, return the Software to Hobby Services at 3002 North Apollo Drive, 
Suite #1, Champaign, IL 61822 accompanied by proof of  purchase, your name, your 
address, and a statement of defect, or return the Software with the above information 
to KES.  This Limited Warranty is void if failure of the Software has resulted in 
whole or in part from accident, abuse, misapplication or violation of this Agreement.  
Any replacement Software will be warranted for the remainder of the original 
warranty period or thirty (30) days from your receipt of the replacement software, 
whichever is longer.  This warranty allocates risks of product failure between 
Licensee and KES.  KES's product pricing reflects this allocation of risk and the 
limitations of liability contained in this warranty.  

9. NO OTHER WARRANTIES.  KES DISCLAIMS ALL OTHER 
WARRANTIES, BOTH EXPRESS IMPLIED, INCLUDING BUT NOT LIMITED 
TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND THE 
ACCOMPANYING WRITTEN MATERIALS.  THIS LIMITED WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHER RIGHTS 
WHICH VARY FROM JURISDICTION TO JURISDICTION.  KES DOES NOT 
WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED, ERROR FREE OR MEET LICENSEE'S SPECIFIC 
REQUIREMENTS.  THE WARRANTY SET FORTH ABOVE IS IN LIEU OF 
ALL OTHER EXPRESS WARRANTIES WHETHER ORAL OR WRITTEN.  THE 
AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF KES ARE NOT 
AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR 
ADDITIONAL WARRANTIES ON BEHALF OF KES.  ADDITIONAL 
STATEMENTS SUCH AS DEALER ADVERTISING OR PRESENTATIONS, 
WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY 
KES AND SHOULD NOT BE RELIED UPON. 

10. Exclusive Remedies.  You agree that your exclusive remedy against KES, 
its affiliates, contractors, suppliers, and agents for loss or damage caused by any 
defect or failure in the Software regardless of the form of action, whether in contract, 
tort, including negligence, strict liability or otherwise, shall be the return of the 
purchase price paid or replacement of the Software.  This Agreement shall be 
construed in accordance with and governed by the laws of the State of Oregon. 
Copyright and other proprietary matters will be governed by United States laws and 
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international treaties.  IN ANY CASE, KES SHALL NOT BE LIABLE FOR LOSS 
OF DATA, LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING 
FROM BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, 
OR OTHER LEGAL THEORY EVEN IF KES OR ITS AGENT HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM 
BY ANY OTHER PARTY. Some jurisdictions do not allow the exclusion or 
limitation of incidental or consequential damages, so the above limitation or 
exclusion may not apply to you.  

11. General Provisions.  Neither this Agreement nor any part or portion hereof 
shall be assigned, sublicensed or otherwise transferred by you.  Should any provision 
of this Agreement be held to be void, invalid, unenforceable or illegal by a court, the 
validity and enforceability of the other provisions shall not be affected thereby.  If 
any provision is determined to be unenforceable, you agree to a modification of such 
provision to provide for enforcement of the provision's intent, to the extent permitted 
by applicable law.  Failure of a party to enforce any provision of this Agreement 
shall not constitute or be construed as a waiver of such provision or of the right to 
enforce such provision.  If you fail to comply with any terms of this Agreement, 
YOUR LICENSE IS AUTOMATICALLY TERMINATED.  

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT 
YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND THAT BY 
CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR 
RUNNING THE SOFTWARE, OR BY PLACING OR COPYING THE 
SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE 
BOUND BY THIS AGREEMENT'S TERMS AND CONDITIONS.  YOU 
FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE 
AGREEMENTS BETWEEN KES AND YOU, THIS AGREEMENT IS A 
COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND 
LIABILITIES OF THE PARTIES. THIS AGREEMENT SUPERSEDES ALL 
PRIOR ORAL AGREEMENTS, PROPOSALS OR UNDERSTANDINGS, AND 
ANY OTHER COMMUNICATIONS BETWEEN KES AND YOU RELATING TO 
THE SUBJECT MATTER OF THIS AGREEMENT. 

WWEEBBSSIITTEESS  
This menu item contains links to RealFlight related websites.  The options include: 
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GREAT PLANES – 
Publishers of RealFlight G3.5.  Visit this site for information on the many other 
Great Planes products available. 

KNIFE EDGE –  
Developers of RealFlight G3.5.  Visit the Knife Edge’s forum to share experiences 
and technical support with other RealFlight owners.  The Knife Edge forums also 
play host to a wide variety of free, downloadable aircraft, trim schemes, flying sites 
and more. 

REALFLIGHT – 
Visit the RealFlight website for more information about the RealFlight family of 
products, search the knowledge base for technical support, or contact our support 
staff if you have questions. 
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AAPPPPEENNDDIIXX  AA..    BBAASSIICCSS  OOFF  FFLLYYIINNGG  

AAIIRRPPLLAANNEE  BBAASSIICCSS  

SWITCHES 
Before you fly the plane, make sure all the switches are in their off or low rates, 
positions.  The switches may be assigned to different items depending on how you 
have configured your controller and which aircraft you are flying.  Review the 
description of the aircraft to determine if this is applicable to your model.  If you are 
using your own transmitter to control RealFlight, please consult your transmitter 
owner’s manual for more information. 

CENTERING 
Trim tabs are the small slider controls on the controller (two per controller stick).  
They “trim” the aircraft so that it flies straight and level.  For example, if an airplane 
has a tendency to veer slightly downward, you may need to add a slight “up” nudge 
to the elevator.  You can do this by sliding the elevator trim, a click or two at a time, 
towards the bottom of the controller. 

CCRRAASSHHIINNGG  
Takeoffs are optional, but landings are mandatory.  For any type of aircraft or flying, 
successfully landing an aircraft is a crucial skill to master. 

The key to a perfect landing is undivided concentration.  Pay close attention to the 
altitude, orientation, and speed of the aircraft as it approaches the runway.  Use each 
crash as a learning experience to perfect your approach and the landing. 

RealFlight has several tools to help you stay on top of things during approach and 
landing.  See the “Landings” section below for some ideas. 

AAIIRRPPLLAANNEE  FFLLIIGGHHTT  
RealFlight G3.5 simulates how R/C aircraft really fly.  This allows you to practice 
R/C flying without worrying about expensive crashes.  Additionally, RealFlight G3.5 
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is ideal for practicing new maneuvers and experimenting with various parameter 
adjustments. 

It is important to remember, however, that a simulator will only help you learn to fly 
if you let it.  Otherwise, it is just a game.  Learning to fly R/C aircraft requires a 
commitment.  One does not just grab the sticks and start dazzling the crowds.  A 
methodical, patient approach will help you get the most out of this simulator. 

This section is not designed to teach you how to fly.  However, it will help you 
enhance your experience with the simulator and obtain the most from your 
experiences. 

TAKEOFFS 
When you are taking off, start with the throttle in low position and slowly increase 
throttle by pushing the throttle stick away from you towards the top of the transmitter 
until you are at about half speed.  Stay in the middle of the runway (you can steer the 
plane using the rudder).  When you have built up enough speed, gradually pull back 
on the elevator stick to climb off the runway.  If the plane is tracking well, apply the 
rest of the power more quickly, climb out, and gain altitude. 

Be careful not to veer off the runway.  In a real plane, chances are that you would 
crash (or get stopped on the grass).  Usually this means bent landing gear and a 
broken prop.  If your plane has retracts, they could even rip out of the wing. 

LANDINGS 
It is very important to land on the runway, rather than veering off, or touching down 
before you reach the runway.  Either of the latter usually produces a moderately 
expensive crash.  If you “cartwheel” (wing tip hits the ground first), the wing can 
break, resulting in lengthy down time while you repair your airplane. 

Start by aligning your plane with the runway.  Fly the approach normally, using your 
throttle to control the rate of descent.  Try to land at the slowest speed possible.  If 
your plane has flaps, use them to kill speed (but be careful; with flaps down your 
plane will try to pitch up and climb).  If your plane has retractable landing gear, 
lower them.  As you touch down, remember to keep your nose up! 

RealFlight has several tools to help you practice landings.  

• Before you try to land yourself, you may want to get a lesson from a 
pro.  To do so, click the Training menu followed by the Virtual Flight 
Instruction… menu item.  Choose Jason Shulman as the instructor.  
From the list of options, select the Landing maneuver. 

• As you land, use the NavGuides to keep track of your speed, altitude, 
and distance above ground. 

AEROBATICS 
When you practice aerobatics, the three important steps are: 

• Start the plane straight and level, in a controlled situation 

• Perform the maneuver 

• Get back into a straight, controlled situation 
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Anyone can give it full throttle, jam the sticks in all directions and watch the plane 
tumble and roll.  However, this is not what you will do out in the field.  Do this and 
you will not have control of the airplane! 

By getting set up properly, performing the maneuver, and then finishing cleanly, 
your experience will be more rewarding as well as more realistic. 

Concentrate on making the maneuvers “clean.”  If you are doing a roll, try to keep 
the plane on a straight line as you roll.  If you are doing a loop, try to make a 
perfectly round circle. 

If you want to practice aerobatics using RealFlight G3.5, try the new Virtual Flight 
Instruction feature (accessible via the Training menu).  The Virtual Flight Instruction 
feature provides a series of personal lessons taught by pros. 

THROTTLE MANAGEMENT 
Avoid the temptation of giving the plane full throttle and keeping it there for hours at 
a time.  This teaches you bad habits and makes even a good flier look like a rookie 
out at the field. 

Many of the maneuvers require proper throttle management in order to make a 
maneuver look good.  Loops, stalls, torque rolls, touch-and-goes are just a few 
examples.  Try doing various maneuvers at differing speeds.  Try performing a slow 
roll at medium throttle and keeping a perfectly straight line.  This difficult maneuver 
will earn you more praise at the field than doing a full speed, full stick roll. 

RUDDER MANAGEMENT 
Most airplanes can (more or less) be effectively flown with just the elevator and 
ailerons.  Good pilots will tell you that the proper use of the rudder is just as 
important, however.  Many aerobatic maneuvers require excellent rudder usage. 

Rudder control is especially important when landing in a crosswind.  Pilots that 
cannot use the rudder usually land in the tall grass (embarrassing!).  Pilots that do 
use the rudder can land on the numbers almost every time. 

TAKE CRASHES SERIOUSLY 
Out at the field a crash might result in one or more of the following: 

• Bruise your ego 

• End flying for the day 

• Cost you money 

• Cost you time to rebuild 

• Cause injury to yourself or a bystander 

• Even win you a nice “best crash trophy!” 

Of course, when you crash on the simulator, there is really no harm done.  None, that 
is, except the bad habits you can learn.  Take the crashes seriously.  Learn from each 
one and you will be a better pilot out at the field. 
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HHEELLIICCOOPPTTEERR  BBAASSIICCSS  
 

A model helicopter is a very complicated machine, which operates on the same 
aerodynamic principles as its full-scale counterpart.  These principles are quite 
complicated to explain and understand.  However, it is not necessary to understand 
all the underlying aerodynamics in order to successfully fly a model helicopter (or a 
computer simulation). 

The following will help you to better understand the basics of helicopter flight, and 
the relationship between control stick movements and the actions of the machine. 
Refer to these instructions often as you become more proficient. 

Please note:  the inputs below are shown using a Mode 2 transmitter. 

COLLECTIVE (LEFT STICK - VERTICAL MOVEMENT) 
The spinning rotor blades, which act like rotating wings, lift the helicopter into the 
air.  Changing the pitch (angle of attack) and speed of the blades, using the 
“collective” and throttle causes the helicopter to rise and descend vertically.  
Adjusting “collective” increases and decreases the blade pitch.  The “throttle” 
control increases and decreases engine RPM.  On a model helicopter, the collective 
and throttle controls are mixed electronically, and controlled by the throttle stick on 
the transmitter or controller. 
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RUDDER (LEFT STICK - HORIZONTAL MOVEMENT) 
To turn the nose of the helicopter left or right, change the tail rotor pitch (by using 
the “rudder” control).  Changes in collective stick movement will require changes in 
the amount of rudder input to maintain heading. 
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CYCLIC STICK (RIGHT STICK) 
The cyclic stick replaces the “aileron” and “elevator” controls found on a fixed-wing 
aircraft.  “Cyclic” is the term given to the control of the main rotor that allows the 
helicopter to fly forward, backward, left and right.  Forward cyclic stick movement 
causes the helicopter to pitch forward, left cyclic cause the helicopter to tilt sideways 
to the left, on so on.  You move the helicopter forward or sideways using a 
coordinated movement of both the cyclic and collective control sticks.  Moving the 
cyclic stick to the right, while simultaneously increasing collective, will cause the 
heli to move sideways to the right.  “Rudder” control is used to maintain heading. 
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IDLE-UP 
A switch on the controller actuates a special function, known as “idle-up.”   Idle-up 
offers an alternate throttle and pitch curve, different from the curves used for 
hovering.  Idle-up is usually used for aerobatics, when the pilot wants engine power 
added when pitch is subtracted.  For example, inverted hovering positive throttle and 
negative pitch, so pulling the collective stick back provides positive throttle AND 
increased pitch together. 

THROTTLE HOLD 
Another special function is known as the “throttle hold”.  When activated, this switch 
sets your throttle to idle but allows the collective to function normally.  This allows 
you to practice autorotations without shutting the engine off. 

GYRO 
Any sudden change to the torque of the main rotor, such as a quick change in RPM 
or a wind gust, can cause the helicopter to turn unintentionally to an unwanted 
direction. An electronic device known as a gyroscope (gyro) is used to “monitor” 
and correct for this by giving commands to the rudder control to help stabilize the 
machine. 

Gyros come in a variety of types, each with different features.  A normal gyro will 
not return the heli to its former heading; it will only stop the unwanted sudden 
movement.  We recommend you start by using the heading hold gyro instead; it will 
keep the nose of the helicopter pointed in the desired direction regardless of outside 
forces. 
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HHEELLIICCOOPPTTEERR  FFLLIIGGHHTT  

HOVERING 
The machine hovers by adjusting the collective control to maintain altitude, the 
rudder to maintain heading, and minute adjustments to the cyclic controls to maintain 
location.  Hovering is the most important aspect of heli flight to master, since every 
other movement of the machine starts and stops with a hover. 

FORWARD FLIGHT 
The heli moves forward by increasing cyclic (moving the cyclic control forward).  
This causes the helicopter to tilt forward, resulting in a forward thrust.  As the cyclic 
increases, the collective must also be increased to maintain the desired flight path.  
As forward speed increases, the collective can be reduced slightly. 

BACKWARD FLIGHT 
Backward flight is accomplished by moving the cyclic control aft, which causes the 
helicopter to tilt backward.  As the cyclic is moved aft, the collective must also be 
increased to maintain desired flight path.  As backward speed increase, the collective 
can be reduced slightly. 

SIDEWAYS FLIGHT 
Moving the cyclic control left will cause the helicopter to tilt left.  Add collective 
and right rudder to cause the heli to “slide” sideways to the left.  As speed increases, 
it will require progressively more rudder to maintain heading. 

To move right, simply follow the same procedure, but reverse the cyclic and rudder 
movements (move cyclic right, apply left rudder). 

TURNING: 

FROM FORWARD FLIGHT- 
Moving the cyclic control left, while applying a small amount of aft cyclic and 
feeding in left “rudder”, will cause the helicopter to make a coordinated turn to the 
left.  Right movement of the cyclic and rudder sticks will cause the heli to turn to the 
right. 

FROM A HOVER- 
Use the rudder to rotate the nose of the heli in the direction you want. 

Learning to fly a model helicopter is more difficult and challenging than any other 
radio control models, but is also the most rewarding as you master the techniques 
required for sustained hover and forward flight.  Computer simulation of model 
helicopter flight is an excellent tool for learning the basics and dramatically reducing 
the learning curve when you move on to the actual model itself. 
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AAPPPPEENNDDIIXX  BB..    RREEAALLFFLLIIGGHHTT  GG33..55  
LLAAUUNNCCHHEERR  

RREEAALLFFLLIIGGHHTT  GG33..55  LLAAUUNNCCHHEERR  
The RealFlight G3.5 Launcher is the gateway to simulator fun.  This item allows you 
to run the simulation, register and update the software, and much, much more. 

To run RealFlight or to access the additional options, click the RealFlight G3.5 
Launcher located on your desktop. 
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RUN REALFLIGHT 
To start running RealFlight, press the RealFlight G3.5 Launcher located on your 
desktop.  Next, click the Run RealFlight button.  The simulation will begin loading 
the terrain, airport objects, textures, etc.  Your simulation experience will begin as 
soon as the loading process completes. 

AADDDDIITTIIOONNAALL  OOPPTTIIOONNSS  
Click on the Additional Options button to access a variety of useful information 
pertaining to RealFlight G3.5. 

 

RESTORE DEFAULTS- 
Use this button to restore RealFlight G3.5’s default settings.  It will NOT remove 
custom aircraft, flying sites, etc.  It is designed to simply restore the factory default 
values and settings. 

REGISTRATION/UPDATES- 
Use this button to register and update the software. 

ONLINE REGISTRATION 
This button allows you to register your copy of RealFlight G3.5.  The registration 
information entitles you to complimentary technical support and free online updates. 
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Please enter in all the correct registration.  If you forget your password, contact Great 
Planes Support.  To do so, email them at rfsupport@greatplanes.com or telephone 
them at 217-398-8970 (option #1).  They will confirm your identity, and issue you a 
new password. 

HARDWARE INFORMATION 
RealFlight G3.5 offers the option of automatically sending us information pertaining 
to your system hardware and settings when you register.  If you leave the Send 
Hardware Information box checked when you register, RealFlight G3.5 will send us 
this information. 

This hardware information will assist us in diagnosing any problems you may 
encounter later, should you need to contact Technical Support Consequently, we 
suggest that you leave this box checked when registering. 

This feature is optional.  If you uncheck the box, RealFlight G3.5 will not send us 
any information about your system.  Alternatively, you can view exactly what 
information RealFlight will send us before you decide.  To view the information, 
click the Technical Support button.  When the Technical Support page appears, 
click Assemble System Information. 

UPDATE TO LATEST VERSION 
After registering (you only need to register once), you can update to the latest 
version.  This will download all necessary files and correctly install the upgrade. 

Click this button to Update to Latest Version. 

CHECK FOR UPDATES BEFORE STARTING REALFLIGHT 
If you check this box, every time you run the RealFlight G3.5 software it will check 
to determine whether or not there is a newer version of RealFlight G3.5 available to 
you.  If a new version exists, RealFlight G3.5 will ask if you wish to download and 
install the newer build. 

Please note:  your PC must be connected to the Internet in order to check for updates. 

ADVANCED OPTIONS 

UPDATE TO SPECIFIC VERSION 
If you are having problems with a version you just downloaded, you can actually go 
backwards and retrieve a previous version.  If the previous version fixes your 
problem, please contact our technical support team at rfsupport@greatplanes.com 
and let them know about the problem encountered. 
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CLEAR DOWNLOAD CACHE 
Occasionally, files may become corrupted during a download.  If you are having 
difficulties with the online updates, remove all cached files using this option, choose 
Update to Specific Version and then select the Completely Refresh option. 

UNINSTALLING REALFLIGHT 
Click the Uninstall RealFlight button to uninstall the software.  The following 
dialog will appear: 

 

We suggest that you use this method, not the “Add/Remove Programs” feature in 
Windows, to uninstall RealFlight G3.5.  Doing so through the RealFlight G3.5 
launcher will remove all necessary RealFlight G3.5 files. 

UNINSTALL PROGRAM 
Choose this option to uninstall only the RealFlight G3.5 program itself. 
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UNINSTALL DATA FILES 
Choose this option to uninstall any user files such as your created airports, 
customized aircraft, color schemes, songs etc.  Be careful with this option!  You 
could lose a lot of your work by inadvertently uninstalling these files. 

REMOVE SERIAL NUMBERS 
Choose this option to remove the serial numbers from your system.  You have two 
options available if you check this box. 

• For this product only 

• For all RealFlight products, including Expansion Packs, older RealFlight 
editions, and Add-Ons 

REMOVE ALL CACHED FILES FROM THE ONLINE UPDATE 
Choose this option to remove all cached download files from your system.  If you 
uninstall these files, future downloads may take a little longer. 

VIEW WEB SITE 
Click the View Web Site to visit the RealFlight web site.  A browser window will 
open for you and you will be automatically directed to the site. 

READ HELP FILE 
Press the Read Help File button to bring up the help file for RealFlight G3.5. 

TECHNICAL SUPPORT 
Press the Technical Support button to bring up technical support information about 
your system.  If you encounter any problems with RealFlight, this information can 
help you to resolve it on your own, or can help Great Planes’ Support Staff to 
diagnose the problem. 
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SYSTEM INFORMATION 
This displays a list of the critical system information.  Before you email technical 
support, or report a bug with the software, please be sure to cut and paste this 
information into your email.  This will assist them greatly in diagnosing the 
difficulty. 

REINSTALL DIRECTX 
Choose this option to reinstall DirectX.  Occasionally this will fix corrupted 
installations. 

ENTER TECHNICAL SUPPORT CODE 
Choose this option to enter a technical support code.  If you do encounter problems 
running RealFlight, our Technical Support team may supply you with a code to input 
here.  Entering this code will help them diagnose or resolve your problem. 
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EMAIL TECHNICAL SUPPORT 
This gives you the email address rfsupport@greatplanes.com to which you can email 
your problems.  If you do email us, please be sure to attach the Assemble System 
Information output to your email. 

ASSEMBLE SYSTEM INFORMATION 
Choose this option to collect critical information about your system, and about your 
RealFlight settings.  You may find this information useful if you try to troubleshoot 
problems on your own.  Moreover, if needed you can cut and paste this information 
into an email to Great Planes Technical Support.  When you use the online 
registration to register RealFlight, this is the hardware information that is sent to 
Great Planes. 

 

VIEW WEB TECHNICAL SUPPORT 
Choosing this option will open a browser window, and take you to a web site that 
contains the most up-to-date technical support information for RealFlight G3.5. 

VIEW TASKS 
This shows you a list of all tasks that are running on your computer.  Some tasks can 
interfere with RealFlight G3.5 and may need to be closed.  Our Technical Support 
team will be glad to help you close problem tasks. 

INCLUDE SERIAL NUMBERS 
Check this box is you plan to assemble all system information to send to RealFlight 
Technical Support.  If you are sending this information to anyone else, don’t check 
this box.  The serial numbers are unique to you, and should only be shared with 
RealFlight Technical Support. 
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DX DIAGNOSTICS 
This brings up Microsoft’s DXDIAG utility.  Using this utility can further help 
diagnose your system. 

Important:  if you send us information about your system to help us diagnose a 
problem, please do not use DXDIAG to generate that information.  Instead, please 
use the “Assemble System Information” feature [see above].  The “Assemble System 
Information” output file contains more information than the DXDIAG output. 

 

MSINFO 
This option will run MSInfo.  This will give you even more information about your 
system.  This program is not always installed a particular computer, but normally 
comes with programs such as Microsoft Office®. 
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DISPLAY PROPERTIES 
This brings up the display properties for your monitor.  You can use this page to 
change the resolution of your desktop. 

 

EXPLORER 
This button launches Windows Explorer.  This Microsoft Windows utility can help 
you locate, move and backup your files. 
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LAUNCH DEVICE MANAGER 
This button launches the Device Manager.  This Microsoft Windows utility will help 
you determine driver dates, as well as installing and updating video and sound card 
drivers. 
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AAPPPPEENNDDIIXX  CC..    IIFF  YYOOUU  EEXXPPEERRIIEENNCCEE  
DDIIFFFFIICCUULLTTIIEESS  WWIITTHH  RREEAALLFFLLIIGGHHTT  
GG33..55……  

IINN  GGEENNEERRAALL  
The RealFlight G3.5 simulator is on the cutting edge of technology, and runs using 
advanced hardware.  Consequently, there is always the possibility you may 
experience a few difficulties.  Should the need arise, we provide extensive resources 
to help. 

Besides providing the best R/C simulator, we sincerely feel that we provide the best, 
most extensive product support for any R/C simulator.  Since cards, drivers, and 
operating systems are always changing, we work hard to keep our support team up to 
date on the latest issues and problems that RealFlight G3.5 users might encounter. 

This section starts with a summary of the various sources of RealFlight G3.5 
information, support, and problem solving help that you can access.  Then we will 
show you some simple but powerful steps that can resolve or prevent most 
RealFlight G3.5 problems.  Finally, if these steps fail to solve your problem, we will 
show you the most effective ways to acquire additional assistance. 

HOW TO GET HELP AND INFORMATION 
As a RealFlight G3.5 user, you have access to an incredible amount of information 
about this product.  Much of this information can help you resolve problems, or 
correctly access and use program features.  Here is where you can find it: 

• The manual.  Most common RealFlight problems can be resolved by 
following the instructions in later sections of this chapter.  There is 
additional information found in other chapters that explain additional 
RealFlight G3.5 features. 

• Visit our product Knowledge Base at http://www.gpsoftware.com.  
This great resource is an indexed, searchable collection of articles that 
described solutions to almost every known problem with RealFlight, 
RealRace, and all of our other software products.  In fact, this is the 
same information database used by our product support technicians.  
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• Visit the Knife Edge Software Message Boards at 
http://www.knifeedge.com.  This is a place where owners of 
RealFlight, RealRace, and other Knife Edge products post questions, 
comments and responses.  Sometimes our product support technicians 
and product developers from Knife Edge post replies and 
announcements as well.  You may find a thread that discusses the same 
difficulties that you are experiencing.  

• Contact our Product Support department by email at: 
rfsupport@greatplanes.com .  Alternatively, our staff is also available 
via telephone or postal mail at: 

RealFlight Product Support 
3002 North Apollo Drive 
Suite #1 
Champaign, IL 61822 
Voice phone: (217) 398-8970(Option 1) 
FAX phone:  (217) 398-7721 
The product support teams are specially trained, and have many 
resources to help you resolve problems with RealFlight G3.5. 

• Visit the home page of Knife Edge Software, the makers of RealFlight, 
RealRace and other R/C simulation products, at 
http://www.knifeedge.com.  On this page, you can link to the Knife 
Edge Chat Room, where you can chat live with other RealFlight or 
RealRace users.  Sometimes product developers from Knife Edge hang 
out here as well.  Please note, however, that due to time, staffing and 
other constraints we usually cannot provide problem troubleshooting 
assistance in the chat room. 

 

BEFORE YOU DO ANYTHING ELSE… 
 

If you are experiencing difficulties with RealFlight G3.5, you should always try the 
steps below first.  These steps really do cure most problems our users experience.  
Even if you are not having a problem, these same steps often help make RealFlight 
and your computer work better. 

Here are the steps you should take (instructions for each step follow): 

• Update your video and sound card drivers (see instructions below) 

• Update to the latest version of RealFlight G3.5 

• If the problem persists, run the DirectX test programs 

• If these steps do not work, read on to the next section 

Update Your Drivers 
Before you do anything else, you should make sure you have updated your video and 
sound drivers.  A large number of problems encountered by RealFlight users can be 
cured by updating drivers. 

A driver is a software program that controls your video or sound card.  Each card 
manufacturer provides drivers for its own cards.  To work correctly, RealFlight relies 
on your video and sound card drivers. 
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It is very important to use the latest available driver for your card.  Card 
manufacturers frequently release updated drivers to fix problems that occur when the 
driver is used with programs such as RealFlight G3.5.  The driver that came with 
your new computer, or on your Windows CD, or on a CD included with the new card 
you bought, may not be the latest version. 

If you do not know how to update drivers, you can find instructions in our 
Knowledge Base article Q01-1038, How to Update Drivers, at 
http://www.gpsoftware.com/kb/q01-1038.htm.  This page will take you through the 
process step-by-step, and has links to driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight G3.5 
As we regularly release program updates, the difficulty that you are seeing may 
already be fixed in an update.  Even if you just bought RealFlight, you should update 
to the latest version. 

Run the DirectX Test Programs 
If you have updated your drivers and RealFlight to the latest versions, and your 
problem persists, you should try to run the DirectX samples that come with 
RealFlight. 

The DirectX samples (DirectDraw, Direct3D, Sound, etc.) are test programs written 
by Microsoft.  These samples ship with DirectX, and are designed to check whether 
your DirectX installation, video/sound cards and drivers, etc., are working correctly.  
They should work on any DirectX 9 compliant driver. 

These samples are found in the Technical Support area of the software.  Click the 
Technical Support button followed by the DX Diagnostics button.  Next, click 
either the Sound or the Music tabs, then the Test DirectX Music/Sound buttons.  
Once these tests have been completed, press the Display tab to access the Test 
DirectDraw and TestDirect3D buttons. 

The most important tests are DirectDraw and Direct3D, both of which test your 
video card and driver.  If you are having any graphics difficulty in RealFlight G3.5 
(including RealFlight G3.5 “freezing” your system so that you have to reboot), look 
for the same problem in these tests.  If the problem occurs only after you have run 
RealFlight G3.5 for a long time, make sure to run the tests for a comparable length of 
time. 

If your RealFlight G3.5 problem also occurs in Billboard, the problem lies with your 
video driver, not RealFlight G3.5.  To resolve the problem, try finding updated 
drivers for your card (see above).  If the problem still occurs with the latest drivers, 
you will need to report this problem to the card manufacturer.  Be sure to tell them 
that you tested the card by using Billboard.  Please note:  in rare cases, a newer video 
driver may have more problems than a previous version.  After exhausting all other 
options, you might try obtaining an older driver from the manufacturer to eliminate 
this possible cause as well. 

If These Steps Don’t Work… 
If the steps above do not work, please read on to the next section. 

IF YOU NEED ADDITIONAL ASSISTANCE… 
You have updated drivers, updated RealFlight G3.5, your system successfully runs 
the DirectX sample programs, and you are still having problems.  What next? 
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As a first step, we suggest checking our knowledge base at 
http://www.gpsoftware.com.  This is an easy to use, searchable, browsable database 
of known problems and solutions for RealFlight, RealRace, and our other software 
products.  This is the same database that our Product Support technicians use when 
helping customers.  We constantly update the knowledge base to address new 
problems as we discover them.  In many cases, you will be able to find an article that 
gives clear, concise instructions for resolving your difficulty. 

You may also want to check the Knife Edge Message Boards at 
http://www.knifeedge.infopop.net.  This is a place where owners of RealFlight, 
RealRace, and other Knife Edge products post questions, comments and responses 
about problems.  You may find a discussion thread about the problem you are 
experiencing. 

You can also contact Product Support at Great Planes via email at: 
rfsupport@greatplanes.com. 

IMPORTANT.  If you do contact Product Support, you can help us enormously by 
providing detailed information about your computer system.  Since your problem 
may only occur on a particular video or sound card, particular driver version, etc., we 
may need this information to help us diagnose your problem.  To get your system 
information, use the RealFlight G3.5 Launcher.  Click the Additional Options 
button.  Next, click the Technical Support button, followed by the Assemble 
System Information button.  This will create a file called “c:\launcheroutput.txt”, 
which contains your system information.  You can attach this file to an email. 

EEXXAAMMPPLLEESS  OOFF  CCOOMMMMOONN  PPRROOBBLLEEMMSS  AANNDD  SSOOLLUUTTIIOONNSS  

IF YOU DON’T SEE YOUR PROBLEM IN THIS CHAPTER… 
This chapter contains a few examples of common problems and concerns that 
RealFlight users have experienced. 

Remember that we can never provide a complete list of problems and solutions in a 
program manual.  That’s because RealFlight--and the computers, cards and drivers it 
uses--are constantly evolving.  As such, we maintain a detailed Knowledge Base at 
http://www.gpsoftware.com.  By keeping our Knowledge Base online, we can 
provide you with the latest information about resolving problems that RealFlight 
users are currently experiencing.  So, if you don’t see your difficulty described in 
this chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 
issues. 

MY COMPUTER “FREEZES” WHEN I RUN REALFLIGHT. 
Sometimes, you may also notice sound skipping or repeating, or a computer reboot 
while flying.  To resolve this type of problem, you must update the drivers for your 
video and sound cards.  This is very important.  Card manufacturers regularly 
update their drivers to fix this type of problem.  Even the driver that came with your 
new computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” 
driver, and another driver (variously called “special purpose”, “alternate”, or “beta” 
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driver).  If RealFlight G3.5 “freezes” with the “recommended” driver, try using the 
alternate driver instead. 

If you are sure you are using the latest drivers, and have followed all the other steps 
in the previous section (update RealFlight G3.5, test DirectX) and are still having 
difficulty with your computer locking up while running RealFlight, please contact 
Great Planes Technical Support. 

IMPROVING REALFLIGHT G3.5 PERFORMANCE 
During installation, RealFlight G3.5 analyzes your computer’s hardware 
specifications.  RealFlight G3.5 then tries to optimize its configuration to best take 
advantage of that hardware, and achieve the best possible performance. 

However, if the performance is less than you desire, you can adjust some of 
RealFlight G3.5’s settings to improve the simulation speed and frame rate: 

• Ensure that the drivers for the video and sound cards are up-to-date. 

• Turn off all other programs, especially virus checkers and network 
applications (such as Instant Messengers) while running RealFlight 
G3.5.  Use CTRL-ALT-DELETE and check the Task Manager to 
verify that nothing else is running in the background. 

• Reduce the texture quality.  This can have a profound effect on cards 
that do not have a high texture memory. 

• Eliminate the items shown in the simulation.  To do so, access the 
View menu title, then access the Show menu item.  Click an item type 
to remove it from the simulation.  It may be necessary to eliminate 
several items before performance meets your expectations. 

• Reduce the number of open Gadgets and Viewports.  Click the ‘X’ on 
each Gadget or Viewport that you wish to close. 

• Reduce the number of recordings currently in use. 

OTHER COMMON PROBLEMS 
Here are some other things you may want to watch for. 

• Check the CD for scratches or blemishes.  Even minor scratches or 
fingerprints can cause random problems that appear to be program 
bugs. 

• Make sure your hard drive has at least 500 MB of space available.  To 
check this: 

1. Double click on the My Computer icon on your desktop 

2. Right click on your main hard drive (usually drive “C:\”) 

3. When the popup menu appears, select Properties 

4. In the dialog that appears, view the amount of space available on 
the drive 

If you need additional space, try emptying the Recycle Bin. 

• Verify that all other programs are closed prior to starting RealFlight 
G3.5.  RealFlight works best when it is the only program running. 
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• If all else fails, try rebooting your computer.  Occasionally, Windows 
(particularly 98 and ME) may become unstable after prolonged and 
continuous use.  A simple reboot may clear up any difficulties. 
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GGLLOOSSSSAARRYY  OOFF  TTEERRMMSS  

180-Degree Turn 
This basic flight practice starts with a take off, and then demonstrates 180 degree 
turns on a flight path parallel to the runway. 

360-Degree Turn 
In this practice, you will learn to fly the aircraft in a complete circle (360-degree 
turn).  This maneuver is a great way to learn control inputs for turns while keeping 
the same radius and altitude.   

3D Acceleration 
3D operations require a huge number of calculations.  Modern computers offload 
many of these calculations to the video card, rather than performing the calculations 
directly on your computer's CPU.  This speeds up the simulation and allows for 
faster frame rates, thereby increasing the realism of the simulation. 

AccuModel 
RealFlight G3.5’s AccuModel aircraft editor offers the most powerful, most flexible 
aircraft editor ever released in an R/C simulator. 

Active View 
The active view is the view that is affected by the commands in the View menu.  
Only one view at a time is active.  You can make a view active by clicking on it with 
the mouse.  When you want to control a view’s properties, you must first make it the 
active view. 

AFR 
Advanced Flight Recorder.  This feature allows the pilot to not only view 
prerecorded maneuvers, but also allows them to record their own maneuvers.  During 
the playback of maneuvers, the pilot has the ability to select from a number of 
different options such as fast forwarding, rewinding, looping, speeding up and 
slowing down the recordings.  These recordings may also be sent to others via the 
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Internet.  The pilot can also activate an onscreen transmitter to watch the stick inputs 
for each prerecorded maneuver. 

Aileron 
Hinged control surfaces located on the trailing edge of the wing, one on each side, 
used to provide control of the airplane about the roll axis.  The control direction is 
often confusing to first time modelers.  For a right roll or turn, the right hand aileron 
moves upward and the left hand aileron moves downward.  The movements are 
reversed for a left roll or turn. 

Airfoil 
A surface (such as a wing or propeller blade) with a shape and orientation such that it 
provides or controls stability, direction, lift, or propulsion. 

Airframe 
A term used to describe the general components of an aircraft when using RealFlight 
G3.5’s AccuModel aircraft editor.  For example, selecting the airframe will call up 
the fuselage, wing(s) and tail of an airplane. 

Arm 
In this context, the arm is the distance from the point of the application of a force to 
the axis of rotation.  If you press down on the tip of a wing, for example, the arm is 
the distance from the point where you are pressing to the root of the wing. 

Auto-Play 
A Windows feature that automatically detects when a CD-ROM is inserted and runs 
the specified program on the CD-ROM. 

Autorotation 
A maneuver in which the pilot attempts to bring in the heli in for a landing without 
power from the engine.  The momentum of the blades is enough to slow the heli 
prior to landing. 

Autorotation Event 
An event where players attempt to autorotate onto a target (similar to Spot Landing).  
Each player takes a turn.  Players collect different point amounts based on landing 
location.  The Autorotation Event works for helicopters only.  The Deadstick Event is 
for airplanes. 

Avalanche 
The Avalanche is a loop with a snap roll at the top of the loop.  This snap roll must 
be centered at the top of the loop. 
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Bilinear Filtering of Textures 
Refers to using a more accurate filtering scheme than linear filtering which can cause 
blocky looking textures.  Bilinear filtering causes a blurring of the textures which 
improves the over all appearance. 

Channel Mapping 
This term describes the ability of RealFlight G3.5 to alter the mapping or input of the 
servos to accurately reflect the actual controls from an R/C controller. 

Chat 
This is a real-time communication between two G3.5 users which is conducted via 
the PC.  G3.5’s multiplayer feature enables a public chat if so desired. 

Chord 
The chord of a wing or surface is the width of the surface.  A wider chord offers 
increased lift.  However, a wider chord also generates more drag when the aircraft 
rolls. 

CG 
CG is the abbreviation for the phrase Center Of Gravity.  This is the point at which 
the aircraft balances fore to aft and side-to-side.  The location of this point is crucial 
to how the aircraft reacts in the air.  For airplanes, a tail-heavy plane will be very 
snappy, but generally unstable and susceptible to frequent stalls.  Conversely, a nose-
heavy plane will tend to track better and be less sensitive to control inputs, but will 
generally drop its nose when the throttle is reduced to idle.  This makes the plane 
more difficult to land, since it takes more effort to hold the nose up.  A nose heavy 
airplane will have to come in faster to land safely. 

Collective 
A mechanism on a helicopter that changes the pitch of the main blades, thereby 
allowing the helicopter to ascend or descend accordingly. This is the control that 
adjusts the pitch of the rotor blades. 

Collision Detection 
G3.5 sports the most advanced collision detection modeling ever used in an R/C 
model simulation.  It blankets the entire aircraft, ensuring accurate modeling of the 
aircraft when it collides with objects and items within the simulation.   

Control Panel 
The RealFlight G3.5 Control Panel is useful for many aspects of the G3.5 program. 

Control Surface 
Generally defined as the portion of the airfoil that moves.  Examples include 
ailerons, elevators, rudders, flaps, and spoilers. 
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Controller 
A device used to control an aircraft in RealFlight.  G3.5 ships with the Great Planes’ 
USB InterLink Plus Controller by Futaba.  This device can be used as a standalone 
controller, or as an interface to use your own R/C transmitter.  Previous versions of 
RealFlight shipped with either a Futaba game port controller or a Transmitter 
Adapter Interface.  For information on the latter two controllers, please see the 
manuals that came on the program CD with those versions of RealFlight. 

Cuban Eight 
This maneuver requires that the pilot perform a half roll on each of the descending 
forty-five degree down lines, allowing the pilot to fly a horizontal figure eight 
without performing an outside loop. 

Deadstick 
A term used to describe unpowered flight (glide) when the engine ceases operation.   

Deadstick Landing Event 
See Autorotation Event.  The Deadstick Landing Event is specific to airplanes. 

Dihedral 
The V-shaped bend in a wing.  Increasing the dihedral usually enhances the 
aerodynamic stability of an airplane, and causes the rudder to control both the roll 
and yaw axis.  This is why some trainers and sailplanes require only three channels 
of radio control (i.e., they have no ailerons). 

Direct Control Interface 
This is a method for using your own radio to completely control the aircraft.  This 
usually means you have a separate radio program on your radio for each aircraft that 
you want to fly in RealFlight G3.5 with this method.  All mixing and radio functions 
are performed on your radio and RealFlight simply passes the values directly to the 
aircraft servos.  This is in contrast to the Joystick Emulation Interface. 

Direct3D Technology 
A Microsoft DirectX technology used to render the 3D image when you have a 
graphics accelerator card.  It works best on faster computers. 

DirectX 
A technology created by Microsoft that controls graphics and sound operations. 

Dithering 
A method of removing and/or simulating colors that may not be available to the 
graphics processing unit. 
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Down Thrust 
This is the downward angle of the engine in relationship to the centerline of the 
airplane.  Down Thrust helps overcome the normal climbing tendency of flat bottom 
wings. 

Driver 
A software program that controls a card (e.g., video or sound card) in your computer.  
Card manufacturers usually provide drivers as well.  Card manufacturers frequently 
update their drivers to fix bugs or to make their cards compatible with new software 
and hardware.  You can often find an updated driver for your video or sound card by 
visiting the card manufacturers web site and following links to “Drivers,” “Support,” 
“Downloads”, or “Upgrades.” 

Edit NavGuides 
A NavGuide is a gadget that displays continuously updated information about your 
aircraft.  The Edit NavGuides dialog is used to customize the NavGuides gadgets. 

Elevator (Maneuver) 
The Elevator is a maneuver in which the aircraft is made to stall completely with a 
large amount of elevator throw.  The aircraft will descend almost vertically much 
like an elevator. To perform the Elevator, make sure that you have sufficient altitude, 
dive the aircraft vertically towards the ground and pull full up on the elevator stick. 

Elevator (Control Surface) 
Hinged control surface located at the trailing edge of the horizontal stabilizer, which 
provides control of the airplane about the pitch axis and causes the airplane to climb 
or dive.  The correct direction of control is to pull the transmitter Elevator control 
stick back, toward the bottom of the transmitter, to move the Elevator upward, which 
causes the airplane to climb.  Move the Elevator in the other direction to dive. 

Event 
An organized flying contest with a set of rules.  RealFlight G3.5 currently supports 
five types of Events:  Limbo, Spot Landing, Pylon Racing, Autorotation/Deadstick 
and Freestyle.  You can play Events by yourself or with other RealFlight users over 
the Internet.  Use the Event menu to start an Event. 

Exponential 
A feature commonly found on computer radios that desensitizes the servo when the 
sticks are close to the neutral position.  The further the stick position from center, the 
faster the control response. 

Figure 8 
After take off, in this practice, you will learn how to fly a Figure 8.  This is an 
excellent maneuver to learn perspective and orientation of the aircraft from all 
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angles.  Use the ailerons and elevator to turn the aircraft left and right.  Use the 
elevator to ensure that the aircraft maintains a constant altitude. 

Flap 
For Airplanes:  hinged control surface located at the trailing edge of the wing 
inboard of the ailerons.  The Flaps are lowered to produce more aerodynamic lift 
from the wing, allowing a slower takeoff and landing speed.  Flaps are often found 
on scale models, but usually not on basic trainers. 

For Helicopters:  Flapping is an up-and-down motion of the main rotor blade's tip.  
With a "dual-damped" head, (as used in the Kyosho Concept helicopters, for 
example) both blades are able to Flap independently.  With "solid axle" heads (as 
used in the Hirobo Shuttle helicopters, among others), moving one blade up causes 
the other to move down. 

Flare 
The point during the landing approach in which the pilot increases the amount of up 
elevator to smooth the touchdown of the airplane. 

FlexiField 
FlexiField is the most advanced flying site editor ever unveiled.  It presents the 
modeler with the ability to adjust the flying site in virtually any manner desired.  The 
user can add trees, selecting the type, size and color; add, move, size and orient 
buildings, walls and other scenery objects; position and orient the runway; even 
choose the amount and type of lighting at the flying site. 

Flight Failures 
RealFlight G3.5 authentically recreates common difficulties that may be experienced 
at your local flying site.  Practicing with flight failures enabled is a good way to 
practice for emergencies. 

Flight Playback Gadget 
A gadget that lets you control playback of flight recordings using mouse actions. 

Four-Point Roll 
These maneuvers are very similar to a slow roll with the exception of a hesitation at 
either ¼ of the roll or at 1/8 of the roll.  It is important to remember to use rudder and 
elevator to keep the aircraft flying in a straight line. 

Frame Rate 
Frame Rate is the number of times per second that RealFlight creates a different 
picture to display on your monitor.  Frame rate is determined by the speed of your 
CPU and graphics card, and how many RealFlight options you turn on.  This is not 
the same as refresh rate, which is the number of times per second that your monitor 
retraces an image on its screen. 
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Freestyle Event 
An event where players decide on the rules.  RealFlight G3.5 sees that each player 
gets a turn; it is the players’ responsibility to judge the competition.  Use this event 
when you have devised a group activity that requires every player to take a turn. 

Fuselage 
This is the main part of the airplane that holds the wings and engine.  The fuselage is 
often thought of as the “body” of the airplane.  This term is also used to refer to a 
“body” that might be used on helicopters. 

Futaba 
Maker of quality R/C products, including the USB InterLink Plus controller shipped 
with RealFlight G3.5. 

Gadget 
An onscreen display that shows you continuously updated information about your 
aircraft, or lets you control RealFlight features using mouse clicks. 

Global Wind 
This term describes the overall wind conditions in the simulation. 

Governor 
A device used to help maintain a constant RPM (head speed).  Generally used in 
helicopters rather than airplanes. 

Grouping 
A collection of scenery objects or foliage objects in your airport.  Every object in the 
airfield must belong to one Group.  You can place all of your airport's scenery 
objects in a single Group, or create multiple Groups to place objects in categories 
with related objects.  For example, you could have a Group for Trees and another 
group for Buildings within a particular airport. 

Gyro 
A device, most commonly used in helicopters, that aids in controlling the yawing 
action of the helicopter by automatically adjusting the deflection of the tail rotor 
blades. 

HAL Device 
A hardware-accelerated 3D video card driver.  “HAL” is an abbreviation for the 
phrase “Hardware Abstraction Layer” that uses software drivers to communicate 
between RealFlight’s software and the hardware of the PC. 
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Harrier 
A Harrier is a slow forward progression of the aircraft with the nose held high.  Use 
the elevator to stall the progress of the aircraft.  Add in more up elevator until the 
nose approaches 45 degrees.  The throttle should be used to control the forward 
progress of the aircraft, without climbing. 

Host 
In RealFlight G3.5, every multiplayer session requires one player to serve as Host.  
The Host starts the session, and then the other players join.  Other players can leave 
the session whenever they want, but only the Host can terminate the entire session.  
The host must start any multiplayer event (Limbo, Spot Landing, Pylon Racing, 
Autorotation, Freestyle). 

Hot Pluggable/Hot Swappable 
A device is said to be Hot Pluggable or Hot Swappable when you can safely connect 
or disconnect it without turning off your computer or rebooting. 

Humpty-Bump 
The maneuver consists of two vertical lines connected by a half circle flown across 
the top. 

IP Address 
Whenever your computer is connected to the Internet, it has an IP address.  This 
number is a string of digits and periods, and looks something like “123.43.6.78”.  
The IP address is like an Internet “zip code” that tells other computers where to look 
for your computer.  Depending on your Internet connection, your IP address may 
always be the same, or may change each time you connect to the Internet.  For other 
RealFlight G3.5 users to join your Multiplayer session, they must obtain your IP 
address.  You can either provide it to them directly, or post it through the RealFlight 
list server. 

Immelman Turn 
The aircraft will enter a half loop from straight and level flight followed immediately 
by a half roll to straight and level flight. 

Interface Mode 
With RealFlight G3.5 set to Interface Mode, you are using the InterLink Plus 
Controller as an interface to your own R/C radio.  In Interface Mode, your own radio 
controls RealFlight G3.5.  Conversely, in Joystick Mode the InterLink Plus 
Controller (used as a mockup of a R/C transmitter) controls the RealFlight G3.5 
aircraft. 
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Interface Wizard 
When you use your own transmitter to control RealFlight, you must tell RealFlight 
G3.5 which channels your transmitter uses for the various control functions.  The 
Interface Wizard provides a sequence of dialogs to guide you through this process. 

InterLink Plus Controller 
Great Planes’ USB InterLink Plus Controller by Futaba is a USB device shipped 
with RealFlight G3.5.  The InterLink Plus Controller can be used as a standalone 
“mockup” R/C controller, as an interface for using your own R/C transmitter to 
control RealFlight, or both! 

Joystick 
A device that connects to your computer to provide control input for the simulated 
aircraft.  The InterLink Plus controller that comes with RealFlight G3.5 is considered 
a Joystick. 

Joystick Emulation Interface 
A term used to describe using your own radio to emulate the Interlink Joystick.  This 
allows you to use your own radio to fly any of the stock aircraft in RealFlight G3.5.  
Actual radio functions such as mixing and ATVs are performed in the RealFlight 
software, not on your radio.  This is in contrast to the Direct Control Interface. 

Joystick Mode 
With RealFlight G3.5 set to this mode, RealFlight G3.5 is controlled by the InterLink 
Plus controller used as a mockup of a R/C transmitter. 

Leading Edge 
The very front edge of the wing or stabilizer. This is the edge that hits the air first. 

Limbo 
An event (flying competition) in which pilots take turns flying their aircraft under a 
Limbo bar.  The pilot that clears the lowest bar height wins. 

List Server 
RealFlight G3.5’s Multiplayer function lets you publicly “post” your session, so that 
any RealFlight G3.5 user, anywhere in the world, can find out about your session and 
join you (assuming you have not reached the enrollment limit of your session).  The 
place where you post your session is called a List Server.  Use of the List Server is 
optional.  You can preserve privacy by not posting your session, and privately 
communicating your IP address to your selected multiplayer partners. 

Please note that the free, public list server for use by RealFlight owners may be 
modified or discontinued without notice at any time. 
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Low Rates 
A switch on the radio that causes the servos move to much smaller extremes, thus 
making the model respond more slowly to a given control input. 

Mode 
Also known as Flight Mode or Stick Mode, this refers to the transmitter's gimbal 
stick assignments (locations) which determine the flight mode of your controller. 
There are two main modes of control, Mode 1- mostly used in Europe and Mode 2 
which is the predominant method of controlling aircraft commonly used in the 
United States.  

MultiMode 
A G3.5 feature that allows two users to fly simultaneously on the same PC. 

Multiplayer 
A RealFlight G3.5 feature that uses Microsoft's DirectX technology to connect with 
other RealFlight G3.5 users over a network. 

Multiplayer Session 
A network connection between RealFlight G3.5 users that allows each user to fly in 
the same "virtual world," and allows all participants to see and interact with each 
other's aircraft. 

NavGuides 
A gadget that displays continuously updated information about your aircraft. 

Pirouette 
The yawing action of a helicopter that looks much like an ice skater.  One Pirouette 
is equal to one 360-degree rotation. 

Pitch Axis 
The airplane axis controlled by the elevator.  Pitch is illustrated by holding the 
airplane at each wingtip.  Raising or lowering the nose is the pitch movement.  This 
is how the climb or dive is controlled. 

Plumb String 
When you measure your aircraft for RealFlight, some measurements require that you 
have a reference line running straight up and down.  To make such a line, we tie a 
weight to the free end of a string, and let the weight dangle.  Because the string is 
then “plumb” (oriented straight up and down), it is called a Plumb String.  A Plumb 
String is particularly useful in measuring an aircraft’s center of gravity. 
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Point Rolls 
These maneuvers are very similar to a roll with the exception of a hesitation at either 
one quarter or one eighth of the roll. 

Private Session 
A multiplayer session that is not published on our list server.  For a private session, 
the host must distribute his/her IP address to each participant, who must manually 
enter this information to join. 

Propeller 
Props are generally designated by two numbers (for instance, “10 – 6”).  The first 
number is the length (10" in the example) of the prop.  The second number is the 
pitch or angle of the blades.  In this example, the “6” represents the distance the 
propeller will move forward in one revolution. 

Public Session 
A multiplayer session that is published on a list server. 

Pylon Racing 
An event (flying competition) in which pilots take turns flying their aircraft around a 
closed course.  Pylons mark the course perimeter.  The pilot that finishes the course 
first wins. 

RAM 
Random Access Memory. 

ReadySelect 
This is the name given to RealFlight G3.5’s rotating preview box.  This allows a 
rapid view of the aircraft from all angles. 

RealFlight G3.5 
This is the latest and greatest R/C Flight Simulator produced by Great Planes and 
developed by Knife Edge Software. 

RealPhysics 3D 
This is RealFlight’s exclusive physics modeling technology.  RealPhysics 3D 
authentically replicates the actual physics of model aircraft by performing hundreds 
of thousands of floating point calculations each second while delivering sizzling real 
time performance. 

Refresh Rate 
The number of times per second that your monitor retraces an image on its screen.  
This is different from the Frame Rate. 



414  •  Glossary of Terms R/C Simulator RealFlight 

Resolution 
When used in the context of screen Resolution, this term describes the picture quality 
of the screen.  Lower Resolutions will produce an image that is not as sharp as higher 
Resolutions. 

Roll Axis 
The airplane axis controlled by the ailerons.  Roll is illustrated by holding the 
airplane by the nose and tail.  Dropping either wingtip is the roll movement.  Roll is 
used to bank or turn the airplane.  In most airplanes, the ailerons control roll.  
However, when the main wing has dihedral, the plane can be banked using the 
rudder only.  Consequently, many planes with wing dihedral do not have ailerons, 
and the rudder controls both roll and yaw.  This is one reason why most trainer 
aircraft have a large amount of dihedral -- a plane with large dihedral can be 
controlled using fewer input channels. 

Rolloff Factor 
This phrase describes how rapidly the volume of a sound increases or decreases as 
the source draws closer or moves farther away. 

Rudder 
Hinged control surface located at the trailing edge of the vertical stabilizer, which 
provides control of the airplane about the Yaw axis (causes the airplane to Yaw left 
or right).  Left Rudder movement causes the airplane to Yaw left, and right Rudder 
movement causes it to Yaw right. 

Servo 
An electromechanical device that moves the control surfaces or throttle of an 
airplane according to commands from a receiver.  This device does the physical 
work of moving parts around inside the aircraft. 

Session 
See "Multiplayer Session." 

Software Radio 
This term describes RealFlight G3.5’s ability to accurately mimic a computer 
transmitter (complete with mixing, etc.) in the simulation. 

Sound Card 
A card inside your computer that controls audio (what you hear over your computer 
speakers).  Most sound cards plug into your computer’s motherboard.  You can 
upgrade your sound card (or the software driver that controls it) without getting a 
new computer. 
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Specular Highlights 
A graphics rendering technique that makes surfaces (e.g., MonoKote™) appear 
reflective, or “shiny”, in direct light (e.g., sunlight). 

Split S 
The Split S is another step in learning to combine loops and rolls and is a great 
maneuver to decrease your altitude.  A half roll precedes a half loop, making the 
maneuver a mirror image of the Immelman.  The Split S provides course reversal and 
an easy increase in speed. 

Spot Landing 
An event (flying competition) in which pilots take turns trying to touch their aircraft 
down within a small marked landing area.  Each pilot receives a score based on 
touch down location.  The pilot with the highest score wins the event. 

Stall 
When an airplane’s angle of attack is too great to generate lift (regardless of 
airspeed), the plane will dive and rapidly lose altitude.  This is known as a stall.  
Every airfoil has an angle of attack at which it generates maximum lift.  The airfoil 
will stall beyond this angle. 

Thermal System 
This phrase describes the wind flow and effects for the thermals in RealFlight G3.5. 

Throttle Hold 
This is used to keep the throttle at a set position, yet allows input to the collective of 
the helicopter. Generally it is used to practice autorotation. 

Tip Stall 
This is when the airplane stalls and one wing drops. 

Torque Roll 
The Torque Roll occurs when the nose of the airplane is pointed vertically and the 
airplane hovers in place.  The aircraft will rotate left around its roll axis. 

Touch and Go 
Landing and taking off without a pause. Often confused with a good bounce.  

Trailing Edge 
The rearmost edge of the wing or stabilizer. 



416  •  Glossary of Terms R/C Simulator RealFlight 

Trainer 
A model designed to be inherently stable and fly at low speeds, to give first-time 
modelers time to think and react as they learn to fly. 

Trees 
RealFlight Generation 3.5 scenes can includes thousands upon thousands of trees to 
add to the realism.  The trees utilize SpeedTree technology.  (c)2002 Interactive Data 
Visualization, Inc.  All rights reserved. 

TruFlo Wind Dynamics 
RealFlight G3.5’s TruFlo Wind Dynamics is the most accurate wind model ever 
released in an R/C simulator.  It combines five different wind models to recreate the 
ever-changing wind fields found at a real flying site. 

Turbulence System 
This is the ability of RealFlight to induce turbulent, rough air, as would be 
experienced at the flying site. 

USB 
USB, or Universal Serial Bus, is a connection protocol for computer peripheral 
devices (like Great Planes’ USB InterLink Plus Controller by Futaba).  USB 
technology allows you to connect multiple devices to your computer, and supports 
high data transfer rates and is hot swappable.  USB devices have a special connector 
that only fits into a USB port.  Most modern personal computers have USB ports, 
which are usually clearly labeled.  Some computers have one or more USB ports on 
the front of the computer housing, although the USB ports are usually on the back of 
the computer. 

Video Card 
A card inside your computer that produces the images on your video monitor.  Most 
modern 3D video cards have accelerated 3D operations—that is, they perform 
numerical calculations for rendering a 3D scene, to free up your computer’s CPU to 
perform other tasks.  The video card plugs into your computer’s motherboard.  You 
can upgrade your video card (or the software driver that controls it) without 
replacing your computer. 

Viewport 
A picture-in-picture display set within the RealFlight G3.5 main display.  Each 
Viewport is independently adjustable and serves as its own unique “window on the 
world”.  The number of Viewports that may be created depends upon the power of 
your computer processor. 

Virtual Flight Instructor 
This RealFlight G3.5 feature lets you choose from a variety of prerecorded maneuver 
training lessons.  The maneuver is then demonstrated on screen, along with the 
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instructor’s voice and control stick movements.  You can index, pause and even loop 
the maneuver playback for training purposes. 

VirtualRevolution 
This is the exclusive sound technology used by RealFlight G3.5.  As with the 
original RealFlight programs, the sounds are Doppler-correct.  If the user’s sound 
card supports it, surround sound is also available. 

Washout 
An intentional twist in the wing, which causes the wing tips to have a lower angle of 
attack than the wing root.  In other words, the trailing edge is higher than the leading 
edge at the wing tips.  Washout helps to prevent tip stalls. 

Waterfall 
The Waterfall is a maneuver where the plane pivots 360 degrees in the pitch axis 
with as little forward motion and altitude deviation as possible.  As the name 
suggests, this maneuver resembles a waterfall during flight. 

Wing Loading 
The amount of weight per square foot that has to be overcome to provide lift.  It is 
normally expressed in ounces per square foot.  This specification can be easily 
calculated as follows:  first determine the area of the wing in square inches.  Then 
simply divide by 144 to obtain square feet.  Divide the total weight (in ounces) of the 
airplane by the wing area (in square feet). 

This information is valuable when deciding on which airplane to build next.  Planes 
with high wing loading must fly faster to stay in the air.  These are generally 
"performance" airplanes.  Conversely, a plane with lower wing loading does not need 
as much air flowing around the wing to keep it flying.  Gliders and trainer airplanes 
fall into this category because in this case, slow, efficient flight is highly desirable. 

Yaw Axis 
The airplane axis controlled by the rudder.  Yaw is illustrated by hanging the airplane 
level by a wire located at the center of gravity.  Left or right movement of the nose is 
the Yaw movement. 
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